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Getting Started

Quick Tour
Because it is built on both AutoCAD Map 3D and Autodesk MapGuide, you can
use Autodesk Topobase to manage the geometry and attribute data stored in
your Oracle database. For example, you can manage all the pipes, hydrants, and
valves in a municipal water network. When you use Topobase, you can draft
once and then reuse the data in many different ways, depending on your job
function. Topobase provides industry-specific data models and workflows that
help you work more quickly and more accurately.

The Topobase solution includes the following components: Topobase
Administrator (for managing your application), Topobase Client (the desktop
application), Topobase Web (the Web-based application), and Topobase Server
Administrator (for managing your database server).

In addition, Topobase offers customized modules; Electric, Gas, Land
Management, Wastewater, and Water, for use in these industries. These modules
are supported on both the Topobase Client and Topobase Web components.

Feature Classes

In Topobase, a feature class is a group of objects, such as parcels. Each feature
class corresponds to one Oracle table. Each individual feature represents a row
or record in the feature class table.

Your data model can be configured with feature classes and attributes appropriate
to your work.

For example, the Topobase Water module is designed to manage features, such
as pipes, hydrants, and valves, each of which have attributes, such as type, date
installed, and next scheduled maintenance date.
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Display Models

In Topobase, you use Display Models to style geometry, and to administer
thematic views. A display model definition specifies which set of layer files
(feature layers) is loaded into the AutoCAD Map 3D Display Manager.

Using the Display Manager, you can visualize every feature in many ways,
depending on your job function. For example, if you are a land planner, you
can style land use features according to type and size. If you are a maintenance
person, you can style pipes according to the year they were installed, the
material used, and the condition of the pipes.

Use the display model manager to create and edit display models, display
model maps, and layers. See Display Model Manager (page 434).

Workflows

Both Topobase Client and Topobase Web support workflows, which are scripted
operations for creating and analyzing data. For example, you can use workflows
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to create a network pipe or find connected pipes. Workflows apply business
rules to maintain data consistency, accuracy, and design standards.

Jobs

Using Topobase Jobs, multiple project teams can work from the same set of
information at the same time. Team members can select an area of
infrastructure to work on, isolate changes and additions from live data, and
establish an approval process for going live with completed jobs.

Topologies

Topobase topologies maintain relationships between points and lines (network
topologies) and polygons (area topologies) in a logical interrelated network
that facilitates accurate data management, tracing, and analysis. You can also
define logical topologies to include features that are not physically connected.
The topology is updated when geometry is modified or created.

Topologies are often used to solve business problems. For example, by keeping
track of the water pipes and valves that are connected to each other in a water
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network, you can run a trace to determine the houses that are affected if a
particular valve is shut off.

Utility Model

The Topobase utility model is a data model designed for utility applications.
It provides feature classes and rules for network topology. A key element of
the utility model is the separation of geometry and attribute data within the
database. By managing attribute data and geometry separately, you can, for
example, have a single pipe record with multiple geometries. A soft split shares
attribute data among multiple geometries. A hard split creates multiple
geometries, each with its own attribute data.

Topobase Administrator

Use the Topobase Administrator to design forms, create reports, establish rules
for job management, set up users and groups, manage workspaces, documents,
configuration settings, and topologies, customize workflows, and create and
edit the data model.

Topobase Client

Use Topobase Client to display, create, edit, and analyze geometry and attribute
data. Topobase is fully integrated with AutoCAD Map 3D and uses the
AutoCAD Map Display Manager to apply styles to feature geometry.

Workflows with appropriate business rules streamline the drawing process
and maintain data consistency, accuracy, and design standards.
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Topobase Web

Because it is built on Autodesk MapGuide, Topobase Web enables users in the
field to view, analyze, create, and edit geometry and attribute data in a web
browser. Your administrator can create web layouts used to perform some or
all of the following operations: obtain feature information, redline, locate a
specific feature or position, add dimension lines, use workflows (with business
rules) to create and analyze data, use construction and calculation function
(COGO) tools, label features, and generate reports.

Modules Gas, Water, Wastewater, Electric CE, Electric NA

Use the Topobase modules Gas, Water, and Wastewater to document, maintain,
and present utility networks. The data models, workflows, and feature display
settings are specifically designed to support utility organizations.

The Electric CE data model, workflows, and feature display settings are
specifically designed to support electric management organizations in Central
Europe. The Electric NA data model, workflows, and feature display settings
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are specifically designed to support electric management organizations in
North America.

Topobase Land Management

Use the Topobase Land Management module to document, maintain, and
present land management data. The Land Management module provides a
data model and workflows that are specifically designed to manage properties,
real estates, boundaries, and land use coverage consistent and compliant to
federal standards.

Topobase APIs

Use the Autodesk Topobase APIs to create customized applications, plugins,
workflows, and other solutions.

Application modules allow you to customize Topobase for particular purposes
by creating data models, feature rules, update modules, workflows, and changes
to the user interface. You can also create standalone plugins to allow new
functionality and additional mechanisms for user interaction with documents
and workspaces.

Autodesk Topobase provides a large number of samples that show you how
to use the API. These are provided in both C# and Visual Basic formats. Samples
cover a broad range of categories, such as:

■ Connecting to the database

6 | Chapter 1   Getting Started



■ Customizing the user interface

■ Manipulating features

■ Creating new workflows

Detailed developer documentation is available in the online help.

Overview of Setting Up Topobase

Licensing Topobase

For specific information, see the Topobase Installation Guide.

Setting Up TBSYS

After the Topobase installation, you must install the Topobase System User,
TBSYS. To install TBSYS, run Topobase Server Administrator. For specific
information, see the Administrator Guide, section Setting up the Database
(page 27).

Setting Up Topobase Client

The Topobase workspace is the user's working environment. When a user
opens a workspace, the appropriate feature classes, workflows, menus, and
tool bars are loaded and ready for use. The administrator defines the workspace
and can customize it, assigning the appropriate roles and rights based on job
function.
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A workspace contains one or more documents, each containing data models.
For example, one workspace can contain a land management document and
a wastewater document for users who need access to both documents. When
you create a workspace, you can either create a document from scratch or
import an Oracle dmp file.

You can apply different display models as needed for your work. Topobase
provides a default display model and autoload layers to help orient users to
the map before generating.

For each document in the workspace, you can adjust the data model, customize
the Document Explorer, set up rules for jobs, design feature class forms,
customize workflows, define Feature Search searches, and specify the contents
of menus and tool bars.

See Setting Up Topobase (page 55).

Setting Up Topobase Web

The administrator can create web applications for users in the field. The
workspaces, data forms, workflows, jobs, and Feature Search searches you
define for Topobase Client can also be used in any Topobase Web application
that you create. This means that your users can edit data in Topobase Client
on the desktop, or in Topobase Web from a web browser.

Associate your workspace with a Topobase Web Layout that you create using
Autodesk MapGuide Studio. Direct your users to the appropriate URL for their
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work. By assigning display models that can be viewed on the web, you can
easily switch between several display models.

Viewing, Creating, and Editing Data

Opening a Workspace

A Topobase workspace is your customized working environment. It contains
one or more documents that contain the feature classes, visualization styles,
and workflows relevant to your work. The workspace also provides the
appropriate access rights for your role. To begin to work with Topobase, open
a workspace.

Using Topobase Commands

Topobase data is organized by classes of features such as Pipes or Valves.
Right-click a feature class in the Topobase pane to view available commands
such as Show Form to view feature information and Digitize to create new
geometry. You can also start workflows by right-clicking the feature class. Use
the Document Explorer to browse feature classes and create new features.

Viewing Geometry

Use the Generate Graphics command to populate your map with the feature
geometry in the database.
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Your administrator defines the styles and themes that control the display of
your features. Each feature class can be associated with one or more layers
that have associated styles. Use styles to display the same features in different
ways depending on your needs. All feature classes, for example pipes, houses,
and parcels can be visualized in many ways as needed by your job function.
For example,

■ If you are a land planner you might want to see land use themed according
to type of use as well as parcel size. In this case, one feature class would
have two ways of displaying the same data.

■ If you work in maintenance, you might want to see pipes themed according
to the year they were installed, the material used and the condition of the
pipes.

■ If you are a project manager, you might want to see the land planning
layers and the maintenances layers.
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Creating Features

Feature creation commands are organized by feature class. Right-click a feature
class to display all available feature creation commands. You can digitize new
geometry, digitize geometry and populate a form with attribute data, convert
existing AutoCAD geometry into Topobase features, or perform any available
creation workflow.

When you create a new feature, it is automatically associated with the correct
feature class. If the feature class is part of a topology, the new geometry is
incorporated, and the topology is updated. Feature rules ensure that new
features are consistent. Your administrator can establish required attributes
and available settings for attribute forms.

Editing Features

Use AutoCAD commands to edit feature geometry. Select the feature, click
Home tab ➤ Quick Access panel ➤ Edit Geometries. Grips are displayed on
the feature. Make changes and click Edit Geometries again to end Edit
Geometries mode, and protect features from inadvertent change. Changes are
saved to the database immediately.
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You can also make changes to a specific set of features. Display the form for
a feature class, use the filter to find a subset of features, and make your edits.
Use Global Update to update all features in the set. Remove the filter to edit
all features in the class.

12 | Chapter 1   Getting Started



Learning Topobase

User Documentation

Online help is provided for each Topobase component; Administrator, Server
Administrator, Client, Web, Water, Wastewater, Gas, Electric (NA and CE),
Land Management, and Survey.

Infocenter

The InfoCenter provides a quick and easy search through the complete set of
available documentation. Use the Settings dialog box for InfoCenter to select
the documentation that you want to search, and the number of results to
display.
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Other Information

For more information about Topobase and to interact with other users, see
the following locations:

■ Topobase Discussion- Participate in discussion with other Topobase users.

■ Topobase Support- Obtain product support.

Topobase Administrator Features

Designing Forms

Use the Form Designer to customize feature class forms, define multiple forms
for a single feature class, and to assign different forms to different user groups.
Each feature class has its own form that contains attribute data. Customize
forms by adding or removing attributes, related records, and layout elements.
You can also add or remove tabbed pages, customize form tool bars, and adjust
the size or position of form elements. In Topobase Administrator, do the
following:

■ open a workspace

■ open the document node
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■ click the Form Designer node

■ select a feature class from the Form Explorer

■ under Form Types, select a form, such as Default

■ click Edit to open the Designer dialog box

Working With the Data Model

Use the Data Model Administrator to create and edit feature classes, add feature
class attributes, enable feature classes to work with jobs, manage domain tables
of attribute values, manage labels, create and manage topologies, and define
feature rules. In Administrator, open the workspace, open the document node,
and then click the Data Model node.

Designing Report Templates

Use the Report Designer to create templates for customized reports. Your users
can generate reports in either Topobase Client or Topobase Web. Assign reports
to any Topobase feature class form. Report definitions are stored in the
document (TB_RPT_*tables). In Administrator, open the workspace and open
the document node. Click Document menu ➤ Report Designer.

Setting up Jobs

Use the Job Administrator to set up Topobase Jobs. Jobs are based on Oracle's
VPD (Virtual Private Database) technology which allows multiple states for a
feature in the database. For example, a set of features can be Open (in progress),
Pending (awaiting approval), and Live (approved and complete, read-only).

Use Topobase Jobs to specify an area of infrastructure that is being built or
modified, keep modifications separate from live data, and establish an approval
process for going live with completed jobs.

To work with jobs, the document you plan to use must be job-enabled. You
can then create a job template where you can specify which feature classes
will be used in the job. Topobase Client and Topobase Web users can use the
Job Manager to work the specified feature classes. In Topobase Administrator,
open the workspace and open the document node. Click Job Administrator.

Pessimistic Locking

Topobase Jobs support two types of feature locking to handle job conflicts.
Use Pessimistic Feature Locking to detect and solve any job conflicts as early
as possible. Job conflicts will be detected as soon as the same feature is modified

Topobase Administrator Features | 15



in different jobs. You use Partial Posting to extract a subset of features from
the current job in order to change its state to Live immediately. Then the
modified features can be modified again in other jobs. Use Optimistic Feature
Locking, if you want to allow modifications, even if conflicts occur. With
Optimistic Feature Locking, job conflicts will not be detected immediately,
but only when you change the job state. In Topobase Administrator, use
Document Settings to set up the feature locking type.

Use the Job Explorer to view and process all modifications that have been
made in a job. For example, you delete (undo) modifications. Also, you can
lock those features manually, that you plan to modify, so they cannot be
modified by other users.

Defining Profiles

Use the Profile Designer to set up profile definitions and templates for any
document that contains the Profile Extension. In Topobase Administrator,
open the workspace, open the document node, and click the Profile Designer
node. Click Create to specify the profile settings. In Topobase Client, you start
the Profile Manager to draw the profiles, based on your profile definition.

Defining Topologies

Use the Data Model Administrator to create and manage topologies, set tracing
conditions for network topologies, and define tracing templates. Use tracing
templates in Topobase Client to execute network tracing in utility networks,
such as water, wastewater, and gas.

In the Administrator, open the workspace, open the document node, and
click the Data Model node. Right-click the Topologies node to create a new
area or a new logical topology. Network topologies are created as part of the
utility data model.

Network topologies represent the connections between real world objects.
Network topologies consist of nodes and edges that comply with the Topobase
utility model. They are used in the Topobase utility applications, such as
Water, Gas, or Wastewater. Network topologies are created as part of the utility
data model. For more information, see Utility Reference in the Topobase
Administrator Guide.

Managing Workflows

Topobase workflows are scripted operations that apply business rules to
maintain data consistency and accuracy as well as to facilitate common
operations. Topobase provides workflows for many data creation, analysis,
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and reporting operations. These workflows are supported in both Topobase
Client and Topobase Web applications.

Use the Workflow Administrator to create your own workflows. Note that to
do this, Microsoft Visual Basic, Microsoft .NET, and Topobase API (Application
Programming Interface) knowledge is required.

Managing Users and User Groups

Create users and groups. Assign workspaces and define user interface based
on groups. To manage users and groups, click the Setup node in Administrator
and then click User, and User Groups.

Administrator Tools

Use Topobase Administrator tools to manage customization, and data
migration.

■ The SQL Assistant simplifies the creation of SQL select statements. It
facilitates the entry of table names, attribute names, and relations. SQL
Assistant also provides context specific information about the database
schema with which you are working. For example, it displays list tables,
views, feature class attributes, feature relations, and queries whether the
values are actually stored in the database. In Administrator, whenever you
are defining an SQL select statement, click SQL Assistant, or click Workspace
menu ➤ SQL Sheet to start a standalone version.

■ The Topobase Data Checker validates the quality of your data. For example,
define any set of consistency checks that can be executed after data has
been imported into a document. Start the data checker either manually
on demand or on a scheduled basis. You can either check the whole
database, or jobs only. In a scheduled mode, the result is provided as a
report that can be emailed to any recipient.

■ The Topobase Schema Converter analyzes and converts any Oracle structure
into a Topobase database schema. For example, to convert an Oracle table
in a Topobase feature class. The schema converter analyzes non Topobase
tables, and lists any conflicts. After resolving the conflicts, you can start
the conversion, which adds Topobase specific columns, renames the
geometry column to GEOM, creates and stores the Topobase metadata.

■ The Topobase Security Administrator. defines Oracle users/roles with
customized access rights on a Topobase document. Autodesk Topobase
provides several permission templates, such as Full Access, or Read Only.
You can save your own permission templates for reuse.
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■ The Topobase Oracle Data Import is a migration tool to transfer Oracle
data from any Oracle user to a Topobase document. The first migration
step has imported the data into an intermediate Oracle user, without
changing the original data structure (flat port). Then, the Oracle Data
Import transfers the data into your final Topobase document, according
to your mapping definition.

Topobase Client Features

Electric Module

Use the Topobase Electric NA and CE modules to document, maintain, and
present electric networks in North America and Central Europe, respectively.
The data models, workflows, and feature display settings are specifically
designed to support electric management organizations in these regions.

Topobase Electric NA provides workflows specific to North American electric
management organizations. You can compute load, reconfigure circuit and
flow, reconfigure phase, and transfer load.

Topobase Electric CE provides workflows specific to Central European electric
management organizations. You can perform a variety of analysis workflows
on your networks, or run a house connection creation workflow. In addition,
Topobase Electric CE provides workflows for creating cross section templates.

Use the Electric Explorer to view, build, and maintain electric networks. The
Electric Explorer provides access to many features at one time and can display
the relationships between features. Each class of features is displayed in a
separate container that enables you to select multiple features and edit them
at once. The Electric Explorer displays segments, ducts, conductors, devices,
and other electric elements and provides functions and workflows to manage
network features. Profiles let you customize the Electric Explorer to show just
the feature containers you need for your work.
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Wastewater Inspection

Wastewater networks require regular inspections in order to avoid sanitation
and flood damage. Accurate inspection data is important in order to judge
the severity of necessary repairs and closely estimate renovation costs. This
can be done by means of importing inspection data. Once inspection data is
imported, into Topobase, you can:

■ Verify the inspection data

■ View video to check the inspection data quality

■ Classify damage and wastewater network features

■ Import hydraulic computation results

The Inspection Editor allows you to review imported inspection data pertaining
to specific sections of the wastewater network. If an inspection video is
available, you can view the content and edit observations made by the
inspection team. If you notice damage that was not caught by the inspection
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team, you can add and classify new observations. To simplify the review of
inspection data, the Inspection Editor displays a side-view representation of
the inspected section of pipe along with damage codes at specific distances
along the length of the section. An Observation Editor displays a graphical
representation of the inside of the inspected section. Using the Observation
Editor, you can review the type of damage found, verify its severity and extent,
and update an observation, if necessary.

Display Models

Use Topobase Display Models to administer thematic views. A display model
definition specifies which set of layer files (feature layers) is loaded into the
Display Manager. The settings are stored in display model (.tbdm) files so they
can be shared with your customers and other groups in your organization.
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You can apply different display models as needed for your work. Topobase
provides a default display model and autoload layers to help orient users to
the map before generating. You can use multi-map windows to display the
features in multiple drawings. For each drawing window you can define
different stylizations.

Retrieving Information

In Topobase Client and Topobase Web, as well as the modules, you can retrieve
information about any feature. Select the feature in the map and then click
Home tab ➤ Quick Access panel ➤ Attributes to display the feature class form.
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Creating New Features

Right-click a feature class to access the commands for creating new features.
For example, you can draw new geometry, convert existing drawing objects
to features stored in the database, or use a workflow to create new features.

Working With Jobs

Your administrator can set up multiple jobs to allow changes to be made and
reviewed before going live. For example, setting up two jobs for the same
project can help evaluate design and cost alternatives. After completion, all
jobs are retained in history for future reference. Jobs are supported in both
Topobase Client and Topobase Web. A perimeter controls the area included
in the job. The Jobs toolbar is only available if feature classes are job-enabled.
Use Topobase Administrator to enable jobs and define job rules.
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Schematics and Generalizations

In Topobase, you can create schematics and generalizations. You can build
orthogonal and geoschematic diagrams. Use generalization features to represent
real world features in modified locations that are easier to view and understand.
Before you can build a schematic or generalization, your Topobase
administrator must create a schema or generalization plan. The schema plan
specifies the type of schematic to generate (orthogonal or geoschematic), the
schema topology, the feature classes that can be included, and some specific
drawing settings. Similarly, the generalization plan specifies the feature classes
to include.

Change from the Real World display to a schematic or generalization display
using the Representations drop down on the ribbon. Click Home tab ➤ Data
Source panel ➤ Representations.
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To create a schematic, click Home tab ➤ Data Source panel. From the
Representations list, select the schematic plan created by your administrator.
Display the Workflow Explorer and run the Build Schematic workflow. Select
the features to include in the schematic either directly from the map or by
using a trace. The set of features are displayed in a feature explorer so you can
review them. When you are satisfied with the set of features, click Build to
draw the schematic. To create a generalization, click Home tab ➤ Data Source
panel. From the Representations list, select the generalization plan created by
your administrator. Display the Document Explorer, right click a generalization
feature class, and digitize the feature.

Labeling Features

You can display any attribute of a feature as label text and position the label
precisely in relation to the associated feature. Labels are stored in the label
feature class which is a child of the feature class whose attribute data is
displayed. Each feature class can have only one label feature class. To add a
label, click Home tab ➤ Quick Access panel ➤ Create Label. Then click the
feature to label.

Analyzing Data

Use the Network Tracer and the Topology Checker to perform analysis on
your network. When configuring the Network Tracer, you can choose a tracing
template, specify Start and Stop features, set stop conditions, and other trace
options. Use the Topology Checker to locate errors in network topologies.
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Survey

Use the Topobase Survey module to import and process field measurements.
The module provides tools to import terrestrial and GPS survey data. You can
import the field data and calculate the coordinates in a survey database schema.
Using statistical quantities, you can analyze the results, and distribute the
coordinates to the appropriate documents, such as Water, or Wastewater.

Plotting

Create plot designs and save them as plot templates. Use a plot template as
the basis for many separate plots. Topobase plots the area of the map you
define, using the current state of the features. You can print a plot or save it
to a file. Plots and plot templates are stored in the Plot Library.

A Topobase plot specifies the settings for sending a map to a plotter. It specifies
the printer, paper size, scale, rotation, and display model for the map. It defines
elements such as a map placeholder, legend, north arrow, and scale-bar. These
elements are stored as a special feature class rather than as AutoCAD objects,
so they are saved in the database. Using a display model and plot templates,
you can create plots with title blocks and other elements.

Topobase Client Features | 25



Topobase Web Features

Editing and Styling Features

In Topobase Web, most of the key features are the same as Topobase Client
features. Because Topobase Web is built on Autodesk MapGuide, use Autodesk
MapGuide Studio to create layer styles and labels. You create a layout and
publish it to the Web for your users. Feature editing is direct. There is no need
to enable Edit mode. Some operations, such as Create Feature From Geometry
(which creates a new feature from an AutoCAD object) are not available.

Redlining and Dimensioning

Use redlining to mark up a map with temporary features, text, or symbols for
printing or sharing. Use dimensioning to add temporary dimension lines or
orthogonal marking to features in the map. Redline and dimension layers are
stored in the web cache and are not saved to the database.

Fusion Templates

Use a Flexible Web Layout to view and interact with maps on the Internet or
an intranet. A flexible web layout is a CSS-based web layout, which allows you
to modify the templates provided with MapGuide Studio and to add third
party templates. When you build a new Flexible Web Layout, you only need
to specify the map to display. All other settings have default values.

New Features in Topobase Administrator
Users and User Groups

You can now assign a user to multiple user groups. Use case: A single person
needs to access multiple user groups. See Users and User Groups (page 97).

Structure Editor

The Topobase Structure Editor simplifies the process of data model
customization. See Topobase Structure Editor (page 303).

LDAP support

Topobase supports LDAP and Active Directory (single sign on), so you can
integrate Topobase more seamlessly into your corporate environment, and
avoid the Topobase login dialog.
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Server Administrator

The Server Administrator provides a wizard to set up your database (TBSYS),
and to update your existing documents. See Server Administrator (page 28).

1-Click Maintenance

Use the 1-Click Maintenance tool to run several basic database maintenance
checks on one click. See Database Maintenance (page 136).

Job Administration

The new Job Administrator UI provides a single point to set up your job
templates, and to administer job transition. See Job Administrator (page 353).

Area Topology Tolerance

For area topologies you can now specify a tolerance value for area modifications
outside a perimeter. See Area Modification Outside Perimeter (page 316).

See also:

■ New Features in Topobase Client

Setting up the Database
After the first Topobase installation, you create the Topobase System User
TBSYS. The Topobase Administrator and Topobase Client logins require the
credentials for TBSYS.

Use the Topobase Server Administrator (page 28).-----Create TBSYS (page 30)

To provide limited rights for Topobase users, you
can create a Topobase Main User, TBMAIN.

-----Create TBMAIN
NOTE If you delete TBSYS, you will also delete
TBMAIN.
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For learning purposes, we recommend that you
install some or all of the demo data sets.

-----Set up the demo data (page 39)

After you have installed a newer version of Topobase, you update your
Topobase System User TBSYS, and you update your existing documents.

IMPORTANT You cannot run a Topobase Client version that is higher than the
Topobase server version. A message notifies you if server and client versions are
incompatible.

Use the Topobase Server Administrator (page 28).-----Update TBSYS (page 31)

The Server Administrator wizard steps you
through this procedure. See also Document
Structure Updates (page 33).

-----Update your documents

Start the application.-----Start Topobase (page 34)

Server Administrator
Use the Topobase Server Administrator to administer the Topobase System
User, and to update the structure of your documents (database schemas).

In the Topobase Server Administrator wizard, on the left, the Task Overview
guides you through the necessary steps. The wizard validates your entries. Use
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the contextual navigation buttons at the bottom to continue. Use the links
in the Task Overview to get back to a previous task.

DescriptionServer Administrat-
or wizard

Establishes the connection to the Oracle database. You login
as Oracle user with rights on SYS.DBMS_RLS and DBA rights.

Step 1: Connect To
Database

After the first installation of Topobase, you unlock the MDSYS
user. If your Spatial System User MDSYS is set up correctly,
this step will be skipped.

Step 1b: Manage
Spatial User

Manages the Topobase System user. You can create, update,
unlock, or delete the Topobase system user TBSYS.

Step 2: Manage Sys-
tem User

In the Topobase System User Information grid, entries in red
indicate the values that need to be updated.
See also Topobase System User TBSYS (page 32)

Manages the Topobase Main user. You can create, update,
unlock, or delete the Topobase Main user TBMAIN.

Step 3: Manage
Main User

Lists the documents along with their data model components
and extensions that are referenced in TBSYS, and compares

Step 4: Select Docu-
ments

the current version to the latest version. Each component
has a data model code (page 184) that is displayed in paren-
theses.
A document consists of several components, each with its
own version.

■ General document version.

■ Module version, such as Water, Gas.

■ One or more extensions, such as COGO, Plot.

See also Document Structure Updates (page 33).

Verifies your Topobase Administrator rights. To update the
document structure, you need Topobase Administrator rights.

Step 5: Verify User
Permissions

See also User Login (page 38).

Displays details about the document structure updates that
are being performed. When the updates are finished, you
can view and save the update report.

Step 6: Update Docu-
ments
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When you start the Topobase Server Administrator, and the system cannot
connect to the Topobase System User, do the following:

■ In the server explorer in the left pane, click Topobase System User.

■ Enter your password and click Refresh.

■ IMPORTANT If you try to connect to TBSYS using a wrong password more
than ten times, the TBSYS account may be locked. To unlock the account, click
Unlock.

To create the Topobase System User (TBSYS) and the Topobase Main user
(TBMAIN)

You perform these steps after the initial installation of Topobase.

Make sure that Oracle Services are running and you have your Oracle login
names and passwords available.

1 Click Start menu ➤ Programs ➤ Autodesk  ➤ Autodesk Topobase
2011 ➤ Autodesk Topobase Server Administrator 2011.

2 Under step 1, Connect To Database, login as Oracle user with rights on
SYS.DBMS_RLS and DBA rights (default “SYS”). Service name (SID) default
is ORCL.

3 Enter your login credentials , and click Next to establish the connection.

The system checks the Spatial user MSDYS. MDSYS must be unlocked
and the password must not be expired. If the MDSYS is not set up, the
wizard displays the Connect To Database - Manage Spatial User step.
Unlock the username, and set a password.

4 Click Next.

5 Under step 2, Manage System User, click Create.

6 In the Create A New Topobase System User dialog box, enter the user
name, and a password for TBSYS.

Topobase allows you to select the default and temporary table spaces
TBSYS will use. You can choose these table spaces from the pick-lists.

7 Click OK.

8 Under step 2, Manage System User, enter the password, and click Refresh,
and view the Topobase System User Information grid.

9 Click Next to continue.
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10 Under step 3, Manage Main User, click Create.

11 In the Create A New Topobase Main User dialog box, enter the user name,
and a password.

Topobase allows you to select the default and temporary table spaces
TBMAIN will use. You can choose these table spaces from the pick-lists.

12 Click Next to continue.

NOTE The MDSYS and TBSYS usernames and passwords are case sensitive in
Oracle 11g.

Step 4, Select Documents, only applies if you have installed a newer version
of Topobase, and if you have existing documents. See Document Structure
Updates (page 33).

To update the Topobase System User (TBSYS) and the structure of the
Topobase documents

You perform these steps after you have installed a newer version of Topobase.

1 Click Start menu ➤ Programs ➤ Autodesk  ➤ Autodesk Topobase
2011 ➤ Autodesk Topobase Server Administrator 2011.

2 Under step 1, Connect To Database, login as Oracle user with rights on
SYS.DBMS_RLS and DBA rights (default “SYS”). Service name (SID) default
is ORCL.

3 Enter your login credentials , and click Next to establish the connection.

The system checks the Spatial user MSDYS. MDSYS must be unlocked
and the password must not be expired. If the MDSYS is not set up, the
wizard displays the Connect To Database - Manage Spatial User step.
Unlock the username, and set a password.

4 Click Next.

5 Under step 2, Manage System User, select the TBSYS user, and enter the
password.

6 Click Refresh, and view the Topobase System User Information grid. The
Topobase Server Version, and the Topobase Client Version must match.

7 Click Update.

8 To read the update details, click View Log.

9 Save the log file for further reference.
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10 Click Next to continue.

11 Step 3, Manage Topobase Main User, displays your TBMAIN. Normally,
no action is required. Click Next to continue.

12 Step 4, Select Topobase Documents displays your existing documents.
Select all documents to update. Click Next to continue.

13 In step 5, Verify User Permissions, log in as a Topobase Administrator.

14 Click Update.

15 In step 6, Update Documents, the status window lists the updates that
are applied to each document. Errors that prevent a document from being
updated, are highlighted in red.

16 To read the update details, click View Log.

17 Save the log file for further reference.

18 Close the Server Administrator.

Topobase System User TBSYS
The Topobase System User (TBSYS) is the server component of Topobase. It is
the system database schema TBSYS that stores application settings and
server-side procedures.

The Topobase Administrator and Topobase Client logins require the credentials
for the Topobase System User (TBSYS).

Managing multiple TBSYS users

If needed, you can install multiple TBSYS users in the same Oracle server. For
example, if you need to run two Topobase versions side by side. Using the
Topobase Server Administrator, you can manage each TBSYS independently.
Note that each TBSYS would need its own set of documents, because the
document version and the TBSYS version must match, and you cannot work
with documents of an older version.

TBSYS and TBMAIN

If you do not want to provide the TBSYS credentials to all Topobase users, you
can create a Topobase Main User (TBMAIN). TBMAIN has restricted rights on
TBSYS: administrative users must connect through TBSYS. Non-administrative
users can log in to Topobase Client using TBMAIN rather than TBSYS.
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NOTE If you are an administrative user, logging in using the Topobase Main User
(TBMAIN) credentials disables your administrative privileges. For example, you
cannot log in to Topobase Administrator using TBMAIN, or you cannot use the
administrator functionality of Topobase Client, such as editing all viewports,
administering filter definitions or reference records.

To work with Topobase Client, we recommend that you connect to the
Topobase Main User TBMAIN. When you are connected to TBMAIN,
administrator functionality is not available.

See also:

■ Server Administrator (page 28)

Document Structure Updates
After you have installed a newer version of Topobase, the structure of your
existing documents has to be updated. This update is incorporated in the
Server Administrator workflow, step 4. See To update the Topobase System
User (TBSYS) and the structure of the Topobase documents TBSYS:updatin...
(page 31)

The document structure update comprises

■ General structure updates, such as Topobase system table updates. This
update is driven by the document version.

■ Module-specific updates, such as adding new feature classes, or domain
values. This update is driven by the module version.

■ Updates of the extensions. This update is driven by the extension version.

■ Updates partner-specific enhancements. This update is driven by the custom
module version.

Alternatively, you can update the document structure using Topobase
Administrator. When you open a workspace, for each document, you are
prompted to update the structure of the document.

See also the Topobase Structure Editor (page 303).
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Starting Topobase
You can start Topobase Client and Topobase Administrator separately.

In the Topobase Login dialog box you can specify two connections: One is to
the application and one is to the Topobase System User (TBSYS).

When you start Topobase Client or Topobase Administrator, you establish the
Topobase System User connection in the Topobase Login dialog box. There
are two users for Topobase: TBSYS and TBMAIN. Mostly a default connection
is specified during the configuration process. See also Topobase System User
TBSYS (page 32).

At the first launch of Topobase Administrator, after installing a newer Topobase
version, you are prompted to update the Topobase forms. Click Yes to start
this update. If you are prompted to update the structure of the document,
click Yes. See also Data Model Code (page 184).

Topobase Web

Before launching Topobase Web you have to provide a web layout. See Setting
Up Topobase Web (page 107)

To start Topobase Administrator

1 Click Start menu  ➤ Programs  ➤ Autodesk  ➤ Autodesk Topobase
2011 ➤ Autodesk Topobase Administrator 20xx.

2 In the Topobase Login dialog box, enter your user name and password.
The default user name is Topobase. You can leave the password empty.

3 At the first login, you must connect to the Topobase System User. Click
Options>>> and enter the Topobase System User credentials. You specify
these settings only once. See also To connect to the Topobase system user
TBSYS (page 35).

4 Click Connect.

5 Click Workspace menu ➤ Open.

6 Select a workspace and click Open.

7 If no workspaces are available, click Cancel.

If you do not have an open workspace, only the basic setup commands are
available in the Administrator explorer.
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You start by clicking a command on the Administrator menus or by clicking
an item in the Administrator explorer. See Exploring Topobase Administrator
(page 49).

Topobase Administrator with explorer pane, menu bar, and property pane.

To start Topobase Administrator from Topobase Client

1 Click Start menu  ➤ Programs  ➤ Autodesk  ➤ Autodesk Topobase
2011 ➤ Autodesk Topobase Client 2011.

2 Log in as Administrator.

3 Click Setup menu ➤ Administrator.

To connect to the Topobase System User TBSYS

1 Start Topobase Administrator.

2 In the Topobase Login dialog box click Options>>> to show all options.

3 In the Topobase Main User section enter the login parameters to the
Oracle database schema TBSYS.
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User name: TBSYS

Password: Default is TBSYS (check with your administrator).

Service name: Default ORCL (check with your administrator).

4 Click Options<<< to hide the Topobase Main User section.

5 Enter the login for the Topobase application. If you connect for the first
time, use the following values:

User name: Topobase

Password: Leave empty.

Topobase is the default user, which is a member of the administrator user
group. Later you can create more users and user groups to work with.

6 Click Connect to start Topobase.

To connect to the Topobase Main User (TBMAIN)

1 Start Topobase Client.

2 In the Topobase Login dialog box click Options>>> to show all options.

3 In the Topobase Main User section enter the login parameters for the
Topobase Main User TBMAIN.

User name: Check with your administrator.

Password: Check with your administrator.

Service name: Default ORCL (check with your administrator).

4 Click Options<<< to hide the Topobase Main User section.

5 Enter the login for the Topobase application. If you connect for the first
time, use the following values:

User name: Topobase

Password: Leave empty.

Topobase is the default user, which is a member of the administrator user
group. Later you can create more users and user groups to work with.

6 Click Connect to start Topobase.

To start Topobase Client

See the Topobase Client User Guide.
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To start Topobase from the command line

Use the following command line parameters.

Username=<username>

Password=<your password>

Workspace=<workspace>

TBSysUserName=<tbsys>

TBSysPassWord=<your password>

TBSysService=<service>

SplashScreen=Off

/nologo

Example—Start Topobase Client

<topobase_client>\acad.exe c:\data\empty.dwg ;Username=Topo

base;PASSWORD=TOPOBASE;TBSysUserName=TBSYS;TBSysPassWord=TBSYS;TB

SysService=ORCL;SplashScreen=Off; /nologo

NOTE You have to specify a drawing file. This can be any empty (*.DWG) file.
Note that after the drawing file name, you must enter a blank, followed by a
semicolon, followed by the parameters. If you do not provide the parameters for
TBSYS, the system will log in using the values you previously entered in the login
dialog box.

Example—Start Topobase Administrator

<topobase_administrator>\bin\Topobase.Admin.exe Username=Topo

base;Password=TOPOBASE;TBSysUserName=TBSYS;TBSysPassWord=TBSYS;TB

SysService=ORCL;SplashScreen=Off;

Example—Start Standalone Topobase Client

<topobase_client>\bin\Topobase.exe Username=Topobase;Password=TO

POBASE;TBSysUserName=TBSYS;TBSysPassWord=TBSYS;TBSysSer

vice=ORCL;Workspace=TB_LM;SplashScreen=Off;

To start Topobase Web

Open the browser and launch Topobase Web either with the Desktop shortcut
icon or with the following URL:

http://<HOSTNAME>/MapGuide2011/TBWeb/login.aspx

The login.aspx can also be used with optional parameters to automatically
login and select a workspace.

■ SystemUser
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■ SystemUserPassword

■ ServiceName

■ Username

■ Password

■ Workspace

NOTE The URLs should all be entered on a single line without any spaces.

Examples

http://localhost/MapGuide2011/TBWeb/Login.aspx?Username=Topobase&Password=TOPOBASE

http://localhost/MapGuide2011/TBWeb/Login.aspx?Username=Topobase&Password=TOPOBASE&Workspace=LAND_MANAGEMENT

http://localhost/MapGuide2011/TBWeb/Login.aspx?Workspace=TB_LM

See also:

■ Setting Up URL Parameters (page 114)

To view the connected Topobase system user

1 Start Topobase Administrator.

2 In the Topobase Login dialog box, click Options >>> to display the
Topobase System/Main User section.

User Login
When you log in, you must enter your personal user name. Depending on
which Topobase user group you belong to, you have user group specific access
rights to the database. See also Users and User Groups (page 97).

Topobase provides a virtual personal login for each user. After installation you
can start Topobase with the following default user:

■ User name: Topobase

■ Password: TOPOBASE (or empty).
The user Topobase is member of the Admin user group.
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NOTE The password is case sensitive. Note, that the default password, which is
the same as the user name, is upper case.

Depending on how the product is configured, you may not see the login
dialog. For details see example 127_LoginPlugIn
(<topobase_client>\Developement\Samples\CSharp).

To change a password

1 Log in using the old password.

2 Click Settings tab ➤ Setup panel ➤ Change Password.

Setting up the Demo Data
The instructions show the configuration with the Land demo data set, and
the Water demo data set that is delivered with the setup.

To set up the Client demo data

The database must be set up.-----Check requirements (page 45)

Use Topobase Administrator to import the demo
data set.

-----
Start Topobase Administrator
(page 34)

The Topobase workspace is the user's working
environment.

-----
Create a workspace, and import
data (page 41)

Setting up the Demo Data  | 39



Use the Default Display Model, or a sample
display model. See also Overview of Display
Models (page 429).

-----Provide a display model (page 43)

To set up the Web demo data

You must set up the database, and IIS.-----Check requirements (page 45)

You can use the workspace you have created
during the Topobase Client setup.

-----Create a workspace. See To create a workspace with access to the
demo dataStart Topobase Administrator. Login
with the follo... (page 41)

Use Topobase Administrator to specify the
MapGuide credentials.

-----Set up MapGuide (page 117)

In Topobase Client, use the Publish To MapGuide
command to create the Web layout based on the
display model.-----Create Web layout (page 44)
If you do not have Topobase Client installed, you
can load a MapGuide package. See Load the Land
MapGuide package (page 44).

Use Topobase Administrator to associate your
workspace with a symbol library.

-----
To assign the symbol library (page
117)

See also Setting Up Topobase Web (page 107).
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To create a workspace with access to the land and water demo data

1 Start Topobase Administrator.

2 Login with the following values:

User name: Topobase

Password: Leave empty.

3 Click Connect.

4 Click Workspace menu ➤ New.

5 Type the workspace name TB_LM_WA, and click Create.

6 In the Workspace Manager click Import.

7 Select import method Import from Oracle Dump File and click OK.

8 Select the template dump file
<topobase_administrator>\template\modules\land\dump\TB_LM.dmp.

9 In the Dump Import dialog box, type the name and password of the
Oracle user (database schema), for example:

User name: TB_LM

Password: AVS

10 In the Dump Import dialog box, check the Import Parameters and the
tablespace settings whether they are conform to your Oracle installation.

11 Click Import.

12 Login as user with DBA rights, for example SYSTEM with password
MANAGER.

13 If prompted to Compute the Statistics, click Yes. The Topobase schema
is optimized.

14 After the import the data structure of the imported document is checked.
If prompted to update the structure of the document, click Yes.

15 In the Workspace Manager click Import.

16 Select import method Import from Oracle Dump File and click OK.

17 Select the template dump file
<topobase_administrator>\template\modules\water\dump\TB_WA.dmp.

18 In the Dump Import dialog box, type the name and password of the
Oracle user (database schema), for example:
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User name: TB_WA

Password: AVS

19 Continue with the same steps as for the Land demo data.

To create a display model (based on the default display model)

You create a display model that defines the stylization for your feature layers
by modifying the default feature layers. See also Default Display Model (page
430).

1 Start Topobase Client and open the workspace with access to the land
and the water demo data.

2 Click Home tab ➤ Display panel ➤ Display Model ➤ Create Display
Model.

3 In the Display Model Create dialog box, click File menu ➤ Open ➤ Open
Default Display Model.

4 In the right pane, enter a name, such as Default Land Water.

5 Optionally modify the default display model. For example:

■ Click the View Alphabetically tab, and use the toolbar icons to remove
layers, or the rename layers.

■ Click the View By Draw Order tab, to adjust the draw order.

■ Under Layer Properties, select Autoload for the following feature
classes: PARCEL_L, and WA_LINE.

6 Click Save, create a new folder, and save the display model.

NOTE The default location is a sub folder of the <default display model
repository>.

We recommend that you create a central display model repository in
your files system, and that you store each display model in a separate
folder.

See also Display Model Repository (page 431).

7 Click Home tab ➤ Display panel ➤ Generate Graphic.

8 Use the Display Manager to stylize the layers. To save your modifications,
click Home tab ➤ Display panel ➤ Save Display Model.
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To check the default display model repository

In the Display Model Manager, you can check the location of your display
model repository.

1 Click Home tab ➤ Display panel ➤ Display Model ➤ Create Display
Model.

2 In the Display Model Create dialog box, click Settings menu ➤ Change
Default Location. Review the location. Do not change the setting now.
Click Cancel.

3 Close the Display Model Manager, and exit Topobase Client.

To create a display model (merge sample display models)

Use the Display Model Manager to merge two display models, so it can be
used in a workspace with access to the land and water demo data. The sample
display models are installed in the <default display model repository> (page
47).

1 Start Topobase Client and open the workspace with access to the land
and the water demo data.

2 Click Home tab ➤ Display panel ➤ Display Model ➤ Create Display
Model.

3 In the Display Model Create dialog box, on the right pane, enter the
name, such as DM Land Water.

4 Under Display Model Repository, expand the repository node, and the
Modules node.

5 Under Land, expand Land display model, and New Display Model Map.

6 Select the New Display Model Map, and click Add.

7 In the View Alphabetically tab, select the New Display Model Map.

8 Click Rename Selected Item  . Enter a name, such as Land Water
Display Model Map

9 Under Display Model Repository, under Modules, select Water Display
Model Map, and click Add.

10 In the View Alphabetically tab, expand the Water Display Model Map,
and select all layers. Use <Shift> + Click to select multiple layers.
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11 Drag the selected layers to the Land Water Display Model Map.

12 Select Water Display Model Map, and click Remove Selected Items

 .

13 Click Save, and specify a name and folder to save the display model.

14 Click Home tab ➤ Display panel ➤ Generate Graphic.

To create a Web layout (Publish To MapGuide)

Create a Web layout that is based on the display model.

1 Start Topobase Client, and open the workspace TB_LM_WA.

2 On the ribbon, click Home tab ➤ Display panel ➤ Open Display Model.

3 Select DM Land Water.

4 Click Home tab ➤ Display Panel ➤ Generate Graphic.

5 In Display Manager, click Tools ➤ Publish To MapGuide.

6 Connect to the MapGuide site.

7 Under Select A Destination Folder, create a folder Land Water.

8 Click Publish.

9 In the Choose A Web Layout dialog box, select Flexible Web Layout.

The Choose A Web Layout dialog box only appears, if you are logged in
as Administrator, and if no Web layout has been assigned before.

To load the Land MapGuide package

1 Start MapGuide Site Administrator by entering the following URL in a
web browser:

http://localhost/MapGuide2011/mapadmin/login.php

2 Login as an adminstrator. The default username is Administrator and the
default password is admin.

3 In the navigation pane, click Manage Packages.

4 Under Load Package, click Configure Package Directory.
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5 Under Resource Service, for Packages Folder change the directory path
to the location of the Land MapGuide package:
<mapguide>\WebServerExtensions\www\TBWeb\Modules\Land\MapGuide
Package.

6 Click Save.

7 In the navigation pane, click Manage Packages.

8 Under Load Package, locate and select Topobase Land Package.mgp and
click the Load Package icon.

9 Click OK.

Requirements
Before Before starting the configuration, make sure you meet the following
requirements.

Requirements for Setting up Topobase Client

■ Oracle services are running.

■ Topobase System User (TBSYS) is installed. See Setting up the Database
(page 27).

■ Topobase Client and Topobase Administrator are installed and activated.

Requirements for Setting up Topobase Web

■ Pop-up blocking is disabled in Internet Explorer.

■ IIS web site is running.

■ Oracle services are running.

■ Topobase Administrator is installed.

■ Topobase System User (TBSYS) is installed. See Setting up the Database
(page 27).
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Topobase Demo Data Sets
Demo data sets are available for Topobase Client and Topobase Web. These
include MapGuide packages with web layouts that can be loaded by MapGuide
Enterprise Administrator.

The demo data sets are provided in the <topobase_client>\Template\Modules
and <topobase_administrator>\Template\Modules folders. The MapGuide
packages are provided in the <topobase_web>\Modules folder.

Demo data sets

■ Land (parcels and land use)

■ Land Job enabled

■ Water (water network)

■ Wastewater (wastewater network)

■ Electric NA (North American electric network)

■ Electric CE (Central European electric network)

■ Gas

■ Survey

■ Land_CH

MapGuide packages with Topobase web layouts

■ Land

■ Water

■ Wastewater

■ Gas

■ Electric NA

■ Electric CE

■ Survey

■ Land Job

■ ALKIS
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■ Land_CH

NOTE The web layout packages are configured for the demo data sets. Please
read the readme.txt file in the template folder before using them.

Using Display Model Samples

Autodesk Topobase Client provides sample display models for the demo data
sets, and for the following extensions.

■ COGO

■ Dimension

■ Plot

The sample display models are provided in the folder
<roaming>\Autodesk\Autodesk Topobase Client 2011\R18.1\enu\Display
Model Repository.

NOTE After the first Topobase installation, the default display model repository
is set to this folder. See Display Model Repository (page 431).

Topobase Prototype Drawings

Autodesk provides prototype drawings Prototype_*.DWG for the demo data
sets. They contain a number of symbols that can be used for point stylization.

Overview of the Administrator Module
Use the Topobase Administrator to design forms, create reports, establish rules
for job management, set up users and groups, manage workspaces (page 586),
documents (page 581), configuration settings, and topologies, customize
workflows, and create and edit the data model. Use Topobase Administrator
tools to manage customization, and data migration.

Data Model Administrator

Use the Data Model Administrator to create and edit feature classes, add feature
class attributes, enable feature classes to work with jobs, manage domain tables
of attribute values, manage labels, create and manage topologies, and define
feature rules. See Overview of Data Model Administrator (page 181).
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Form Designer

Use the Form Designer to customize feature class forms, define multiple forms
for a single feature class, and to assign different forms to different user groups.
See Form Designer Reference (page 357).

Profile Designer

Use the Profile Designer to set up profile definitions and templates for any
document that contains the Profile Extension. See Overview of Profiles (page
545).

Report Designer

Use the Report Designer to create templates for customized reports. See Report
Designer Reference (page 483).

Data Checker

The Topobase Data Checker validates the quality of your data. For example,
define any set of consistency checks that can be executed after data has been
imported into a document. See Topobase Data Checker (page 131).

Schema Converter

The Topobase Schema Converter analyzes and converts any Oracle structure
into a Topobase database schema. See Data Model: Oracle Schema Converter
(page 285).

Oracle Data Import

The Topobase Oracle Data Import is a migration tool to transfer Oracle data
from any Oracle user to a Topobase document. See Topobase Data Transfer
(Oracle Data) (page 289).

Security Administrator

The Topobase Security Administrator defines Oracle users/roles with customized
access rights on a Topobase document. Autodesk Topobase provides several
permission templates, such as Full Access, or Read Only. You can save your
own permission templates for reuse. See Security Administrator (page 63).
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Exploring Topobase Administrator
In Topobase Administrator you can use a number of workspace, document,
and configuration tools.

The Workspace node is only available if a workspace is open. It contains the
workspace-specific settings and document nodes with document-specific
settings.

The Setup node provides basic administration tools.

Administrator Workspace Menu
Use the Workspace menu commands to configure workspaces, as shown in
the following table:

DescriptionWorkspace menu
commands

Creates a new workspace. You can also create a new docu-
ment (page 581) at the same time.

Create

Opens a workspace.Open
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Administers workspaces and documents. See also To add or
remove documents from a workspaceworkspaces:adding -
to a documentworkspace managerYou use... (page 62).

Edit

Closes the workspace.Close

Deletes the selected workspace. This command deletes only
the workspace. You can also choose to remove Oracle data-
base users.

Drop

Opens the SQL Sheet. See Using the SQL Sheet (page 142).SQL Sheet

Specifies the Web layout. See also Setting Up MapGuide
(page 117).

Web Layout

You can switch off Plug-Ins for the workspace to improve
performance.

Plug-In Control

NOTE You can also switch the Plug-In controls for all work-

spaces or documents using Setup menu ➤ Plug-In Control.
If you switch off a Plug-In for all workspaces, the Plug-In will
not be available in specific workspaces, even if it is switched
on.

Quits the Administrator.Exit Administrator

Administrator Document Menu
Use the Document menu commands to create and customize Topobase
documents.

The Document menu is available only when a workspace is open. A workspace
can contain more than one document (page 581). Select the appropriate
document in the tree view before starting the commands, as shown in the
following table:

DescriptionDocument menu com-
mands

Opens the Document Settings panel.Settings
See also Document Settings (page 69).
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Starts the data model administrator.Data Model
See also Exploring Data Model Administrator (page 185).

Starts the Explorer Manager.Explorer
See also Document Explorer (page 94).

Defines the document explorer tree views. Detailed API
knowledge is required.

Explorer Configurator

See also Explorer Configurator (page 103).

Starts the Job administrator to define and edit job tem-
plates, and to specify Job transition settings. See also
Job Administrator (page 353).

Job Administrator

Configures automatic numbering for point features. See
Point Numbering (page 84).

Point Numbering

Checks for data errors. See Topobase Data Checker
(page 131).

Data Checker

Starts the form designer. See also Form Designer Intro-
duction (page 357).

Form Designer

Available for plot enabled documents. Specifies plot and
island plot settings. See Plot Settings (page 476).

Plot

Starts the Profile Designer. Sets up profile definitions for
the Topobase Client, Profile Manager.

Profile Designer

See Overview of Profiles (page 545).
Available for documents that contain the Profile Exten-
sion.

Defines business rules for data acquisition, analysis, or
reporting. See Workflow Definition (page 103).

Workflows

Specifies the file location for Topobase Web, applies to
the document manager, and to the file selection (page
398) in feature class forms.

File Upload

See also Web File Upload (page 119).

Runs database maintenance routines. See Database
Maintenance (page 136).

1-Click Maintenance
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Defines search statements.Feature Search
See also Feature Search Introduction (page 527).

Defines the document specific user interface for each

user group (page 586).
User Interface

See Document User Interface (page 78)

NOTE  You must re-open the workspace after you have
modified the settings.

Creates and Designs reports.Report Designer
See also Report Designer Introduction (page 483).

Available for Electric documents. Defines user group
specific profiles for the Electric Explorer.

Electric Explorer

See Topobase Electric Explorer Profiles.

Opens the SQL Sheet. See Creating SQL Expressions
(page 137).

SQL Sheet

Opens the Topobase Structure Editor. See Topobase
Structure Editor (page 303).

Strucure Editor

Administers feature class forms.Form Manager >

Exports or imports form definitions. Select the topics
and feature classes whose forms you want to export.

Form Import
Form Export

Select Others to export a form definition of a common
table that belongs to no feature class or domain and is
not a TB_ system table. The forms are exported into an
XML File.

Removes unused form definitions. All form layouts and
definitions without a parent feature class are removed.

Form Check

NOTE This check can also be started in the 1-Click
Maintenance batch. See Database Maintenance (page
136).

Checks the form definitions (database indices) and
provides hints to improve performance. Hints are written
into a log file.

Form Performance Hints
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Exports the following components:Export

Exports the document options to an XML file: Menus
(Basis), Menus (Single), toolbars, form toolbars and

Document Settings

menus, FlyIns and reports. See also Exporting Document
User Interface Settings (page 82).

Exports the document as an Oracle dump file (*.dmp).Oracle Dump

Imports the following components:Import

Imports document options that have been exported to
an XML file.

Document Settings

Opens the Interlis Structure Import wizard. See Interlis
Import.

Interlis Structure Import

Transfers data between two Topobase documents. See
Topobase Data Transfer (Oracle Data) (page 289).

Oracle Data

The Oracle Data Import is only available for documents
that contain the Oracle Data Import Extension. See
Document Settings (page 69).

Administrator Setup Menu
Use the Setup menu commands to configure users and user groups (page 586),
as shown in the following table:

DescriptionSetup menu commands

Opens the Security Administrator. See Security Ad-
ministrator (page 63).

Security Administrator

Configures Topobase users and user groups. See
Users and User Groups (page 97).

Usergroups
User

Customizes the application related Client user inter-
face for each user group.

User Interface

Click the tabs to configure the Standalone Client
toolbar, and the TB commands.
See Client User Interface (page 100).
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Specifies the Autodesk MapGuide credentials. See
Setting Up MapGuide (page 117).

MapGuide

Switches off Plug-Ins. For example, To improve per-
formance, clear the Plug-Ins that you do not want
to be loaded.

Plug-In Control
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Topobase Administration

Setting Up Topobase
The database administrator prepares and configures the Oracle® database and
prepares workspaces for Topobase users.

Overview of Setup

The database must be set up.-----Check requirements (page 45)

Create workspaces for single or multiple
documents, which are Oracle database schemas.

-----Create workspaces (page 58)

Create one or more Oracle database schemas,
such as Land Management, Waste Water, or
Water.

-----Create documents (page 58)

2
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You can create one or more guest users with
customized access rights on a document.

-----Grant access rights (page 64)

After preparing the workspaces, the database
administrator makes them accessible for the-----Make workspaces accessible
different user groups. See Users and User Groups
(page 97)

Define user groups, such as ADMIN, EDITOR, and
VIEWER, and assign the appropriate workspaces
to user groups.

-----Create user groups (page 99)

Define unique personal logins for each user and
assign users to appropriate user groups.

-----Create users (page 99)

Specify the functionality for different user groups.
Specify menu bars and tool bars for documents.

-----Set up documents (page 78)

Use Topobase Client to set application options.-----Set application options (page 121)
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Use Topobase Client to set document options.-----Set document options (page 127)

Workspaces and Documents
The Topobase workspace is the user's working environment. When a user
opens a workspace, the appropriate feature classes, workflows, menus, and
toolbars are loaded and ready for use. The administrator defines the workspace
and can customize it, assigning the appropriate roles and rights based on job
function.A workspace contains one or more documents (page 581), each
containing data models. For example, one workspace can contain a land
management document and a wastewater document for users who need access
to both documents. When you create a workspace, you can either create a
document from scratch or import an Oracle dmp file.

As a user, you access the documents by opening a workspace.

To create a document, you must create a workspace or open an existing
workspace.

In the Workspace Manager section of the Administrator window, you define
the documents in the workspace.

DescriptionWorkspace Manager

Specifies the name.Workspace Name

Creates, imports or removes documents.Documents

Creates a new document. Opens the Create New Docu-
ment dialog box. You specify the document properties.

New

See also Create New Document Dialog Box (page 71)

Imports a document. See also To import documents (page
62).

Import

Removes a document from TBSYS (page 584). You can
only remove documents that are not part of any workspace.

Drop
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To create a workspace

1 Start Topobase Administrator.

2 Click Workspace menu ➤ Create.

3 Enter a workspace name, for example WS_water, and click Create.

To create a document (using a template)

You use Topobase administrator to create a new Topobase document. When
you create a Topobase document, you can use a data model template, which
is a predefined data structure.

1 Start Topobase Administrator.

2 Create, or open the workspace.

3 In the right pane, in the Workspace Manager section, under Documents,
click New.

4 On the navigation pane, click the General link. Enter the document name
(caption), the name of the database schema, and password. Also, specify
the tablespace names.
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Topobase data model administrator: Creating a new document is the same as creating
an oracle database schema.

5 On the navigation pane, click the Modules link.

6 Under Modules, select the Module, such as Water Data Model. Do not
select any module, if you want to create your own data model from
scratch.

7 Under Extensions, optionally select one or more data model extensions
such as COGO, Dimensioning, or Plot.

8 Click the Units link. These settings are used for calculations.

9 Click the Spatial link. These settings are used for spatial storage and
operations. Notice the tolerance, which is important for accuracy of
coordinates.

10 Click the Jobs link. These settings are used for job enabling the document.
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11 Click OK. The document is created. The basic structure is displayed in
the data model administrator.

See also:

■ Create New Document Dialog Box (page 71)

To create a document (import dump file)

Use the Workspace Manager to import documents from Oracle (*.dmp) files.
Workspaces cannot be imported.

1 Start Topobase Administrator.

2 Create, or open the workspace.

3 Enter a workspace name and click Create.

4 In the right pane, in the Workspace Manager section, under Documents,
click Import.

5 In the Import dialog box, select Import From Oracle Dump File.

6 In the File Selection dialog box select the (*.dmp) file.

Demo data sets (*.dmp) are provided in the
<topobase_administrator>\Template\Modules folder.

7 In the Dump Import dialog box, specify import options, as shown in the
following table:

DescriptionDump Import options

Specifies the database schema.Oracle User

Specifies the name of the Oracle database schema.User name

Specifies the Oracle password.Password

Specifies the Oracle tablespaces that will be used to create
a new Oracle user. These settings are used to store new
data, or indexes.

Tablespaces

If the tablespaces that are specified in your dump file exist,
these tablespaces will be used.
If the tablespaces that are specified in your dump file do
not exist, the default tablespaces will be used.
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Specifies the default table space.Default

Default is TEMPORARY DATATemporary

Specifies the table space where the data of the index is
stored after the import. Default is INDEX.

Index

Controls the dump import.Import Parameters

Specifies the Oracle import function. Default is
<ora>\bin\imp.exe

Executable

Specifies the Oracle import arguments.Arguments

8 Click Import to continue.

9 Log in as Oracle user with DBA rights, for example SYSTEM.

10 Click Login.

The (*.dmp) file is imported. If necessary, the document structure is
updated. Click YES to update the document structure. It is recommended,
that you compute the statistics after the import. Click Yes to compute
the statistics.

11 Review the import log file.

The import log files are stored in the Log folder (default is
<topobase>\Log.

The document is shown in the Administrator explorer, and in the
Workspace Manager.

12 In the Administrator explorer, select the document.

13 Under Document Settings, on the General tab, you can enter a document
name that is different from the name of the Oracle database schema.

14 Click Save.

To optimize the Topobase schema

We recommend to run the Optimize Topobase Schema command after the
import. If not done after the import, you can start this as follows.

1 In the administrator explorer expand the document, and click Data Model.
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2 In the Data Model Administrator, right-click the document root node
and click Optimization  ➤  Optimize Topobase Schema.

To add or remove documents from a workspace

You use the Workspace Manager to add to or remove documents from a
workspace.

1 Start Topobase Administrator and open the workspace.

2 In the Administrator explorer, click the workspace.

3 Specify options, as shown in the following table:

DefinitionsWorkspace Manager

Lists all existing database schemas.Available Documents In TB-
SYS

Lists all documents of the current workspace.Documents In Workspace
<name>

Removes or adds documents to a workspace. Use the
up and down arrow you can change the document

Arrow buttons

order, which affects the display order of the tabs in
the document explorer.

Creates a new document. Opens the Create New
Document dialog box. You specify the document
properties.

New

See also Create New Document Dialog Box (page
71)

Two import methods are available.Import

Adds an existing document, such as an Oracle data-
base schema that has been imported with Oracle
tools before.

Import From Existing Oracle
Schema

Creates a document by importing an Oracle (*.dmp)
file.

Import From Oracle Dump File

Removes a document from TBSYS. You can only re-
move documents that are not part of any workspace.

Drop

62 | Chapter 2   Topobase Administration



Export Topobase documents into a (*.dmp) file.

1 Click Setup menu ➤ Administrator.

2 In the Administrator explorer, click the document to export.

3 Click Document menu ➤ Exports ➤ Oracle Dump.

4 Verify the export parameters, as shown in the following table:

Dump Export Description

Specifies the directory for the (*.dmp) file.Output Directory

Export Parameters

Specifies the Oracle export function. The default is
<ora>\bin\exp.exe

Executable

Specifies the Oracle export arguments.Arguments

5 Click Export.

6 View the log file.

Security Administrator
Use Topobase Security Administrator to define and setup Oracle users/roles
with customized access rights on a Topobase document (main document).
Autodesk Topobase provides several permission templates, such as Full Access,
or Read Only.

NOTE To use the Security Administrator, you must have DBA rights. You must be
familiar with Oracle, and the Topobase document.

Main document—Document (Oracle schema) that contains your data.

Guest document—Document that accesses the main document by a role. You
can create different roles to provide different levels of access to the main
document. A guest document does not have any data tables, but only
synonyms and privileges on the main document.

Guest user—Oracle user <guest> that has been created using the Security
Administrator, and that has a role TBR_<guest> that defines the relation

Workspaces and Documents | 63



between the main document and the guest document. A guest document has
some additional roles named TOPOBASE_* for internal use.

The role TBR_<guest> has specific rights on your main document, for example
restricted access to some or all feature classes.

IMPORTANT You must manually maintain each role associated with the main
document.

For example, when you introduce new tables to your main document, for
example by adding a new feature class, domain, topology, utility, extension,
or intersection, or by running a data structure update, you must adjust the
settings for each new table, using the Security Administrator.

TIP In the main document, use the SQL Sheet to query the privileges on that user.

select * from user_tab_privs;

select * from user_tab_privs_made;

Select * from user_tab_privs_recd;

NOTE A guest document is based on a role on the main document. Therefore
you cannot edit the document related settings. To edit the document related
settings, open a workspace containing the main document.

To create a guest document

1 Start Topobase Administrator.

2 Click Setup menu ➤ Security Administrator.
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3 Log in as Oracle user with DBA rights, for example SYSTEM

4 In the Security Administrator dialog box, under Roles, click Add.

5 Enter a name for the Oracle guest user, and specify the password.

6 Select a permission template, such as Read Only.

7 Under Data To Access, select the document you want to define the role
for.

8 Click Save.

9 Under Roles, select the guest user, and click Edit. On the Data tab, review
the access rights of the role TBR_<guest>.

10 Click Close.

11 Click Workspace menu ➤ Open.

12 Select the workspace you want to add the guest user to.

13 Under Available Documents in Tbsys, select the guest user, and click the
arrow icon to add it to your workspace.

Managing Roles
Use the Security Administrator to create and edit Oracle roles.

In the Security Administrator dialog box, in the explorer, select the Role node,
and click a button to add a guest user, or to edit a TBR_<guest> role.

DescriptionSecurity Administrator
- Roles

Displays the guest users.Roles explorer

Select the Role node, and click Add to create a guest user
with a role.

Add

Edits the role of the selected guest user.Edit

Duplicates the selected guest user and the role. Creates
a guest user and a role using the same settings as the se-
lected user. Enter a name for the duplicate guest user.

Duplicate
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Deletes the selected guest user and the role.Delete

To create a guest user with a role

You use the Security Administrator to create an Oracle guest user with a role.

1 In the Security Administrator explorer, select the Role node.

2 On the right pane, click Add.

3 Under Add Role, specify the permission settings as shown in the following
table.

DescriptionAdd Roles

Name of the Oracle guest user, for example TB_LM_Guest.Name

Specifies the password, and the table spaces for the guest
user.

Access

Selects the main document to grant the access rights to.Data

Selects the permission template. See also Permission
Templates (page 68).

Permission Template

Selects the main document.Data To Access

Creates the user and the role in the database.Save
To edit the role, select the guest user, and click Edit. See
To edit a roleUse the Security Administrator to edit the
role settings. In the Security Administrato... (page 66).

To edit a role

Use the Security Administrator to edit the role settings.

1 In the Security Administrator explorer, select the guest user/role.

2 Edit the permission settings as shown in the following table.

DescriptionSecurity Administrator -
Edit Roles
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Displays the Oracle settings of the selected guest user. To
change the password, click Edit.

Access tab

Displays the database objects, and their data permission
settings.

Data tab

In the grid, use the menu commands.
Click the column heading to sort the values. For each
database object, select the permission type.

Loads permission settings that have previously been saved
from a (*.SecDef) file. See also Permission Templates (page
68).

File menu ➤ Open

Saves the permission settings into a (*.SecDef) file.File menu ➤ Save As

Saves the permission settings as a permission template
that can be used when you create a role. See also Permis-
sion Templates (page 68).

File menu ➤ Save As
Permission Template

Redirects the data permission settings to another main
document that has the same data structure. Opens the
Redirect Data Connection dialog box.

File menu ➤ Redirect
Data Connection

For example, if the main document is being replaced by
another main document with the same data structure.

Clears the selected rows.Edit menu ➤ Clear Selec-
tion

Selects all rows.Edit menu ➤ Select All

Enables the Advanced Edit mode. In Advanced Edit mode,
you can modify the permission settings for all database
objects, such as system tables.

Edit menu ➤ Enable Ad-
vanced Editing

WARNING Changes to system tables can corrupt the
database.

Displays or hides the filter area. To filter database objects
by name, or by type.

Filter

Activated after you have made any modifications. Saves
the modifications.

Save button
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Restores the original settings.Reset

Permission Templates
For each database object, you specify the following permissions: Select, Insert,
Update, Delete, Execute, Alter, Direct.

NOTE If you assign one or all of the following permissions to a feature class or a
package, the system automatically assigns the Select permission: Insert, Update,
Delete, Execute.

The Topobase Security Administrator provides permission templates, such as
Full Access, or Read Only. You can define and reuse your own permission
settings. Permission settings for the database objects View, Synonym, Package
are stored in (*.SecDef) files. For example:

SIUD--- LM_LANDUSE

SIUD--- LM_LANDUSE_L

SIUDEA- *

The letters indicate the rights, followed by a blank, and the object name. Use
the object name *, to set the rights for all objects that are not yet defined in
the previous lines. Also, you use * to filter LIKE.

Description(*.SecDef) key

Indicates a comment line.*

SelectS

InsertI

UpdateU

DeleteD

AlterA

ExecuteE

Direct GrantG
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Optionally you save your permission settings as permission templates.
Permission templates can be used, when you add a new role. The templates
are stored in the directory
<topobase_administrator>\Data\SecurityAdministrator, as soon as you have
used the Add command once.

To create a permission template

1 In the Security Administrator explorer, select the role.

2 On the right pane, click the Data tab.

3 Edit the settings.

4 In the grid, click File menu ➤ Save As Permission Template.

5 In the Save Permission Template dialog box, under New Data Setting,
enter a name for the permission template.

6 Click Save.

Document Settings

NOTE  The document settings are read only, except for the document password,
and the Jobs Settings.

When you create a document, you specify these settings. For more information
about the settings see Create New Document Dialog Box (page 71).

Modules

You can add any module to the current document. However we recommend
that you add only one module per document.

Extensions

You can add extensions to the document. Extensions are database
enhancements such as COGO, Dimensions, Profiles, or Plot.

Jobs

See Job Enabling (Document Settings) (page 347)
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Customized Data Model

You can create and maintain customized data models, such as country specific
data model enhancements that are not covered by the standard modules. See
also Topobase Structure Editor (page 303).

To view the Document settings

 ➤ In the Administrator explorer, click Document menu ➤ Settings.

Alternatively, click the Document node.

To add a module to the document

1 In the Document Settings, on the navigation pane, click the Modules
link. Under Modules, select the module to add. Click Save. Topobase
Administrator adds the data model code to the system table
TB_DATAMODELCODE.

2 When the document is reloaded, you will receive a prompt asking whether
you want to update the database structure.

To remove a module from a document

This will not delete the feature class tables of this data structure. However the
module will not be updated any more.

 ➤ In the Document Settings, on the navigation pane, click the Modules
link. Clear the module to remove.

To add the Dimensioning extension to the document

1 In the Document Settings, on the navigation pane, click the Modules
link. Under Extensions, select Dimension Extension. Click Save. Topobase
Administrator adds the topic Dimension to the document.

2 When the document is reloaded, you will receive a prompt asking whether
you want to update the database structure.

See also Adding Dimensions.

To add the Plot Extension

1 In the Document Settings, on the navigation pane, click the Modules
link. Under Extensions, select Plot Extension. Click Save.

2 See Configuring Plots (page 475).
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To add the Oracle Data Import Extension

1 In the Document Settings, on the navigation pane, click the Modules
link. Under Extensions, select Oracle Data Import Extension. Click Save.

2 See Topobase Data Transfer (Oracle Data) (page 289).

To add the Templates Extension

1 In the Document Settings, on the navigation pane, click the Modules
link. Under Extensions,select Templates Extension. Click Save.

2 See Data Model: Feature Templates (page 259).

To add or to update a customized data model

1 In the Document Settings, on the navigation pane, click the Modules
link.

2 Under Customized Data Model, browse for the Customized Data Model
File (*.genx).

3 Under Custom Module/Extension, select the data model.

4 Click Save.

See also To create a data model file to apply customer specific updates to a
predefined data model structureS... (page 306).

Create New Document Dialog Box
Define the new document in the Create New Document dialog box, using the
following settings:

NOTE For existing documents the Document Settings are read only. See Document
Settings (page 69).

Use the links on the navigation pane to access the
document settings.

Create New Document dia-
log box

Specifies the database names and table spacesGeneral settings
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Specifies a document name, and the name and
password of the Oracle database schema. Specify
the name according to Oracle conventions.

Login

Recommendation: Use only the characters a-z, 0-9
and _ (underscore). Do not specify a name that
starts with a number.

Specifies the tablespaces. Select default, temporary,
and index tablespaces from the objects available
in your Oracle database.

Tablespaces

Selects the modules, extensions for the document.
The version of the module/extension is displayed
right to the item.

Modules settings

Selects the data model extensions to be applied.
The following extensions can be added to any
module or document.

Extensions

■ COGO Extension—Adds the COGO feature
classes. See also Construction Introduction.

■ Dimension Extension—Adds the default feature
classes for orthogonal and aligned dimension-
ing. See also Data Model: Dimensioning (page
252).

■ Interlis Export Extension—Adds feature classes
to store the Interlis export configuration. See
the Land Management CH User Guide.

■ Plot Extension—Adds the plot feature classes.
See also Plot Reference (page 475).

■ Profile Extension—Adds the data structure to
manage profile data. See also Overview of
Profiles (page 545).

■ Oracle Data Import Extension—Adds system
tables TB_MIG_* that are required for the Or-
acle Data Import. See also Topobase Data
Transfer (Oracle Data) (page 289).

■ Templates Extension—Adds the template fea-
ture classes. See also Data Model: Feature
Templates (page 259).
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Selects the module database schema.Modules
Do not select any module if you want to create a
new database schema from scratch.
Select a module, such as Water, Wastewater or
Electric to create a pre-defined data structure.
Performs the following steps:

■ Stores the data model code in the system table.

■ Creates the database schema, using the unit
settings.

■ Imports pre-configured forms.

See also Overview of Data Models (page 182).
See also Topobase Structure Editor (page 303).

Selects customized data model enhancements. See
Topobase Structure Editor (page 303).

Custom Modules / Extensions
and
Customized Data Model

Displays settings that specify default units for the
attributes, such as for ORIENTATION or LENGTH.

Units settings

Also, you can define specific units for each attribute
when you create it.
The settings are used when the document is created
either for the default attributes or, for example,
during the creation of a water module:
WA_TANK.CAPACITY is a volume. Depending of
the default settings, the corresponding unit will be
set.
The settings must never be modified at any later
time. The settings are saved in the system table
TB_INFO. The default orientation is dependent on
the angle unit.
Examples:
Selected: Degree and Clockwise -> Default orienta-
tion = 90
Selected: Gon and Clockwise -> Default orientation
= 100

Settings that specify spatial storage and operations
and values for calculations.

Spatial settings

Specifies the dimension.Dimensions
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Selects 2D to store the plane geometry (easting,
northing) in the GEOM attribute, and the elevation
(height) in the Z attribute.

2D

Selects 3D to enable 3D support, and to store the
coordinates (easting, northing, and elevation) in
the GEOM attribute.

3D

IMPORTANT We recommend that you use Oracle
11g, if you enable 3D support.

Oracle Spatial Tolerance defines the maximum
precision for numeric data; the default value is
0.0005.

Tolerance

IMPORTANT This setting is critical for data pro-
cessing performance and the size of spatial indices.
For best results, we recommend it be set to a con-
sistent value between 0.01 and 0.005 for all tables
in a schema. For example, a setting of 0.005 means
that measurements in meters can be precise to 5
mm. Project architects are encouraged to set this
value before creating any feature classes in Topo-
base. The spatial tolerance value can be altered for
a specific feature class.

Defines the range of the spatial index. For faster
performance, set these values close to the actual
used range of coordinates, that is used.

Min Northing, Min Easting,
Max Northing, Max Easting

Assigns a spatial reference ID (SRID). For spatial in-
dexing you can assign a spatial reference system

Spatial Reference ID

(Oracle spatialSRID). The SRID is saved in the MD-
SYS User (CS_SRS). Some valid settings are:
Switzerland: SRID = Swiss National System
(352257)
Germany: SRID = GK Zone x (DHDN)
This parameter is important for later spatial opera-
tions, such as transformation into another system.
All feature classes will inherit this SRID. See also
About Coordinate Systems (page 75)
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Specifies settings for versioning, such as job en-
abling, feature locking, and job perimeter.

Jobs Settings

See also Job Enabling (Document Settings) (page
347).

See also:

■ Data Model: Feature Classes (page 196)

■ Data Model: Spatial Relationship Settings (page 282)

■ Overview of Profiles (page 545)

About Coordinate Systems
Topobase supports multiple coordinate systems. This means that you can join
different database schemas with non-identical coordinate systems. Also, this
means that a workspace can contain several documents where each document
(page 581) has a different coordinate system (SRID). The Topobase support
covers graphic generation and graphic editing (digitizing with back
transformation of the digitized coordinates).

NOTE A document can have either one SRID assigned or none. The document
SRID automatically applies to all feature classes of the document.

During graphic generation, when a workspace contains several documents
with different coordinate systems, the SRID is used for on-the-fly coordinate
transformation, representing the geometry data in AutoCAD Map in one global
coordinate system.

Use Topobase data model administrator to assign a coordinate system:

■ Assign an SRID when you create the document. See Create New Document
Dialog Box (page 71).

■ Set the SRID of a document at any time.

NOTE These settings apply to the document. In addition there are coordinate
system settings, such as the coordinate system of a drawing (Map Coordinate
System) and of a feature layer (Display Manager - FDO provider).

If you represent the data in a drawing, Topobase Client validates the
configuration of the coordinate systems and performs the transformation
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when necessary. For example, a workspace has document SRID A and the
AutoCAD Map drawing contains the Global Coordinate System B. For
representation in the map, a transformation from A to B is performed. If one
of the coordinate systems has not been set, no transformation and no
generation of graphics is possible.

Although the representation is transformed in the drawing, all calculations
and geometry updates are made in the document coordinate system. Also,
the coordinate values shown in the Topobase dialog boxes and feature class
forms are the internal database values.

See also Topobase Client User Guide, Working with Multiple Coordinate Systems.

For more information about SRID, see Oracle Spatial Users Guide and Reference.

Updating the Coordinate System

You can set the SRID (coordinate system) for all feature classes of a document
(page 581). For example, you have imported a document whose coordinates
are stored in system B, and no SRID is set. If you want to process this document
in a workspace that contains a document with a distinct coordinate system,
you must set the SRIDs accordingly.

Restrictions

■ If the document contains views with relations to external tables, you cannot
update the SRID.

IMPORTANT The Update Coordinate System command does NOT transform the
coordinates in the database.

The Update Coordinates System command updates the metadata: SDO_SRID
of all geometries, spatial indices, and the Oracle SRID. The document length
unit will be set according to the selected SRID. However, if the coordinates
do not correspond to the SRID, you must transform the geometry in an
additional step.

Topobase does not support the update of the SRID for a single feature class or
topic.

To update the SRID

1 Start the data model administrator.

2 In the data model explorer, select the document node item.

3 Right-click and click Spatial menu ➤ Update Coordinate System.

76 | Chapter 2   Topobase Administration



4 In the Update Coordinate System dialog box, select the SRID, using either
of the following settings:

DescriptionUpdate Coordinate System
Dialog Box

Displays the current coordinate system.Current Coordinate System

Specifies a system that is provided in the Oracle
Spatial System user (MD-
SYS.SDO_CS_SRS.CS_NAME). Select a system.

New Coordinate System

Displays the well-known text (WKT) description of
the SRS.

WKT

Document Password
If the password for the document (Oracle database) has been changed, for
example, using an external tool, you can no longer open the workspaces with
this document. In the Manage Document Password dialog box, either set a
new password or remove the document from the workspace.

By default you can specify the document password when you import a
document into a workspace.

NOTE For Oracle 11 g, by default, passwords expire after 180 days, and you must
set a new password. Your Oracle administrator can change this behavior. To set
a new password, for example, use the SQL Sheet, log in as SYSTEM user, and
execute the command alter user <name> identified by <new password>. When you
open your workspaces, in the Manage Document Password dialog box, set the
new password accordingly.

See also:

■ To add or remove documents from a workspaceworkspaces:adding - to a
documentworkspace managerYou use... (page 62)
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Document User Interface
You can customize the document-specific user interface by specifying which
tool bars are available for specific user groups.

NOTE  You must re-open the workspace after you have modified the settings.

For more information about user groups, see Users and User Groups (page 97).

To customize the document-specific user interface

1 Start Topobase Administrator and open a workspace.

2 In the Administrator explorer, expand the document. Click User Interface.

3 In the User Interface section, define the interface by doing one or more
of the following:

■ Click the Menus (Basis) tab to configure general shortcut menus for
Document explorer items. See also To set up general shortcut
menusYou use the Menus (Basis) settings to customize shortcut menus
for i... (page 79).

■ Click the Menus (Single) tab to configure specific shortcut menus
based on the general settings. See also To set up specific shortcut
menusdocument explorer: customizing shortcut menuscustomizing
shortcut m... (page 80).

■ Click the Toolbars tab to configure tool bars for the Topobase
Standalone Client, and the Topobase Web version.

■ For Topobase Client and Topobase Web - Basic Layout, use the
Construction Toolbar, and the Main Toolbar setting.

■ For Topobase Web - Flexible Layout, use Fusion Common Toolbar,
and Fusion COGO Toolbar.

■ Click the Forms tab to configure forms tool bars and shortcut menus.
See also Customizing Form Toolbars and Menus (page 81).

■ Click the FlyIns tab to specify the FlyIns. See also Document FlyIns
(page 83).

■ For Topobase Electric documents: Click the Feature Container tab to
specify the menu items that are available for the selected user group
in a feature container, such as the Electric Explorer.
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■ Click the TB Commands tab to specify which TB commands are
enabled for the selected user group. See also Configuring Topobase
Commands (page 81)

Setting Up Shortcut Menus
There are two steps in customizing shortcut menus. First, use Menus (Basis)
to define which menus are available for each type of Document explorer item,
such as a point feature class or a topology. Next, use Menus (Single) to further
define which specific menus are available for each individual item, such as a
specific feature class.

The document explorer includes items such as feature classes, topologies, or
intersection. See also Document Explorer (page 94)

In general, you can perform all operations using shortcut menus.

For each user group, you can define which shortcut menus are
available for each item.

To set up general shortcut menus

You use the Menus (Basis) settings to customize shortcut menus for items in
the Document Explorer . You can control the functionality available for each
User group. For example, you can limit the commands that members a user
group can use.

1 Start Topobase Administrator and open a workspace.

2 In the Administrator explorer, expand the document. Click User Interface.

3 In the User Interface section, click the Menu (Basis) tab. The list displays
all types of explorer items.
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4 Select a user group, for example ADMIN.

5 Select an item, for example Topic and expand it.

6 Select the menu commands that you want to be available.

Enabling the commands for the Topic shortcut menu for the ADMIN
user group.

To set up specific shortcut menus

In addition to general settings that apply to all items of one type (such as all
topics) you can specify shortcut menus for individual items (such as an
individual topic).

1 Start Topobase Administrator and open a workspace.

2 In the Administrator explorer, expand the document. Click User Interface.

3 In the User Interface section, click the Menu (Single) tab. The list displays
all explorer items of the selected document.

4 Select a user group, for example ADMIN.

5 Select a menu item, for example the topic Building, and expand it.

6 Select the menu commands that you want to be available.

80 | Chapter 2   Topobase Administration



Configuring Topobase Commands
For the Topobase Client version, you can customize the document related TB
commands that are available for each user group.

When you disable a TB command, the command cannot be executed. That
means, if you enter the command in the command line, or if you click the
button on the Ribbon, a message notifies you that the command cannot be
executed.

See also:

■ Client User Interface (page 100)

To disable or enable TB commands

1 Start Topobase Administrator and open a workspace.

2 In the Administrator explorer, expand the document. Click User Interface.

3 In the User Interface section, click the TB Commands tab.

4 Select a user group, for example ADMIN.

5 Select the commands that you want to provide.

Customizing Form Toolbars and Menus
Topobase Client provides feature class forms, containing icons, tools, and
shortcut menus to process data. Use the Form Toolbar/Menus option to define
the icons, tools, and shortcut menus that can later be assigned to different
feature class forms and customized for a user group.

Topobase includes the following default toolbar and menu configurations:

■ Domain—In a domain table form you do not need a Create Feature icon,
only an Add New icon.

■ Feature—The feature class forms toolbar/menu contains Create Feature
and Digitize New Geometry icons/commands.

■ Label—In the label feature class forms toolbar/menu you need neither the
Create Feature nor the Add New icon/command, because labels usually
are created using the Label Placer (page 583).
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■ Others—You can define your own types of form tool bars/menus. Use the
Add button.

NOTE For technical reasons, the configuration list of icons and menu commands
shows all possible items even though some are hidden by the application. For
example, the Domain toolbar list displays the Highlight and Digitize commands
as selected. However, they will never be included in the Domain toolbar.

For more information about the tools and menu commands, see the Topobase
Client User Guide, Using Feature Class Forms.

To customize form tool bars and menus

1 Start Topobase Administrator and open a workspace.

2 In the Administrator explorer, expand the document. Click User Interface.

3 In the User Interface section, click the Forms tab.

4 Select a user group, for example ADMIN.

5 Select a form type, for example Domain.

6 Select the icons you want to be available on the toolbar.

Exporting Document User Interface Settings
You can export the document user interface configuration. For example, you
have set up the document user interface for different user groups, such as
ADMIN, EDITOR, and VIEWER. You want to share this configuration with
other offices or customers who work with the same document. User groups
that are not available on the target system are created during the import.

Use the Document Settings export command to export the following settings
(*.xml).

■ User group specific document explorer shortcut menus, such as shortcut
menus for the VIEWER user group that contains only the Show Forms
command.

■ User group specific document tool bars, such as a Main toolbar for the
VIEWER user group that does not contain the Delete Feature icon.
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■ User group specific feature class form tool bars and shortcut menus, such
as a toolbar for the VIEWER user group that does not provide edit
functionality.

You can import the settings file (*.xml) using Document
menu ➤ Import ➤ Document Settings.

To export document user interface settings

1 Start Topobase Administrator and open the workspace.

2 In the Administrator explorer, select the document.

3 Click Document menu ➤ Export ➤ Document Settings.

4 In the Document Settings Export dialog box, select the settings to export.

5 Click Export.

Document FlyIns
FlyIns are components of a Topobase explorer pane. Like feature class forms,
they can be either of the following:

■ docked in = included in the application window

■ docked out = independently flying on the desktop.

Some examples of FlyIns:

■ Document Explorer

■ Job Management

■ Workflow Explorer

You can either display or hide the available FlyIns with the Document >
Toolbars/FlyIns command. Also, you can switch between the Workflow and
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Document explorer with the icons on the Document toolbar. 

NOTE Some FlyIns are only available in the Topobase Web version.

To view available FlyIns

1 Start Topobase Administrator and open a workspace.

2 In the Administrator explorer, expand the document. Click User Interface.

3 In the User Interface section, click the FlyIn tab.

4 Select a user group, for example ADMIN.

5 Select the FlyIns you want to provide.

For each document and user group, you can define which FlyIns are available.

Point Numbering
Automatic point numbering helps to manage long and complex point numbers,
and makes point acquisition more efficient and less error-prone for the field
crew.

Use Topobase Administrator to set up automatic point numbering for your
documents. Automatic point numbering applies to new point features that
are either imported, calculated, or digitized. By default, no point numbering
is applied. Some Topobase applications, such as Survey require a point number.

Requirements: Automatic point numbering applies to point feature classes
that have the default attribute TB_POINTNUMBER. See also Feature Class
Type: Point (page 208).

NOTE Automatic point numbering does not support manual updates of the point
number.

A Topobase point number consists of two parts.

■ Repetitive prefix
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■ Increment that is auto generated, and incremented by 1

For example, the following point numbers have the prefix CT219611, followed
by a 5 digit increment.

CT219611 50005

CT219611 50006

CT219611 50007

CT219611 50008

You configure the prefix, using four different point numbering types. You
configure the increment by creating feature class groups.

Point numbering types

■ Per Document

■ Per Group

■ Grid 100m

■ Raster Plan

IMPORTANT We recommend that you do not change the point numbering type
once it has been assigned.

To set up the automatic point numbering

1 Start Topobase Administrator, and open the workspace.

2 In the administrator explorer, expand the document node, and click
Point Numbering.

3 On the right pane, under Point Numbering, configure the numbering
type as shown in the following table.

DescriptionPointNumbering set-
tings

Selects the numbering type. By default, no automatic
numbering is used. Automatic point numbering is often

Select The Point Num-
bering Type

used by the Land Management modules. For point num-
bering types, see
Point Numbering Per Document (page 87)
Point Numbering Per Group (page 88)
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Point Numbering Per Grid 100m (page 89)
Point Numbering Per Raster Plan (page 91).

Specifies the selected numbering type.Settings

Specifies the number of digits for the increment part of
the point number. The number of digits must match the
increment minimal and maximal value.

Number Of Digits For
Increment Value

Specifies a prefix that is used when the maximum incre-
ment value is exceeded. For example, your increment

Exception Prefix

minimal value is 1, and your increment maximal value is
999, so the system can generate point numbers for 999
points. For any additional point, the system uses the excep-
tion prefix. Then you can filter for these points, and
modify the numbers accordingly.

For numbering type Per Document. Specifies the repetitive
number part.

Standard Prefix

Selects the point feature classes for automatic point num-
bering. The explorer displays all point feature classes. Point

Group Settings

feature classes that do not have the TB_POINTNUMBER
attribute, are highlighted in red.
Point feature classes that have not been grouped, are listed
under the Unassigned FC node.
You create one or more groups, and specify the point
numbering rules for each group. Within a group, the same
increment settings are applied, and the increment is
unique.

Specifies the numbering rule for the selected group.Settings For Selected
Group <name>

Specifies the first value of the increment.Increment Minimal
Value

Specifies the maximum value for the increment.Increment Maximal
Value

For numbering type Per Group. Specifies the repetitive
number part for the selected group.

Prefix Per Group
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Displays a sample point number using the specified set-
tings.

Number Example

Creates a feature group. For example a group named Ca-
dastre, or Construction. Use the arrow buttons, or drag an
unassigned feature class to the group.

Create

Renames the selected group.Rename

TIP Press F2 to rename a group. Press F5 to refresh the
tree view.

Point Numbering Per Document
Use the point numbering type Per Document to generate point numbers that
are unique per document. All point number use the same repetitive number
part. For the increment, you can define groups of feature classes, where each
group uses a specific number range.

Example: You use the repetitive number part CT2196 for all points, however
for projected points, you provide the numbers 1-49999, and for topographic
points, you provide the numbers 50000-99999.

CT219611 50001 -> topographic point

CT219611 00001 -> projected point

CT219611 00002

CT219611 50002

CT219611 99999

ERCT 00001 -> number range exceeded

To set up a point numbering per document

In this example, you define point numbering for two feature class groups that
use the same repetitive part, but different increments.

1 Start Topobase Administrator, and open the workspace.

2 In the administrator explorer, expand the document node, and click
Point Numbering.

3 On the right pane, under Point Numbering, Select The Point Numbering
Type, select Per Document.

4 Expand the Settings, and specify the repetitive part.
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Number Of Digits For Incremental Value: For example, 5.

Exception Prefix: For example, ERRCT.

Standard Prefix: For example, CT219611.

5 Expand the Group Settings to select the point feature classes.

6 Click Create, and enter the name, such as Control Points.

7 From the Unassigned FC node, select the feature classes to enable point
numbering. Use the arrow buttons, to move the selected feature class
under the group node.

8 Create other groups as needed, such as Topographic Points.

9 Select the feature class group, such as Control Points.

10 Under Settings For Selected Group, specify the increment number part.

Increment Minimal Value: For example, 1.

Increment Maximal Value: For example, 49999.

11 Select the next feature class group, such as Topographic Points.

12 Under Settings For Selected Group, specify the increment number part.

Increment Minimal Value: For example, 50000.

Increment Maximal Value: For example, 99999.

Point Numbering Per Group
Use the point numbering type Per Group to generate point numbers for feature
class groups. For each feature class group, you specify the repetitive number
part, and the increment.

To set up a point numbering per group

1 Start Topobase Administrator, and open the workspace.

2 In the administrator explorer, expand the document node, and click
Point Numbering.

3 On the right pane, under Point Numbering, Select The Point Numbering
Type, select Per Group.

4 Expand the Settings, and specify the repetitive part.

Number Of Digits For Incremental Value: For example, 5.
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Exception Prefix: For example, Error.

5 Expand the Group Settings to select the point feature classes.

6 Click Create, and enter the name, such as Control Points.

7 From the Unassigned FC node, select the feature classes to enable point
numbering. Use the arrow buttons, to move the selected feature class
under the group node.

8 Create other groups as needed, such as Topographic Points.

9 Select the feature class group, such as Control Points.

10 Under Settings For Selected Group, specify the increment number part.

Increment Minimal Value: For example, 1.

Increment Maximal Value: For example, 99999.

Prefix Per Group: For example CO.

11 Select the next feature class group, such as Topographic Points.

12 Under Settings For Selected Group, specify the increment number part.

Increment Minimal Value: For example, 1.

Increment Maximal Value: For example, 99999.

Prefix Per Group: For example TOP.

Point Numbering Per Grid 100m
Select the point numbering type Grid 100m to generate a point number where
the prefix is depending on the point coordinates.

■ The repetitive number part is generated from the 100 <length unit> value
of the coordinates: 3 digits of the easting value + 3 digits of the northing
value. That means the repetitive part always consists of a 6 digit value.

■ The increment part can be configured for different feature class groups.
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To set up a point numbering per 100m grid

1 Start Topobase Administrator, and open the workspace.

2 In the administrator explorer, expand the document node, and click
Point Numbering.

3 On the right pane, under Point Numbering, Select The Point Numbering
Type, select Grid 100m.

4 Expand the Settings, and specify the repetitive part.

Number Of Digits For Incremental Value: For example, 6.

Exception Prefix: For example, Error.

5 Expand the Group Settings to select the point feature classes.

6 Click Create, and enter the name.

7 From the Unassigned FC node, select the feature classes to enable point
numbering. Use the arrow buttons, to move the selected feature class
under the group node.

8 Create other groups as needed.

9 Select the feature class group.

10 Under Settings For Selected Group, specify the increment number part.

Increment Minimal Value: 1

Increment Maximal Value: 99999.
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Point Numbering Per Raster Plan
Select the point numbering type Raster Plan to generate a point number where
the prefix is depending on the location of the point in a specified raster.

■ You specify the repetitive number part per raster. You either define your
own raster, or you load a raster plan from the Land Management (CH)
document.

■ The increment part can be configured for different feature class groups.

To set up a point numbering per raster plan (Land Management (CH))

1 Start Topobase Administrator, and open a workspace that has access to
the Land Management (CH) document.

2 In the administrator explorer, expand the document node, and click
Point Numbering.

3 On the right pane, under Point Numbering, Select The Point Numbering
Type, select Raster Plan.

4 Expand the Settings, and specify the repetitive part.

Number Of Digits For Incremental Value: For example, 6.
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Exception Prefix: For example, Error.

Under Raster Plan Definition, click Load.

For each raster, specify the prefix.

The Load button is only available for documents with the Land
Management (CH) data model. Then, the prefix is loaded from
LM_PL_PLAN.PLAN_NUMBER, and the values for Easting Minimum,
Northing Minimum, Easting Maximum, and Northing Maximum are
loaded from the plan topology feature class LM_PLAN_TSUR. This requires
that the topology LM_PLAN needs to be initialized and without errors.

5 Expand the Group Settings to select the point feature classes.

6 Click Create, and enter the name.

7 From the Unassigned FC node, select the feature classes to enable point
numbering. Use the arrow buttons, to move the selected feature class
under the group node.

8 Create other groups as needed.

9 Select the feature class group.

10 Under Settings For Selected Group, specify the increment number part.

Increment Minimal Value: For example, 1.

Increment Maximal Value: For example, 999999.

Feature Explorer
For each feature class, you can define a representation string that will be
displayed in the feature explorer. You can display any feature class attribute,
or the topic. Also you can display units. By default, the feature explorer displays
the FID of the features.

For example, when displaying the results of a road network tracing in the
feature explorer, you can specify that the road name is displayed instead of
the FID. You define the representation string in the data model administrator.

For example, when displaying the results of a utility network tracing in the
feature explorer, you can specify that both the attribute feature class and the
related geometry feature class is displayed.

The representation string is stored in the system table TB_DICTIONARY.

See also Topobase Client User Guide, section Feature Explorer.
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To define the representation string for the feature explorer.

1 Start the data model administrator.

2 Select the feature class.

3 Right-click, and click Edit Feature Class.

4 In the Feature Class Edit dialog box, click the Feature Explorer Settings
tab.

5 On the Feature Explorer Settings tab, use the options as shown in the
following table.

DescriptionFeature Explorer Settings  tab

Selects an element to display in the feature ex-
plorer. Select one of the following.

Displayed Items For <feature
class caption>

■ Attributes

■ Feature Class Information

■ System Units

■ Delimeters / Text

The values for the selected element are displayed
a list. For example, if you select Attributes, the
list displays the feature class attributes.

Adds the selection to the string editor.

String editor to display the selected elements in
braces {}. You can edit the representation string.
The string is validated immediately.

String For Displayed Items

To add any static text, type the text in the string
editor.
To add dynamic text, enter a value in braces {}.
Valid values are listed in the Value list.

Preview of the string.<feature class name> Display
Preview
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To display the area unit, enter: {AREA}
{AREA.Unit.Symbol}

Examples

To display any static text, enter the text. For ex-
ample: Feature: “{FID}”

Feature: 123

{TB_DICTIONARY.Caption}: {FID}.Control Cable: 123
Displays feature class caption, a colon, a space,
and the FID of the feature.

To display a related attribute, enter: WW_MAN-
HOLE_MODEL.ID_MATERIAL.

To display a utility feature class along with its re-
lated geometry feature class, for the utility feature
class, enter: {TB_DICTIONARY[F_CLASS_ID_AT-
TR].Caption}.

For a utility feature class: To display the feature
class caption and the FID of both the attribute
feature and the geometry feature.

Pipe: 123 (Line 124)

{TB_DICTIONARY[F_CLASS_ID_ATTR].Caption}:
{FID_ATTR} ({TB_DICTIONARY.Caption} {FID})

For a line feature class: To display the feature class
caption, FID, length of the line with two decimals,
and the unit.

Control Line 123 (15.60 m)

{TB_DICTIONARY.Caption} {FID} ({LENGTH:0.00}
{LENGTH.Unit.Symbol})

Document Explorer
In the Topobase explorer pane, you use the Topobase document explorer to
view and edit data. Use the Topobase administrator to define document
explorer profiles. You can define which items are displayed in the document
explorer and configure document explorers for each document.
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Configuring the Topobase document explorer.

Click the Explorer edit button to edit the document explorer.

Definitions and objects that can be shown in the document explorer are:

DescriptionExplorer Definition

Processes feature classes.Data Model

Processes domain tables.Domains
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Lists the topologies.Topologies

Starts intersection definitionsIntersections

Lists the Client system tables.System

Specifies an explorer profile.Explorer Groups

Displays jobs ordered by date, state or type.Job By

Displays job-enabled feature classes.Job Enabled Topics

Displays jobsJobs

Lists the plot feature classes. We recommend that
you do not display the plot feature classes in the
document explorer.

Plot

Lists the viewports.Viewports

Lists the workflows.Workflows

To configure a document explorer

1 Start Topobase Administrator and open a workspace.

2 Click Document menu ➤ Explorer Manager.

3 In the right pane, configure the document explorer content and layout,
as shown in the following table:

DescriptionExplorer Manager

Specifies the group to edit, for example Default.Explorer Profile

Creates, removes or renames the explorer profile. Click a
button.

Create, Rename, Delete

Specifies the document explorer items.Explorer Profile Settings

Adds or removes a selected item to or from the document
explorer. Click the arrow.

Arrow buttons
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Displays the order of the items in the tree view. Use the
arrow buttons to change the display order.

Definitions in <explorer
profile name>

Displays the tree, where you can select or clear the nodes.Check Nodes To Be Dis-
played In This Profile

NOTE You can also edit this tree in the Topobase explorer
pane by clicking the explorer edit button.

Saves changes, you make in the explorer tree.Save Tree

Specifies access rights for explorer profiles. You can assign
explorer profiles to user groups.

Explorer Profile Secur-
ity

For example, define an explorer profile that displays all
workflows, and make it unavailable for the VIEWER user
group.
The settings are stored in the document, in the table
TB_EXPLORER_GROUP_UG_RESTR.

NOTE If a user is member of several user groups, he will
see the explorer definitions and objects of all his user
groups (OR). See User Group Priority (page 100).

Displays the user groups that can access the current ex-
plorer profile.

User Group With Access
To <explorer profile>

When you create a new explorer profile, all user groups
can naccess the new profile.

Displays the user groups that cannot access the current
explorer profile.

User Group With No Ac-
cess To <explorer pro-
file>

Users and User Groups
Topobase application users are grouped into User groups that have rights to
access the document. The rights are defined by the administrator and typically,
these include the following user groups:

■ ADMIN User—Has unrestricted access to all data. All commands are
available.

■ EDITOR User—Can edit all or parts of the data. All editing commands are
available.
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■ VIEWER User—Can view and analyses the data. No editing or administrator
commands are available. The user interface provides only the icons and
menus that are needed.

After the installation of Topobase Client there is one default user, Topobase,
who is a member of the ADMIN user group. Use Topobase Administrator to
create more user groups with different access rights, such as VIEWER and
EDITOR. Create more users for each person who works with Topobase Client,
such as Mr. Smith or Ms. Miller.

Mr. Baker is a member of the EDITOR group, and the VIEWER group. As an editor, he
can access two workspaces. As a viewer he can access one workspace.

You can create user groups (page 586) with specific rights and add users to the
group.

You can create as many user groups as necessary and define their rights in
detail. In addition to data access rights, a user group has access to specific
workspaces.

You can assign one user to multiple user groups. See also User Group Priority
(page 100).

Use the Topobase Administrator Setup options to create user groups, add users,
and assign workspaces. Also, you can create or remove users and user groups.
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See also:

■ Workspaces and Documents (page 57)

To create a user group

1 In the Administrator explorer, click Setup menu ➤ User Group.

2 Under User Group, click Create.

3 Enter a name, such as VIEWER.

4 In the Workspaces section, click the workspace and click the arrow button
to assign it to the user group.

To assign a workspace to a user group

You assign a workspace to a user group. The default user group is the ADMIN
group.

1 In the Administrator explorer, click Setup menu ➤ User Group.

2 Under User Group, select a user group, such as VIEWER.

3 In the Workspaces section, select the workspace and assign it to the user
group. Either use the button or double-click the item.

4 Exit the Administrator.

To create a user

1 In the Administrator explorer, click Setup menu ➤ Users.

2 Under Users, do one of the following:

■ To create a user with Administrator rights, click Create Admin.

■ To create any other type of user, click Create.

3 Enter a name, for example, Jimmy.

4 In the Groups section, select one or more user groups you want to assign
the user to. Either use the button or double-click the item.

5 If you assign multiple user groups, you can change the priority. Use the
arrow buttons to move the user groups up or down. See User Group
Priority (page 100).

6 Exit the Administrator.
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See also User Login (page 38).

To remove a user

1 In the Administrator explorer, click Setup menu ➤ Users.

2 Select the user you want to remove, and click Delete.

To remove a user group

You can only remove a user group if no users are assigned to that group.

1 In the Administrator explorer, click Setup menu ➤ User Group.

2 Select the user group, for example VIEWER, and click Delete.

User Group Priority
When a user is assigned to multiple user groups, the following rule applies:
The user has the highest privilege allowed by the user groups the user is
assigned to. A priority is used where a single choice of group needs to be made.

The priority is specified by the order in which the user groups appear in the
user setup, in the Assigned Groups box. See To create a user (page 99).

If you are a member of multiple user groups

■ Feature class form—You will be using the feature class form that is assigned
to the first group in group priority order.

■ Document explorer—In the document explorer you will see the explorer
definitions and objects of all user groups (OR).

■ Jobs—You will be able to use all job templates of all groups (OR).

■ Electric explorer—You will be able to use the explorer profiles of all groups
(OR).

Client User Interface

Client Commands

You can customize the Client user interface by enabling or disabling
application related TB commands. When you disable a TB command, the
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command cannot be executed. That means, if you enter the command in the
command line, or if you click the button on the Ribbon, a message notifies
you that the command cannot be executed.

Standalone Client Menu Bar

You can customize the Client user interface for different user groups. For
example, you can hide or disable commands for a user group.

Customize the Standalone Client menu bars for different user groups.

See also:

■ Configuring Topobase Commands (page 81)

To customize the Client TB commands

1 In the Administrator explorer, expand Setup. Click User Interface.

2 Click the TB Commands tab.

3 Select the user group.

4 Select the commands you want to enable.
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To customize the Standalone Client toolbar

You can customize the Standalone Client toolbar for different user groups.
For example, you can hide icons that are not available for a user group.

1 In the Administrator explorer, expand Setup. Click User Interface.

2 Click the Toolbars tab.

3 Select the user group.

4 Expand the toolbar you want to customize, for example Main.

5 Select the icons you want to provide. Clear the check boxes for icons you
do not want.

To customize the Standalone Client menu bar

1 In the Administrator explorer, expand Setup. Click User Interface.

2 In the User Interface section, in the Usergroup list, select the user group,
for example ADMIN.

3 Click the Menu tab.

4 Expand the menu you want to customize, for example Workspace.

5 Select the menu items you want to provide. Clear the check boxes for
items you do not want.

Setting Up Topobase Modules
Some modules require additional settings.

■ Topobase Wastewater. See Set Wastewater Document Options.

■ Topobase Electric.

■ See Topobase Electric Explorer Profiles

■ See Classify Devices

■ See Set Topobase Electric Options
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Explorer Configurator
Application developers can customize the Topobase document explorer profiles
for each document, using the Explorer Configurator.

To create explorer statements

1 Start Topobase Administrator and open a workspace.

2 In the Administrator window, click Document menu ➤ Explorer
Configurator.

Create new definitions and statements that are displayed dynamically in the
Topobase document explorer, in the same way the default topics, feature
classes, and so on are displayed.

On the Statements tab, under Select Statement, us the SQL Assistant to create
the select statements.

The review example demonstrates some settings that can be made

1 In the Explorer Configurator, expand the Workflows item.

2 Select Workflows and click the Statements tab.

Notice the explorer icon definition, the node item captions, and the SQL
statements.

See also:

■ Creating SQL Expressions (page 137)

■ Select Statement Validation (page 107)

For more information see the Topobase Developer’s Guide.

Workflow Definition
Topobase workflows provide basic functionality for workflows that are used
in Topobase applications, such as Water, Wastewater, Gas, Electric, or Land
Management. Workflows guide you through tasks like:

■ Acquisition

■ Analysis
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■ Reports

For each workflow that has been started, a separate workflow area is displayed.
The workflow area contains embedded information about the further
procedures and displays options and check boxes to control the execution of
the workflow.

Application developers can define workflows for each document (page 581)
using the Topobase administrator. Note that to do this, VB .NET and Topobase
API (Application Programming Interface) knowledge is required. This
knowledge is not presented in this manual.

For more information about using the application workflow, s refer to the
appropriate manual:

■ Topobase Water User Guide

■ Topobase Wastewater User Guide

■ Topobase Gas User Guide

■ Topobase Electric User Guide

■ Topobase Land Management User Guide

See also:

■ System Table TB_WORKFLOW (page 180)

■ Explorer Configurator (page 103)

To define a workflow

1 Start Topobase Administrator and open a workspace (page 586).

2 In the administrator explorer, select the document.

3 Click Document menu ➤ Workflows.

4 The workflow property pane shows a tree view of the defined workflows.

5 In the workflow explorer, select the root node and click Create. Enter a
name, such as Network Point Acquisition.

6 In the workflow explorer, select the new workflow. In the right pane,
enter the workflow properties.
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7 It is recommended that you sort the workflows by categories. To create
a category, use Create Workflow. Leave the script code property empty.
Then select the category item and click Create Workflow.

DescriptionWorkflow Ad-
ministrator

Specifies the name of the category or the workflow.Name

Specifies the caption of the category or the workflow. The caption
is displayed in the document explorer tree. Define a caption that
describes the function clearly.

Caption

Specifies an icon for the explorer tree. Click  to select a
picture. The file has to be either in the <topobase>\pics\Explorer
folder or a <topobase>\pics sub-folder. Examples:

Picture

IconWorkflow.ico: <topobase>\pics\Explorer\
\Dialog\WFStep.jpg: <topobase>\pics\Dialog\

Creates a new category or workflow.Create

Deletes a workflow.Delete

WARNING If you delete a category, all workflows are deleted.

Saves the workflow definitions.Save

Specifies the target application that the workflow definition is
designed for. Use this option to mark workflows that have been

Target Applica-
tion

created especially for the Topobase Web or the Topobase Client
version. Depending on this option, the workflow will be available
in the Client or Web document explorer.

Specifies the script code. Complete the skeleton in the script code
window. You can use VB .NET and the Topobase API.

Script Code

Enter “me.” to view valid expressions.

Checks the syntax.Validate

The definition is stored in the document in the system table TB_WORKFLOW.

Workflow Definition | 105



The default icons of the workflow explorer tree nodes are assigned in the
administrator explorer statement configuration.

To show a workflow in the document explorer

You can provide the workflows, using the Topobase document explorer, where
users can start the workflows. Consider creating an explorer profile for all
workspaces.

1 Start Topobase Administrator and open a workspace.

2 Define the workflow.

3 Select the document and click Document menu ➤ Explorer.

4 In the Explorer manager, add the workflow item to the appropriate
document explorer definition or create a new explorer profile for the
workflows.

5 In the explorer tree, check all workflows that you want to provide.

6 Click Save Tree.

To start a workflow from the Topobase document explorer.

1 Start Topobase Client and open a workspace.

2 Select the document explorer that contains the workspaces.

3 In the document explorer, expand a workflow category.

4 Select the workflow you want to start, right-click and click Execute.

Feature Rule Definition
Application developers can define feature rules in the data model administrator.

To edit feature rules

1 Start Topobase Administrator and open a workspace.

2 Click Document menu ➤ Data Model.

3 In the data model explorer, select a feature class, right-click and click Edit
Feature Rules.
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See also:

■ Topobase Feature Rules Reference

■ About Feature Rules (page 571)

Select Statement Validation
During your configuration work, you sometimes need to define SQL select
statements. In most UIs, you can execute and validate your definitions, such
as the definition syntax. You use:

■ Feature Search Administrator

■ Explorer Configurator.

The execution results are shown in the SQL Info dialog box. In case of errors
or unwanted results, you can edit the SQL statement and repeat the validation,
as long as it is successful.

Setting Up Topobase Web

Overview of Web Setup
The administrator can create web applications for users in the field. The
workspaces, data forms, workflows, jobs, and Feature Search definitions you
define for Topobase Client can also be used in any Topobase Web application
that you create. This means that your users can edit data in Topobase Client
on the desktop, or in Topobase Web from a web browser.

You must set up the database, and IIS.-----Check requirements (page 45)

The Topobase workspace is the user's working
environment.

-----Set up workspaces (page 58)
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Use Topobase Administrator to specify the
MapGuide credentials.

-----Set up MapGuide (page 117)

Use Topobase Client, to publish your workspaces,
and display models to MapGuide.

-----
To create the Web layout (page
108) You can also start from scratch, and Load the

Topobase Web package (page 110). The Web
package contains default resources.

Use Topobase Administrator to associate your
workspace with Layout elements, such as a
symbol library.

-----
To assign the symbol library (page
117)

Direct your users to the appropriate URL for their
work.

-----
Provide URL parameters to log in
(page 114)

Start Topobase Web.-----Start Topobase Web (page 37)

Creating a Web Layout
If you have have set up Topobase Client workspaces and display models, you
can use the Publish To MapGuide command to publish your map components,
and to create web layouts.

Basic Web Layout—Employs a basic AJAX based framework developed by the
open source geospatial community.
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Flexible Web Layout—Employs an advanced Fusion based framework that
supports a variety of widgets.

Publish To MapGuide includes the following:

■ Creation of the Web layout

■ If you have administrator rights, and if the Web layout has not been
specified before: Assignment of the Web layout to the workspace. See also
Setting Up MapGuide (page 117).

■ Assignment of the the display model. See Assigning Display Models for
Topobase Web (page 118).

NOTE You can provide predefined web layouts by creating MapGuide web
packages.

To create Web layouts from scratch, see Configuring MapGuide Studio (page
110).

To create a Web layout (Publish To MapGuide)

The Web layout you are creating for the workspace is based on the current
display model. When you are logged in as an administrator, and you publish
your workspace for the first time, and if no Web layout has been assigned
before, you can specify which type of Web layout to use: Basic Web Layout,
Flexible Web Layout, or No Layout.

1 Start Topobase Client, and open the workspace.

2 On the ribbon, click Home tab ➤ Display panel ➤ Open Display Model.

3 Select the display model.

4 Click Home tab ➤ Display Panel ➤ Generate Graphic.

5 If the display model contains several display model maps, select the
drawing to publish.

6 In Display Manager, click Tools ➤ Publish To MapGuide.

7 Connect to the MapGuide site.

8 Under Select A Destination Folder, create a folder.

9 Click Publish.

Publish each display model map to a separate folder.
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10 In the Choose A Web Layout dialog box, select a Web layout, such as
Flexible Web Layout.

If you want to configure the layout manually, select No Layout. See
Configuring MapGuide Studio (page 110).

To publish a Plot display model to MapGuide

Usually, you have a separate Plot display model that is used to display the
plot features, such as the frame, north arrow, legend, or scalebar.

1 Open the Plot display model.

2 Publish to MapGuide. Under Select Destination Folder, create a folder,
such as Plot.

Configuring MapGuide Studio
Use MapGuide Studio to create the Web layout for Topobase Web from scratch.
Autodesk Topobase provides a Topobase Web MapGuide Package that can be
used as a template to configure MapGuide Studio for Topobase Web.

Use Topobase Administrator to associate your workspace with a Topobase
Web Layout that you have created using Autodesk MapGuide Studio. See To
set up the Web layout (page 117).

BEST PRACTICE Use Topobase Client, and the Publish To MapGuide command
to create a Web layout that matches your workspace and display model. See
Creating a Web Layout (page 108).

NOTE For the demo data sets Autodesk provides web packages.

To load the Topobase Web MapGuide package

The Topobase Web MapGuide Package (file name: Topobase Web Layout
package.mgp) contains default map resources for creating a flexible Web
layout, for creating a flexible Web layout with COGO toolbar, and for creating
a basic Web layout.

1 Start MapGuide Site Administrator by entering the following URL in a
web browser:

http://localhost/MapGuide2011/mapadmin/login.php

2 Login as an adminstrator.
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3 In the navigation pane, click Manage Packages.

4 Under Load Package, click Configure Package Directory.

5 Under Resource Service, for Packages Folder change the directory path
to the location of the MapGuide package that you want to load.

6 Click Save.

7 In the navigation pane, click Manage Packages.

8 Under Load Package, locate and select Topobase Web Layout Package.mgp
and click the Load Package icon.

9 Click OK.

To create a flexible web layout

1 Start MapGuide Studio.

2 In the Topobase Web Layout folder, right-click the flexible web layout
resource and click Copy. Copy this resource to the folder that contains
your published Topobase data.

NOTE The flexible web layout resource is available in the Topobase Web
MapGuide Package. For more information on loading this package, see To
load the Topobase Web MapGuide packageStart MapGuide Site Administrator
by entering the following... (page 110).

3 Open the flexible web layout resource.

4 In the Configure Components of the Selected Template pane, click the
Map tab.

5 For Map Resource Used In This Layout click [...], locate and select the
map to reference in the web layout.

6 Click File  ➤  Save.

To create a flexible web layout with the COGO Toolbar

1 Start MapGuide Studio.

2 In the Topobase Web Layout folder, right-click the FlexibleCOGO web
layout resource and click Copy. Copy this resource to the folder that
contains your published Topobase data.

3 Open the FlexibleCOGO web layout resource.
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4 In the Configure Components of the Selected Template pane, click the
Map tab.

5 For Map Resource Used In This Layout click [...], locate and select the
map to reference in the web layout.

6 Click File  ➤  Save.

To create a basic web layout

1 In the Topobase Web Layout folder, right-click the basic web layout
resource and click Copy. Copy this resource to the folder that contains
your published Topobase data.

2 Open the Basic web layout resource.

3 For Map Resource Used In This Layout click [...], locate and select the
map to reference in the web layout.

4 Click File  ➤  Save.

To create a data connection

In MapGuide Studio, we recommend that you configure the Feature Resource
using a connection to the Topobase system user TBSYS.

1 Start MapGuide Studio.

2 In the Site explorer, click the Data folder. Right click and select
New ➤ Data Connection.

3 In the Connect to Data dialog box select Autodesk FDO Provider for
Topobase and click OK.

4 Enter the connection properties (TBSYS).

5 Select the Data Store row and click […].

6 In the Data Store Selection dialog box select the document you want to
work with.

7 Enter user name and password, and save it into the Data folder.

8 Click Test Connection.

To create layers

1 In the Site explorer, click the Layers folder.
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2 Right click and select New ➤ Layer.

3 In the Settings section click […] in the Data Resource ... row.

4 Select the data connection you created previously.

5 In the Feature Data Setup group box set the layer properties.

6 Save the layer.

7 Continue to create other layers. For detailed information refer to
MapGuide Studio help.

To create a map

1 In the Site explorer, click the Map folder.

2 Right click and select New  ➤ Map.

3 Enter a description.

4 In the Settings section, select the coordinate system. For example, *XY-M*
(Arbitrary X Y Coordinates (Meters).

5 Enter the coordinates.

6 Add the required Layers to the map.

7 Save the map to MapGuide Server with MapGuide Studio (Map folder).

8 In the Map Preview section click Refresh to show a preview of the map.

To add Topobase commands to the Web layout

1 In the Web Layout Editor click the New Commands link.

2 In the New Commands section click Add.

3 Select Invoke URL. A new record is added to the grid control.

4 In the right pane enter command name, title, tooltip and so on.

5 Click the Additional Parameter tab and enter the following value for URL
To Invoke: …/TBWeb/FeatureExplorer.aspx.

6 Make sure the Disable Command If Nothing Is Selected option is
deselected.

7 In the Toolbar and Menus section click the Task Bar Menu tab and add
the new command and save it.
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8 Repeat step 1 to 7 for the following commands:

■ Redlining: ../TBWeb/Redlining.aspx

■ Dimensioning: ../TBWeb/Dimensioning.aspx

■ Feature Search: ../TBWeb/PositionFinder.aspx

If you want to have the Feature Explorer automatically at startup, open the
web layout. In the textbox "URL for hometask displayed...", enter:
"../TBWeb/FeatureExplorer.aspx".

Setting Up URL Parameters

URL actions

Use the UrlAction.aspx and its parameters to start Topobase Web. Using the
parameters you specify the following actions.

■ Login: ACTION=LOGIN&<parameters>

■ Logout: ACTION=LOGOUT

■ Zoom via FIDs:
ACTION=ZOOM&FIDS=<fid,fid>&HIGHLIGHT=True&FACTOR=<factor>&MARK=True

■ Zoom via bounding box: ACTION=ZOOM&BBOX=<coordinates>

■ Draw temporary points: ACTION=MARK&POINTS=<coordinates>

All parameters can either be passed in the URL via GET method or by
submitting a form via POST method. Using the POST method, you can handle
larger data sets, and meet higher security requirements.

URL parameters to login

Use the URL parameters to specify the system user, system user password, user,
user password, service, and workspace.

■ TBSYS_USER

■ TBSYS_PWD

■ SERVICE

■ TB_USER
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■ TB_PWD

■ WKSPACE

The login parameters are required only at the first call. Following calls reuse
the parameters of the existing Topobase Web session.

Example:

http://localhost/mapguide2011/TBWeb/

UrlAction.aspx?ACTION=LOGIN

&TBSYS_USER=TBSYS

&TBSYS_PWD=tbsys

&TB_USER=Topobase

&TB_PWD=

&SERVICE=ORCL

&WKSPACE=TBWEB.

URL Logout

We recommend that you call the Logout action before you perform actions
with a different user or workspace. Example:

http://localhost/mapguide2011/TBWeb/

UrlAction.aspx?

ACTION=LOGOUT

URL parameters to zoom via feature IDs

Use the URL parameters to specify the Zoom by feature IDs. Example:

http://localhost/mapguide2011/TBWeb/urlaction.aspx?

TBSYS_USER=TBSYS

&TBSYS_PWD=tbsys&TB_USER=Topobase&TB_PWD=

&SERVICE=ORCL&WKSPACE=TBWEB

&ACTION=ZOOM

&FIDS=3503%2C3890

&HIGHLIGHT=True

&FACTOR=1.5

&MARK=True

■ FIDS= lists the feature IDs, separated by a comma.

■ HIGHLIGHT= Optionally highlights the specified features in the map.

■ FACTOR= Optionally sets a magnification factor by which the map extend
will be multiplied.
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■ SCALE= Optionally specifies the scale of the map. If both SCALE and
FACTOR are provided, SCALE is ignored. If no SCALE is specified, the scale
of the current map applies.

■ MARK= Optionally adds a symbol to mark the specified features.

URL parameters to zoom via bounding box

Use the URL parameters to specify the Zoom by a bounding box. Example:

http://localhost/mapguide2011/TBWeb/

urlaction.aspx?TBSYS_USER=TBSYS

&TBSYS_PWD=tbsys&TB_USER=Topobase&TB_PWD=

&SERVICE=ORCL&WKSPACE=TBWEB

&ACTION=ZOOM

&BBOX=687486%2C335868%2C687544%2C335916

■ CRS= Optionally specifies the coordinate system code

■ BBOX= Specifies the 2D bounding box to zoom. Can either be
minX,minY,maxX,maxY coordinates of a rectangle, or
X1,Y1,X2,Y2,…,Xn,Yn(,X1,Y1) values that specify a polygon.

URL parameters to draw marker points

Use the URL parameters to draw temporary markers in the map. Example:

http://localhost/mapguide2011/TBWeb/

urlaction.aspx?TBSYS_USER=TBSYS

&TBSYS_PWD=tbsys&TB_USER=Topobase&TB_PWD=

&SERVICE=ORCL&WKSPACE=TBWEB

&ACTION=MARK

&POINTS=687575.139%2C335793.35%2C687562.656%2C335944.721

&ZOOMTO=True

&MARKING=On

■ CRS= Optionally specifies the coordinate system code

■ POINTS= Specifies the point coordinates (p1.x,p1.y,p2.x,p2.y,p3.x,p3.y)

■ ZOOMTO= Optionally specifies whether a zoom is applied.

■ TOLERANCE= When MARKING is off, optionally specifies a tolerance of
unmarking.

■ MARKING= Optionally unmarks points (MARKING=OFF).
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Setting Up MapGuide
With Topobase Administrator, you can provide workspaces, and display models
for the Topobase Web version that is based on Autodesk MapGuide®.

To specify Map Guide credentials

The credentials are required for some Web functions to log in, and to set up
the Web layout.

1 Start Topobase Administrator, and open the workspace.

2 Click Setup menu ➤ MapGuide.

3 Enter the credentials as shown in the following table.

DescriptionMap Guide

Specifies the MapGuide site, for example ht-
tp://127.0.0.1/mapguide2011.

MapGuide Site

NOTE You must enter the IP number. Do not use
the machine name such as  localhost.

Specifies the user name to log into MapGuide®

Studio. For example Administrator.
MapGuide User Name

Specifies the password to log into MapGuide Studio.
For example admin.

MapGuide Password

To set up the Web layout

You select the Web layout elements for the selected workspace.

1 Start Topobase Administrator, and open the workspace.

2 Click Workspace menu ➤ Web Layout.

3 Do one or more of the following:

DescriptionWeb Layout

Select a Web layout. If you have several layouts for the
workspace, Topobase Web uses this layout as initial view.

Web Layout
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For example Library://Topobase
Land/TB2011_LM_B.WebLayout, if you use the AJAX
viewer.
For example Library://Topobase Land/TB2011_LM_F.Ap-
plicationDefinition, if you use the Fusion viewer.

NOTE When you use the Publish To MapGuide command
with administrator rights, and if the Web layout has not
been specified before, the Web layou is assigned automat-
ically.

Select the symbol library, for example Library://Topobase
Land/Data/Prototype_LM.SymbolLibrary.

Web Symbol Library

Select the symbol name. For example BAV28. This symbol
is used to highlight the Feature Search result. See also
Feature Search Introduction (page 527).

Web Symbol Name

Assigning Display Models for Topobase Web
In Topobase Web, you can use several display models to display your map.
To provide a display model for use in Topobase Web, perform the following
steps.

■ In Topobase Client, create the display model.

■ Publish the display model to MapGuide, and create the MapGuide
Definitions. If a display model contains several maps, you publish each
display model map to a separate Map Definition. You publish each display
model map into a different folder. See also To create a Web layout (page
109).
If you use the Publish To MapGuide command to create the Web layout,
the assignment of the display models is done automatically.

To assign a display model for Topobase Web

Use the Publish To MapGuide  (page 109) command.

To view the assigned display models for Topobase Web

1 Start Topobase Client, and open the workspace.

2 Click Home tab ➤ Display Panel.
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3 From the Save Display Model list, select Assign Display Model For Use In
Topobase Web.

4 The Assign Display Model For Use In Topobase Web dialog box, displays
the assigned display models.

5 Click Close.

To modify the settings, click Edit.

DescriptionAssign Display Model
For Use In Topobase
Web

Lists the display models that are available in the document.
These are all display models that are available in the Dis-
play Model select box.

Display Model

Name of the display model, and number of maps that are
defined in the display model.

<display model> (nr)

Name of the display model map.<map>

Displays the assigned MapGuide Definition. For each map,
you assign a layout.

MapGuide Definition

Edits the assignment.Edit

In Edit mode: Saves the settings.Save

Web File Upload
In feature class forms, you can assign documents to each feature, for example
using the document manager, or the file selection control. For use in Topobase
Web, you specify the IIS alias for the file location.

See also Document Manager and folder names for Topobase Web (page 153).

To set up the file location

1 On your Web server, create a folder to store your documents, for example
C:\Public Documents.
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2 Start the IIS manager, and on your Web Site, create a new Virtual
Directory. We recommend that you do not use a sub folder of the
MapGuide directory.

3 Enter an alias, such as MyPublicDocs.

4 Select your Web Site Content Directory, for example C:\Public
Documents.

5 Under Access Permissions, select Read, Write, and Browse.

To define the file location for Topobase Web

1 Start Topobase Administrator and open the workspace.

2 Select the document, and click Document menu ➤ File Upload.

3 Under Local Directory, enter the folder name, such as C:\Public
Documents.

4 Under IIS Alias, enter the alias, such as MyPublicDocs.

Performance Improvements
This section provides ways to optimize your Topobase Web configuration.

■ Generating maps as a JPG or PNG8 instead of PNG (for AJAX)
You can increase the speed of a site if you generate a map from Autodesk
MapGuide server as a JPG or PNG8. The file size of JPG or PNG8 images
created for the AJAX viewer application can be smaller than a PNG image;
however, the PNG file has a higher display quality.

To do generate a map as a JPG or PNG8 file, edit the RequestMapImage()
function of the ajaxmappane.templ file, and then change the FORMAT
parameter to JPG or PNG8. You can find the ajaxmappane.templ file in
the <install directory>\WebServerExtensions\www\viewerfiles folder.

■ Verify that all spatial indices are valid in your document.

■ Use views instead of client side joins. When you use a view, use only the
attributes in the views which you need.

■ For layer definitions, use only the attributes which you need.

■ Work with scale ranges. For big scales and static data, use .sdf, .shp, or
raster. For smaller scales or live data, use data from a database.
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■ For raster, use the .ecw format.

■ Use cs transformation only if necessary.

■ Use base layers.

■ Verify that you do not have invalid views in your document.

■ Refer to the MapGuide implementation Best Practices Guide:
http://images.autodesk.com/adsk/files/mapguide_enterprise_implementation_best_practices.pdf.

Setting Application Options
Application options are stored in the Topobase system database schema TBSYS
(page 584). Use Topobase Client to set application options.

To set common application options

You use the common application options to specify layout, directories for log
files and user settings.

1 Start Topobase Client, and open the workspace.

2 Click Settings tab ➤ Setup panel ➤ Application Options.

3 In the tree view, click Common.

4 In the right pane, edit the options.

DescriptionCommon options

Upon login, opens feature class forms that were
previously open until you closed the workspace.

Load Last Open Forms

Upon login, opens the last workspace you used.Remember Last Workspace

Specifies the folder in which to save report tem-
plates. The default directory is <topobase>\Reports.

Report Root Directory

Specifies the temporary and log directories. The
default directories are <topobase>\temp and <to-
pobase\log.

Temp. and Log Directory

For example, the log files of document imports are
stored in the log directory.
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Specifies the directory for data. The default direct-
ory is <topobase>\Data.

Data Directory

For example, the word serial letter templates are
stored in the data directory.

To set Map Options application options

Map Options apply to the AutoCAD Map connection. Use Map Options to
specify options for all documents (page 581).

1 Start Topobase Client, and open the workspace.

2 Click Settings tab ➤ Setup panel ➤ Application Options.

3 In the tree view, click Map Options.

4 In the right pane, edit the options, as shown in the following table:

NOTE Changes to Map Options apply immediately. Document level options
override some Map Options.

DescriptionMap Options

Redirects the feature information request from the label
feature class to the parent. If this check box is selected,

Display Info about Label's
Parent

you can click a label in the map to view information
about the related object. For example, click a point
number to view information about the point. If you
clear the check box, only label information is displayed.
See also System Table TB_GN_INFO_REDIRECT (page
154).

Opens a feature class form in edit mode. When you use
Create A Feature With Form the form is opened after

Open Form In Edit Mode
After Digitizing

digitizing. This option makes the form ready for addi-
tional attributes.

Searches for points that already exist in the database,
when creating a new point feature.

Vicinity For Digitizing
Points [m]

This option finds points that are in the vicinity of the
new point and that have defined values for "Z (height)"
and "QUALITY". If points are found, these attribute
values are applied to the new point. In the map docu-
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ment options, you can specify feature classes for the
vicinity search.
Search results are displayed in the command window.

Regenerates the graphic before highlighting the fea-
tures. Use this option to generate graphics to display

Always Display Highlighted
Features

the features that are currently excluded by a filter set-
ting, such as a viewport, or any other filter entered in
Display Managers context menu Query to filter data.
For example, when you highlight tracing results.

Specifies the zoom factor for highlighting the current
feature of a feature class form or in the feature explorer
using the highlight button.

Zoom For Feature High-
light/Zoom GoTo

Specifies the viewport. Enter fix values.Configuration For Point
Feature Classes

Specifies the viewport. Enter a magnification factor as
follows:

Configuration For Other
Feature Class Types

■ 0 = The current viewport does not change when
you highlight a feature.

■ between 0 and 1: Zooms in. For example, enter
0.5 to zoom to the features and then zoom in with
a factor of 2.

■ > 1: Zooms out. For example, enter 2 to zoom to
the features with a factor of 2.

The viewport size is calculated based on the feature
extension.

Specifies how a job perimeter is displayed in the map.
You can highlight the perimeter with a solid or hatch
pattern. See also Getting Jobs Started (page 345).

Perimeter Display Options

Specifies the feature classes to which the vicinity search
shall be applied.

Vicinity Search

NOTE To set options for individual documents, use Document Map Options. See
also To set document Map optionsYou use the document Map options for settings,
that are specific to only ... (page 129).
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To set COGO application options

You can use COGO application options to define settings for Topobase
construction functions.

1 Start Topobase Client, and open the workspace.

2 Click Settings tab ➤ Setup panel ➤ Application Options.

3 In the tree view, expand COGO.

4 In the right pane, edit the options, as shown in the following table:

DescriptionCOGO

Specifies the mode for right angle course calculation.
Select either:

Right Angle Course

■ Point Mode—The right angle course is defined
by an arbitrary sequence of known points and
measured sections.

■ Base Line Mode—The right angle course is
defined by two existing points that specify the
base line section followed by measured sections.

See also the Topobase Client User Guide, section
Constructions: Right Angle Course.

Specifies calculation precision. The default is 0.001.Precision

Specifies whether a line can be considered straight
after inserting or extracting a point.

Split Tolerance

This value specifies the maximum distance of a point
from the line, which must be greater than the spatial
tolerance.
See also the Topobase Client User Guide, section
Constructions: Line Processing (Vertices).

Splits the line after you use the Insert Point com-
mand.

Split Line After Inserting
Point

Specifies how the Precision and Reliability attributes
are set by the Survey application when the Insert

Point Insertion Settings

Point command is used to insert a point into a line.
When an existing point is projected onto a line, its
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reliability is improved and its coordinates are
changed.

Defines the feature attribute where the precision of
an inserted point is saved.

Precision

Defines the feature attribute where the reliability of
the inserted point is saved.

Reliability

This attribute usually refers to a domain *_TBD. You
can specify the value (*_TBD.ID) for the two states
Reliable and Not Reliable.
For example, reliability values could be stored in the
domain table RELIABILITY_TBD where
ID = 1 is not reliable
ID = 2 is reliable

Specifies the reliable value ID. For example 2.Reliable

Specifies the not reliable value ID. For example 1.Is Not Reliable

See also the Topobase Client User Guide, section Overview of Construction.

To set document explorer options

You use the Topobase document explorer (page 582) options to control general
user interface behavior.

1 Start Topobase Client, and open the workspace.

2 Click Settings tab ➤ Setup panel ➤ Application Options.

3 In the tree view, click Document Explorer.

4 In the right pane, edit the options, as shown in the following table:

These settings take effect when you reopen the workspace.

DescriptionDocument Explorer op-
tions

Opens feature class forms or starts workflows by double-
clicking the feature class or workflow item.

Double Click Opens The
Form
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Displays the table name and F_CLASS_ID in the status
bar at the bottom of the Document explorer. This in-
formation is useful for administrators.

Display Information About
Selected FeatureClasses

To set Generate Graphic application options

You use the Generate Graphic application options to control the Topobase
viewport (page 586).

1 Start Topobase Client, and open the workspace.

2 Click Settings tab ➤ Setup panel ➤ Application Options.

3 In the tree view, click Generate Graphic.

4 In the right pane, edit the options, as shown in the following table:

These settings take effect when you reopen the workspace.

DescriptionGenerate Graphic op-
tions

Specifies default values for the extension of a viewport.
These values can be modified later in the Advanced Gener-
ate Graphic dialog box.

Viewport Creation

See also the Topobase Client User Guide, section Displaying
Features In Your Map.

Specifies the default height and width when you define a
viewport using a point in the center of the drawing.

Configuration For Point
Feature Classes

Specifies a magnification factor when you define a viewport
with a non point feature in the center of the drawing. The

Configuration For Oth-
er Feature Class Types

viewport size is calculated based on the feature extension.
Enter a magnification factor as follows:

■ 0 = A selected polygon feature is used.

■ between 0 and 1: Zooms in. The filter rectangle is
smaller than the bounding box of the selected geo-
metry.

■ 1 = No change.

■ > 1: Zooms out. The filter rectangle is greater than the
bounding box of the selected geometry.
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Specifies settings for display models.Display Model

Specifies the path where the display model files such as
(*.tbdm) and (*.layer) are stored. See also Display Model
Repository (page 431).

Repository Base Path

Specifies whether to open a new drawing each time you
select a new display model, and generate graphic.

Drawing Options
When Generating A
Display Model

Closes the current drawing. Opens a new drawing for each
display model map of the selected Display Model.

Close Current Drawing

For example, you select a display model DM1, and generate
graphic to populate Drawing1.DWG. Then, you select anoth-
er display model DM2. Drawing1.DWG is closed, and a new
drawing Drawing2.DWG is populated.

Keeps the current drawings open, and opens a new drawing
for each display model map of the selected Display Model.

Keep Current Drawings
Open

Loads the first display model map of the selected Display
Model into the active drawing (*.DWG), such as an AutoCAD
drawing (*.DWG) that contains projected parcels.

Reuse Active Drawing

Then, you select a display model, and generate graphic.
The display model adds the feature layers to your active
drawing, and you can use the command Create New Fea-
ture From Geometry to transfer the projected parcel geo-
metry into the database.

To view the loaded PlugIns

Use the application options to view a list of loaded PlugIns.

1 Start Topobase Client, and open the workspace.

2 Click Settings tab ➤ Setup panel ➤ Application Options.

3 In the tree view, click Plug-Ins.

Setting Document Options
You use the Document options to control settings that are specific to only
one document (page 581). These settings are saved either in the document or
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in the system database schema TBSYS (page 584). In order to edit the document
options, the workspace must be open.

Document options work in addition to application options, and are specific
to each document.

NOTE Some document options are only available to members of the Admin user
group (page 586).

Common Document Options
You cannot edit common document options. They provide general document
information.

DescriptionCommon op-
tions

Name of the Oracle® database schema:Database Schema
<schema>@<oracle service>

Unique identifier.Document ID

Version of the document structure. This value changes
whenever the data model is updated.

Version

Version of the (*.jar) file that controls server-side functionality.
This value can be different from the document structure version.
However the first number has to be identical in both.

TBSYS Version

These values identify different data models. For example, the
DM Code (Data Model Code) controls the scope of necessary
data model updates.

Keys/Data Model
Codes

See also System Table TB_DATAMODELCODE (page 152).

To view common document options

1 Start Topobase Client, and open the workspace.

2 Click Settings tab ➤ Setup panel ➤ Document Options.

3 In the tree view, click Common. The options in the following table are
displayed:
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To set document Map options

You use the document Map options for settings, that are specific to only one
document. These settings override the general Map application options.

1 Start Topobase Client, and open the workspace.

2 Click Settings tab ➤ Setup panel ➤ Document Options.

3 In the tree view, click Map Options.

4 In the right pane, edit option settings.

NOTE You set general Map options using the Map application options. Using the
document Map options, you can override the Map application options.

Vicinity Search—In the document map options you can specify single feature
classes to which the search shall be applied, in addition to the application
map options.

See also:

■ To set Map Options application optionslabels:redirecting to parent
featurejobs:perimeterperimeter:di... (page 122)

To set COGO and dimensioning options

You use the COGO and dimensioning document options to control
construction issues, that are specific to only one document.

1 Start Topobase Client, and open the workspace.

2 Click Settings tab ➤ Setup panel ➤ Document Options.

3 In the tree view, click COGO And Dimensioning.

4 In the right pane, edit option settings.

DescriptionCOGO and Dimensioning area

Deletes the temporary COGO features to
clarify the construction workflow. Normally

Delete Construction Features From The
Document

these are deleted as soon as Topobase
COGO is finished.

Specifies the dimension feature classes to
store dimensioning that can optionally be

Dimension Feature Class For
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DescriptionCOGO and Dimensioning area

created when you use the COGO com-
mands.

Selects a dimension feature class that stores
the orthogonal dimensioning.

Orthogonal Calculation

Selects a dimension feature class that stores
the arc dimensioning.

Arc Intersection

Settings for dimensioning.Dimensioning area

Specifies an offset value for aligned dimen-
sioning.

Constant Offset For Aligned Dimensioning.

NOTE You set general COGO options using COGO application options.

See also:

■ To set COGO application optionsright angle course:setting the
modetolerance:setting the split -You c... (page 124)

To set document Jobs options

When opening a document, the Live state will be used by default. You use
document Jobs options to change this behavior.

1 Start Topobase Client, and open the workspace.

2 Click Settings tab ➤ Setup panel ➤ Document Options.

3 In the tree view, click Jobs.

4 In the right pane, edit option settings.

DescriptionJobs area

Specifies the job state that will be used
when you open the document.

Always View The Data In The Document
Using The Following Job State

You need Administrator rights to specify
the job state.

Specifies that the most recent job will be
used when you open the document. For

Always Open This Document Using The
Most Recently Selected Job
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DescriptionJobs area

example, to work on large jobs that require
several days of work.

See also:

■ Overview of Jobs (page 341)

■ Job Leasing (page 351)

■ Managing Jobs

Topobase Data Checker
Use the Topobase Data Checker to validate the quality of your data. For
example, define any set of consistency checks that can be executed after data
has been imported into a document.

You can start the data checker either manually on demand or on a scheduled
basis. For example, you run a set of checks when you are ready to change the
job state.

In Topobase Client, when you start the Data Checker, the result of the checks,
is displayed in the feature explorer, for example features with wrong or
inconsistent data. Optionally, you generate a report that logs the
inconsistencies.

In a scheduled mode, the result is provided as a report that is sent via E-mail
to a specified recipient. Then, you can resolve the conflicts on the whole.

To configure the data checker in Topobase Administrator

1 Open the workspace.

2 In the administrator explorer, select the document.

3 Click Document menu ➤ Data Checker.

4 Under Data Checker, use the General tab to create and edit checks. Use
the Scheduled tab, to schedule the execution of the checks.
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On the General tab use the icons and shortcut menus as show in the following
table.

DescriptionData Checker General
tab

New Check. Opens the Data Check dialog box, and creates
a new data checker definition. See Creating a Data Check
(page 133).

Remove Check. Removes the selected check.

Edit Check. Opens the Data Check dialog box for the selec-
ted data check. You can modify the description and the
select statement.

Import Check. Open the file selector. Select an (*.XML) file
to import.

Export Selected Checks. Exports the selected data checks
into (*.XML) files.

On the Schedule tab use the icons and shortcut menus as show in the following
table.

DescriptionData Checker Sched-
uled tab

New Scheduled Task. Opens the Scheduled Data Check
dialog box, and creates a new scheduled task. See
Scheduling a Data Check (page 135).
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Remove Scheduled Task. Removes the selected task.

Edit Scheduled Task. Opens the Scheduled Data Check
dialog box.

To start the data checker in Topobase Client

1 Open the workspace.

2 Click Tools tab ➤ Modify panel ➤ Data Checker.

3 In the Data Checker dialog box, select one or more checks.

4 Click Execute.

Creating a Data Check
Use Topobase Administrator to define and configure data checks.

DescriptionData Check dialog
box

Specifies a name.Name

Specifies a parent data check for the selected data check.Parent Check

Specifies a description.Description

Specifies the SQL select statement that will be executed
by the selected data check.

Check Statement

Activates the check. Checks that are not activated cannot
be selected in Topobase Client, in the Data Checker dialog
box.

Active

Checks whether the SQL select statement is valid.Check SQL
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Starts the SQL Assistant. See also Using the SQL Assistant
(page 139).

SQL Assistant

Specifies advanced options.Advanced Options

Specifies a module name. If you define data checks to be
used by a customized PlugIn, you use the Module Name

Module Name

value to filter the data checks that are executed. For ex-
ample, to use the Data Checker through the API.

Specifies the Row Level SecurityRow Level Security

Recommended. Select this optionData Check Applies To
The Selected Job Or To ■ To execute the data check in the current job - in case

of manual start.The Live Job (For
Scheduled Tasks)

■ To execute the data check in the Live Job - in case of
scheduled start.

Select this option to execute the data check in the entire
database.

Data Check Applies To
The Entire Database

Check statements

A check statement is an SQL select statement that analyzes the data and returns
errors. If the check statement does not return any rows, the data is valid.

The SQL select statement must return a set of FIDs, and should match the
following skeletons.

■ For simple data checks, use
SELECT fid FROM <feature class> WHERE <checking condition> ORDER BY fid;

■ For advanced data checks, use
REPEAT <select statement> FOR <select statement>;

This SQL select statement repeats the first select statement as long as the
second select statement returns a result.

In the first <select statement> you can use placeholders that represent
columns of the second <select statement>.
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Example

REPEAT

SELECT fid from $f_class_name WHERE <checking condition>

FOR

SELECT f_class_name from TB_DICTIONARY where f_class_name like

'EL%';

TIP Define any database view to perform the check, and use the Check statement
to execute a SELECT on this view. For example: SELECT fid FROM <database view>
ORDER BY fid;

Scheduling a Data Check
The Scheduled tab displays the scheduled task. Select a task in the data grid,
and click Edit Scheduled Task to view the properties.

DescriptionData Check Sched-
uled tab

Displays the task name.Taskname

Displays the number of selected data checks.Checks

Displays the weekday when check will be executed.Weekdays

Display the start time of the scheduled data check.Start Time

Display the E-mail address the report will be send to.Report Recipient

Define a scheduled task as shown in the following table.

DescriptionScheduled Data
Check dialog box

Specifies the task name. The task name is used as E-mail
subject.

Task name

Specifies the days and the time when the data checks will
be executed.

Schedule

Specifies the E-mail addresses of originator and recipient.Report area
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Specifies the SMTP server, such as Host Name, Port, and
authentication.

SMTP area

Selects the data check that will be executed in the selected
task.

Checks

NOTE For Oracle 11: The Oracle 11 security model requires that you configure
an ACL (Access Control List). Then, the scheduled job can send an E-mail with the
data checker results. For more information, see Oracle 11 Users Guide and
Reference.

Database Maintenance
Topobase provides the 1-Click Maintenance tool to run several basic database
maintenance checks on one click. We recommend that you use this tool to
check your documents on a regular basis.

NOTE  Some of these checks are also available in the data model explorer from
the document node context menu. See Document Shortcut Menu (page 189).

1-Click Maintenance performs all or a selection of database checks, and
automatically fixes issues as shown in the following table.

DescriptionDatabase Check

Detects and recompiles invalid database objects, such as
triggers, and views.

Invalid Database Ob-
jects

Fixes or removes invalid entries in TB_DICTIONARY.Topobase Dictionary

Checks the naming of the indices and constraints.Indices And Constraints

Creates valid spatial indices and meta data for all feature
classes.

Spatial Configuration

Document

Cleans up TB_UFID, and adds missing FIDs.TB_UFID

Fixes the NextVal of the system sequences.Topobase Sequences

Removes unnecessary forms and controls.Form Check
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Renews the statistics of feature classes and tables.Gather Statistics

Document node ➤ Optimization ➤ Optimize Feature
Classes.

Cleans up the system log tables.Topobase Log Tables

DescriptionDatabase Checks
Without Fixing Capab-
ilities

Checks whether the scriptcode that is used in reports is
valid.

Report Check

Validates the geometries of all feature classes. Detected is-
sues cannot be fixed automatically.

Geometry Validation

Checks, if the feature classes based on views are defined
correctly. Detected issues cannot be fixed automatically.

View Definition

To check your database

Make sure no other user is connected to the document.

1 Start Topobase Administrator and open the workspace.

2 Select the document, and click Document menu ➤ 1-Click Maintenance.

3 In the 1-Click Maintenance area, under Database Checks, select the checks
to perform.

4 Click Scan For Issues.

For each check, an icon indicates whether issues have been found.

5 To see the list of issues, click the row.

6 To fix the issues, click Fix Issues.

Creating SQL Expressions
Topobase Administrator contains an SQL assistant to simplify the creation of
SQL select statements. In all dialog boxes, where you can enter an SQL
statement, you can use the SQL assistant, for example when you create a label
definition, or when you customize feature class forms. Depending on the
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condition in which you start the SQL assistant, specific information, such as
valid parameters, is provided.

IMPORTANT To use the SQL assistant you have to be familiar with Oracle, SQL,
and the Topobase document. This knowledge is not subject of this manual.

You use the SQL assistant in the following components and tasks.

■ Report Designer, see also Report Designer Introduction (page 483).

■ Form Designer, see also Form Designer Introduction (page 357).

■ Defining tracing conditions, see also Logical Topology: Tracing Templates
(page 329).

■ Feature Search, see also Feature Search Introduction (page 527).

■ Explorer Configurator, see Explorer Configurator (page 103).

■ Creating label definitions, and defining rules for label regeneration. See
also Data Model: Labels (page 223)

■ Defining Intersections, see also Data Model: Intersections (page 274).

NOTE The SQL Assistant is specific to the condition in which it is started. For
general purposes, use SQL Sheet. SQL Sheet is the standalone version of the SQL
assistant. See also Using the SQL Sheet (page 142).

The SQL assistant facilitates the entry of table names, attribute names and
relations. It provides context specific information about the document you
are working with. For example, you can list tables, views, feature class
attributes, feature relations, and explore the values are actually stored in the
database. Then, you click or double-click to add the values to the SQL
expression, so that no misspellings will occur.

Validating the SQL expression

Before saving the select statement, you can validate the syntax. Click Execute

menu ➤ Execute or click  to execute the select statement. The result
is displayed in the script output box. Syntax errors are highlighted and marked
with a "^" sign.

TIP Press <ESC> to abort the select statement while it is executed. For example,
if the select statement returns a large number of records.
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Using the SQL Assistant
The SQL Assistant dialog box consists of the following components.

NOTE The SQL Sheet provides some of the components of the SQL Assistant as
a standalone version, such as the Relation Wizard, as described in the following
table. See also Using the SQL Sheet (page 142).

DescriptionNumber

Expression input box. Displays the select statement. Use the con-
trols or type directly to edit the select statement.

1

Click File menu ➤ Save to store the select statement.

Click File menu ➤ Open to load an existing (*.sql) file.

Executed script output box. Displays the execution records. Click

File menu ➤ Save Output As to store the content in a file.

2

Tables and database objects list. Displays current database objects,
for example tables, synonyms or views. Select an object to display

3

more information. In the list, right-click an object, and use the
commands.
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For example, right-click a table name, and click Grid, to view the
table content in a data grid.

Attribute list. Displays the attributes and the data type of the se-
lected objects.

4

Get Values. Displays the values of the selected attribute. Select an
attribute from the list, and click Get Values to display the unique

5

values of the attribute. Duplicate entries are not listed here (SELECT
DISTINCT).

Advanced Controls section. Displays controls that can be used to

create SQL expressions. Click  to display all controls.

6

Click to add the operator at the cursor point in the expression
input field.

Operators

Double-click to add the function at the cursor point in the expres-
sion input field.

Functions

Displays the parameters that are available in the current task. For
example, for label definition select statements, the parameter $ID
is available.

Parameters

Under Value, enter a value that will replace the parameter, when
you run the select statement using the Execute command.

Relation wizard. Displays related tables. Expand the explorer
nodes, and click to add the relation statement at the cursor point
in the expression input field. The expression queries a value

7

NOTE The relation wizard is also available from the table list.
Right-click the table, and click Relation Wizard.

SQL Assistant menu bar. See also SQL Assistant Menu Bar (page
141).

8
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SQL Assistant Menu Bar
The SQL Assistant menu bar provides commands to edit and run the SQL
scripts. Most of the commands are standard SQL commands. The following
table shows some useful commands.

NOTE Some commands and icons are deactivated in the SQL Assistant. They are
available if you use the SQL Sheet. See also Using the SQL Sheet (page 142)

DescriptionMenu

Commands to store and reuse the SQL expressions. The default
folder for (*.sql) files is <topobase_administrat-
or>\Data\SQLSheet\Scripts.

File

■ Open—Opens an existing (*.sql) file and adds it to the Expres-
sion input box. You can edit the expression, and then execute
it.

■ Save—Saves the content of the expression input box.

■ Save Output As—Saves the content of the Executed Script
output box.

Commands to edit the content of the Expression input box and
the Executed Script output box.

Edit

■ Clear—Removes the content of the Expression input box, or
the Executed Scripts output box, depending on where the
cursor is.

Commands to execute and commit the select statements.Execute

■ Execute At Cursor—Executes the select statement beginning
at the cursor position. Use this command, if you if you have
a large SQL expressions that you want to be executed partly.

■ Spool—Use the spool commands to create a spool file. The
default spool file name is <topobase_administrat-
or>\Data\SQLSheet\Log\Spool.log.

■ History—Displays all select statements that have been ex-
ecuted. To re-use, select the select statement, and click Copy
To SQL Sheet.
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Starts SQL scripts that are stored in (*.sql) files. The menu shows
all (*.sql) files that are stored under <topobase_administrat-

Scripts

or>\Data\SQLSheet\Scripts. Scripts that are stored in a subfolder
will appear in a sub menu.
Copy your own SQL scripts to this location to make them available
through this menu.

Commands to start tools.Tools

■ Gather Table Statistics—For example, use this command to
update the record numbers that are displayed with the table
names in the table list.

■ Spool File—Opens the spool file.

■ Log File—Opens the log file.

■ Options—Settings to control the SQL Assistant, such as
autocommit setting, import and export command parameters.
For example, set EnableF4 to False, if you do not want the
content of the input or output box to be removed when you
press [F4]. For example, set Show Amount Of Records Behind
The Table to True, if you want to display the number of re-
cords (USER_TABLES.NUM_ROWS).

Using the SQL Sheet
The SQL Sheet is the standalone version of the SQL Assistant.

See also Creating SQL Expressions (page 137).

IMPORTANT To use the SQL Sheet you have to be familiar with Oracle and SQL.
This knowledge is not subject of this manual.

To start SQL Sheet

1 Start Topobase Administrator

2 Click Workspace menu ➤ SQL Sheet.
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NOTE You can start the Topobase SQL Sheet without Topobase Administrator.
The SQL Sheet is installed with Topobase Administrator in the
<topobase_admin>\Bin folder. Create a shortcut of the file
<topobase_admin>\Bin\SQLSheet.exe. Then, you start the SQL Sheet by
double-click.

To log in - connect

■ Under User, select an Oracle user from the list, and enter the password and
the Oracle service name.

■ Optionally, enter the Oracle system user name and password. These are
required, if you want to import or export Oracle (*.dmp) files, or drop users
or tables.

To connect to another database

■ Click Connect  to open the Login dialog box.

■ Variant: In the list of database objects, select Users.

■ In the user list, right-click the user, and click Connect.

To export an Oracle user to a (*.dmp) file

■ Optionally set export options: Click Tools menu ➤ Options.

■ In the list of database objects, select Users.

■ In the user list, right-click the user, and click Dump Export.

To view the database size

■ From the database objects list, select User Spaces. The list displays all
database users with their file size.

■ From the database objects list, select Tablespaces. The list displays the size
of the tablespaces. Expand the node items, and use the shortcut menu to
change the size of a table space.

To export the current Oracle user to a (*.dmp) file

■ Optionally set export options: Click Tools menu ➤ Options.
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■ Click Tools menu ➤ Dump Export.

To create an Oracle user

You can use the SQL Sheet to create an create Oracle user. Note, that this is
not a Topobase database schema. To create a Topobase database schema, use
Topobase Administrator.

■ Click Tools menu ➤ Create User.

To view database objects

From the database objects list, you select a database object. Then, select an
item, and right-click to open shortcut menus. For tables, you can apply several
predefined filters.

■ Users—Displays all Oracle users.

■ Tables (All)—Displays all table names. Optionally displays the number of
records (USER_TABLES.NUM_ROWS). Note that this number represents
the result of a former table statistics, and might differ from the actual
number of records. To update these values, click Tools menu  ➤ Gather
Table Statistics.

■ Tables (User Tables With Data)—Displays all user tables that contain data.
User tables are non system tables. For example, in a Topobase document,
user table names start with a prefix that indicates the module, such as WW
for Wastewater, or GA for Gas.

■ Tables (User Tables All)—Displays all user tables.

■ Tables (Topobase System)—Displays the Topobase system tables. See also
Topobase System Tables (page 149).

■ Tables ($)—Displays the spatial tables.

■ Tables (Filtered)—Displays tables using a filter expression that you enter,
such as TB%.

■ Other database objects, such as Views, Synonyms, Sequences, Indexes,
Triggers.

To transfer the attribute names to the expression input box

■ When yo select a table, the column names are displayed. Select one or
more items from the list, right-click and click Select ? From Table.
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SQL Sheet menu bar

■ See also SQL Assistant Menu Bar (page 141).

To start the SQL Spy and SQL Error Spy

Use the SQL Spy, and the SQL Error Spy to analyze problems. The SQL Spy
displays all select statements that are currently executed against the Oracle
database by any Topobase or other application. The SQL Error Spy displays
select statements that could not be executed.

■ Click Tools menu ➤ SQL Spy to start the SQL Spy.

■ Click Tools menu ➤ SQL Error Spy to start the SQL Error Spy.

SQL Sheet commands

The SQL Sheet provides three types of commands. As appropriate, the
commands can be started through the menu bar, the shortcut menus, or you
can type the commands directly in the expression input box.

■ See SQL Sheet: Standard SQL Commands (page 145).

■ See SQL Sheet: SQL Plus like Commands (page 146).

■ See SQL Sheet: Special Commands (page 146).

SQL Script Examples

For more examples, view the sample scripts that are provided under
<topobase_administrator>\Data\SQLSheet. To add the scripts to the expression
input box, do one of the following.

■ Click Scripts menu ➤ <script name>.

■ Click File menu ➤ Open, and select the file.

SQL Sheet: Standard SQL Commands

IMPORTANT To use the SQL Sheet you have to be familiar with Oracle and SQL.
This knowledge is not subject of this manual.

For example, standard commands are: COMMIT, ROLLBACK, SELECT, INSERT,
UPDATE, DELETE, CREATE, DROP.
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SQL Sheet uses transactions, and the COMMIT is executed either automatically
when you quit the SQL Sheet, or when you start it explicitly through the
Execute menu ➤ Commit. You can use the AutoCommit option, if you want
to your changes to be committed immediately. Click Tools menu ➤ Options.

SQL Sheet: SQL Plus like Commands

IMPORTANT To use the SQL Sheet you have to be familiar with Oracle and SQL.
This knowledge is not subject of this manual.

■ DEFINE <variable name>—Creates a user defined variable. Note that in
SQL Sheet, the command must be finished with a ";".

■ DESC <table name>—Displays the table definition in the Executed script
output box.

■ SPOOL commands—See SQL Assistant Menu Bar (page 141).

■ SPOOL <file name>—Creates a spool file with the given name.

■ SET HEADING ON/OFF— Switches off the headings of the output result.
For example, use SET HEADING OFF and Set ECHO OFF if you want to
create a script from the output, and you only need the data without any
comments.

SQL Sheet: Special Commands

IMPORTANT To use the SQL Sheet you have to be familiar with Oracle and SQL.
This knowledge is not subject of this manual.

■ ABORT—Ignores all select statement that follow this command. For
example, if you have several select statements, use this command to execute
only the first part.

■ CONNECT—Connects to the database. Optionally, use parameters, for
example CONNECT <user name/password>, or CONNECT <user
name/password@service>.

■ EXPORTDUMP <user name> <filename>— Creates a (*.dmp) file. To specify
the export options, click Tools menu ➤ Options, and set the
CommandLineDumpExport option.
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■ EXCEL <select * from <table name>>–Opens MS Excel and displays the
result of the select statement in an (*.xls) file. Use the command EXCELFILE
<file name> <select * from <table name>> to store the result of the select
statement in a file without opening the Excel file.

■ ASCIIFILE <file name> <select statement>–Stores the result of the select
statement in a TAB separated ASCII (*.txt) file.

■ GRID select * from <table name>–Displays the result in a grid dialog box.
You can edit the values.

NOTE To commit the changes, click Update, Commit And Close, or start the
COMMIT command.

■ REM–Marks a comment. Or enter “--”

■ FIND <value> [,Filter]–Searches all columns of all tables for the given value.
Optionally, set a filter.

■ CLS or CLEAR–Clears the output window.

■ EXECUTE <procedure name>– Executes a stored procedure.

■ SELECTDOUBLES <select statement> CONDITION <condition> KEY
<key>–Finds duplicate values. For example: SELECTDOUBLES * from

MY_FEATURE condition TB_POINT_NUMBER KEY FID <condition> contains
the column names to be analyzed. <key> contains the primary key.

■ DELETEDOUBLES <select statement> CONDITION <condition> KEY
<key>–Deletes duplicate entries.

■ SETDELETEDDOUBLES <...> CONDITION <condition> KEY <key>–Use
this command for previous Topobase versions (TB2). Sets the attribute
DELETED to 1 for duplicated values. Example: SETDELETEDDOUBLES * from

MY_FEATURE CONDITION attribute1,attribute2.

■ SHELL Filename [,wait]–Executes a system command. Example: SHELL
notepad.exe. Example: SHELL notepad.exe,true.

■ EXPLAINPLAN <select * from <table name>>–Find the execution plan of
a select statement, so that you can analyze which indexes are used, and
find out how to optimize the select statement.

■ REPEAT <...> FOR <...>— Repeats a select statement, and inserts parameters.
The first select statement is repeated, and the values from the second select
statement are inserted into the first select statement. The results are stored
in a temporary table TB_SQL_RESULT.
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■ GATHERTABLESTATS—Collects statistical information for all tables of a
user. The command executes the following: BEGIN
DBMS_STATS.GATHER_TABLE_STATS('username', 'tablename',

cascade=>TRUE); END;

■ PACKDATA <select expression>—Writes all column values of a child table
to a column PACKDATA1 of a parent table. The column PACKDATA1 is
of the data type VARCHAR2. Example: packdata select p.fid, c.name

from parent p, children c where p.fid=c.FID_parent order by p.fid;

■ PACKDATA2—Writes all column values of a child table to a column
PACKDATA2 of a parent table. The column PACKDATA2 is of the data
type CLOB. Use this command for large data sizes.

■ COMPDBWITH <user name>—Compares the data structure of the current
Oracle user with another user, and displays the differences.

■ DEF <table name>—Displays the table definition in the Executed script
output box. The command displays more details that the DECSC command.

Using the SQL Assistant in the Form Designer
In the Form Designer, you use the SQL Assistant when defining control
properties that require SQL statements.

When you click the item in the property pane, a  button appears. Click
this button to start the SQL Assistant.

Example - Querying relations

In the Gas database schema, the feature class GA_FITTING has a relation to
the GA_CONDITION_TBD feature class. The example shows how to query the
CONDITION and to display it on the form.

1 Open a workspace that has access to a Gas database schema.

2 Start the Form Designer.

3 Add a Read-Only SQL Text Box. Click the SQL property, and start the
SQL Assistant.
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Under Relations, the related feature classes are displayed. Select one in the
tree view, and click, to insert the select statement that retrieves the related
value into the expression input box. Then, replace the * with the attribute
you need, such as VALUE.

See also:

■ Form Designer Example: Read-Only SQL TextBox (page 411)

■ Form Designer Example: Editable SQL TextBox (page 413)

■ Form Designer: Editable SQL TextBox - Properties (page 388)

■ Form Designer: Feature Highlighter - Properties (page 390)

Topobase System Tables
Topobase stores system information in client and server system tables.

The client system tables are stored in the Topobase document. They store
document-specific settings.
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WARNING Do not edit the Topobase system tables manually. If you do this, your
application might not work properly any longer.

The server system tables are stored in TBSYS (page 584) (Topobase database
server). They store settings that are valid for the whole application, such as
application menu settings.

The system tables must not be edited manually, however they contain
information that can help administrators in case of trouble shooting, as shown
in the following table:

DescriptionTable

Stores attribute names for translation.TB_ATTRIBUTE

Describes size and location of Topobase.Forms.Form (non generic
dialog boxes) for Web and desktop version.

TB_FORM_LOCATION

See System Table TB_DATAMODELCODE (page 152).TB_DATAMODELCODE

Stored in TBSYS. This table is not used.TB_DATAMODELCODES

Stored in TBSYS. Defines the default mode for every user.TB_DIALOG_USER

Stored in TBSYS. Stores the default value for DefaultMode.TB_DIALOG

Stores the description of the feature class tables. See also System
Table TB_DICTIONARY (page 152).

TB_DICTIONARY

Stores the dimensioning configuration. Dimensioning consists of
a parent dimensioning feature class, a point feature class for

TB_DIMENSION

symbols, a line feature class, a label feature class, and a child label
line feature class. See also Data Model: Dimensioning (page 252)

Stores project settings.TB_INFO

See System Table TB_INTERSECTION (page 157).TB_INTERSECTION

Manages jobs. See also System Tables TB_JOB_* (page 159).TB_JOB_*

See System Table TB_LABEL_DEF (page 166)TB_LABEL_DEF

See System Table TB_NET_* (page 167).TB_NET_*
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Defines searches. See also System Table TB_POSITION_FINDER
(page 170).

TB_POSITION_FINDER

See System Table TB_RELATIONS (page 172).TB_RELATIONS

Stores feature rules. See also System Tables TB_RULE* (page 176).TB_RULE_*

Stores the configuration for the Polygon And Line Definition re-
port. For configuration, see also Report Designer: Polygon and
Line Definition Report (page 518).

TB_SURFACE_*

See System Table TB_TOPOLOGY* (page 180).TB_TOPOLOGY

See System Table TB_WORKFLOW (page 180).TB_WORKFLOW

Stores user defined variables that can be used for stylization. See
Topobase Text Function TB_VARIABLE (page 468).

TB_VARIABLE

Stores the document version, data model codes, data module
versions, and the extension versions.

TB_VERSION

System tables for toolbar and menu settings.TB_GN_*

Stores properties of all controls used in the generic forms of the
document.

TB_GN_CONTROL

Specifies the default position/size of forms (tables); for example
the height of the detail of a master-detail form

TB_GN_DIALOG

Stores settings for form menus and tool barsTB_GN_DIALOG_BAR_ITEM
Example: If the form toolbar contains a highlight button, you
will find a row with the following value in TB_TB_GN_DIA-
LOG_BAR_ITEM.NAME:
Topobase.Map.MapDialog/TBHighlightBounded

Stores configuration of the Highlight Related Features command.TB_GN_DIALOG_HIGHLIGHT
See also System Table TB_GN_DIALOG_HIGHLIGHT (page 153).

Stores user/machine dependent position/size.TB_GN_DIALOG_MACHINE_USER

Stores settings for document toolbar buttons.TB_GN_DOCUMENT_BAR_ITEM

Stores file names for Topobase Web.TB_GN_DIRECTORY_ALIAS
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See also System Table TB_GN_DIRECTORY_ALIAS (page 153).

Stores redirection information. See also System Table
TB_GN_INFO_REDIRECT (page 154).

TB_GN_INFO_REDIRECT

Stores settings for application menu items. Stored in TBSYS.TB_GN_MENU_ITEM

Stores settings for document menu items.TB_GN_MENU_ITEM

Stores settings for application toolbar buttons. Stored in TBSYS.TB_GN_TOOLBAR_ITEM

System Table TB_DATAMODELCODE
The TB_DATAMODELCODE table resides in the Topobase document (page
581) and contains the users valid data model codes. A document can have
several data model codes, for example, if the document contains both a survey
and profile structure.

See also:

■ Overview of Data Models (page 182)

System Table TB_DICTIONARY
This table stores the description of the feature class tables.

DescriptionAttributes of TB_DICTIONARY

Primary key.F_CLASS_ID

Name of the feature class.F_CLASS_NAME

Caption of the feature class. This caption is displayed
on the UI, for example in the document explorer.

CAPTION

Feature class type. O = polygon, P = point, L = line
string, T = attribute, A = label, E = centroid.

F_CLASS_TYPE

Specifies whether the feature class is read only.READ_ONLY
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Specifies whether this feature class is a view. 1 = This
feature class is a view. The default is 0 = This feature
class is a table of the current data base schema.

TABLE_DOES_NOT_EXIST

Specifies the string that is displayed in the feature
explorer. Default is {FID}. See also Feature Explorer
(page 92).

FEATURE_REPRESENTATION

System Table TB_GN_DIALOG_HIGHLIGHT
This table specifies linked features to highlight. For example, if you highlight
a manhole, the appropriate manhole cover is also highlighted. The highlight
button is only available on the form toolbar if there are appropriate settings
in the system table TB_GN_DIALOG_HIGHLIGHT.

Example

ValueAttribute

MYPOINTHIGHLIGHT_FEATURECLASS

fid={parent_fid}HIGHLIGHT_FILTER
Use any SQL expression in the filter.

System Table TB_GN_DIRECTORY_ALIAS
This table specifies the links to file or picture folder names for Topobase Web
version. It is used for form designer and report designer controls that specify
a file name or a picture file. The first part of the file name will be replaced
using this table.

NOTE If your pictures are stored in the <topobase>\Pics folder or a subfolder,
you need not to specify an alias in TB_GN_DIRECTORY_ALIAS.

Control properties that use file/folder names:

■ Text box

■ Picture box

■ Picture combo box
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■ Static picture

Example with filename "c:\dat\mydocuments\house55.bmp"

1 Create an alias in the IIS for "c:\dat\mydocuments\". For example,
"MyPictures")

2 Create a new record in TB_GN_DIRECTORY_ALIAS and set

Directoryname="c:\dat\mydocuments\"

AliasName= "http://mycompany.com/MyPictures/"

All Web file names that begin with "c:\dat\mydocuments\" are preceded by
"http://mycompany.com/MyPictures/".

There are two ways to specify the alias name. You can either enter a complete
URL or a relative address. For example, when you specify a complete URL,
such as http://mycompany.com/MyPictures, the alias name is the absolute path.
When you specify an alias without the HTTP part, such as MyPictures/, the
alias name is related to the IIS alias TBWEB.

Also, you can create a virtual directory that is not located under MapGuide
and specify the complete URL as alias.

NOTE Restart Topobase after making new entries or changing older entries.

See also:

■ Form Designer: Property TextBox - Properties (page 398)

■ Form Designer: Picture Linker - Properties (page 396)

■ Form Designer: Picture Combobox - Properties (page 395)

■ Form Designer: Static Picturebox - Properties (page 404)

■ Report Designer: Picture Control (page 505)

System Table TB_GN_INFO_REDIRECT
The following table defines redirection information:

DescriptionAttribute of TB_GN_INFO_REDIR-
ECT
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Stores the unique key, which is system-gener-
ated.

ID

Specifies the feature class that is selected in
the map.

F_TABLE_NAME

Specifies the name of the form that is opened
instead of the feature class form.

DIALOG_TABLE_NAME

Specifies an attribute of the feature that is se-
lected in the map.

F_COLUMN_NAME

Specifies an attribute of the form to be opened
that is related to F_COLUMN_NAME.

DIALOG_COLUMN_NAME

Specifies a complex filter, for example, if you
have relations between more than one table.

INFO_FILTER

Opens a form in another document. If the
document is not found in the currently open

DIALOG_DOCUMENT_NAME

workspace, the system searches all open doc-
uments and opens the first form it finds.

In the following cases, a redirection definition in the TB_GN_INFO_REDIRECT
table is not necessary:

■ For labels and their parent feature class. Because redirection for labels is
common, you can activate label redirection by using a document option.

■ The utility application has a default redirection to show the utility objects
when you select a network geometry.

Example 1: To click a manhole but show the section form, set the following
values:

ValueAttribute

MANHOLEF_TABLE_NAME

FID_SECTIONF_COLUMN_NAME

SECTIONDIALOG_TABLE_NAME
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FIDDIALOG_COLUMN_NAME

Example 2 shows the use of INFO_FILTER:

ValueAttribute

Specify the name of the feature class that is selected
in the map.

F_TABLE_NAME

(leave this blank)F_COLUMN_NAME

Specifies the name of the form to open instead of
the feature class form

DIALOG_TABLE_NAME

(leave this blank)DIALOG_COLUMN_NAME

FID in (select FID_PARENT from PARCEL_TBL where
{Fids})

INFO_FILTER

The word {Fids} is replaced with the FIDs of the graphic. The whole expression
is set as a filter on the form to open.

See also:

■ Overview of the Utility Model (page 244)

■ To set Map Options application optionslabels:redirecting to parent
featurejobs:perimeterperimeter:di... (page 122)

System Table TB_INFO
The following table stores system information. The table resides in the
document.

DescriptionAttributes of TB_INFO

Unique keyID

Parameter.PARAM

Value, if the parameter is of type CHAR.VALUE_CHAR
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Value, if the parameter is numeric.VALUE

CommentaryCOMMENTARY

Some important parameters are the following:ID

Version of Topobase structure.1001

Name of the Topobase System User (TBSYS database
schema)

1002

System Table TB_INTERSECTION
The following table stores intersection definitions.

NOTE The properties are set with the data model administrator.

DescriptionAttributes of TB_INTER-
SECTION

Stores the unique key, which is system-generated.ID

Specifies the name of the intersection.NAME

OO = Polygon/Polygon => PolygonTYPE
OL = Polygon/Line => Line
OP = Polygon/Point => Point
LL = Line/Line => Point
LP = Line/Point => Point

True/false: Adjusts the area of the second feature class
to the area of the first feature class. Only useful for
polygon/polygon intersections.

ADJUST_SECOND

Specifies the condition that excludes features from an
adjustment. Example: s.area <100.

ADJUST_EXCLUDE

Defines a perimeter for a buffer. All features inside the
perimeter are returned.

BUFFER_PRIM_FC
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Primary feature class.F_CF_CLASS_NAME_PRIM

Secondary feature class.F_CLASS_NAME_SEC

Specifies the name for intersection feature class. If the
table does not exist, it is created automatically. The
name must not contain blanks.

F_CLASS_NAME_INTER

Specifies the job used to get data from DB. If “JOBID=
0”, the currently selected job is used.

PRIM_JOBID
SEC_JOBID

Selects values from other tables to store in the intersec-
tion feature class. These values can be used for reports.

PRIM_UPDATE_STATE-
MENT

This method is faster than creating a view that joins in-SEC_UPDATE_STATEMENT
formation from other tables and from the intersection
results.

Stores “AREA” and “AREA_NOMINAL” on OO intersec-
tions (polygon/polygon). Set to true or false.

STORE_GEOMETRY

Stores the maximum value of the difference between
the area of the primary and summary of the secondary
feature class where no adjustment is started.

TOL_AREA_NOMINAL

Sets the spatial tolerance for the intersection. This toler-
ance is equal to the smallest tolerance of primary and
secondary feature class.

TOLERANCE

Restricts features participating in the intersection. The
restriction can be defined as a WHERE Clause.

WHERE_CLAUSE_SEC
WHERE_CLAUSE_PRIM

TB_STATE_INTERSECTION defines the state in which the intersection applies.
If an intersection is called with the same primary and secondary feature classes,
it must be executed before the merge job. All other intersections can be called
after the merge.

See also:

■ Creating an Intersection (page 275)
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System Tables TB_JOB_*

WARNING Do not edit Topobase Job system tables manually. This causes data
loss and can corrupt jobs. Values are updated using triggers. For example, if you
made modifications using SQL, manual editing is not necessary.

System Table TB_JOB_VERSION
The table TB_JOB_VERSION stores the complete history of every feature. The
feature table has one job relevant attribute: JOB_VERSION. The table
TB_JOB_VERSION also controls which features are visible.

TB_JOB_VERSION holds the history of every feature and controls which features are
visible.
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With JOB_VERSION the FID is not unique, however with the Virtual Private Database
it is.

Example: A “SELECT * from <feature class> returns the following values:

With Job 1: 24, (.X.), 12.1, ‘A’, 1

With Job 2: 24, (.Y.), 13.5, ‘A’, 2

The JOB_OPERATION_ID shows the operation performed on the feature, for
example, Insert, Modify, or Delete.

DescriptionAttributes of TB_JOB_VERSION

CONFLICT

Specifies the version of an object (feature).
Mandatory.

JOB_VERSION

Specifies the previous version of an object.
Optional.

JOB_OLD_VERSION

Specifies the job ID. Mandatory.JOB_ID

Specifies the job operation ID. Mandatory.JOB_OPERATION_ID
1 = INSERT,
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2 = UPDATE,
3 = DELETE
- 1 = Indicates that this feature has already
been existing, at the moment of the job en-
abling of the feature class.

Stores the OS user.OS_USER_NAME

Stores the operation date.OPERATION_DATE

Defines the state of the feature, either:STATE
1 = live
2 = pending
3 = open
4 = deleted
(additional states can be defined in
TB_JOB_STATE)

After a table has been job enabled, a new value for JOB_VERSION is created
for every object (sequence TB_JOB_VERSION_S):

■ JOB_OLD_VERSION is set to -1.

■ JOB_ID will is 1 = live, for every feature.

■ JOB_OPERATION_ID is -1 for every feature.

■ STATE is 1 = live, for every feature.

If a user works on a feature within a certain job (JOB_ID) and for example
modifies a feature, the operation is registered in TB_JOB_VERSION as follows:

■ JOB_OLD_VERSION is set to the number, the feature had before the
modification.

■ JOB_ID is < current Job ID.

■ JOB_OPERATION_ID is 2 = "modification".

■ STATE is 3 = open.

You can trace the history of every feature, including the operation performed,
the date, user, and initial appearance.

TB_JOB_VERSION.JOB_OPERATION_ID can be used in Display Manager to
highlight modified or newly created features, so they can be distinguished
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from life features. Also, you can define a special style for the deleted features.
See Styling Job-Enabled Features (page 470).

System Table TB_JOB_STATE
The system table TB_JOB_STATE stores the job state configuration. To define
additional job states do this at the very beginning of all job configuration and
data capture. After working with jobs respective job-enabled features do not
add any new job states.

DescriptionAttributes for TB_JOB_STATE

Stores the unique key, which is system-generated.ID

Specifies the job name.NAME

Indicates whether the state is the initial
state for each job. 0= No. 1 = Yes.

INITIAL_STATE

NOTE There can only be one initial state.

Indicates whether the features can be
modified using insert, update, or delete.

FEATURES_EDITABLE

Specifies the job state whose features are
displayed additionally to the features of
the current job state.

USE_JOBID

For example, this might specify that all live
features are displayed, even if they do not
belong to the current job state.

The following table shows the default job states:

Use Job IDEditableInitial stateNameID

NoNoNoLive1

NoNoNoPending2

1 (live)YesYesOpen3

NoNoNoDeleted4
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System Table TB_JOB_STATE_TRANSITION
The system table TB_JOB_STATE_TRANSITION stores the job state transition
rules. You can define additional transition rules. Besides, you must do this at
the beginning of all job configuration and data capture.

DescriptionAttributes of
TB_JOB_STATE_TRANS-
ITION

Stores the foreign key to the previous state
(TB_JOB_STATE) in the state diagram.

PREDECESSOR_ID

Stores the foreign key to the next state
(TB_JOB_STATE) in the state diagram.

SUCCESSOR_ID

Specifies the value indicating what the soft-
ware must do when the state transition is ex-
ecuted.

TRANSITION_TYPE

■ M—Merge the features.

■ D—Delete the job.

■ N—Do nothing.

Specifies the value indicating whether the
transition is made forward (F) or backward
(B).

TRANSITION_DIRECTION

Example: A forward transition could be a
merge process (open -> pending). A backward
transition could be an undo of a merge pro-
cess (pending -> open).

NOTE A transition type with D for delete can never be backward.

The following table shows the default job state transition rules:

TypeDirectionSuccessorPredecessorID

Merge (M)Forward (F)Pending (2)Open (3)1

Merge (M)Backward (B)Open (3)Pending (2)2
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Merge (M)Forward (F)Live (1)Pending (2)3

Delete (D)Forward (F)Deleted (4)Open (3)4

Delete (D)Forward (F)Deleted (4)Pending (2)5

Job states and job state transitions. The direction of a transition can be forward F or
backward B. M merges the features.

The initial point can only have one initial state as successor. There can only
be one initial state.

System Table TB_JOB
The system table TB_JOB contains the list of all jobs.

WARNING There are two default (virtual) jobs in every database: Pending Job
and Live Job. They are necessary for job management, even if you do not work
with Topobase jobs. Do not delete these jobs, as this will cause malfunctions.

DescriptionAttributes of TB_JOB
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For internal use only. Defines
the job state for live and
pending virtual jobs.

USE_STATE

System Table TB_JOB_PERIMETER
The system table TB_JOB_PERIMETER administers the job perimeters.

DescriptionAttributes of TB_JOB_PERI-
METER

Specifies the job the perimeter belongs to
(TB_JOB).

JOB_ID

Specifies the perimeter type.JOB_PERIMETER_TYPE_ID

■ Type 1—Stores the perimeter that has
been digitized or selected. For type 1
perimeters no F_CLASS_ID is stored.

■ Type 2—For each perimeter feature class
that is used in the job template, one type
= 2 perimeter is created.

Specifies the ID of the perimeter feature class.F_CLASS_ID

Specifies the ID (TB_TOPOLOGY.ID) of the
topology that builds the geometry of the

TOPO_ID

perimeter. For JOB_PERIMETER_TYPE_ID=1
perimeters no TOPO_ID is stored.

Example: The job template contains the topics Parcel and Land Cover. Each
topic is part of a topology and has its own perimeter feature class. In a job,
when you select the perimeter using the parcel topology, an intersection with
the land cover topology is performed and for each perimeter feature class a
record with JOB_PERIMETER_TYPE_ID=2 and the TOPO_ID is added.
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System Table TB_LABEL
The system table TB_LABEL contains the IDs of feature classes and their related
label feature classes. This table lists all feature classes that have a label feature
class. The IDs refer to TB_DICTIONARY.F_CLASS_ID.

DescriptionAttributes of TB_LABEL

Stores the unique key, which is system-
generated.

ID

Specifies the ID of the label feature class table (child). This table contains the attribute
data.

TBL_F_CLASS_ID

Specifies the ID of the feature class table (parent). This table contains the text.PARENT_F_CLASS_ID

System Table TB_LABEL_DEF
The table TB_LABEL_DEF contains SQL Select statements that return text when
placing or updating labels.

NOTE  Do not edit this table manually. Use the Topobase data model administrator
(Label Properties).

DescriptionAttributes of TB_LABEL_DEF

Stores the label definition ID. User defined label definitions start with ID 10.000. IDs <
10.000 are used for Autodesk applications.

ID

Stores the label ID. All label definitions of one feature class are grouped by this label_ID.
For example, if you have defined four labels for a certain label feature class, those for
definitions will all have the same label_ID.

LABEL_ID

Specifies the label name.NAME

Stores the label select statement. See alsoLabel Select Statements (page 236).SELECT_STATEMENT

Specifies a sample label.EXAMPLE

Defines the position of the label.Position_along_object
1 = Start; 2 = Middle; 3 = End. Default is Middle.
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Specifies the absolute text coordinates offset.Absolute_offset_*

Specifies the relative text coordinates offset.Relative_offset_*

Stores the text orientation.ORIENTATION

Specifies whether the text orientation is absolute or relative. Either 0 = absolute or 1 =
relative.

IS_RELATIVE_ORIENTATION

Specifies whether the label is created when the feature was created. Either 1 = Yes or 0
= No.

Autolabel

Specifies whether the user selects the label position. Either Yes or No.User_selects_position

Specifies whether the label text will be NULL if the select statement returns NULL. Either
1 = Yes or 0 = No.

Overwrite_label_text_with_null

Specifies a select statement to query the scale.Scale_select_statement

Specifies a prefix for label text.Pre

Specifies a suffix for label text, for example a unit of measurement could be used.Suf

Specifies a select statement to find the coordinates of a parent feature.Select_statement_geometry

Specifies whether the label is active. Either 1 = Yes or 0 = No.Active

System Table TB_NET_*
The system tables TB_NET_* reside in the document. They store the network
tracing system information.

System Table TB_NET_TRACE_TPL
This table stores the network tracing definitions.
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See also:

■ Logical Topology: Tracing Templates (page 329)

DescriptionAttributes of
TB_NET_TRACE_TPL

Primary keyID

Specifies the actions to be applied on the
resulting features:

ACTION

0 = no action
1 = highlight
2 = show results
3 = highlight and show result

Specifies that the template can be selected
by the user.

ACTIVE

CommentaryCOMMENTARY

Specifies the direction of the trace:DIRECTION
1 = up; forward
2 = down; backward
3 = both directions

Specifies the name, that is displayed in the
network explorer.

NAME

Specifies the type of network trace:TRACE_TYPE
1 = shortest path
2 = minimum cost spanning tree
3 = reachability
4 = within cost analysis (not yet implemen-
ted)
5 = nearest neighbors analysis (not yet
implemented)
6 = all paths between two nodes (not yet
implemented)
7 = traveling salesman problem analysis
(not yet implemented)
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Specifies the topology for which the tra-
cing template has been defined.

TOPOLOGY_ID

System Table TB_NET_SCOND_DEF
This table stores the search conditions for network analysis. The table resides
in the document.

See also:

■ Defining Tracing Conditions (page 331)

DescriptionAttributes of TB_NET_SCOND_DEF

Primary keyID

Specifies, that the condition can be selec-
ted by the user. Either 0 = deactivated or
1 = active.

ACTIVE

Commentary.COMMENTARY

Specifies the type of the condition:IS_COST
0 = stop condition
1 = cost calculation algorithm

Specifies the name of the condition.NAME

Specifies a select statement.SQL_STMT

Identifies the topology for which the con-
dition has been defined.

TOPOLOGY_ID

Specifies to which component of the topo-
logy the condition applies:

TOPO_TYPE

1 = nodes, 2 = edges.
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System Table TB_POSITION_FINDER
The system table TB_POSITION_FINDER resides in the document.

DescriptionAttributes of TB_POSI-
TION_FINDER

Base attributes

Specifies the name or header of the search
that will be displayed in the Feature Search
group box.

NAME

Specifies the search type:GUITYPE
1 = sequential (Default)
2 = flat
3 = PlugIn

Defines the order of the entries. Default =
0.

PRIORITY

The following four attributes are needed
to define a sequential search.

Sequential search

Stores the title and short explanation that
will be returned with the n th query.

STMT_TITLE_*

Stores the search query. This is a standard
SQL statement.

SELECT_STMT_*

NOTE The first search query has no
placeholders.

Stores the geometry query. Always option-
al, except when it is the last query.

GEOM_STMT_*

select geom from <table> where

fid = {x}.

Stores the input type for the results in the
n th query:

INPUTTYPE_*

1 =select list (Default);
2 = text box
3 = text box with auto complete
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Defines an optional message to be used as
a prompt if the search query returns no
rows.

NOT_FOUND_MSG_*

The following attributes are needed for flat
search: With these attributes, the select
statement is composed as follows:

Flat Search

select <pk_column>, <in-

put_colums>from

<table_name>where upper(<in-

put_column>) like up-

per(<param>)order by <or-

der_column>

Stores the name of table or view contain-
ing the data.

TABLE_NAME

Stores the name of the attribute containing
the primary key. This is the key attribute.

PK_COLUMN

Specifies the attribute containing the geo-
metries. This is the geometry attribute.

GEOM_COLUMN

Specifies the order of the query results.
May contain more than one attribute
(comma separated). Optional.

ORDER_COLUMN

Stores the input attributes (1-5) that will
be used for the WHERE Clauses.

INPUT_COLUMN_*

Stores a short explanation of the corres-
ponding input column_* of the data table.

STMT_TITLE_*

Stores the message to be used as a prompt
if the search query returns no rows. All

NOT_FOUND_MSG_1

other ‘NotFound Messages’ (2-4) will be
ignored.

Stores the properties used in a Plug-In
search.

Assembly Name
Namespace
Class Name

System Table TB_POSITION_FINDER | 171



See also:

■ Feature Search Introduction (page 527)

System Table TB_RELATIONS
The system table TB_RELATIONS table stores relations between feature classes.
For example, you can define relations when you add an attribute (page 213) to
a feature class, using the Data model administrator.

DescriptionAttributes of TB_RELA-
TIONS

Stores the unique key, which is system-generated.ID

Stores the name of the parent table, for example a do-
main table *_TDB. Domain tables usually are parent
tables.

PARENT_TABLE_NAME

Stores the parent attribute name. Example:PAR-
ENT_COLUMN_NAME ■ FID, if the parent is a feature class table.

■ ID, if the parent is a domain table.

Stores the name of the child table, for example a label
feature class table.

CHILD_TABLE_NAME

Stores the name of the child attribute. Example:CHILD_COLUMN_NAME

■ FID_xxx, if the child is a feature class table.

■ ID_xxx, if the child is a domain table.

Specifies whether the child feature is deleted when the
parent feature is deleted.

DELETE_CHILD

N—Set Relation to Parent to NULL when Parent is deleted.
Default.
L—Do not alter child when parent is deleted.
D—Delete Feature when Parent is Deleted.
C—Don't delete Feature when a parent exists.
P—Don't delete Feature when a child exists.
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Specifies whether a child feature is created. Either 1 = Yes
or 0 = No. Default = 0.

CREATE_CHILD

Specifies the handling of related child features when
splitting features.

SPLIT_MODE

NULL—Split acts like a Delete.
S—Duplicate Children.
A—Assign Children.

Specifies the handling of related child features when
joining features.

MERGE_MODE

NULL—Merge acts like a Delete.
I—Join Children If Identical.
M—Join Children.
K—Keep All Children.

Specifies that the record is active. Either 1 = Yes or 0 =
No. Default = 1.

ACTIVE

TB_RELATIONS: Parent, Child, Sibling
Topobase data models frequently use two types of relations:

■ relation between a feature table and a domain table.

■ relation between two feature tables, one of which is a master table and
one is a detail table.

The following illustration shows the relation between a feature table and a
domain table:
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The following illustration shows the relation between a master table and a
detail table:
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Topobase Data Model: The most frequent master-detail relation is —between a feature
class and a label feature class.

TB_RELATIONS: Master-Detail Relations
In a Master-Detail relation, one feature class can have multiple relations to
another feature class. For example, a master feature, such as a building can
have several detail features. Similarly, each feature can have several labels.

Topobase Data Model: Master-Detail relation

In Topobase Client feature class forms, you can either show the detail features
in a separate tab or you can display a reference button to open the related
form and all related features in the filter. You configure this in Topobase Form
Designer.
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Topobase Data Model: Display of related features in feature class forms

See also:

■ Designer Menu: Master-Detail (page 366)

System Tables TB_RULE*
The system tables TB_RULE* store the Topobase feature rules.

See also:

■ About Feature Rules (page 571)

DescriptionTable

Stores feature rule parameters.TB_RULE_PARAM

Stores all rule base definitions.TB_RULE_DEF
See also System Table TB_RULE_DEF (page 178).

Lists rule base groups. Feature rules can be grouped.TB_RULE_GROUP
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Specifies which feature rules are applied to a feature
class when it is created (L = for line string, P = for
point, T = for label feature classes).

TB_RULE_FCLASSTYPE

If F_CLASS_TYPE is empty, the rule is assigned to all
feature classes.

Stores the configuration of individual rules for each
feature class (applied rule base definitions).

TB_RULE_BASE

NOTE Only rules that are listed here can be activated.

Stores temporary data for server-side feature rules and
topology or compound feature classes.

TB_TMP_FEATURE
TB_TMP_FEATURE_TBL

Topobase feature rule system tables
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System Table TB_RULE_PARAM
This table stores the parameters of the feature rule definitions. Only the stored
parameters are available in the Edit Rule Base dialog box, where you can assign
values.

DescriptionAttributes of
TB_RULE_PARAM

Stores the primary key.ID

Stores the ID of the rule definition in TB_RULE_DEF.RULE_DEF_ID

Specifies the name.NAME

Specifies a default value.DEFAULT_VALUE

Stores an index (1 - 10). The parameters can be used in the
trigger text using the alias %P<index>, for example %P1 or
%P2.

POSITION

System Table TB_RULE_DEF
This table stores the feature rule definitions.

For server-side feature rules, the definition includes the actual program. The
rules can be identified by their IDs.

For client-side feature rules, the definition includes the rule name, class name
and assembly name, as shown in the following table:

DescriptionAttributes of
TB_RULE_DEF

Stores the primary key.ID

Specifies a short name for the rule.NAME

Specifies the name of the class where the method is defined.
For client-side feature rules.

CLASSNAME

Specifies the name of the assembly where the method is
defined. For client-side feature rules.

ASSEMBLY
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NOTE For server-side feature rules this attribute must be
NULL.

Specifies the PL/SQL block forming the body of the rule. For
server-side feature rules.

TRIGGER_TEXT

NOTE For client-side feature rules this attribute must be
NULL.

Specifies the trigger type: Either 1 = row trigger or 0 =
statement trigger.

IS_ROW

Specifies the trigger property: Either 1 = rule body is immut-
able or 0 = rule body can be edited.

IS_SYSTEM

Specifies when the rule is activated.IS_DEFAULT
1 = The rule is a default rule that is activated when a match-
ing feature class is created.
0 = The rule is not activated by default.

Specifies the default priority for this rule.DEFAULT_PRIORITY

Specifies whether chaining is allowed.REQUIRES_ID
1 = Allows chaining of dependent triggers, for example,
when a row trigger requires a statement trigger. For server-
side feature rules.

Specifies when a trigger is executed.EXECUTE_COLUMN
0 = trigger is always executed.
Not NULL = The trigger only executes when an attribute
matching the specified name is modified.

Specifies whether the rule belongs to a group. Is NULL for
standalone rules.

RULE_GROUP_ID

Specifies the version of the rule in the format. For client-side
feature rules.

RULE_VERSION

Concise description of the rule.DESCRIPTION

These fields map to an event (before/after insert/update/de-
lete). A value of 1 means that the rule can react on that kind
of event.

BI, BU, BD, AI,
AU, AD
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System Table TB_TOPOLOGY*
Topologies require the following some system tables, which reside in the
document:

TB_TOPOLOGY—Lists the available topologies.

TB_TOPOLOGY_DEF—Stores the relationship to participant feature classes.

System Table TB_WORKFLOW
The system table TB_WORKFLOW stores the workflow definitions. It resides
in the document.

DescriptionAttributes of
TB_WORKFLOW

Stores the unique key, which is system-generated.ID

Sets values related to the definition in the Workflow admin-
istrator. Set this value = 1 to write protect the definition.
this case only the caption can be modified.

IS_SYSTEM

Specifies the unique name that is displayed in the docu-
ment explorer (page 582).

CAPTION

Specifies the name of the workflowNAME

Stores the TB_WORKFLOW.ID of the root workflow. This
value is used for the sort order in the workflow explorer tree.

PARENT_ID

Stores the name of the icon in the workflow explorer. The
pictures must be saved in the <topobase>\pic folder or a
sub folder.

PICTURE

Controls the sort order of the node items in the explorer
tree.

PRIORITY

Stores the VB .NET script code (up to 4000 characters).SCRIPTCODE

See also:

■ Workflow Definition (page 103)
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Data Model

Overview of Data Model Administrator
Use the data model administrator to create a Autodesk Topobase™ document
(page 581) and to configure feature class tables within a document. A data model
includes topics, feature classes, topologies and intersections.

Topobase data model administrator provides tools to do the following:

■ Create and edit topics and feature classes.

■ Create domains.

■ Create label feature classes and define labels.

■ Update label text.

■ Add attributes to feature classes.

■ Build compounds.

■ Create, Initialize and edit topologies.

■ Define intersections.

■ Create Schematics and Generalizations.

To learn more about administrative tasks, refer to the following topics:

■ Create New Document Dialog Box (page 71)

■ Data Model: Feature Class Types (page 198)

■ Data Model: Labels (page 223)

3
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■ Data Model: Topologies (page 263)

Overview of Data Models
When you create a Topobase document, you can specify whether to add a
predefined data structure. In the Document Settings, under Modules, you
select the data model to add to the document.

DescriptionData Model

Data model for Topobase Electric Central Europe
(CE).

Electric Central Europe Data
Model

Data model for Topobase Electric North America
(NA).

Electric North America Data
Model

Data model for Topobase Gas.Gas Data Model

Data model for Topobase Land Management CH.Land Switzerland Data Model

ALKIS data model (based on GeoInfoDoc V6).Land Germany Data Model

Database schema for Topobase Survey (Survey
document). Use one central Survey document to

Survey Module

control your calculation projects. See Survey Data-
base.

Data model for Topobase Wastewater. See the To-
pobase Wastewater User Guide.

Wastewater Data Model

Data model for the import of inspection data. See
the Topobase Wastewater User Guide.

Wastewater Data Model (For
Intermediate Document)

Data model for Topobase Water. See the Topobase
Water User Guide.

Water Data Model

Data Model Description

Print a Data Model Description report to get a complete overview about topics,
feature classes, and attributes.
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Additional information

Entity Relationship Diagrams are available for the module data models. In
addition, explanations of the different feature classes are available in the
module documentation.

Data Model DescriptionEntity Relationship Dia-
gram

Module

Topobase Water Data ModelWater Data Model DiagramWater

Topobase Wastewater Data
Model

Wastewater Data Model Dia-
gram

Wastewater

Topobase Gas Data ModelGas Data Model DiagramGas

Topobase Electric NA Data
Model

Electric NA Data Model Dia-
gram

Electric North America

Topobase Electric CE Data
Model

Electric CE Data Model Dia-
gram

Electric Central Europe

Topobase Land Management
CH Data Model

Land Management CH Data
Model Diagram

Land CH

To print a data model description

1 Start Topobase Client, and open the workspace.

2 In the Document Explorer, select the document.

3 Click Output tab ➤ Reports And Profiles panel ➤ Open Report.

4 In the Report dialog box, select the report Data Model Description.

5 Click Preview.

6 In the preview window, select one of the output options.

To export a data model description to Excel

1 Start Topobase Administrator and open the workspace.

2 Click Workspace menu ➤ SQL Sheet.
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3 In the SQL Sheet, execute the following command.

excel select a.name Topic_Name,

a.caption Topic_Caption,

b.f_class_name FeatureClass_Name,

b.caption FeatureClass_Caption,

c.name Attribute_Name,

c.caption Attribute_Caption,

c.description Attribute_Description

from tb_topic a, tb_dictionary b,

tb_attribute c

where a.id = b.topic_id and b.f_class_id = c.f_class_id order by

a.name, b.f_class_name, c.name

Data Model Structure Update
Topobase provides several routines to update the standard data structure. You
use the Topobase Server Administrator to apply the updates to all your
documents. Normally, data structure updates are required, after you have
installed a newer Topobase version. See Server Administrator (page 31).

■ System related structure update—This update is driven by the Topobase
version that is stored in TB_VERSION.

■ Module related structure update—This update is driven by the data model
code, and the data model version. This update covers the standard Topobase
data models.

Customized Data Model Files

Any customer specific data model enhancement, such as country kit
enhancements, are not covered by the standard updates. However, you can
create customized data model files that can be used to provide specific data
model enhancements, and updates . See Topobase Structure Editor (page 303).

Data Model Code

The data model code contains update information about the data model. The
code is read when you open a workspace. If you open the workspace in
Topobase Administrator, and the data model is not up-to-date, you are
prompted to start update routines (page 33).
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NOTE The data model code is stored in the user data base schema in
TB_DATAMODELCODES.

The data model code consists of three parts, representing <company>.<module
or extension>.<submodule>. For example, a company value 1, 2, or 42 indicates
an Autodesk data model. For example, the data model code 2.14.0 indicates
the standard COGO data model extension. For example, the sub module
indicates a country specific data model enhancement.

In Topobase Client, you can view the data model codes of the current
document. See also Setting Document Options (page 127).

Exploring Data Model Administrator
Only members of the administrator user group (page 586) can start the Topobase
Administrator module!

Data Model Explorer

The data structure of the selected document is displayed in the data model
explorer. The items are shown in a tree view, starting from the Topobase root
node in the following order:

Document (<name>@<datasource>) (root node)

Topics (page 585) (Data Model node)

Domains (page 582) (Domains node)

Utilities (Utilities node)

Topologies (Topologies node)

Intersections (Intersections node)

In the data model explorer, you can right-click any object to see a shortcut
menu of commands related to that object. If available, further details
concerning the selected item are shown in the details pane on the right.

To start the data model administrator

1 Click Start menu ➤ Programs ➤ Autodesk ➤ Autodesk Topobase
2011 ➤ Autodesk Topobase Administrator 2010.

2 Log in as administrator.

3 Click Workspace menu ➤ Open, and open a workspace (page 586).
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4 In the Administrator explorer in the left pane expand the workspace item
and select the document (page 581).

5 In the Administrator window, click Document menu ➤ Data Model.

In the right pane, the data model administrator is opened.

Topobase data model administrator with data model explorer.

If you select a topic (page 585), the details pane shows the feature classes of
this topic. If you select a feature class (page 582), the details pane shows the
attributes (database columns).

If you point to an attribute in the details pane, the attribute properties are
displayed in a tool tip.

To explore the document for an overview of tables, attributes, and relations

You use the Topobase data model administrator to explore the data structures
of a document.

1 Start Topobase Administrator and open the workspace.

2 In the Administrator window, click Document menu ➤ Data Model.

3 In the data model explorer, expand the Data Model node.

4 Click a topic name to view its feature classes. Feature classes are shown
on the right in the property pane.

186 | Chapter 3   Data Model



5 Move the cursor to a feature class row. A tool tip displays information
about the feature class, such as the number of features.

6 In the data model explorer, expand a topic and select a feature class name.
Attributes and their definitions (Oracle columns) are displayed in the
property pane. The caption and the Oracle table name are displayed in
the status bar.

7 Expand a label feature class and select a label definition. The SQL Select
statement is displayed in the property pane.

8 Expand the Domain node and click a domain name. All values of this
domain table are displayed in the property pane. The caption and the
Oracle table name (_TBD) are displayed in the status bar.

9 Expand the Topology node and click a topology name. The icon indicates
whether the topology was initialized correctly or not. Feature classes that
are part of the topology are displayed in the property pane.

Right-click an item to view more details or edit the item.

The following symbols and icons represent structures and relations:

ExplanationIcon

Topobase root node (expanded), also called document, Oracle user,
project, and dump.

Data Model node, topic node

Point feature class with no related objects

Point feature class with related objects, but not expanded

Point feature class with related objects, expanded

Attribute feature class

Compound Polygon feature class

Compound Linestring feature class
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Linestring feature class

Label feature class

Label definition

Polygon feature class

Centroid feature class

Dimension feature class

Representations node

Geoschematic Plan

Orthogonal

Generalization

Domain node

Domain table

Topology node

Area Topology, not yet initialized

Area Topology, initialized without errors

Logical Topology. Expand the logical topology item to view the re-
lated conditions and tracing templates (network analysis).
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Intersection node, with sub entries

Intersection

Utility node

Utility

See also:

■ Data Model: Feature Class Types (page 198)

Document Shortcut Menu
The following commands on the document root node shortcut menu affect
the whole document. Some of the commands can also be started from the
topic or feature class level.

Some of the commands can also be started as a batch. See Database
Maintenance (page 136).

To display the shortcut menu, right-click the document node item in the data
model explorer and click a command, as shown in the following table:

DescriptionShortcut Menu
Document Node

Empties the tables (TRUNCATE) of feature data, but
retains the tables and schema.

Empty Topobase

Creates the required grants for the current Topobase
(Oracle commands), in case of trouble shooting.

Create Grants

Reads some settings from TB_INFO and saves them
for the session:

Set Environment Variables

- Index table space (TB_TMP_MGMT)
- name of TBSYS.
This command creates all user synonyms on TBSYS;
sets all required settings for Job package and recreates
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the package; creates a context that corresponds to
user names; and re-creates ON_LOGON trigger.

Commands that use sub-commands to process com-
pounds. See also Data Model: Compounds (page 260).

Compound

Commands that use the following sub-commands to
process indices: UFID (unique feature ID) and FID
(feature ID)

UFID

Resets the FID sequence, so the sequence can start
from the beginning. For example, this is necessary,

Reset FID Sequence

when a document (page 581) has been emptied.
You can also reset the FID sequence if the sequence
does not match the maximum FID value from the
TB_UFID table.

Deletes all FIDs from TB_UFID that have no correspond-
ing feature. If there are many unnecessary entries this
may improve performance.

Cleanup UFID Table

1-Click-Maintenance: TB_UFID.

Restores missing entries in TB_UFID, for example, if
values have been deleted manually.

Restore UFID Table

1-Click-Maintenance: TB_UFID.

Command that uses the following sub-commands to
process spatial indices.

Spatial >

Inserts or updates spatial metadata. This is data about
the minimum and maximum of X and Y, the SRID,

Insert Or Update Spatial
Metadata

spatial Tolerance and dimension; Stored in TB_DIC-
TIONARY.
1-Click-Maintenance: Spatial Configuration.

Creates or replaces spatial indices.Create Or Replace All Spa-
tial Indices 1-Click-Maintenance: Spatial Configuration.

Deletes spatial indices.Drop All Spatial Indices

Writes spatial metadata and spatial indices for
TB_PERIMETER and TB_JOB_PERIMETER. Stored in
TB_INFO.

Check Spatial Config. For
System Tables
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Updates the spatial reference ID (SRID). See also To
update the SRID (page 76).

Update Coordinate System

Rounds the geometry. For example, if you have the
Round Geometry feature rule enabled, and want to
adjust imported data. See also Round Geometry.

Round Geometry On All
Feature Classes

Command that uses the following sub-commands to
process triggers.

Triggers >

Creates or replaces, enables or disables all triggers.All Triggers

See Data Model: Compounds (page 260).Compound Triggers

Command that uses the following sub-commands for
database optimization (DBMS_STATS*). These are im-

Optimization

portant for the Oracle optimizer to generate optimal
execution plans.
For more information refer to Oracle Spatial Users Guide
and Reference.

Runs the DBMS_STATS.GATH-
ER_SCHEMA_STATS(USER,cacade=>true) command.

Optimize Topobase
Schema

This procedure gathers (not estimates) statistics for all
objects in a schema and on the indexes.
We recommend that you optimize the Topobase
schema after you have imported a document from a
dump file. It is recommended that you run the Optim-
ize command whenever you have extensive changes
to the data, such as imports or major updates.

Runs the DBMS_STATS.GATHER_TABLE_STATS([USER],
[Table], cascade=>true) command for the feature class

Optimize Feature Classes

tables. This procedure gathers table, column, and in-
dex statistics.
1-Click-Maintenance: Gather Statistics.

Runs the DBMS_STATS.GATHER_TABLE_STATS([USER],
[Table], cascade=>true) command for the following

Optimize Topobase System
Tables

tables: TB_UFID and TB_JOB_VERSION. This procedure
gathers table, column, and index statistics.

Updates all label texts of all label feature classes.Update Label Texts
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See also Label Commands (page 240).

Command that uses the following sub-command to
process jobs.

Jobs >

Selects a job. Available for job enabled documents.
For commands that process feature classes you must

Choose Job

select a job. For example, for Update Area Attribute,
or Update Label Texts.

For live jobs, removes all historical elements that are
stored in the feature class and the TB_JOB_VERSION
table. See also System Tables TB_JOB_* (page 159)

Erase Job History For Live
Features

Converts Oracle tables to Topobase feature classes.
Analyzes the document schema, and opens the Con-

Convert Tables To Feature
Classes

vert To Topobase Schema dialog box. Data Model:
Oracle Schema Converter (page 285).

This command opens the SQL Protocol window, where
you can create a log file of SQL statements that the

SQL Protocol

data model administrator executes during your work.
You can control which type of statements you want
to log. You can copy or save the statements for future
use. Once you close the SQL Protocol window the
logged statements are removed.

Reloads the data structure tree from the tables, display-
ing any changes you have made. Use this command
or press F5.

Refresh

Topics Shortcut Menu
Related Topobase feature classes are combined into a collection called Topics.
You can edit or create topics and subtopics using shortcut menus, as shown
in the following table:

DescriptionShortcut Menu
Topic Node

Creates a new topic (main level).Create Topic
Topic Name: Specify a name for the topic.
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Caption: Enter a caption. The caption is displayed
in the various Topobase explorers. Maximum 255
characters.

Right-click the topic item you want to process in the data model explorer and
choose a command, as shown in the following table:

DescriptionShortcut Menu
Topic Item

Creates a new topic (sub level).Create Topic

Creates a new feature class in the current topic.Create Feature Class

Sets shared properties for all feature classes of
the current topic. These properties can also be

Edit Feature Classes

set individually, either when you create or when
you edit the feature class.
See also Data Model: Feature Classes (page 196).

Renames the topic, changing the caption.Rename Topic

Clears the topic from all features, emptying all
feature classes in the current topic (TRUNCATE);
Oracle feature class tables are maintained.

Empty Topic

Drops all feature classes and features in the cur-
rent topic. All Oracle feature class tables are de-
leted (DROP).

Drop Topic

Updates all label texts of the label feature class
in the current topic. See also Label Commands
(page 240).

Update Label Texts

A hook indicates that the selected topic is job
enabled. See also Overview of Jobs (page 341).

Job Enabled
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Feature Class Shortcut Menus
In the data model explorer, you can right-click the feature class you want to
process and choose a command. You can also use shortcut menus for label
definition items, as shown in the following table:

DescriptionShortcut Menu
Feature Class Item

Creates a new feature class under the current one (sub
feature class). See also Data Model: Feature Classes
(page 196).

Create Feature Class

Defines a new label definition. This command is only
available for label feature classes. See also Label
Properties (page 225).

Create Label Definition

Creates auto labels. You can create labels for features
that have auto label definitions but are missing labels.

Create Auto Labels

For example, if you have disabled label triggers during
a data import, you can create the missing auto labels.
This operation is not available for label feature classes.

Adds a new attribute, which means you add a column
to the Oracle table. See also Adding Attributes (page
213).

Add Attributes

Edits the feature class properties. See also Editing
Feature Classes (page 210)

Edit Feature Class

Renames the feature class, changing the caption.Rename Feature Class

Deletes all features of the feature class (TRUNCATE);
Oracle feature class table is maintained.

Empty Feature Class

Drops all features in the current feature class. The
Oracle feature class table is also deleted (DROP).

Drop Feature Class

Defines a set of feature rules (rule base) for each fea-
ture class. See also About Feature Rules (page 571).

Edit Feature Rules

Commands to process compound feature classes. See
also Data Model: Compounds (page 260).

Compound
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Commands to process Spatial indicesSpatial

Creates or replaces spatial indices.Create Or Replace Spatial In-
dex

Drops spatial indices.Drop Spatial Index

Commands to process triggers of the feature class
tables.

Triggers

Sub-commands that create or replace, drop, enable
or disable all triggers.

Triggers

See also Data Model: Compounds (page 260).Compound Triggers

Commands that use the following sub-commands for
database optimization (DBMS_STATS*). For more in-

Optimization

formation see Oracle® Spatial User’s Guide and Refer-
ence.

Runs the DBMS_STATS.GATHER_TABLE_STATS([USER],
[Table], cascade=>true) command for the feature class

Optimize Feature Class

tables. This procedure gathers table, column, and in-
dex statistics.

Updates the label texts. Available only for label feature
classes. See also Data Model: Labels (page 223).

Update Label Text

Calculates the length again; available only for feature
classes with LENGTH column.

Update Length Attribute

Calculate the area again. Available only for feature
classes with AREA attribute.

Update Area Attribute

Calculates the intersection of a feature class with an-
other. Available only for feature classes that are al-

Intersect With

lowed to be intersection primary feature classes (which
are at the moment polygon and line string). See also
Data Model: Intersections (page 274).

Starts the Topobase form designer, to customize the
form. See also Starting Form Designer (page 357)

Form Designer
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A hook indicates that the selected feature class is job
enabled.

Job Enabled

DescriptionShortcut Menu
Label Definition Item

Displays the properties that you can edit. Right-click
the label definition. Click Properties. See also Label
Properties (page 225).

Properties

Drops the label definition. Right-click the label defini-
tion. Click Drop.

Drop

Data Model: Feature Classes
When creating a feature class, you always attach it either to a topic or to
another feature class, in which case, it is a sub-feature class, or a child class.

To create a feature class, right-click the parent topic, or feature class and click
Create Feature Class. The Create Feature Class dialog box is displayed.

After finishing the default settings of a feature class, you can add any required
customer attributes. See also Adding Attributes (page 213).

Also, you can register a database view as feature class. See Creating a Feature
Class From a View (page 212).

Feature Class Create Dialog Box
When you create a feature class, you create an Oracle table with certain default
columns (attributes). After a feature class is created, you can add any number
of additional custom attributes.

DescriptionFeature Class Create Dia-
log Box
Feature Class Properties
tab

Creates a new feature class.Create New Feature
Class
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Creates a feature class from an existing database view.
Lists the views that exist in the current document. See
also Creating a Feature Class From a View (page 212).

Create Feature Class
From An Existing View

Specifies a table name. Enter a name that complies with
Oracle format restrictions. If you are planning to use
jobs, limit the name to 19 characters.

Name

Note: Names for Oracle tables can consist of 30 charac-
ters maximum. Since the table names for Topobase for
identification of the system provide certain initials and
extensions, fewer letters are available for the actual
names. Avoid national or special characters such as ä, â,
ö, ü, $,%, &.

Specifies the caption that is displayed in explorer tree
views. It can contain up to 255 characters. You can use
blanks.

Caption

Specifies the type. Select the type in the list. If you select
a geometry feature class type, the Geometry Settings

Type

tab is active. See also Data Model: Feature Class Types
(page 198).

Assigns a model feature class. See Data Model: Model
Tables (page 220).

Model Feature Class

Sets the feature class to read-only. See also Setting a
Feature Class Read Only (page 211)

Set Feature Class To Read
Only

Displays the topic of the feature class.Topic

NOTE If the Feature Class Create dialog box has been
opened from the Create Utility Model dialog box, the
Create New Topic command is available.

Specifies settings for point feature classes.Point Feature Class Set-
tings tab

Adds attributes to store the point’s accuracy and reliab-
ility. See also Feature Class Type: Point (page 208).

Add Attributes To Store
The Point’s Accuracy And
Reliability
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Select Prompt For Orientation With Each New Feature
if you do not want to use the default orientation. When

Digitizing Settings

digitizing a new point in Topobase Client, you will be
prompted to specify the orientation.
Select Prompt For Z Value With Each New Feature if you
want to enter the Z coordinates while you are digitizing
a new point in Topobase Client. Only available, if 3D is
enabled.

NOTE You can enable or disable the Digitizing Settings
using the Edit Feature Class command. See Editing Fea-
ture Classes (page 210).

NOTE The Digitizing Settings for the Z value are valid
in AutoCAD Map 3D, if you digitize a Topobase feature.
If you are digitizing an AutoCAD entity, use the Map 3
D Options dialog box, 3D Modelling tab to enable the
Z value input.

For feature classes with geometry, some attributes for
the spatial reference system (spatial column GEOM) are

Geometry Settings tab

displayed in the Geometry Settings tab. The default set-
tings here were defined during the creation of the Topo-
base.
You can modify these settings for each feature class, but
be aware that this requires more modifications to keep
the system consistent.
Create New Document Dialog Box (page 71).

Controls the behavior of each feature class during spatial
selections. If you use a polygon or rectangle to select

Set Spatial Settings

features, these settings specify the conditions for element
selection.
See also Data Model: Spatial Relationship Settings (page
282)

Data Model: Feature Class Types
Each feature class consists of one feature table. This table has a fixed basic
structure, but you can create additional columns (attributes).
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Basic Structure: Every feature has an identifier FID (feature identifier) that is
unique for each database schema (document (page 581)).

The feature geometry is saved in Oracle Spatial (standard attribute GEOM).

For more information, refer to the Oracle Spatial Users Guide and Reference.

DescriptionFeature Class Types

For attribute tables (features without geometry).

Attribute

For centroids. A special point associated with a poly-
gon that is defined by line strings. A centroid is sur-

Centroid rounded by the features of a line string feature class
that builds the polygon.
Examples: parcels, land use.

For features with any geometry (lines, point, or poly-
gon). Normally, a feature class contains features of

Collection only one geometry type. In a collection feature class,
you can store features with different geometry, which
means that you can store point features, line features,
and so on in one single feature class.

For polylines. A group of two line string feature
classes.

Compound LineString

For areas. Built as a group of a line string and a poly-
gon feature class.

Compound Polygon

For dimensioning. Consists of related tables: Dimen-
sion feature class <name>, line string feature class

Dimension <name>_L, label feature class <name>_TBL with line
string <name>_HL and point feature class <name>_P.

For text. Is related to a parent feature class and
therefor can only be created from feature class level.

Label
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NOTE In Topobase Client, in the Display Manager,
only label feature classes with the name extension
_TBL can be used as Annotation Layers.

For polylines.

LineString

For (closed) polygons. Consists of arcs as well as lines
or polylines.

Polygon

For points.

Point

See also:

■ Data Model: Domain Tables (page 219)

■ Data Model: Model Tables (page 220)

Feature Class Type: Attribute
This feature class is for features without geometry. Examples of attribute feature
classes are denotations, lists, and so on.

Default Attributes of Attribute Feature Class

Primary keyFID

Feature Class Type: Centroid
Centroids usually are part of area topologies. Create area topologies using the
data model administrator.

See also:

■ Data Model: Topologies (page 263)

Default Attributes of the Centroid Feature Class
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Primary keyFID

For more information, see Oracle Spatial Users Guide
and Reference.

GEOM

ORIENTATION

Area calculated by topology function.AREA

Feature Class Type: Collection
Feature class for objects that can be either point, line, or polygon.

Default Attributes of the Collection Feature Class

Primary keyFID

For more information, see Oracle Spatial Users Guide
and Reference.

GEOM

AREA

LENGTH[2D,3D]

ORIENTATION

Feature Class Type: Compound Polygon
A compound polygon is like a polygon, except that the line segments that
form the polygon can have different line attributes. For example, a compound
polygon can show a building (closed polyline) with one subterranean wall
segment that is drawn with a dotted line.

PARENT feature class = Polygon feature class: Data of this feature class is saved
redundantly. It is a standard polygon feature class. If the associated line strings
do not frame a polygon, no polygon is saved. The essential feature attribute
data is stored in the parent feature class.

Default Attributes of the Compound Polygon Feature Class (Parent Polygon)
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Primary keyFID

For more information, see Oracle Spatial Users
Guide and Reference.

GEOM

Calculated area.AREA

Oracle error code if polygon geometry is not valid.INVALID_GEOMETRY_ERROR

CHILD feature class = Line string feature class (child, single segments): This
is a standard line string feature class with an additional column for a reference
to the polygon feature class (FID_PARENT). Its name indicates the related
polygon, for example "Single Segment [<compound name>]" or <compound
name>_L. Normally the child line strings have few attributes, but can have
one to control representation in graphics, such as "LINE_TYPE".

Default Attributes of the Compound Polygon Feature Class (Child Line String)

Primary keyFID

For more information, see Oracle Spatial
Users Guide and Reference.

GEOM

LENGTH

Foreign key to parent polygon feature.FID_PARENT

See also:

■ Data Model: Compounds (page 260)

Feature Class Type: Compound Line String
A compound line string is a type of line string in which individual line strings
can have different line attributes. The polyline can be drawn with distinct
line types for each segment. For example, compound line strings are used for
pipelines, where particular segments have special attributes to display the
segments at crossing points.
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The essential feature attribute data is stored in the parent feature class.

Default Attributes of the Compound Line String Feature Class (Parent Line String)

Primary keyFID

Feature geometry polyline. For more in-
formation, see Oracle Spatial Users Guide
and Reference.

GEOM

Calculated length of all segments.LENGTH

State of line in relation to the polyline:
(TRUE = valid, Lines not connected)

INVALID_GEOMETRY_ERROR

Child feature class (single segments): Normally, the child line strings have
few attributes, but can have one to control representation in graphics, such
as "LINE_TYPE".

Default Attributes of Compound Line String Feature Class (child line string)

Primary keyFID

Feature geometry polyline. For more in-
formation, see Oracle Spatial Users Guide
and Reference.

GEOM

Length of a single segment.LENGTH

Foreign key to parent polyline.FID_PARENT

See also:

■ Data Model: Compounds (page 260)

Feature Class Type: Dimension
A Topobase dimensioning consists of several related feature classes. When
you add the Dimension Extension to a document, the dimensioning feature
classes are created, as shown in the following illustration. See also Document
Settings (page 69).
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Topobase Data Model: A dimensioning feature class consists of several related feature
classes.

Dimension Parent: This attribute table does not store any geometry.

DescriptionDimension Table

<dimension>

Primary keyFID

Type of dimensioning:DIMENSION_TYPE
AA = Aligned Abscissa Only
AT = Aligned Text Only
AC = Aligned Complete
OC = Orthogonal Complete
OE = Orthogonal Extension Baseline

Dimension Children: These tables store the geometry.

DescriptionDimension Point Child

<dimension>_P

Stores the points at the start and endpoints of the
measure line, such as abscissas and ordinates.

Primary keyFID
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For more information, see Oracle Spatial Users Guide
and Reference.

GEOM

Foreign key to dimension parent table.FID_PARENT

AS = Start of orthogonal abscissa.POINT_TYPE
AE = End of orthogonal abscissa.
AE_ = End of orthogonal abscissa, not to be displayed.
OS = Start of orthogonal ordinate.
OE = End of orthogonal ordinate.
S = Start of aligned line, abscissa.
E = End of aligned line, abscissa.

DescriptionDimension Line Child

<dimension>_L

Stores the measure line.

Primary keyFID

For more information, see Oracle Spatial Users
Guide and Reference.

GEOM

Foreign key to dimension parent table.FID_PARENT

LENGTH

AL = Aligned line, abscissa.LINE_TYPE
AL_ = Aligned line, abscissa, not to be displayed.
HL = Help line for dimension.
HL_ = Help line for dimension, not to be dis-
played.
OO = Orthogonal ordinate.
OA = Orthogonal abscissa.
OAE = Orthogonal abscissa extension.
OAB = Orthogonal baseline abscissa.

Stores the offset of the measure line.OFFSET

Measured dimension of aligned line or orthogonal
abscissa.

MEASURED_A
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Measured dimension of orthogonal ordinate.MEASURED_O

Calculated dimension of aligned line or orthogon-
al abscissa.

CALCULATED_A

Calculated dimension of orthogonal ordinate.CALCULATED_O

Label

<dimension>_TBL

The label feature class stores the measure label
texts. See also Feature Class Type: Label (page
206)

DescriptionDimension Label Line

<dimension>_HL

Stores lines that are related to labels, for example
lines that point to the feature where the label
belongs to.

Primary keyFID

For more information, see Oracle Spatial Users
Guide and Reference.

GEOM

Foreign key to dimension label table.FID_PARENT

See also:

■ Data Model: Dimensioning (page 252)

Feature Class Type: Label
A label feature class can only be created from the feature class level. Each
feature class can have only one label feature class.
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NOTE In Topobase Client, in the Display Manager, only label feature classes with
the name extension _TBL can be used as Annotation Layers. See also Styling Label
Features (page 452).

The default attributes of a label feature class are as follows:

Default Attributes of the Label Feature Class

Primary keyFID

Foreign key to parent table’s FIDFID_PARENT

Label geometry = insertion point. For more
information, see Oracle Spatial Users Guide
and Reference.

GEOM

Horizontal alignment of the label. The de-
fault is Center.

HORIZONTAL_ALIGNMENT

Foreign key to TB_LABEL_DEF.ID.LABEL_DEF_ID

Text of the label.LABEL_TEXT

Text orientation.ORIENTATION

This value is no longer used. Use alignment
attributes instead. See also Label Properties:
ORIGIN conversion (page 235)

ORIGIN

Label prefix.PRE

Label suffix.SUF

Vertical alignment of the label. The default
is Halfline. See also Label Properties:
Alignment (page 233)

VERTICAL_ALIGNMENT

A label feature class always belongs to a parent feature class (relation
FID_PARENT). Normally a label feature class has no additional columns and
the application user (page 586) will never edit it. The attributes of a label feature
class are generated when a user places a label.
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See also:

■ Data Model: Labels (page 223)

■ Creating a Label Definition (page 240)

Feature Class Type: Line String

Default Attributes of the Line String Feature Class

Primary keyFID

For more information, see Oracle Spatial Users Guide and
Reference.

GEOM

LENGTH

See also:

■ Feature Class Type: Compound Line String (page 202)

Feature Class Type: Point

Default Attributes of the Point Feature Class

Primary keyFID

For more information, see Oracle Spatial Users Guide
and Reference.

GEOM

Orientation of the point geometry.ORIENTATION

Height, for example, terrain elevation.Z

QUALITY

When creating a point feature class, you can optionally
add the following attributes. For example, these attrib-

Optional Point Feature
Class Attributes

utes are used by survey applications to store accuracy
and reliability values, which are usually set automatic-

208 | Chapter 3   Data Model



ally by the application. For example the Topobase
Construction functions automatically set values.
See also Data Model: Feature Classes (page 196)
See also To set COGO application optionsright angle
course:setting the modetolerance:setting the split -You
c... (page 124)

Stores a point number.TB_POINTNUMBER

Stores the accuracy of the ground representation.TB_ACCURACY_POSITION

Stores the accuracy of the height representation.TB_ACCURACY_HEIGHT

Stores the reliability of the ground representation. This
value indicates the quality of the measuring method.

TB_RELIABILITY_POSITION

Stores the reliability of the height representation. This
value indicates the quality of measuring method.

TB_RELIABILITY_HEIGHT

Stores the name of the attribute that specifies whether
the ground representation of the point is reliable or
not. The attribute is of type check box (1=yes, 0 = no).

TB_POSITION_RELIABLE

Stores the name of the attribute that specifies whether
the height coordinate of the point is reliable or not.
The attribute is of type check box (1=yes, 0 = no).

TB_HEIGHT_RELIABLE

Feature Class Type: Polygon

Default Attributes of the Polygon Feature Class

Primary keyFID

Polygon geometry.GEOM
For more information, see Oracle Spatial Users Guide
and Reference.

The area is calculated by Topobase.AREA
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See also:

■ Feature Class Type: Compound Polygon (page 201)

Editing Feature Classes
In the data model administrator you can modify the following feature class
properties. See also Feature Class Properties (page 196).

■ Feature Class Properties
Feature class caption. Set or reset the feature class read-only.

Model Feature Class. Assign a model feature class. See Data Model: Model
Tables (page 220).

■ Point Feature Class Settings—Digitizing Settings.

■ Geometry Settings—Edit Spatial Relate Settings.

■ Feature Explorer Settings—Define which feature information will be
displayed in the feature explorer. See Feature Explorer (page 92).

■ Job Settings—For topics: Assign a perimeter feature class and buffer to all
feature classes of the topic. The Job Settings tab is only available if the
document is job enabled.

See also:

■ Setting a Feature Class Read Only (page 211)

■ Assigning a Job Perimeter (page 349)

■ Overview of Jobs (page 341)

To edit a feature class

1 Start the data model administrator.

2 In the data model explorer, select the feature class.

3 Right-click, and click Edit Feature Class.

4 In the Feature Class Edit dialog box, enter your modifications.
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Setting a Feature Class Read Only
In the data model administrator, you can set a feature class to read-only so
that users cannot update and delete the data.

Examples

■ Use this option for feature classes that store imported data, which is not
managed by the Topobase application.

■ We recommend that you use this option when you create a feature class
from a view.

For read-only feature classes the following commands are deactivated:

Administrator functions

■ Empty Feature Class

■ Update length/area attribute

■ Compound processing: eliminate/build/convert

■ Update Label Texts

Client functions

■ Digitizing

■ Creating new features

■ Dimensioning

NOTE This read-only property is achieved by deactivating Topobase commands
in the user interface and not by Oracle rights. Oracle commands, such as insert,
are still available from the Oracle side.

See also:

■ Data Model: Feature Classes (page 196)

■ Editing Feature Classes (page 210)
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Creating a Feature Class From a View
You can include Oracle views in Topobase documents and use them in the
same way as the document's own feature class tables. For example, you can
use views to combine data from different feature classes in one table. Then,
you define reports containing this data or you define Feature Search definitions
based on the view. Also, you can use views to stylize features in the Display
Manager.

In the Topobase demo data set TB_LM you find a sample view
LM_V_LANDUSE_TSUR. It is used for stylization.

NOTE Alternatively, you can use Dynamic Stylization to query attributes from
multiple feature classes. See Creating Topobase Calculations (page 466).

NOTE You can only register a view once. If a view has already been registered as
feature class, it is not displayed in the Existing Views list.

View definitions

When you define a view that can be used as feature class, the following
conditions must be met.

■ The views must contain the attribute FID. A view that does not contain
the FID is not displayed in the Existing Views list.

■ If you want to be able to edit the features, the view must contain FID and
GEOM that come from the same feature class. Then, the view will be
registered as a feature class that handles geometries.

To create a feature class from an existing view

1 Create the view using any oracle tool. It is recommended that the name
starts with a prefix indicating the module in addition to a prefix such as
_V indicating that this is a view. For example, LM_V_.

2 Start the data model administrator, and start the Create Feature Class
command.

3 In the Create Feature Class dialog box, on the General tab, select Create
From Existing View.

4 From the Existing Views list, select the view to register. The name of the
feature class is the same as the name of the view, and you cannot edit
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the name. When you hover over the name of the view, the view definition
is displayed.

5 Enter the caption to be displayed in the explorer tree views.

6 Optionally edit the type: By default the feature class type is the same as
for the view. For example, edit the type to create a Collection feature
class from a view that has been defined as a line type feature class.

7 Select Feature Class Is Read Only. See also Setting a Feature Class Read
Only (page 211).

8 Click OK to register the view.

Adding Attributes
When you create a feature class with the data model administrator, it has
default attributes that are specified by the feature class type. However, you
can add more attributes.

Right-click the feature class to which you want to add a column, and click
Add Attributes to open the Add Attributes dialog box. Add attributes as shown
in the following illustration and table.
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DescriptionAdd Attribute Dialog Box
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Specifies the column name. Enter a name that
complies with Oracle format restrictions. If the

Name

column relates to data in another table, it is re-
commended that you use a prefix to indicate this
relationship. Example: FID_<parent> or ID_<do-
main>.

Specifies the caption to be displayed in the feature
class form. You can modify this caption later with
the Topobase Form Designer.

Caption

Description. The description is shown as tool tip
when the user points to the attribute in the detail
pane of the data model administrator.

Description

Selects a unit type, if required, such as Angle or
Area.

Unit Type

Selects an appropriate unit, such as Gon Clock-
wise or Square Meter.

Unit

Specifies type and precision. In the list box, select
the appropriate type, subject to Oracle specifica-

Type
Precision and Scale

tions. See also Attribute Type, Precision and Scale
(page 216).

Specifies a default value. Optionally, assign a de-
fault value and specify whether the attribute is
mandatory or optional.

Default Value

Specifies whether the attribute is optional.Optional

Attribute relation settings, including Relation
Type, Split Rule, and Merge Rule. See also Parent
Table Settings (page 216).

Parent Tables

Adds the relation to a domain table.Select Domain

Adds one or more relations to a feature class.Select Feature Classes

For more information refer to Oracle Administrator's Guide.
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Attribute Type, Precision and Scale
You can specify the attribute type, precision, and scale using the following
values.

DescriptionAttribute Type

Variable length character string -> relationsVARCHAR2 (n)

Number having precision p and scale s -> relationsNUMBER (p,s)

Valid date rangeDATE

Pointer to binary file on diskBFILE

Binary large objectBLOB

Fixed length character data CHAR(20)CHAR

Character Large ObjectCLOB

LongLong

NationalNChar

National Character Large ObjectNCLOB

National Character.Nvarchar2 (n)

Raw binary dataRaw (n)

Number of digits in the fractional part of the SECOND
date time field

TimeStamp (n)

For more information refer to Oracle Administrator's Guide.

Parent Table Settings
For data types "NUMBER" and "VARCHAR2" you can specify a relationship
between the attribute and another table. To do this, you create an attribute
that is a foreign key to a primary key in another table (the parent table). These
settings are stored in a system table TB_RELATIONS. You set the following:
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Select Domain—Select the parent table from all domain tables of the current
database schema. The relation is directed to the unique ID column of the
domain table, and has the Relation Type: Set Relation To Parent To NULL
When Parent Is Deleted.

Select Feature Classes—Select the parent tables from all feature classes of the
current database schema. The relation is directed to the unique FID column
of the parent table. You can define multi-relations that connect the attribute
to several feature classes by selecting multiple feature classes.

Relation Type—Specifies whether deleting a parent feature also deletes a related
child feature, or deletes only the foreign key. The relation type is stored in
the system table TB_RELATIONS.DELETE_CHILD.

DescriptionRelation Type

For domains (lists), this value is
selected automatically, because

Set Relation To Parent To NULL When Parent
Is Deleted.

otherwise the list items are also
deleted.

Don’t Alter The Child When Parent Is De-
leted.

Select this value for slope hatches
that have a foreign key to the

Delete Feature When Parent Is Deleted.

slope edge. Then the hatch lines
are deleted when the edge is de-
leted.

Don't Delete Feature When A Parent Exists.

Don't Delete Feature When A Child Exists.

Duplicates the child features. The
value of the parent reference attrib-

Duplicate Children

ute in the copies reference each
fragment resulting from the split.

Split Rule—Specifies the handling of child features when splitting the parent
feature. If no split rule is set, the Relation Type applies. The mode is stored in
the system table TB_RELATIONS.SPLIT_MODE.

DescriptionSplit Rule
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Assigns the child feature to a par-
ent feature.

Assign Children

For example, for attribute child
features, associates each child with
the longest fragment resulting
from the split. For for point fea-
tures, associates each child with
the closest fragment resulting
from the split.

Duplicates the child features.Duplicate Children
The value of the parent reference
attribute FID_<PARENT> in the
copy references each fragment
resulting from the split.

Merge Rule—Specifies the handling of child features when joining parent
features. If no merge rule is set, the Relation Type applies. The mode is stored
in the system table TB_RELATIONS.MERGE_MODE.

DescriptionMerge Rule

Sets the parent reference attribute
FID_<PARENT> of the child feature
to the new joined parent feature.

Keep All Children

Combines all children of the join-
ing fragments into a single child
feature.

Join Children

Like Join Children rule, but a test
is made first that the children are
identical.

Join Children If Identical

For example, the Split/Merge modes apply to the following parent feature
classes in Topobase Electric: Segments, Ducts, Conductors.

In a utility model, when you hard split (page 244) a line, the split rule applies.
For example, if you hard split a wastewater section (parent) with related section
observations (children).
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See also:

■ System Table TB_RELATIONS (page 172)

■ TB_RELATIONS: Parent, Child, Sibling (page 173)

Modifying Attribute Properties
You use the data model administrator to modify attribute properties. At any
time, you can modify the Caption and Description. For user defined attributes,
you can also modify the Unit Type and Unit attributes.

In the details pane, right-click the attribute and click Edit Attribute.

Deleting Attributes
You use the data model administrator to drop feature class attributes. In the
details pane, right-click the attribute and click Drop Attribute. The command
deletes all values and drops the attribute from the database table.

Data Model: Domain Tables
You can create and edit domain tables in the Topobase data model
administrator. In the data model explorer, right-click the Domains item and
click Create Domain.

NOTE The suffix _TBD is added automatically to the Domain Table Name you
enter. Domain tables have a set of standard attributes. We recommend that you
do not add attributes to a domain table.

The data model explorer displays the most important domain values as shown
in the following table.

DescriptionDomain Tables Attrib-
ute

Displays the unique key. <domain_TBD.ID>Key

Displays the value. <domain_TBD.VALUE>Value

Displays the short value. <domain_TBD.SHORT_VALUE>Short Value
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Specifies that the record is active. Selected by default.
Clear to hide or de-activate the record in the domain
list.

Active

Editing a Domain Table

To edit a domain table

1 In the data model explorer, expand the Domains item.

2 Click the domain table that you want to edit.

3 In the grid view on the right, edit the table.Click the record you want to
edit and enter the new values.

4 To add a new record, right-click anywhere in the grid and click Create.

If you add a new record, the Key value is filled automatically with the next
free ID (unique).

To delete a record, select it in the grid, right-click and click Delete.

NOTE If you want to add or update a large number of domain values, open the
feature class form, export the domain table to Excel and edit and re-import the
data.

See also Topobase Client User Guide

Data Model: Model Tables
You can use model driven attributes to provide a consistent and smart way
of data acquisition. Using model tables, you constrain attributes based on
other attributes. These attributes are called model driven.

Example: To use a model table for diameter and material

1 In the model table, specify valid combinations of diameters and material,
such as Iron - 50; Iron - 100, Concrete - 400, Concrete - 300.

2 Assign the model table to the main feature class, such as Pipe.

3 In Topobase Client, in the main feature class form, use the Model Selector
control to enter the attribute values, or to open the Model table.
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The following instructions show the concept of model tables. For example,
in Topobase Gas, you use the Pipe Model table, to acquire Pipe attributes.

To use a model table for data acquisition

1 Start Topobase Client, and open a workspace with access to the Gas demo
data set.

2 In the document explorer, expand the topic Pipe. Right-click Pipe, and
click Show Form.

3 In the Pipe form, select a Pipe.

4 Besides Model, click  to show the Pipe Model form.

The Pipe Model form consists of two sections: At the top is the filter
section for the model attributes. Use the horizontal scroll bar in the
middle of the form to view all attributes. The lower section displays the
models (model table records) that match the current feature. For example,
if not all model related attributes of the main feature are filled, several
models would be applicable.

5 Use the filter area to search for any other models.

6 In the data grid, select a model, and click Apply.

7 The main feature class changes into Edit mode. Check the values, and
click Update to insert the attribute values as specified in the selected
model.

8 In the main feature class, click  again. The model table filter is set
to the model you just applied. That means that the main feature attributes
match the model attributes. To apply another model, use the filter area.

9 Close the Pipe Model form.

Alternatively, you select a model from the model list. In the Pipe form, on
the General tab, select a model from the list. The list displays the Model Name
(MODEL_NAME). If no model name is assigned, the list shows an empty entry.
If the model table does not contain the attribute MODEL_NAME, the value
of the VALUE attribute is shown. If no attribute VALUE is available, the list
shows the FID.
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To assign a model table to an existing feature class

1 Start the data model administrator.

2 Select the main feature class.

3 Right-click, and select Edit Feature Class.

4 In the Edit Feature Class dialog box, click the General tab.

5 Under Model Feature Class, select the attribute feature class you want to
assign to the feature class.

6 Click OK.

You can use any attribute feature class as model table. If the model feature
class contains attributes that are not in the main feature class, you can
optionally add these attributes.

In the parent feature class form, the model table can be accessed using the
Model Selector. Use the Form Designer to add the Model Selector control.

To add the Model Selector.

1 Start the Form Designer.

2 Select the parent feature class.

3 Click Designer.

4 See Form Designer Reference (page 357).

Updating Model Tables
Topobase 2009 introduced a flexible management of the model feature classes
(model tables). In previous versions, some Topobase applications used model
tables named <name>_MODEL. When you open a document that has the old
model table structure, the system updates existing model tables, so they support
the new concept of model driven attributes.

The data structure update performs the following steps.

■ Main feature class—The attribute FID_MODEL that links to the model
table, will be removed.
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■ Main feature class—All attributes of the related model table will be added.
The values of these model attributes are filled with the model information
of the model table, so that no data is lost.

■ Main feature class form—A model selector will be added. Use the model
selector to access the values of the model table.

■ Model table—The attribute NAME_NUMBER is renamed to MODEL_NAME.

NOTE The model feature class is still being used, according to the new concept.
However the model attributes are now stored in the main feature class, and you
use the model table to support data acquisition.

Data Model: Labels
In Autodesk Topobase applications, you can display any attribute data of a
feature as label text, and align the label consistently in relation to the displayed
feature. Labels are stored in a special label feature class <feature class>_TBL
that is a child of the parent feature class whose attribute data is to be displayed.
Each feature class can have only one label feature class.

Topobase Data Model: Labels display attribute data as text.

Example: The label feature class TREE_TBL contains text that displays species
and vitality of trees. The parent feature class that stores the attribute data is
TREES.
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Topobase Data Model: Relations between feature table and label feature class. The
attribute itself (name of the tree = Great Oak) is saved with the feature. To display
this value as text in graphics, generate labels.

The label definition consists of a select statement to query the attribute values
from the database, in addition to rules about how to display the text (offset,
insertion point). The select statement is executed each time the feature is
regenerated. Therefore, the label always displays the current value and if you
update a value in the database, labels that use this data are updated.

You can use the data model administrator to create and define label feature
classes and custom labels. Use Topobase Client or Web to create and position
labels for selected features.

NOTE Each feature class can have only one label feature class, but can have any
number of label definitions.

See also:

■ Creating a Label Definition (page 240)
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Label Properties
Label properties define how the label text is selected from the database and
how the label is positioned.

To edit label properties

1 Start the data model administrator.

2 In the data model explorer, select the label definition.

3 Right-click and click Properties.

Topobase data model administrator: Label Properties dialog box
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Label Properties: Label Information

DescriptionLabel Properties Dialog
Box
Label Information

Default is <label feature class name> Label: You can
change the default value to any clear name. The label

Name

name is displayed in the explorer tree views and the
Choose Label Definition dialog box. It is saved in
TB_LABEL_DEF.NAME. The label name can have up to
255 characters and may contain blanks (and special
characters).

Creates a label upon feature creation. These labels are
called Auto Labels.

Automatically Create La-
bel When Feature Is Cre-
ated

Specifies that the label is displayed by the label placer.
Selected by default. Clear this check box if you do not

Label Is Active

want to display this label for selection with the label
placer (page 583).

Specifies the text to be displayed by an SQL select
statement. Default statement:

Content To Display (Se-
lect Statement)

select FID from <table name> where FID =

$ID

This statement returns the FID. The easiest change is to
replace the column name FID with the name of another
attribute that you want to display as label text.
See also Label Select Statements (page 236).

Opens the SQL Assistant. Optionally, you use the SQL
Assistant to create SQL expressions. See Creating SQL
Expressions (page 137).

Assistant button

Creates an "empty" label even if there is no correspond-
ing value in the feature table. If necessary, you can up-

Display NULL If The Se-
lect Statement Returns
NULL date the data for these labels later, using the Update

Label Texts command.
If this check box is cleared and the select statement re-
turns nothing, no label record is created.
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Standard text included before or after the selected text,
such as an abbreviation or a unit of measurement. For

Prefix/Suffix

stylization in Display Manager see To style an annotation
layer (page 452).
Alternatively you can use the CONCAT statement in the
label SQL select statement.

Defines the auto labels for attribute feature classes. See
also Label Geometry Select Statements (page 238)

Parent Geometry (Select
Statement)

Optionally displays a sample text. Enter an example of
label text.

Sample Text

Defines regeneration rules for label definitions. See also
Label Properties: Regeneration Definition (page 227)

Regeneration Definition

Label Properties: Regeneration Definition
You can define regeneration rules for label definitions. Normally, labels are
updated (regenerated) automatically when an attribute is modified. However,
this only updates the attributes of the main feature class, which is the feature
class the label definition belongs to.

Regeneration rules are applied, if the label definition contains text that is
stored in a secondary related feature class. For example, a label definition of
the building feature class that displays informations that is stored in the street
feature class.

In the Label Properties dialog box, click Regeneration Definition to define
regeneration rules.

DescriptionLabel Regeneration
Definition dialog box

Selects a rule. The default name for a rule is the name
of the current label definition.

Regeneration Rules

Creates a new rule.Create New Rule

Displays the properties.Selected Regeneration
Rule
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Selects the related feature class (secondary feature class).
If a feature of this feature class is modified, the regener-
ation rule is applied.

Feature Class

Displays the attributes of the selected feature class. Se-
lect an attribute whose modification will cause the re-
generation rule to be executed.

If One Of The Following
Is Changed

Defines a selection to get the label parent ID. The de-
fault statement contains the main and the secondary
feature class. The alias $id has to be used.

Run This Statement To
Get The Label Parent FIDs

Activates the rule.Activate This Rule

Opens the SQL Assistant. Optionally, you use the SQL
Assistant to create SQL expressions. See Creating SQL
Expressions (page 137).

Assistant button

NOTE If you define a label regeneration rule, some RegnerateLabel feature rules
are added to the secondary feature class. You can view these in the feature rule
editor.

IMPORTANT Do not deactivate these rules in the feature rule properties. Use the
Activate This Rule option in the Regeneration Definition dialog box to deactivate
or activate the rule.

Label Properties: Positioning

DescriptionPositioning

See also Label Properties: Positioning and Orienta-
tion (page 231)

Absolute
Relative

Specifies that when labels are created, the user is
prompted to enter the label position by mouse

User Selects The Label Position

click. Text box insertion point and orientation are
used as defined.
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Label Properties: Orientation

DescriptionOrientation

See also Label Properties: Positioning and Orienta-
tion (page 231)

Absolute
Relative

Specifies that the labels are rotated so they are
readable. This option can be required if the label

Preserve Text Readability (Flip
When Necessary)

positioning properties create upside down labels
for some features. When the label is created, the
orientation is either calculated relative to the feature
geometry or set to the absolute value specified in
the label properties. The orientation of upside down
labels is greater or equal to 200 Gon (180 degree).
Select this option to rotate those labels at 200 Gon,
to make them readable, and to store the adjusted
orientation in the database.

NOTE This option does not flip existing texts, if
you change the map units or the label styles. It
applies to the label orientation that is stored in the
database.

NOTE Do not select this option for flow direction
arrows. The label (symbol) orientation would not
show the correct flow direction.

NOTE  If this option is not selected, you must select
the option "Labels Are Fixed (Not Dynamic)" in the
Style Editor, if you want to display labels that are
upside down. See also Styling Label Features (page
452). If you deselect both options "Labels Are Fixed
(Not Dynamic)" and "Preserve Text Readability (Flip
When Necessary)", labels that are upside down
would not be displayed.

In the Orientation section, a circle indicates the label orientation.

Example—Absolute orientation = 100 Gon.
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 The red arrow indicates the label orientation. For absolute
orientation it references the Base Angle = North. For example, select Absolute
and enter 100 Gon to display the labels horizontally. This is the default setting.

Example—Absolute orientation = 0 Gon.

 The red arrow indicates the label orientation. For absolute
orientation it references the Base Angle = North. For example, select Absolute
and enter 0 to display the labels that are aligned with North.

Example—Relative orientation = 100 Gon.

 The black arrow indicates the parent feature orientation. The
red arrow indicates the label orientation. For relative orientation it references
the parent feature orientation. For example, select Relative and enter 100 Gon
to display the labels perpendicular to the parent feature.
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NOTE In Topobase documents the Base Angle is North. In Topobase Client, when
you are prompted to digitize the label orientation, the Base Angle of the drawing
will automatically be set to North, so you can digitize the appropriate value. See
also Map Drawing Units (page 456).

Label Properties: Positioning and Orientation
Use the label positioning and orientation settings to specify the label location
relative to the feature geometry. These settings establish the location of a text
box insertion point with reference to a start, middle, or endpoint of the feature.

Topobase Data Model: Defining label positioning and orientation.

Positioning values specify the location of the text box insertion point, relative
to the feature.

You click the start, middle, or end point on the line to specify a feature
positioning point (reference):
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Topobase Data Model: Defining the feature reference for a label

■ For lines with more than one segment, middle is the middle of the mid
segment or the segment prior to this if the number of segments is even.

■ For points the reference is the point.

■ For polygons the reference is the center.

■

In the Label Properties dialog box, for positioning offset values, select one
of the following:

■ Absolute: Specifies the text box insertion point position relative to true
north and east.

■ Relative: Specifies the text box insertion point position relative to a line
perpendicular to the feature direction.

Enter northing and easting values to specify the offset from the feature
positioning point to the text box insertion point.

■ For example, absolute offset values for the figure above are: approximately
dY = - 1 (easting); dX = 2 (northing).

■ For example, relative offset values for the figure above are:
approximately dY = 0 (easting), dX = 3 (northing).
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Orientation values specify an angle of rotation for the text box. Select one
of the following:

■ Absolute orientation: References to true north. For example, values for the
figure above are: approximately 90 Gon.

■ Relative orientation: References to a line perpendicular to the feature
geometry. For example, values for Figure 22 are approximately 100 Gon.
For points, the value refers to a possible stored orientation.

Label Properties: Alignment
For the Alignment properties, you can specify the location of the text box
insertion point (origin) in relation to the text box. These values are also used
in the Display Manager stylization.

DescriptionAlignment

Specifies the text box insertion point horizontally
related to the text box. Select Right, Center, Left.
Default value is Center.

Horizontal Alignment

Specifies the text box insertion point vertically re-
lated to the text box. Select Bottom, Baseline,
Halfline, Capline, Top. Default value is Halfline.

Vertical Alignment

Alignment, is set to the defaults Center and Halfline
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Example: Positioning a label parallel to a line

■ Feature positioning point: Middle.

■ Horizontal Alignment: Center.

■ Vertical Alignment: Bottom.

With these properties, the text is always positioned in the middle of the line,
regardless of its length.

Topobase Data Model: Defining the label location along a line.

See also:

■ Styling Label Features (page 452)

■ Overview of the Display Manager (page 446)

Label Properties: Scaling
Scale select statements are used to position a label text regarding the scale of
a possible map. A scale select statement can use complete SQL select statements
and returns a numerical value of the scale (for example 500 for 1:500 scale),
which is taken into consideration using relative offset when calculating label
position.

DescriptionScaling (Optional)
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Optionally, defines a scale factor select statement
in order to position the label text relative to the
scale.

Scale Factor (Select Statement)

Opens the SQL Assistant. Optionally, you use the
SQL Assistant to create the scale factor select
statement. See Creating SQL Expressions (page 137).

Assistant button

Label Properties: Label ID
Each label definition has a unique identifier that is generated when you create
a new label definition. It is shown in the title bar of the Label Properties dialog
box, for example Label Properties ID 1000.

NOTE The LABEL_ID is a group identifier that marks label definitions belonging
to the same parent feature class.

For better overview, and to separate common application labels from individual
labels, all labels created with the data model administrator by any user (page
586) have IDs starting with 10000. This is also important for updates. Labels
with IDs less than 10000 can be updated when installing a new Autodesk
Topobase version. Labels with IDs greater than 10000 are not affected by
updates in a newer version.

See also:

■ System Table TB_LABEL_DEF (page 166)

Label Properties: ORIGIN conversion
In previous Topobase versions, the text box insertion point was specified using
a 5x5 point matrix related to the text box. The value was saved in the label
feature class attribute ORIGIN. This attribute is no longer used. The attribute
is replaced by the horizontal and vertical alignment property (3x5 matrix).
The document update automatically converts existing ORIGIN values, as
shown in the following table.

AlignmentORIGIN

Bottom, Left1,2
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Bottom, Center3

Bottom, Right4,5

Baseline, Left6,7

Baseline, Center8

Baseline, Right9,10

Halfline, Left11,12

Halfline, Center13

Halfline, Right14,15

Capline, Left16,17

Capline, Center18

Capline, Right19.20

Top, Left21,22

Top, Center23

Top, Right24,25

Label Select Statements
When you define labels, the select statements are the basic part of the
definition. You can define or edit select statements with the data model
administrator user interface (UI) using the Create Label Definition dialog box
or the Label Properties dialog box. You either type the select statement directly
in the input box, or you use the SQL Assistant to create the SQL expression.
See also Creating SQL Expressions (page 137).

The select statements are saved in TB_LABEL_DEF.SELECT_STATEMENT.

The data model administrator uses the following default select statement to
return a feature identifier (FID).

select FID from <table name> where FID = $id
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This select statement can be changed or extended, for example, using static
commentaries, additional queries, formats and so on.

In the following expression, the f is the alias for the feature class table (that
is the f behind the table name, separated by a blank).

select f.fid from <table name> f where f.fid = $id

It is important, that each select statement must contain the placeholder $id.
During label creation, this term is replaced by the FID of the parent feature,
whose attribute data is to be displayed.

The following example from the Land demo data set extends the default select:

„select 'Point number: '|| f.name_number||'Orientation: '||round

(f.orientation,2) from LM_POINT f where f.fid = $id“

Examples of useful SQL additions:

■ Commentary text (with apostrophes)

■ Query the point number (f.name_number)

■ Query the orientation (f.orientation)

■ SQL conform formatting command (round, n, m)

When defining select statements, note the following definition rules:

Definition Rules for Label Select StatementsNo.

Static words or formats must be entered with apostrophes ' ' and
separated by two pipe signs || from one another and from column
names.

1

You can use SQL formatting statements, such as TRUNC, or ROUND.
See also Label Formatting With SQL (page 238).

2

If an alias is defined, it must be used. Otherwise, this selection
cannot be performed.

3

For label definitions that use numerical fields: if there is no record
(NULL), do not write "0" when used, for example:

4

decode (year),Null,'',Year

The expression $s suppresses a description when repeated.5
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If a selection provides several records with repeating data, for ex-
ample, a manhole name when selecting inlets, the '$s' command
immediately after the field name suppresses description repetition.

Label Formatting With SQL
You can use SQL conform format statements such as ROUND and TRUNC.

Examples:

... select round (area,0) from ...

... select round (area,2) from ...

... select trunc (area,-2) from ...

Label Geometry Select Statements
Geometry select statements are used to define auto labels for attribute feature
classes. Since attribute features do not have geometry, you can use a geometry
select statement to query the geometry of the parent feature.

The Topobase utility applications use geometry select statements to generate
auto labels for the network objects. Example:

SELECT FID, GEOM FROM WA_LINE WHERE FID_ATTR = ?

If you create a label definition, the sample geometry select statement is:

select FID, GEOM from [parent] where FID = ?

Note, that every geometry select statement has to be finished by the expression
"..where FID = ?)".

See also:

■ To define a label for a utility objectlabel definition:inscribing utility
attributesYou can define l... (page 251)

Sample Labels
Example—To inscribe the area of a polygon feature class, such as
LM_BUILDING.
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Modify the select statement as follows:

select round (f.area,2) from LM_BUILDING f where f.fid = $id

After the “SELECT”, you must specify the column <area>, which contains the
data that you want to inscribe. You can use SQL format commands as "ROUND"
to specify the number of digits as in the example above. Separator is a ",".
Note, that you can use the character following the table name <LM_BUILDING
f> as an alias in the SQL statement.

Example—To inscribe the building type, which is saved in a related domain
table, you must include this table and relate it to a WHERE clause.

select u.value from LM_BUILDING f, LM_BUILDING_TYPE_TBD u where f.id_type =
u.id and f.fid = $id

When you save the label definition, the syntax of the SQL statement is checked.
When you use the SQL Assistant, you can execute and check the SQL statement
at any stage of the definition.

If you execute the SQL statement separately, delete the "f.fid=$id" at the end
of the statement.

In case you make any modifications to a select statement, you can update the
existing label text:

■ In the data model explorer, select the label feature class.

■ Right-click and click Update Label Texts

Working with Complex Labels
In a label definition select statement, you can use the CONCAT_LIST function
to define multiline labels, such as in the gas demo data set.

To define a multiline label

1 Start Topobase Administrator and open a workspace that contains the
gas data model.

2 In the data model explorer, under the topic Pipe, select the feature class
Pipe Label.

3 Right-click and select Create Label.

Label Select Statements | 239



4 In the Label Properties dialog box, under Content To Display (Select
Statement), enter the following select statement:

select concat_list(CURSOR(

select 'Value: '||c.value||'\n'

||'Diameter: '||a.DIAMETER_NOMINAL||'\n'

||'Date of Installation: '||to_char(a.date_installation,'YYYY')

from ga_pipe a, ga_material_tbd c

where a.ID_MATERIAL = c.id and a.FID = $id

))myCursor from dual

Label Commands

DescriptionShortcut Menu
Label Item

Updates the label texts in the drawing after you
change a label definition or the corresponding attrib-

Update Label Texts

ute in feature tables. Updates the LABEL_TEXT attrib-
ute of the label feature class tables (***_TBL.LA-
BEL_TEXT) by performing the select statements again.
This command can be performed for all label texts,

either in the current document (page 581) or in a
topic or in a feature class. This depends on the tree
view level from which you start the command.

Creating a Label Definition
In this tutorial you will create a label feature class, a label definition and add
the new label feature class to the document explorer.

Labels display the attribute data associated with features in maps, and generate
text elements.
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The following example demonstrates point number labels in a map, using
data stored in a parent feature class.

Labels are stored in a special feature class type,
Label Feature Class.

-----Create label feature class (page 241)

Specify the text to inscribe.-----Create label definition (page 242)

Make the label feature class accessible.-----
(page 243)Add label feature class to
document explorer

Use Topobase Client.-----Create label (page 243)

To create a label feature class (Topobase Administrator)

1 Start Topobase Administrator and open the workspace.

2 In the Administrator explorer select the document and click Document
menu ➤ Data Model. The data model explorer is shown.

3 If possible, expand the feature class and see whether a label feature class
exists. If so, you can go to step 7. A feature class can only have one label
feature class. If no label feature class exists, you can create one.

4 Right-click the parent feature class and click Create Feature Class.

5 Enter a name, caption, and for feature class type select Label. Click OK.
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NOTE In Topobase Client, in the Display Manager, only label feature classes
with the name extension _TBL can be used as Annotation Layers. See also
Styling Label Features (page 452).

6 The label feature class is displayed in the data model explorer.

7 Right click the label feature class and click Create Label Definition.

Defining a label for point numbers

To create a label definition (Topobase Administrator)

1 In the Label Properties dialog box, specify the text. In the sample select
statement, the label text is the value of the attribute NAME_NUMBER of
the parent feature class LM_POINT.

2 Click OK to save the label definition. A label item is displayed in the data
model explorer. The select statement is displayed in the right pane.
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3 To define more label definitions, right-click the label feature class and
click Create Label Definition.

4 Define the properties in the Label Properties dialog box. For example,
use the default select statement. Click OK to save the definition.

5 Exit Topobase Administrator.

To add the new label feature class to the document explorer (Topobase
Client).

It the new feature classes are not visible in the document explorer, do the
following.

1 Start Topobase Client and open the workspace.

2 In the Topobase task pane, click  Groups to show the Document
explorer group.

3 Click  , and expand the parent feature class. Select the new label
feature class.

4 Click  again. The new feature class is now displayed.

To create a label (Topobase Client)

1 Click Home tab ➤ Display panel ➤ Generate Graphic.
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2 In the drawing, select some points belonging to the parent feature class.

3 Click Home tab ➤  Quick Access panel ➤  Attributes to
open the feature class form.

4 On the form toolbar, click  .

5 In the Choose Label Definition dialog box select the label definition and
click OK.

NOTE The Choose Label Definition dialog box is not displayed if there is only one
label definition. When you create a label, it is generated immediately. In some
cases, the AutoCAD command line might prompt you to click the label position.

For stylization with the Display Manager, make sure that you have established
an FDO connection to the new label feature class.

See also:

■ Using the Display Manager with Autodesk Topobase (page 447)

■ Styling Label Features (page 452)

Data Model: Utility Model

Overview of the Utility Model
The Topobase utility model provides basic utility network components, which
are used in the utility applications, such as Water, Gas and Wastewater. It
splits the network geometry (connectivity) from the attribute data.

The utility network consists of nodes and edges that represent the connectivity.
The utility model stores this network in one point feature class (nodes) and
one line string feature class (edges) and relates the geometry to the different
utility objects (attribute data). When you create a utility model, you choose
to create the appropriate logical (network) topology at the same time.

Example: In the Water application, the utility node feature class has a
multi-relation to all point attribute feature classes, such as armature, emitter,

244 | Chapter 3   Data Model



vents, meters and so on. The utility edge feature class has a relation to the
line attribute feature class Pipe.

Utility data model: Water node feature class Point with its relations to the object
feature classes; shown in the data model explorer.

This structure is not displayed to the user. However, the user can digitize the
attribute feature because of special utility feature rules. Then the geometry
features are processed.

The concept of separating geometry and attribute storage allows for two
different line splitting methods, soft and hard split. These methods determine
how the system deals with the attribute data of the two resulting features.

■ Soft Split—The line is split into two separate features. Each has its own
geometry, but both use the same attribute data.

■ Hard Split—The line is split into two separate features. Both have their
own geometry and both have their own attribute data.

For more information about the utility applications refer to the respective
Topobase Application Guides, such as the Topobase Water User Guide.

See also:

■ Logical Topology Introduction (page 326)
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Utility Data Model
A Topobase Utility data model consists of nodes and edges that are stored in
two geometry feature classes and attribute data that is stored in attribute
feature classes. Each utility feature is described by a geometry feature, which
has no specific attributes (and should not be enhanced) and its related attribute
features. This means that the node type is determined by the related attribute
feature.

The two geometry feature classes consist of the following:

■ Utility edges—One utility edge feature class stores all network lines. Every
edge has a relation to its related attribute feature.

■ Utility nodes—One utility node feature class stores all network points.
Every node has a relation to its related attribute feature.
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Utility Feature Rules
The Topobase utility feature rules are used to keep the database consistent.
You can view and edit the applied feature rules in the data model explorer.

For more information about the utility feature rules, see the Topobase Feature
Rule Reference, section Utility Feature Rules.

To view the feature rules

1 Start the data model administrator.

2 In data model explorer, select the feature class, such as Pipe in the Water
application.
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3 Right-click and click Edit Feature Rules.

4 Click the Client Side (.Net) tab.

Creating a Utility Model
Use the Topobase data model administrator to create and edit utility data
models. The Create Utility Model command creates the relation between the
geometry and the attribute feature classes and adds utility system attributes.

DescriptionShortcut Menu
Utility Item

Creates a utility model (network).Create Utility Model
The concept is to separate the infrastructure from net-
works.
See also Overview of the Utility Model (page 244).

Requirements

■ Attribute feature classes for the utility point and line objects, such as water
house connectors and armatures

■ Point feature class for the nodes (geometry)

■ Line string feature class for the edges (geometry)

■ Logical topology, see Utility Topology Properties (page 319).

These components can be created during the Create Utility model process, as
shown in the following table:

DescriptionCreate Utility Model Dialog
Box

General settings for the utility modelGeneral area

Specifies a name for the utility model.Name

Specifies the utility feature classes. Use the tabs
to select the feature classes that store the network
geometry.

Feature Classes area
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Specifies the point feature class that stores the
nodes.

Point tab

Specifies the line string feature class that stores
the edges.

Line String tab

Specifies the attribute feature classes that store
the utility objects (attribute data). Select one or
more.

Attribute Feature Classes

Creates a new feature class. Opens the Create
Feature Class dialog box, where you can create a
new feature class. Default names are

Create New <…> Feature Class

<model name>_POINT
<model name>_LINE

Specifies a logical topology.Logical Topology area

Lists all logical topologies in which the selected
geometry feature classes participate.
See also Logical Topology Introduction (page 326).

Topology

Creates a logical topology with the geometry
features. Opens the Logical Topology dialog box,

Create New Logical Topology

where you can define a new topology. Default
name is <model name> with the connectivity table
<model name>_CONN.

Creates the model. This button is only active if all
necessary entries are made.

OK

In addition to the default attributes, the utility node and utility edge feature
classes have some system attributes, as shown in the following table:

DescriptionAttributes of Node and
Edge Feature Classes

Utility edge and node feature class (network geo-
metry)

Foreign key: indicates the related attribute feature class;
TB_DICTIONARY.F_CLASS_ID

F_CLASS_ID_ATTR
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Foreign key: indicates the related attribute featureFID_ATTR

Utility edge feature class (network geometry)

Defines the appearance in the drawing (only lines)UTILITY_INFO

Do not add more customer attributes because these tables are processed
automatically.

NOTE The foreign key to the attribute tables is defined as multi relation. With this
we can relate one geometry feature class to several attribute feature classes.
Example: A water point feature can be related to either of the point attribute
feature classes: armature, valve, hydrant.

To create a simple utility data model

1 Start Topobase Administrator.

2 Open the workspace (page 586) that contains the document (page 581).

3 In the administrator explorer, in the left pane select the document.

4 Click Document menu ➤ Data Model.

5 Create two feature classes to hold the geometries:

One feature class of type line string and one of type point.

6 Create attribute feature classes to hold the data. They can be in the same
topic as the geometries or in different topics.

7 Select the Utilities item. Right-click and click Create Utility Model.

8 Enter a name, such as Gas.

9 Select a point feature class and the matching attribute feature classes,
such as Gas_point and Armature, Filter, Siphon.

10 Select a line feature class and the matching attribute feature classes, such
as Gas_line and Pipe.

11 Select a logical topology. If no topology is available, click the Create New
Logical Topology link and click OK in the Logical Topology dialog box.

12 Click OK to create the utility model.

13 Initialize the newly created topology. In the data model administrator,
select the topology, right-click and click Initialize Topology.
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14 Define tracing conditions. In the data model administrator, expand the
topology, and select Conditions. Right-click and click Create Condition.
See also Defining Tracing Conditions (page 331)

15 Define a tracing template. the data model administrator, expand the
topology, and select Tracing Templates. Right-click and click Create
Tracing Templates. See also Logical Topology: Tracing Templates (page
329)

To define a label for a utility object

You can define labels to inscribe the attribute data of the network objects.
Notice, that in the utility model, a network object itself has no geometry, but
is related to a geometry feature class (node or edge).

To place label texts using the auto label function, you must define the labels
using a geometry select.

1 Start Topobase Administrator and open the workspace.

2 In the administrator explorer, select the document.

3 Click Document menu ➤ Data Model.

4 In the data model explorer, select the network feature, for example Pipe.

5 Select the label feature class. Right-click and click Create Label Definition.

Set the following label properties:

DescriptionProperty

This select statement queries the FID. Ex-
ample: Select FID from GAS_PIPE

where FID = $id

Content To Display (Select Statement)

This select statement queries the geometry
of the related feature (FID) that has been

Parent Geometry (Select Statement)

found by the select statement above. Ex-
ample: Select FID, GEOM from

GAS_LINE where FID_ATTR = ?

Select Automatically Create Label When
Feature Is Created.

Label Information

Select Label Is Active.
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DescriptionProperty

Select Preserve Text Readability.Orientation

See also:

■ Label Select Statements (page 236)

Data Model: Dimensioning
Topobase provides special feature classes to store dimensioning in the database.
A dimensioning consists of several related feature classes. A dimensioning
feature class (parent attribute feature class) is related to several child feature
classes that store the geometry components, such as points (symbols) and
lines, and labels.

The default topic Dimension contains two dimensioning feature classes,
Aligned Dimension, and Orthogonal Dimension. Dimensioning either uses
the calculated dimension or the measured dimension.

See also About Aligned Dimensioning (page 253).

See also About Orthogonal Dimensioning (page 255).

Use the Document Settings to add the dimensioning feature classes to any
document. See also To add the Dimensioning extension to the documentIn
the Document Settings, on the navigation pane, c... (page 70).

We recommend that you use the Dimension Extension, and the default
dimension feature classes. Optionally, you can create dimensioning feature
classes manually in the data model administrator.

NOTE Autodesk provides a display model for the Dimension extension. Copy the
files from <default display model repository>\Extensions\Dimension\ to your
display model repository. See also Working with Display Models (page 429).
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Topobase Data Model: Dimensioning feature classes. The dimension parent feature
class is related to the geometry feature classes, Dimension Point Child and Dimension
Line Child.

See also:

■ Document Settings (page 69)

■ Feature Class Type: Dimension (page 203)

About Aligned Dimensioning
Topobase provides several types of aligned dimensioning. Depending on the
dimensioning type, the system uses the LINE_TYPE attribute and the
POINT_TYPE attribute to distinguish the points and lines. In the display
models, you use these attributes to stylize the dimensioning layers.
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Topobase Data Model: Components of an aligned dimension.

An aligned dimensioning consists of points and lines, as shown in the
following table.

DescriptionAligned Dimensioning
type

Default aligned dimensioning including lines and labels.
Consists of:

AC = Aligned Complete

■ Line of type AL: abscissa.

■ Lines of type HL: ordinate help lines.

■ Point of type S: start point of abscissa.

■ Point of type E: end point of abscissa.

Aligned dimensioning where only the abscissa is drawn,
but no ordinate lines. Consists of:

AA = Aligned Abscissa
Only

■ Line of type AL: abscissa.

■ Lines of type HL_: ordinate help lines. Notice the
special line type. In the Display Manager, use the
line type HL_ to hide this helper line in the drawing.

■ Point of type S: start point of abscissa.
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■ Point of type E: end point of abscissa.

Aligned dimensioning where only the label is, but no
abscissa, and no ordinate lines. For example, to display

Aligned Text Only

the length of a building edge in the drawing without
any lines. Consists of:

■ Line of type AL_: abscissa. Notice the special line
type. In the Display Manager, use the line type AL_
to hide the abscissa in the drawing.

■ Point of type S: start point of abscissa.

■ Point of type E: end point of abscissa.

NOTE In the document options you can specify a constant offset value. See To
set COGO and dimensioning optionsCOGO features:delete temporary -construction
features:delete tem... (page 129).

About Orthogonal Dimensioning
Topobase provides several types of orthogonal dimensioning. Depending on
the dimensioning type, the system uses the LINE_TYPE attribute and the
POINT_TYPE attribute to distinguish the points and lines. In the display
models, you use these attributes to stylize the dimensioning layers.

For example, if the abscissa has been extended, because an orthogonal point
is located behind the end point of the abscissa, the line is of type OAE, and
you can style the line as a dashed line.
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Topobase Data Model: Components of an orthogonal dimension.

An orthogonal dimensioning consists of points and lines, as shown in the
following table.

DescriptionOrthogonal Dimension-
ing type

Default orthogonal dimensioning including lines and
labels. Consists of:

OC = Orthogonal Com-
plete

■ Line of type OA = orthogonal abscissa.

■ Lines of type OAE: Orthogonal Abscissa extension.
Only if an ordinate lies behind the abscissa start or
end point.

■ Point of type AS = start point of abscissa.
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■ Point of type AE = end point of abscissa.

■ Multiple lines of type OO: ordinates.

■ For each ordinate: point of type OS: start point of
ordinate.

■ For each ordinate: point of type OE: end point of
ordinate.

Orthogonal Dimensioning based on the extension of a
baseline. For example, you use the edge of a building
as abscissa. Consists of:

OE = Orthogonal Exten-
sion Baseline

■ Line of type OAB = orthogonal abscissa.

■ Lines of type OAE: Orthogonal Abscissa extension.
Only if an ordinate lies behind the abscissa start or
end point.

■ Point of type AS = start point of abscissa.

■ Point of type AE_ = end point of abscissa. Notice
the special line type. In the Display Manager, use
the line type AE_ to hide the end point in the
drawing.

■ Multiple lines of type OO: ordinates.

■ For each ordinate: point of type OS: start point of
ordinate.

■ For each ordinate: point of type OE: end point of
ordinate.

Both OC and OE dimensioning support embedded feature dimensioning. An
embedded feature is a line that intersects the orthogonal abscissa. The
intersection point can be embedded as any other orthogonal point.
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Components of an orthogonal baseline dimension, and an embedded dimension.

Creating and Applying Dimensioning
In this tutorial you will, acting as a Topobase database administrator, add the
dimensioning feature classes. Then, as a user, you will create and delete
dimensions.

Dimensioning must be prepared by the database administrator, who adds the
Dimension Extension to the database. Users can then create dimensions in
Topobase Client.

To add the Dimension Extension (Topobase Administrator)

1 Start Topobase Administrator and open a workspace.

2 In the Administrator explorer, select the document.

3 On the right pane, under Document Settings, on the navigation pane,
click the Extensions link.

4 Select Dimension Extension.
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5 Click Save to add the topic Dimension. This topic groups dimensioning
feature classes for aligned dimensioning and orthogonal dimensioning,
and the label definitions.

The label definitions are used to inscribe the dimension values. The values
are stored in the dimension line feature class (CALCULATED_x and
MEASURED_x). The label definitions use the LINE_TYPE attribute , and
the POINT_TYPE attribute to distinguish between the dimensioning types.

6 Make sure that the Dimensioning feature classes are added to the
document explorer.

7 Define the stylization of the dimensioning layers in the Display Model.

To create dimensions (Topobase Client)

1 Start Topobase Client, open a workspace and generate graphic.

2 See Adding Dimensions.

To delete dimensions (Topobase Client)

A dimensioning consists of several features. You can either delete each feature
on its own or delete all related features.

To select all related features, select the abscissa. To select a single feature, select

the feature, such as the ordinate. Click  Delete Feature.

Data Model: Feature Templates
To work with templates, you must add the Template extension to the
document. See To add the Templates ExtensionIn the Document Settings, on
the navigation pane, click the Extensions... (page 71).

The Template extension adds a topic Template that contains the template
system tables TB_FEATURE_GROUP and TB_FEATURE_GROUP_FEATURE.

You use feature templates to efficiently create recurrent arrangements of
features. A template comprises geometry, attributes, labels and internal
connectivity. Also, you can define templates for different types of equipment
that vary in their attribute values (reference records).

You define a template by selecting existing features in a drawing, for example
prototype features. After having created the template, you can delete the
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prototype features. Templates are defined in a local coordinate system. When
you instantiate a template in the map, you digitize the origin and specify an
orientation.

Optionally a template can be grouped. Then, when you move or rotate a
feature of the group, the group is treated as a unit and all other features are
moved or rotated the same way.

See also:

■ Working with Templates

Data Model: Compounds
A compound is a feature class type that consists of a logical group of feature
classes, which include a parent and a child feature class.

Compounds are used for polygon or line string objects where particular line
segments can have different attributes. Therefore a compound represents a
group of line segments as one object. For example, several child line segments
are combined as a parent polyline or several child line segments are combined
as parent polygon.
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Topobase Data Model: Compound feature classes

When you digitize features of a compound feature class, you digitize the child
line strings, and the parent polygon is generated.

See also:

■ Feature Class Type: Compound Polygon (page 201)

■ Feature Class Type: Compound Line String (page 202)

Compound Triggers
When a compound child is created, triggers perform the automatic generation
of the compound parent features. For this action, triggers do the following:

■ Create the parent feature.

■ Calculate the polygon area (if closed).

■ Calculate the length of the polyline.
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Triggers can be enabled or disabled for any reason. You can start compound
trigger commands in the data model administrator either from the document
(page 581) or from the feature class level.

Compound Commands
You can start the compound commands in the data model administrator
either from the document (page 581) or from the feature class level. See
Exploring Data Model Administrator (page 185).

Convert to a Compound

You can convert a line string or polygon feature class into a compound feature
class. The existing line string or polygon feature class is the parent feature
class and a new child feature class is created. All attributes of the existing
parent class are maintained.

Topobase Data Model: Converting a feature class to a Compound.

Eliminate a Compound

You can convert a compound feature class into a line string or polygon feature
class. The parent feature class persists, but the child feature class (single
segment) and all subordinate feature classes are dropped.
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Build Compounds

You can build compounds to combine the data of two related feature classes.
This can be useful if you are migrating data from a foreign system to Topobase.
Example:

You can build a compound by combining the following:

■ Parent feature class with all attribute data, but no geometry.

■ Child feature class with a relation to parent feature class, no attribute data,
but with geometry, such as line strings.

You use the Build Compound command to save the line string geometry of
the related children for each parent and thus build a compound polygon
feature class.

Data Model: Topologies
You can create and edit topologies in the Topobase data model administrator.
To work on a document’s topology (page 586), you must open the corresponding
document. In the data model explorer, expand the Topology node and
right-click the topology you want to work on.

DescriptionShortcut Menu
Topology Item

Initializes the topology.Initialize Topology
See Area Topology Initialization (page 324).
See Logical Topology Initialization (page 335).
Normally you start the initialization after the creation of
the topology, and when a huge number of topology
enabled features is stored in the database. Then the ini-
tialization creates the corresponding secondary objects,
such as areas, and stores the connectivity.

Clears a topology. You can empty the topology system
tables, and then initialize the topology again.

Clear Topology

Drops the topology definition and tables.Drop Topology

Displays the topology properties.Properties
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See also:

■ Topology Introduction (page 311)

Data Model: Schematics
Topobase supports multiple locations (representations). You can visualize a
feature in different locations, and store the geometries in the database. For
generalization, you can digitize features with multiple locations. Also, Topobase
maintains consistency, when you update or delete features with multiple
locations.

Topobase supports two types of multiple locations.

Schema Plan

A schema plan represents real world features by transforming the original
feature geometry to an alternative location, for example by applying a
coordinate offset. For example, you create geoschematic or orthogonal schema
plans to represent an electric network.

For example, use a geoschematic plan to create a georeferenced cable map for
electric utilities that is derived from pathway geometry.

Generalization

Generalization provides a set of generalization feature classes that can be used
to digitize secondary features at one or more alternative location. For example,
you displace features to create an alternative representation for an overview
map with a scale bigger than 1:10'000.

To create a representation template, start the Topobase data model
administrator. Right-click the Representations node and click a command.

DescriptionShortcut Menu Represent-
ations node

Creates a schema plan template. See also Creating a
Schema Plan Template (page 265).

Create Schematic

Creates generalization feature classes. See also Creating
a Generalization (page 272).

Create Generalization
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To view available representations, click the Representations node. Each
representation type is indicated by a special icon.

■  —Geoschematic diagram

■  —Orthogonal diagram

■  —Generalization

Getting Schematics Started

Use Topobase Administrator to

■ Create schematics feature classes.

■ Create schema plan templates. See Creating a Schema Plan Template (page
265).

■ Create generalization feature classes.

Use Topobase Client to

■ Select the schema plan template.

■ Select the features and build a schema plan, that means to create the
schematic features.

■ Digitize generalization features, using the generalization feature classes.

Building a schema plan means deriving new geometries from existing
geometries based on their existing logical connectivity, and based on the
defined rules.

Creating a Schema Plan Template
The Create Schematics command creates the schema plan template that
comprises the schematic feature classes, and rules how to derive the schematic
features from the real world features.
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To create a schema plan template

1 Start Topobase data model administrator.

2 Expand the document node.

3 Right-click the Representations node, and click Create Schematics.

4 Specify the properties as shown in the following table.

5 Click Create.

DescriptionCreate Schematics

Specifies general settings.General area

Specifies the name. This name will be displayed in To-
pobase Client, when you select the representation.

Schema Plan Name

Specifies the type of schema plan. Select eitherSchema Plan Type

■ Orthogonal

■ Geoschematic

The type of schema plan specifies the rules that apply
when you create the schematic features.

Selects the topology to be associated to the schema.
When you create the schematic features, the topology

Topology

is used to determine the connectivity of the real world
features.
The list displays all logical topologies of the document.

Specifies a point feature class to store the schematic
point features. Either select an existing point feature

Schema Point Feature Class

class from the list, or click Create New to create a new
feature class.

Specifies a line string feature class to store the schem-
atic line features. Either select an existing line string

Schema Line Feature Class

feature class from the list, or click Create New to create
a new feature class.

Specifies the rules to create the schematic features.
Click Details to display a description of the settings.

Settings area
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Some settings only apply to particular types of schema
plans.

Applies to Orthogonal schema plans.Direction Priority
Specifies the priority of the direction in which the
schematic features are drawn. See Schema Plan Settings
(page 268).

■ Horizontal

■ Vertical

■ Left

■ Right

Applies to orthogonal and geoschematic schema plans
in the Electric CE module.

Multiline Distribution

See Multiline Offset and Distribution (Electric CE) (page
270).

Applies to orthogonal and geoschematic schema plans
in the Electric CE module.

Multiline Offset

See Multiline Offset and Distribution (Electric CE) (page
270).

Applies to orthogonal and geoschematic schema plans
in the Electric CE module.

Sort Order

See Sort Order (page 270).

Schematic features can be point or line features. They are stored in two feature
classes.

■ Point location feature class—Point feature class.

■ Line location feature class—Line string feature class.

When you create the schema plan template, a new item is added under the
Representation node. Click the schema plan to view the properties in the right
pane.

Creating a Schema Plan Template | 267



Schema Plan Settings
Depending on the schema plan type, and depending on the module, in the
Create Schematic dialog box, you specify additional settings. The Settings area
only displays the settings that are valid for the selected schema plan type.

Direction Priority

For orthogonal schema plans, specifies the priority of the direction in which
the schematic features are drawn.
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The direction of the lines between two points is derived from the FID. For
example, a line will be created from FID 1 to FID 2, either starting vertically,
horizontally, drawing the line left to the real world feature, or drawing the
line right to the real world feature.
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Multiline Offset and Distribution (Electric CE)

In the Topobase Electric CE data model, you can specify the multiline offset
and distribution, both for orthogonal and geoschematic plans.

■ Multiline Offset— Specifies the offset distance between overlapping
multiline conductor features and the parent single line feature. The offset
line is drawn in parallel to the original feature. The offset is the distance
between the parallel features. Unit is the document length unit.

■ Multiline Distribution—Specifies the distribution of multiline conductor
features around the parent line feature. Can be either

■ Symmetric

■ Left

■ Right

The left or right distribution direction is defined by the FID.

Sort Order

Specifies the order in which parallel conductors are drawn. Can either be Most
Common Segments First or Least Common Segments First. For example, the
conductors having the most segments in common should be drawn in the
middle.
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Use cases for Real World segments (1) represented in a schematic view.

■ (2) uses the option Most Common Segments First.

■ (3) uses the option Least Common Segments First.

For example, use the option Least Common Segments First (3), if the start and
endpoints of the conductors are all on the main line.
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Editing a Schema Plan Template
In the data model explorer, use the shortcut menus to edit a schema plan
template.

To edit a schema plan template

1 In the data model explorer, expand the Representation node, and select
the schema plan.

2 Right-click, and click one of the following commands.

DescriptionSchema plan shortcut
menu

Opens the Create Schema dialog box. You can modify
the name and the settings. You cannot modify the
feature classes and the topology.

Edit Schema

Deletes all associated schematic features, but preserves
the schema plan template.

Empty Schema

Deletes the schema plan template. Optionally you can
also delete all associated schematic features, and the
schematic feature classes.

Drop Schema

Creating a Generalization
The Create Generalization command creates generalization feature classes for
different types of geometry.

To create a generalization

1 Start Topobase data model administrator.

2 Expand the document node.

3 Right-click the Representations node, and click Create Generalization.

4 Specify the properties as shown in the following table.
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5 Click Create.

DescriptionCreate Generalization

Specifies the name. This name will be displayed in To-
pobase Client on the Home tab, in the Data Source
panel, when you select the representation.

Generalization Name

Specifies a point feature class to store the generalization
features. Either select an existing feature class from the
list, or click Create New to create a new feature class.

Generalization Point Fea-
ture Class

Specifies a line string feature class to store the general-
ization features. Either select an existing feature class

Generalization Line Feature
Class

from the list, or click Create New to create a new fea-
ture class.

Specifies a polygon feature class to store the generaliz-
ation features. Either select an existing feature class

Generalization Polygon
Feature Class

from the list, or click Create New to create a new fea-
ture class.

Specifies a collection feature class to store the general-
ization features. Either select an existing feature class

Generalization Collection
Feature Class

from the list, or click Create New to create a new fea-
ture class.
Use a collection feature class to store features of any
geometry type.

Editing a Generalization
In the data model explorer, use the shortcut menus to edit a generalization.

To edit a generalization

1 In the data model explorer, expand the Representation node, and select
the generalization.
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2 Right-click, and click one of the following commands.

DescriptionGeneralization shortcut
menu

Opens the Create Generalization dialog box. You can
modify the name.

Edit Generalization

Deletes all generalization features, but preserves the
generalization feature classes.

Empty Generalization

Deletes the generalization, including the generalization
features. Optionally you can also delete all generaliza-
tion feature classes.

Drop Generalization

Data Model: Intersections
Use the Topobase intersection routines to calculate intersections between two
feature classes. Intersections can be defined in the Topobase data model
administrator and added to the document (page 581) in the Topobase task pane.

Examples: An intersection of the parcel feature class with the land use feature
class determines the polygon sections of different land use for each parcel.

An intersection of the parcel feature class with the control point feature class
determines all parcels where a control point is located.

NOTE You can execute intersections between 3D feature classes, or between a
2D and a 3D feature class. See also Intersections: Setting up 2D / 3D Intersections
(page 281).

The following table shows the different types of intersections:

DescriptionIntersection Type

Polygon with polygon

 OO
Result: polygon feature class

Polygon with line

 OL
Result: line string feature class
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Line with line

 LL
Result: point feature class

Polygon with pointOP
Result: point feature class

Line with point

 LP
Result: point feature class

An intersection requires a primary and a secondary feature class. These feature
classes can be identical. Therefore, for example, you can compare parcel areas
before and after a modification.

Intersection feature class—The results of intersections are stored in the database
in special target feature classes. Each intersection type has its own target feature
class with certain default attributes. The intersection feature class is either
created when the intersection is defined, or it is created explicitly by the user.

Intersections can be performed with a job, or without a job:

Intersection within a job—If the intersection is part of a job, the performance
is dependent on the job change state of the feature class.

Intersection without jobs—In this case, you can start the process manually
from the intersection shortcut menu.

NOTE The intersection feature class is not job-enabled due to dependencies
between topics, if the primary and secondary feature classes are not in the same
topic.

Creating an Intersection

To create an intersection

1 Start the data model administrator.

2 Right-click the Intersection root item and click Create Intersection.
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3 In the Create Intersection dialog box, specify the properties, as shown in
the following table:

DescriptionCreate Intersection Dialog
Box Properties

Definition

Specifies the intersection name. The definition of
the intersections are saved in the database and can
be identified by this name.

Intersection Name

Specifies the caption that is displayed in the UI.Intersection Caption

Specifies the name of the intersection feature class
that stores the intersection results. For each intersec-

Feature Class Name

tion, the system creates a feature class corresponding
to the intersection type.

Specifies the caption that is displayed in the UI.Feature Class Caption

Specifies the job state when the intersection is ex-
ecuted, such as Pending, or Open.

Execute The Intersection
When New Job State Is

Select this option to store the intersection geo-
metry.By default, the resulting geometry is not
saved.

Store Geometry

Primary Feature Class area

Specifies the name of feature class. Select an avail-
able valid feature class in the list box. At the moment

Primary Feature Class

valid feature classes are line string and polygon fea-
ture classes.

Where Clause Of Primary
Feature Class

Opens the SQL Assistant. Optionally, you use the
SQL Assistant to create the WHERE Clause. See Cre-
ating SQL Expressions (page 137).

Assistant button
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Specifies the values from other tables to be stored
in the intersection feature class. These values can be

Update The Values Of
Primary Feature Class

used for reports, which is much faster than making
a view and joining the information from other tables
and the intersection result in the view.

Job used to get data from DB. If “JOBID” is “0”, the
currently selected job is used.

Use This Job

Secondary Feature Class
area

Specifies the name of the feature class. Select an
available valid feature class in the list box.

Secondary Feature Class

Where Clause For Secondary
Feature Class

Opens the SQL Assistant. Optionally, you use the
SQL Assistant to create the WHERE Clause. See Cre-
ating SQL Expressions (page 137).

Assistant button

Specifies the values from other tables to be stored
in the intersection feature class. These values can be

Update the Values Of Second-
ary Feature Class

used for reports, which is much faster than making
a view and joining the information from other tables
and the intersection result in the view.

Specifies the job used to get the data from DB. If
“JOBID” is “0”, the currently selected job is used

Use This Job

NOTE These settings are for intersections of two
polygon feature classes only.

Adjustment area

See Intersections: Adjustment (page 278).

Performs an adjustment. Edit the following settings:Adjust Area_Nominal

Defines a WHERE clause that filters the features to
be adjusted. Example: s.area>100. s is the alias
for the secondary feature class.

Use Only Specified Features
For Adjustment (Where
Clause)

See Intersections: Adjustment (page 278).Tolerance Area_Nominal
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If the result is a polygon, defines a tolerance to clean
up the resulting polygon. If two neighboring points

Tolerance [m] For Intersec-
tion

lie within this tolerance, one point will be removed.
If the pitch of an arc is less than this tolerance, the
arc will be linearized.

Specifies a buffer for the inside selection of the
primary feature class.

Buffer

To find the primary features, all features INSIDE the
perimeter are returned.

The values are stored in the system table TB_INTERSECTION.

See also:

■ System Table TB_INTERSECTION (page 157)

Intersections: Adjustment
When you intersect two polygon feature classes, the sum of all resulting
intersection areas (AREA_NOMINAL) should be equal to the area of the primary
feature class. To achieve this, you can perform an adjustment of areas.

The adjustment function calculates the difference between one area of the
primary feature class and the related sum of areas of the intersection feature
class. Then, the function distributes the difference to the largest resulting area
of the intersection feature class.

Example—The difference between the sum of the intersection area_nominal
(234) and the area_nominal of the primary feature (235) is greater than the
Tolerance Area Nominal. Then, the difference of 1 must be distributed to the
intersection area_nominal.

The distribution is executed twice. The first distribution is executed only for
the features that have not been excluded using the WHERE clause. Then, if
there is still a difference, all features are used for the second distribution.

Example—Intersection between the primary feature class Parcel and the
secondary feature class Landuse. Intersection properties and result areas are
the following:

■ 235 square meter of parcel area

■ 150 square meter of street landuse section
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■ 50 square meter forest land use section

■ 34 square meter grassland.

■ Sum of areas is 234, which is < parcel area.

■ Difference to be distributed = 1

■ Tolerance Area Nominal = 0.5

■ Use Only Specified Features For Adjustment (Where Clause) = s.type !=
1(streets)

In the example the difference must be distributed. Without the WHERE clause
it would be added to the largest area of intersection, which is street. With the
WHERE clause you exclude the streets from the adjustment. Then, the
difference is added to the area of the forest section, because this is the second
largest area. If the parcel has only streets sections, the first distribution can
not be applied. In the second distribution all features will be considered, and
the difference is added to the intersection area_nominal of the largest street
section on the parcel.

See also:

■ System Table TB_INTERSECTION (page 157)

Intersections: Getting Started
To work with intersections, you must have the following:

■ Intersection definition (in the data model administrator).

■ Intersection feature classes and intersections to be shown in the document
explorer in the Topobase task pane

You can start a predefined intersection manually. Use the predefined
intersections for frequent intersections. To start an intersection in the Topobase
data model administrator, right-click the intersection item and click Intersect.

Alternatively, in the Topobase Client or Web task pane, in the document
explorer, right-click the Intersection node and click Intersect. You can either
intersect the whole area or select the areas of the primary feature class.
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To start an intersection from the document explorer

1 In the document explorer, expand the Intersection node and select the
intersection.

2 Right-click and click Intersect.

3 In the Select The Perimeter For The Intersection dialog box, select one of
the following:

Intersect Over Area (select features) and click Select.

Intersect Over All (all features) and click OK.

NOTE When selecting the perimeter in the drawing, we recommend to use an
appropriate Object Snap. For example, to select line features, use OSNAP =
NEAREST.

Also, you can start an intersection and perform temporary and occasional
intersections, by entering the parameters in dialog mode.

To start a temporary intersection

1 Start the data model administrator.

2 In the data model explorer, select the primary feature class. Right-click
and click Intersect With.

3 Select the secondary feature class and double-click.

Under the topic Intersection, the target feature class is created with a name
containing the names of the feature classes.

NOTE If you want to repeat a temporary intersection with the same feature classes,
you must drop the topic of the target feature classes beforehand.

Intersections: Results
The following table describes the target feature class of a polygon –polygon
intersection (OO). The name of the target feature class is specified in the Create
Intersection dialog box. The system creates a topic Intersection with sub topics
<intersection name> for each definition.

DescriptionPolygon—Polygon Intersection
Target Feature Class Column
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Only polygon feature classAREA

AREA_NOMINAL

1 - 4ATTRIBUTE_*

Primary keyFID

Foreign key of primary feature classFID_PRIM

Foreign key of secondary feature classFID_SEC

For more information, see Oracle Spatial Users
Guide and Reference.

GEOM

JOB_ID

Only line string feature classLENGTH

Only point feature classORIENTATION
QUALITY
Z

1 - 3PRIM_*

1 - 3SEC_*

*_TSER feature class: Each target feature class has a related collection feature
class *_TSER. A trigger (feature rule) on the intersection feature class will
validate the new features and copy invalid features to _TSER table.

The perimeter is defined by the selected job or by selection of the user.

Before intersection, all old and invalid features inside the perimeter must be
deleted.

Intersections: Setting up 2D / 3D Intersections
You can execute mixed intersections between a 2D and a 3D feature class. For
example, you intersect a 2D feature class with a view on a 3D feature class.
The intersection is calculated using the 2D coordinates where the Z value is
ignored, and results are stored as 2D geometry, or 3D geometry with Z=0. An
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exception is n intersection in a 3D document, if the secondary feature class
is a point. In that case, the result is the original point with X,X, and Z
coordinates.

To execute mixed intersections, you must set up the intersection feature classes
manually. As a Topobase document can either be 2D or 3D, the 2D and 3D
feature classes are stored in different documents. In the document where you
want to create the intersection (target document), you must create a view to
access the feature class of the source document.

To set up 2D/3D intersections

1 In the target document, create the view.

■ Create a synonym to the feature class in the source document.

■ Grant SELECT on the synonym.

■ Create a view on the synonym.

■ In Topobase Administrator, create a feature class from the view. See
Creating a Feature Class From a View (page 212).

2 Create the intersection. See Creating an Intersection (page 275).

3 If your target document is 2D, set the dimension of the feature class (view)
back to its original value TB_DICTIONARY.DIMENSION = 3. This is
required, because you can only create the intersection if the two feature
classes have the same dimension.

4 Re-open the workspace.

5 Execute the intersection.

NOTE To improve performance in a 3D document, make sure that your primary
feature class is 2D, and your secondary feature class is 3D.

Data Model: Spatial Relationship Settings
Autodesk Topobase applications can analyze spatial relationships. With the
data model administrator, while creating feature classes, you can set spatial
properties to control the spatial behavior during spatial selections.

You can define geographic selections with topology queries or spatial operators.
For example, in Topobase Client in the Advanced Generate Graphic dialog
box, use the Advanced Settings button.
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The SDO_RELATE operator performs both primary and secondary filter
operations, where the mask parameter specifies the topological relation of
interest.

Examples: Spatial Operator SDO_RELATE

Topological relations:

■ SDO_RELATE: spatial operator for evaluation of topological relations.

■ Each spatial object has an interior, boundary, and exterior.

■ The boundary separates interior and exterior.

Oracle Spatial SDO_RELATE operator: Intersection patterns

Names of topological relationships:
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These are the following spatial intersection patterns:

Topological relationshipName

The boundaries and interiors do not intersect.DISJOINT

The boundaries intersect, but the interiors do not
intersect.

TOUCH

The interior of one object intersects the boundary
and interior of the other object, but the two

OVERLAPBDYDISJOINT

boundaries do not intersect. Example: When a
line originates outside a polygon and ends inside
that polygon.

The boundaries and interiors of the two objects
intersect.

OVERLAPBDYINTERSECT

The two objects have the same boundary and
interior.

EQUAL

The interior and boundary of one object is com-
pletely contained in the interior of the other ob-
ject.

CONTAINS

The interior of one object is completely contained
in the interior of the other object, and their
boundaries intersect.

COVERS

The opposite of CONTAINS. A INSIDE B implies
that B CONTAINS A (Boundary and interior of

INSIDE

one object are completely inside the other ob-
ject).

The opposite of COVERS. A COVEREDBY B implies
that B COVERS A (Demarcations of two objects

COVEREDBY

which partially cover themselves, and the interior
of the other object is completely contained
within the object).

The interior and boundary of one object is on
the boundary of the other object (and the second

ON
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object covers the first object). Example: When a
line is on the boundary of a polygon.

The objects are non-disjoint, which means all.ANYINTERACT

For more information, see Oracle Spatial Users Guide and Reference.

Data Model: Oracle Schema Converter
Autodesk Topobase provides a schema converter that converts any Oracle
structure into a Topobase database schema. For example, use the schema
converter to convert an Oracle table in a Topobase feature class. In the first
step, the schema converter analyzes all non Topobase tables, and lists any
conflicts. After resolving the conflicts, the tables are ready to be converted.
The conversion adds Topobase specific columns, renames the geometry column
to GEOM, creates and stores the Topobase metadata.

To analyze and convert an Oracle schema

1 Start Topobase Administrator.

2 Create a workspace.

3 Under Documents, click Import.

4 Do one of the following.

■ Select Import From Existing Oracle Schema. In the Add Existing
Schema dialog box, clear Show Only Topobase Schemas. Select the
schema. Enter the password.

■ Select Import From Oracle Dump File. Select the dump file. Specify
the settings. Enter the password.

5 If you select a non-Topobase schema, or a non Topobase dump file, you
are prompted whether to create a Topobase structure, and to open the
Topobase Converter now. Click Yes.

6 In the Create New Document dialog box, under Extensions, check the
Extensions, and under Spatial, check the SRID. Click OK.

NOTE Topobase supports only one SRID per document. When you create a new
document to import a non Topobase schema, make sure that you specify the SRID
in the Document Settings - Spatial. Then, the schema converter will convert all
tables that match the document’s SRID.
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The non-Topobase schema is analyzed, and the results are displayed in the
Convert To Topobase Schema dialog box. Use the settings as shown in the
following table.

DescriptionConvert To Topobase Schema

Displays the analysis results. Use the data grid to
filter for tables where a conflict has been detec-
ted.

Tables

Analyses and Converts the Oracle schema.Analyze And Convert

Analyzes the data structure. If you have resolved
any conflict, click Analyze to restart the analysis.
You can start the analysis as often as needed.

Analyze

Starts the conversion. See also Converting Oracle
Tables (page 288).

Convert

Selects whether to show all tables in the data
grid, or tables with conflicts only.

Display

Displays the results of the analysis. Click a row,
to display more details in the right pane.

data grid

Displays the table name.Table Name

Displays the result.State

■ Ready = Table can be converted.

■ Resolve Conflicts = Table cannot be conver-
ted. Conflicts must be resolved.

Displays the analysis details of the selected table.
Select a row, and use the options in the right

State Description

pane to resolve simple conflicts, or use any Oracle
tool to resolve other conflicts. If appropriate, se-
lect multiple rows to resolve the conflicts.

Displays the table name. If the table name has
more than 25 characters, enter a shorter table
name.

Table Name
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Specifies the table type to resolve the following
simple conflicts.

Table Type

Table has no geometry column

■ Do not Convert.

■ Convert To Attribute Feature Class.

■ Convert to Domain Table.

Table has a geometry column, but the geo-
metry type cannot be determined

■ Attribute

■ Point

■ Line

■ Polygon

■ Collection

For feature classes that have multiple GEOM
columns, selects the primary geometry column.

Primary Geometry Column

When you have resolved the conflicts, you start the conversion of the tables
that have the state Ready.

To convert the schema

1 In the Convert To Topobase Schema dialog box, click Convert.

2 The data grid displays the converted tables, and the State. The State can
either be Conversion Succeeded, Resolve Conflicts, or Conversion Errors.

For a Conversion Error, the right pane shows more details. Use any Oracle
tool to resolve the errors, and start the analysis and the conversion again.

NOTE To analyze and convert single Oracle tables that are part of a Topobase
document, start the schema analysis in the document. In the data model explorer,
right-click the document node and click Convert Tables To Feature Classes.

For more information, see Oracle Spatial Users Guide and Reference.

See also:

■ Data Model: Feature Class Types (page 198)
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■ Data Model: Domain Tables (page 219)

Converting Oracle Tables
The Topobase schema converter converts tables that store geometry according
to the GTYPE of the geometry data, as shown in the following table.

Feature Class TypeGeometry type GTYPE

Point feature class.Point

Collection feature class.Multipoint (2D)

Line feature class.Line
Multiline

Polygon feature class.Polygon
Multipolygon

Attribute feature class.Unsupported geometry types,
such as LRS, 3D Point Cloud,
Composite Surface, Solid.

After the Conversion

Notice, that the conversion of an Oracle schema to a Topobase document
does not perform the following.

■ Create new spatial indices. The conversion re-creates the existing spatial
indexes.

■ Validate geometry.

■ View conversion: Views pointing to renamed geometry columns can
become invalid.

■ Handle job functionality.

■ Distinguish between label feature class, centroid feature class, and point
feature class. These feature classes have point geometry, and will be
converted into point feature classes.

■ Set feature rules, other than the default feature rules, such as to calculate
the length, and the area.
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■ Set different topics. All converted feature classes are assigned to one topic.

Topobase Data Transfer (Oracle Data)
The Topobase Oracle Data Import tool transfers Oracle data from any Oracle
user to a Topobase document. Oracle Data Import requires an Oracle user
(Intermediate document) that stores the data to be transferred. However, it is
not required that the data structure of the intermediate document matches
the final data structure. For example, the intermediate document can contain
data that has been imported from some external sources, without changing
its original data structure (flat port).

For the data transfer into your final document, you use the Oracle Data import.
You specify the mapping definition to distribute the data from the intermediate
document to the final document. The mapping definition for the Oracle Data
import is stored in the final document.

Oracle Data Import—Migration tool to transfer Oracle data to Topobase
documents.

Source document—Topobase document from which the data is transferred.
For example an intermediate Interlis document, to which the Interlis data has
been imported 1:1.

Final document—Topobase document to which the data is transferred.

NOTE Oracle Data import is an integrated part of the Topobase Interlis Import.
See also Mapping Definition for Interlis Data Import (page 301).

IMPORTANT The final document must contain the Oracle Data Import Extension.
See also Document Settings (page 69).

To transfer data between two documents

1 Start Topobase Administrator, and open the workspace that contains the
final document.

2 In the Administrator explorer, select the final document.

3 Click Document menu ➤ Import ➤ Oracle Data.

4 In the Source Document dialog box, select the source document, and
enter its credentials. Click OK.
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5 Specify the mapping definition. See Creating a Mapping Definition (page
290).

6 Test the mapping definition.

7 Import the data.

Creating a Mapping Definition
The Oracle Data import configuration consist of a mapping definition that
describes how each feature of the source document is transferred to the final
document. The mapping definition is stored in the final document (TB_MIG*
tables), and can be exported to an (*.XML) file for reuse in multiple documents.

To create a mapping definition

1 Start Topobase Administrator, and open the workspace that contains the
final document.

2 In the Administrator explorer, select the final document.

3 Click Document menu ➤ Import ➤ Oracle Data.

4 In the Source Document dialog box, select the source document, and
enter its credentials. Click OK.

5 In the Import Oracle Data dialog box, click New.

6 In the Create New Mapping Definition dialog box, configure the mapping
file. See Configuring Oracle Data Import (page 292).

Editing a Mapping Definition
A mapping definition is the Oracle Data import configuration that describes
how each feature of the source document is transferred to the final document.
The mapping definition is stored in the final document, and can be exported
to a (*.XML) file for reuse in multiple documents.

To edit a mapping definition

1 Start Topobase Administrator, and open the workspace that contains the
final document.

2 In the Administrator explorer, select the final document.
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3 Click Document menu ➤ Import ➤ Oracle Data.

4 In the Source Document dialog box, select the source document, and
enter its credentials. Click OK.

5 In the Import Oracle Data dialog box, click Edit.

6 In the Edit Mapping Definition dialog box, configure the mapping file.
See Configuring Oracle Data Import (page 292).

Using Oracle Data Import
You use the Import Oracle Data dialog box to manage the data transfer.

DescriptionImport Oracle Data dialog box

Selects the Oracle Data import configuration that
defines the data transfer.

Select Mapping Definition

Creates a new mapping definition. Opens the
Create New Mapping Definition dialog box.

New

You either start from scratch, or you import and
amend an existing mapping definition (*.XML)
file. See also Importing an Oracle Data Import
Mapping Definition (page 302).

Opens the Edit Mapping Definition dialog box.Edit

Deletes the selected mapping definition.Delete

Specifies a temporary directory to save files, such
as Log files, Error files, or SQL Loader files.

Temporary Directory

Displays status messages.Status

Validates the mapping definition without migrat-
ing any data. The test

Test Mapping Definition

■ Creates access permissions (Oracle grants).

■ Runs the SQL select statements.

■ Revokes the permissions.

■ Writes the results into the log files Or-
acleDataImport.log, and OracleDataImport.err.
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The OracleDataImport.err file stores the SQL select
statements that need to be corrected.

Starts the Oracle Data Import, and transfers the
data to the final document.

Import

Configuring Oracle Data Import
Use Oracle Data import to configure the data transfer, and to create or edit
the mapping definition. The Create New Mapping Definition dialog box, and
the Edit Mapping dialog box consist of several tabs: Overview; Feature Classes;
Domains; Feature Attributes; Domain Attributes.

DescriptionCreate New Mapping Defini-
tion dialog box

Displays a high level overview of the mapping
definition.

Overview tab

Specifies a name. For example, the name is dis-
played in the Import Oracle Data dialog box, or

Mapping Definition Name

when you select the mapping definition for the
Oracle Data import in the Interlis Data Import
dialog box.

If the mapping definition has been imported from
a file, displays the (*.XML) file name. See also

Created From

Importing an Oracle Data Import Mapping
Definition (page 302).

Compares the selected configuration to the data
structure of the current document.

Mapping Definition Status

Indicates whether the configuration of each ele-
ment is complete. Click View to display the detail
tabs.
Linked—Indicates completed mapping defini-
tions.
Not Linked—Indicates missing mapping defini-
tions. For example, if you have not added attrib-
utes to your feature classes.
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Indicates whether SQL select statements that are
executed before and after the Oracle Data import,

Advanced Settings Status

or placeholders have been defined. Click View to
open the dialog boxes to edit the settings. See
Oracle Data Import: SQL Statements and Place-
holder (page 301).

Imports a mapping definition from an (*.XML)
file.

Import

Exports the mapping definition to an (*.XML) file.
For example to backup your configuration.

Export

Quits the dialog box. The mapping definition is
automatically saved.

Close

Opens dialog boxes to create or edit SQL select
statements, and placeholders. See Oracle Data

Advanced Settings

Import: SQL Statements and Placeholder (page
301).

Links the feature classes of the source document
with the feature classes of the final document.

Feature Classes tab

See also Oracle Data Import: Mapping Feature
Classes and Domains (page 296).

Displays the feature classes of the source, and of
the final document. To link two feature classes,

Link Feature Classes area

select the source feature class, then select the final
feature class, and click the Link Feature Classes
icon.

Links the selected feature classes.

Unlinks the selected feature classes.
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Automatically links all feature classes with the
same name.

Creates a copy of the selected feature class in the
final document.

Displays the feature classes that have been linked
in the order they are mapped in the mapping

Linked Feature Classes (Shown
In The Order They Will Be
Mapped) area definition. Use the icons on the right to modify

the order.
Properties: Displays the migration method, such
as SQL Loader, or API.

Unlinks the selected feature classes.

Opens the Edit Properties dialog box. See Oracle
Data Import: Edit Feature Class Properties (page
297).

Links the domains of the source document with
the domains of the final document.

Domains tab

Displays the domains of the source, and of the
final document. To link two domains, select the

Link Domains area

source domain, then select the final domain, and
click the Link icon.

Displays the domains that have been linked. Use
the icon to unlink the domains.

Linked Domains area

Links the feature attributes of the source docu-
ment with the feature attributes of the final doc-
ument.

Feature Attributes tab

Displays the feature classes that have been linked
in the Feature Classes tab. For each feature class,

Prioritized List Of Linked Fea-
ture Classes area

an icon indicates whether all attributes have been
linked.
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Displays the attributes of the selected feature
classes.

Link Feature Attributes

Displays the feature attributes that have been
linked. Displays properties that have been set.

Linked Feature Attributes
(Shown In The Order They Will
Be Mapped) area See also Oracle Data Import: Edit Feature Attribute

Properties (page 299).

Opens the Edit Properties dialog box. See also
Oracle Data Import: Edit Feature Attribute Prop-
erties (page 299).

Automatically links all attributes as specified in
the option.

■ Link all attributes with the same name.

■ Link all attributes that are not linked, to a
NULL attribute, so that all attributes can be
considered as Linked.

■ Link all attributes that contain no data to a
NULL attribute.

Switches to the Domain Values tab. If the item is
related to a domain table, activates the corres-
ponding domain.

Links the domain values of the source document
with the domain values of the final document.

Domain Values tab

Displays the domains that have been linked in
the Domains tab. For each domain, an icon indic-
ates whether all values have been linked.

Linked Domains

Displays the values of the selected domains.Link Domain Values

Displays the domains that have been linked. Use
the arrow buttons to modify the order of the do-
main values.

Linked Domain Values

Opens the Domain Settings dialog box. See Or-
acle Data Import: Domain Settings (page 300).

Domain Settings
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Oracle Data Import: Mapping Feature Classes and Domains
The following sections explain details about the settings that you specify in
the Create New Mapping Definition dialog box.

To link feature classes

1 Click the Feature Classes tab.

Feature classes that have not yet been linked, are marked with a special

icon  .

2 Select the source feature class, and the final feature class.

3 Click Link Feature Classes.

The linked feature classes are added to the Linked Feature Classes list.
Icons indicate that some attributes need to be mapped.

4 Click the Feature Attributes tab.

5 Select the linked feature classes row, and under Link Feature Attributes,
link the attributes.

When you specify a mapping, you can use the table name / attribute name
NULL to explicitly not migrate the item. Then the system does not mark the
item as Not Linked. For example, when you share your configuration with
another user, the NULL items would not be marked as Not Linked. However,
any additional feature classes and attributes of the other document are marked
as Not Linked, and missing mapping definitions can be added.

Feature Attributes

When you link feature attributes, the system checks the attribute type. For
example, you cannot link an attribute of type Number(10) to an attribute of
type Number(1), or you cannot link an attribute of type SDO_GEOMETRY to
an attribute of type Varchar2.

If the final attribute is of type NOT NULL, a DECODE command inserts a
default value.

If both the source attribute name, and the final attribute name is
ORIENTATION, and if the source attribute is of type Number(20,8), and the
final attribute is of different type, the system changes the final attribute type
to Number(20,8).
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FID attribute

When you link the source attribute FID to the final attribute FID, the
application creates a system attribute T2T_FID. In the list, T2T_FID is displayed
in parentheses, next to the FID attribute. T2T_FID stores the source FID. The
final FID will be newly generated during the data transfer, in order to generate
consistent FIDs. T2T_FID (the source FID) is used to restore any relations
between the features.

See Oracle Data Import: Edit Feature Attribute Properties (page 299)

Feature relations

Optionally, relations to other features are restored. For this purpose, the source
FID is stored in system attribute T2T_<attribute name>, and an update SQL
script (Post SQL) is created. The Post SQL will be run after the migration. In
the Linked Feature Attributes list, under Properties, the entry PostScript
indicates that a Post SQL has been created.

To edit the Post SQL, click the Edit icon. See also Oracle Data Import: SQL
Statements and Placeholder (page 301).

Domain table relations

If both the source attribute, and the final attribute has a relation to a domain
table, you have to map the domain tables. That means, you assign the values
of the source domain table to the values of the final domain table.

Example: A source domain table specifies colors, such as 1=Red, 2=Blue, 3 =
Black. You map the source domain table to a final domain table, where the
following values are stored: 53=Red, 54=blue, 55=Black. Then you map the
domain values, so the migration changes the values: 1 to 53, 2 to 54, 3 to 55.

To copy a value of the source domain table to the final domain table, select
the value, and click the Copy icon. For example, to add missing values. This
creates a KEY value, starting at 10001 for numeric keys, and copies the
SHORT_VALUE.

Oracle Data Import: Edit Feature Class Properties
In the mapping definition for a feature class, you specify properties as shown
in the following table.

DescriptionProperty

Includes the settings in the mapping definition.Include In Mapping Definition
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Specifies the migration method.Migration Model

■ Add As A New Feature Using Topobase API:
Inserts each feature separately. This method
guarantees data consistency. No post pro-
cessing is required. Use this method to mi-
grate a small amount of data.

■ Add A New Feature Using SQL Loader: This
method inserts the data from SQL Loader
files. For each feature class, Insert statements
are created, so that client-side feature rules
would not be applied. For example, use this
method to find a single record that stops the
data transfer.

■ Add As A New Feature Using Insert State-
ment: This method creates an insert state-
ment per feature class, so that client-side
feature rules are not applied. This is the fastest
method. For example, if you migrate a large
amount of data. This method usually requires
post processing.

■ Update Existing Feature Using Filter: Define
an SQL filter expression that is added in the
WHERE part of the SQL select statement. You
can use the alias "a" for the table name. You
can use placeholders for parameters. See Or-
acle Data Import: SQL Statements and Place-
holder (page 301).

For example, use a filter to import an Interlis im-
port project. For the Interlis data import, for each

Filter

feature class, use the filter IMPORT_ID = {IM-
PORT_ID}. Then, the Interlis import, part 2, re-
places the value of the parameter {IMPORT_ID}
with the value corresponding to the selected In-
terlis Import project. See also Import Projects.

Stores any comments, for example, that explain
why a method has been chosen.

Comments
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Migration Model - Using a filter—For example, select the Update Existing
Feature Using A Filter option, if you need to update existing data instead of
inserting data.

Sample scenario: Database A stores parcel data, database B stores additional
data for the same parcels. To migrate the parcel data, you execute two
migration steps.

■ Execute a standard Insert for database A.

■ Execute an Update statement to add the additional data from database B.
Enter the SQL select statement that defines the relation of the source table
and the final table.

Use the alias "s" for the source table and the alias "t" for the final table. For
Example:

s.fid = t.fid

s.flur=t.flur and s.stammnummer=t.stammnummer and s.unternum

mer=s.unternummer

Using these expressions, the following Update statement is used.

update AL_F_FLUR t SET (NAME,KENNUNG) =

(SELECT NAME,KENNUNG FROM AL_F_FLUR s WHERE s.fid = t.fid)

In this case the attributes NAME and KENNUNG have been selected in the
dialog box.

You can use placeholders, see Oracle Data Import: SQL Statements and
Placeholder (page 301).

Oracle Data Import: Edit Feature Attribute Properties
In the mapping definition for feature attributes, you specify properties as
shown in the following table.

DescriptionProperty

Displays the source attribute.Source Attribute Or SQL State-
ment For <source document
name>

Displays the final attribute.Final Attribute For <final docu-
ment name>
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Specifies an alternative attribute name. For ex-
ample, for FID relations and FID attributes.

Temporary Final Attribute
Name

To store the data in a temporary attribute instead
of the final attribute.

Includes the settings in the mapping definition.Include In Mapping Definition

Maps the selected attribute to a domain.Map Attributes To Domains

Defines an SQL select statement that is executed
after the migration, using the connection to the
final user.

Post SQL

For example, use this option for FID relations.
Use the following placeholders:

■ {SOURCEUSERNAME}—replaces the user
name of the source user.

■ {TARGETUSERNAME}—replaces the user
name of the final user.

For example, to maintain the relation between a
feature and its label.

Stores any comments.Comments

Oracle Data Import: Domain Settings
Topobase domain tables have a fixed data structure. See Data Model: Domain
Tables (page 219).

In the mapping definition for domains, you specify which attributes are
displayed in the domain values list of the data model administrator.

DescriptionDomain Settings dialog box

Specifies the primary key of the source domain
table.

Source Key Column

Specifies the primary key of the final domain
table. For a Topobase domain table *_TBD: ID.

Final Key Column

Specifies the source caption.Source Caption Column
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Specifies the attribute that stores the caption in
the final domain table. For a Topobase domain
table *_TBD: VALUE.

Final Caption Column

Oracle Data Import: SQL Statements and Placeholder
Optionally you define SQL select statements that are executed before and after
the Oracle Data import. For example, before the import, you disable triggers.
After the import, you enable the triggers.

Placeholder—Inside the Filter statements, you can use placeholders. or
example:

FID={MY_PARAMETER}

The placeholder name has to be in capital letters. You define the placeholder
in the Set Placeholder dialog box, or you set the values in the API. API values
overwrite the values that are set in the dialog box.

See also:

■ Oracle Data Import: Edit Feature Class Properties (page 297)

Mapping Definition for Interlis Data Import
For Interlis data import to the Land CH data model, Autodesk provides
customized Oracle Data import mapping definitions. You import the files
(*.XML) into your final document. If necessary, you can edit the configuration,
save the modifications, and export the settings into an (*.XML) file for further
reuse.

To import a Oracle Data import mapping definition

1 Start Topobase Administrator, and open the workspace that contains the
final document.

2 In the Administrator explorer, select the final document.

3 Click Document menu ➤ Import ➤ Oracle Data.

4 In the Source Document dialog box, select the source document, and
enter its credentials. Click OK.

5 In the Import Oracle Data dialog box, click New.
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6 In the Create New Mapping Definition dialog box, click Import.

7 Select the Oracle Data import mapping definition (*.XML) file.

8 Click Open.

9 If necessary, modify the configuration settings.

10 Click Close.

See also:

■ Interlis Import

■ Configuring Oracle Data Import (page 292)

Importing an Oracle Data Import Mapping Definition
You can import an Oracle Data import mapping definition (*.XML) file for
reuse and modification.

IMPORTANT The document you import the file to must contain the Oracle Data
Import Extension. See also Document Settings (page 69).

To import an Oracle Data import mapping definition

1 Start Topobase Administrator, and open the workspace that contains the
final document.

2 In the Administrator explorer, select the final document.

3 Click Document menu ➤ Import ➤ Oracle Data.

4 In the Source Document dialog box, select the source document, and
enter its credentials. Click OK.

5 In the Import Oracle Data dialog box, click New.

6 In the Create New Mapping Definition dialog box, click Import.

7 Select the mapping definition (*.XML) file.

8 Click Open.

9 If necessary, modify the configuration settings.

10 Click Close.
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Exporting an Oracle Data Import Mapping Definition
You can export an Oracle Data import mapping definition into an (*.XML)
file.

To export an Oracle Data import mapping definition

1 Start Topobase Administrator, and open the workspace that contains the
final document.

2 In the Administrator explorer, select the final document.

3 Click Document menu ➤ Import ➤ Oracle Data.

4 In the Source Document dialog box, select the source document, and
enter its credentials. Click OK.

5 In the Import Oracle Data dialog box, select the mapping definition, and
click Edit.

6 In the Edit Mapping Definition dialog box, click Export.

7 Specify a file name.

8 Click OK.

9 Click Close.

Topobase Structure Editor
Use the Topobase Structure Editor to facilitate creating, updating, and
deploying specific data models. Specific data models provide

■ new data models that are based on company specific or existing
industry-specific data models.

■ custom modules or extensions based on existing Topobase data models.

■ modification of a standard Topobase data model to suit a particular country
(country kit).
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The Topobase Structure Editor creates XML files (*.genx Data Model Files) that
can be shared with other companies. You apply the Data Model files in the
Topobase Administrator module to update, or to create data model structures.
See also Customized Data Model (page 70).

Topobase Structure Editor supports versioning.

You can manage and edit the following data model objects.

■ topics, feature classes, label feature classes

■ label definitions

■ model feature classes, including records.

■ domain tables, and domain entries.

■ other tables that are not feature classes, and not domain tables

■ attributes, relations, topologies

■ utility models

■ intersections

■ indices, sequences, rows of tables

■ views

The structure editor does not support feature rules, and features (records).

NOTE The structure editor only supports views that refer to feature classes in the
same document.
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To start the Structure Editor

1 Start Topobase Administrator.

2 Click Setup menu ➤ Structure Editor.

DescriptionStructure Editor dialog box

Displays the version of the data model file. When
you create the data model file, the version is set
to 1.0.0.

Version

Clones the current version, and creates a new
one. You can enter a new version number.

Display the data model structure, and the data-
base objects.

Data Model Explorer tab

Provides search tools.Search tab

Displays a grid to edit the properties of the selec-
ted element.

Properties

Creates a new data model.File menu  ➤ New

Opens an existing data model file.File menu  ➤ Open

Exports a Resource file (*.resx) for use in transla-
tion.

File menu  ➤ Export Resource
File

Creates or updates the XML file from the database
schema.

Edit menu  ➤ Create From
Database Schema

Edits the properties of the data model.Edit menu  ➤ Edit Data Model
Properties

Displays previous versions of the data model.View menu  ➤ View Version
History
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To create a data model file to apply customer-specific updates to a predefined
data model structure

This procedure creates a data model file that is based on an existing data model
template. Note that you cannot modify the existing data model.

1 Start the Topobase Structure Editor.

2 In the Structure Editor, click File menu ➤ New.

3 Enter a description, such as Gas Country Kit.

4 Enter a data model code. For customer-specific data model enhancements,
use a data model code > 100.0.0. See also Data Model Code (page 184).

5 Select Extend Existing Data Model, and select the predefined data model,
such as Gas data model.

6 Click OK.

The data model structure is displayed in the Data Model Explorer tab.

7 Continue to add your modifications. Use the context menus. They work
in the same way as the data model administrator commands.

For example, modify a caption, add domain table entries, create
intersections, or add feature classes and topics.

8 Click File menu  ➤ Save As.

9 Enter a name for the data model file (*.genx).

The (*.genx) file only stores the modifications on the existing data model,
and references the data model code of the existing data model.

10 Close the Structure Editor.

To update the data model

Share the data model file (*.genx) with your customers to provide them with
data structure updates. Your customers copy the file to an appropriate folder,
such as <topobase_admin>\Template\Modules\Gas\StructureUpdate\*.genx.

1 Start Topobase Administrator, and open a workspace with access to the
document you want to update.

2 In the Administrator explorer, select the document node.

3 Under Document Settings, click Modules.

4 Under Customized Data Model, browse for the Data Model file (*.genx).
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5 The file is added to the Custom Modules/Extension section.

6 Click Save.

If the custom data model file does not match the data model of the current
document, you can add the data model to your document.

To create a new version of a data model

1 Start the Topobase Structure Editor.

2 In the Structure Editor, click File menu ➤ Open. Select the (*.genx) file
that contains the data model description.

3 Under Version, click  .

4 Enter a new version number, such as 1.0.1, and click OK.

5 Add your modifications.

6 Click File menu  ➤ Save.

7 Click View menu ➤ View Version History.

The (*.genx) file now stores both versions of the modifications, and
references the data model code of the existing data model. In Topobase
Administrator, when you open the workspace, you are prompted to update
the document to the new version.

8 Close the Structure Editor.

To view the version history, open the file, and click View menu ➤ View Version
History.

To export a data model (XML)

Use the Structure Editor to export an existing Topobase database schema into
an XML file, including Topobase system tables, domain values, and optionally
content of tables.

1 Start the Topobase Structure Editor.

2 Click Edit menu ➤ Create From Database Schema.

3 Log in to the document you want to export.
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4 If your database schema contains customized tables (that are not Topobase
feature classes), enter a regular expression to filter the tables. Otherwise,
click OK to continue. Notice that the default filter (MY.*) normally would
not export any tables.

Feature classes, and domain tables are exported by default.

5 When prompted to load the table data, do one of the following.

■ Click OK to include the content of the tables. For example, if you are
exporting an empty database schema, but want to include the content
of the model tables.

NOTE Loading table content can take quite some time.

■ Click No, if you do not want to include the content of the tables.

NOTE Domain values are included by default.

The data model is loaded into the Structure Editor.

6 If any, add your modifications.

7 Click File menu  ➤ Save As.

The (*.genx) file stores the complete data model description.

8 Close the Structure Editor.

To export data model updates

You can export the modifications to the (*.genx) file.

1 Start the Topobase Structure Editor.

2 Click Edit menu ➤ Create From Database Schema.

3 Log in to the document you want to modify.

4 Optionally, save the data model file.

5 Use Topobase Administrator to add your modifications. For example, add
domain values.

6 In the Topobase Structure Editor, click Edit menu ➤ Create From Database
Schema.

7 Click File menu  ➤ Save.
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8 Click View menu ➤ View Version History.

The (*.genx) file stores the modifications you have made using Topobase
Administrator separately.

9 Close the Structure Editor.
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Topology Reference

Topology Introduction
Autodesk Topobase uses topologies to model objects and phenomena of the
real world. Typically, a GIS user needs information about relationships between
objects with topological characteristics. Modeling of land and other flat surfaces
is a perfect application for area topology. Logical topology is appropriate
wherever real world objects are connected to each other in networks.

■ Area topologies are usually invoked to represent parcels in cadastral
applications. Parcels are defined by their borders and should incorporate
data specific to the entire parcel. The border in this model corresponds to a
set of lines and the area to a polygon. With an area topology, you build areas
(polygons) from a set of lines.
An intersection can be performed with polygons as the primary feature class
and polygons, line strings, and points as secondary feature classes. For
intersections, you can use area topologies to build polygons from a set of
lines for the primary feature class. See also Data Model: Intersections (page
274)

■ Logical topologies connect features of any feature classes. The features need
not to be spatially connected, and they need not to have geometry. For
example, a logical topology connects points with points or lines with lines
or lines to points or attribute features with attribute features. For example,
a logical topology can represent a waste water network or electrical
transmission lines.
A network topology is a sub type of a logical topology that is based on an
arc-node model and is based on geometry. Topobase utility models are based
on logical topologies that connect points and lines.

4
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■ Topobase utility applications, such as Water, Gas, or Wastewater, use logical
topologies that comply with the Topobase utility model. See also Overview
of the Utility Model (page 244).

Topologies are maintained at the client-side using feature rules.

See also:

■ Area Topology Introduction (page 320)

■ Logical Topology Introduction (page 326)

Getting Topology Started
Use Topobase data model administrator to

■ Create feature classes.

■ Create the topology and enable topologies for the feature classes.

■ Initialize the topology, using an offline batch operation mode.

Use Topobase Client or Web to

■ Explore and validate the topology using the topology checker. See Checking
an Area Topology and Checking a Logical Topology.

■ Process topologies in online operating mode.

See also:

■ Data Model: Feature Classes (page 196)

■ Creating Topologies (page 312)

■ Topology Offline Initialization Processing (page 338)

Creating Topologies
You create topologies in the Topobase data model administrator.
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To create an area topology

1 Start the data model administrator.

2 In the data model explorer, select the Topologies node item, right-click
and click Create Topology ➤ Area.

3 In the Area Topology dialog box, define the topology.

4 Define the properties and click OK.

The new topology is displayed in the data model explorer.

To create a logical topology

1 Start the data model administrator.

2 In the data model explorer, select the Topologies node item, right-click
and click Create Topology ➤ Logical.

3 In the Logical Topology dialog box, define the topology.

4 See Logical Topology Properties (page 316)

For a Utility model, we recommend that you create the logical topology during
the creation of the utility model. See also Creating a Utility Model (page 248).

After creating a topology, the participating feature classes become
topology-enabled.

To initialize a topology

1 Select the topology. Notice, that in the right pane, the related system
feature classes are displayed.

2 Right-click the topology and click Initialize Topology.

After the initialization, the topology is ready and can be processed in Topobase
Client. From now on, the topology is maintained in online mode.

See also:

■ Topology Online Processing (page 339)

■ Topology Offline Initialization Processing (page 338)

■ Overview of the Utility Model (page 244)
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Area Topology Properties
An area topology consists of two feature classes, centroid and line feature class,
along with its various properties, as shown in the following table:

DescriptionArea Topology Dialog
Box

Contains general settings for the topology.Topology area

Specifies the name of the topology.Name

Selects a centroid feature class (FC). A centroid stores
the essential information of a polygon. Multiple topo-
logies can share a centroid.

Centroid Feature Class

Selects the edge FC. One edge FC can participate in
several topologies.

Line Feature Class

Tolerance area

Sets the arc linearize value. The default value is 0.08.
See also Area Topology Tolerance Values (page 315).

Arc Linearize

Sets the tolerance for area modifications of polygons
that lie outside, or partially outside of the job perimet-
er. See Area Topology Tolerance Values (page 315)

Max. Area Modification
Outside Perimeter

Advanced area

Selects the centroids to be used to build the area topo-
logy. Enter a a filter for the centroid feature class as
follows:

Centroids Filter Expres-
sion

<column> = <value>, for example: ID_TYPE=24.

Selects the edges to be used to build the area topo-
logy.

Lines Filter Expression

See also:

■ Area Topology Introduction (page 320)

■ Checking an Area Topology
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Area Topology Tolerance Values

Arc Linearize Tolerance

You can modify the default value for the arc linearize tolerance during area
topology creation. After the topology is created, the setting cannot be altered
without dropping and recreating the topology.

To view the arc linearize tolerance

1 Start the data model administrator.

2 In the data model explore, select the topology.

3 Right-click and click Properties.

The arc linearize tolerance helps to overcome impurity of the data, especially
minor overlapping of arc segments. If overlapping is detected, then the arc
segment is linearized in the same way that the respective segments, at the
beginning or the end of the arc, are replaced by linear segments. If such
linearization overcomes the topology error and overlapping disappears, the
polygon is stored. Otherwise a topology error is returned.

There is a recommended value for arc linearize tolerance, which cannot be
smaller than the spatial tolerance for the line feature class. It is recommended
that the reference setting is about 2 – 5 times the spatial tolerance of the line
feature class.

Topobase area topology: By setting the arc linearization tolerance, you can control
overlapping of arcs and lines.
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Area Modification Outside Perimeter

When working with area features, modifying an edge inside a perimeter will
have an impact on the corresponding areas located to the left and right of it.
If these areas lie outside the perimeter, or within the perimeter buffer, the
modification can be cancelled, if it is significant.

For job enabled documents, and if the current job has a perimeter assigned,
polygons outside the perimeter are checked, whether the area is changing
more than the specified tolerance. For example, Swiss land management does
not allow changes greater than 1m2.

Logical Topology Properties
A logical topology consists of several feature classes, along with its various
properties, as shown in the following table. To view the properties, in the data
model administrator, select the topology, right-click, and select Properties.

DescriptionLogical Topology Dia-
log Box

Specifies the name of the topology.Topology Name
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Specifies the distance within which two features are
considered as spatially connected. See also Connection
Tolerance Radius (page 318).

Connection Tolerance
Radius

Specifies the default flow between two features. You
can modify this value at any time, using the Manage
Connection dialog box.

Default Flow

The default value is used, if the topology creates a new
connection between two features. For example, if you
digitize a new feature and the topology automatically
connects it to existing features.

Define Logical Topology
area

Specifies the feature classes that are part of the logical
topology. Select one or more feature classes.

Feature Classes In The
Topology tab

Specifies the attribute and the attribute values that
store the flow information. See also Flow Direction
Management (page 318).

Flow Per Feature Class

Specifies the possible connections. For each feature
class in the list on the left side, select one or more

Connectivity Between
Feature Classes tab

possible connected feature classes in the list on the
right side.

For each feature class that is part of a logical topology, a button is added to
the feature class form. Use the Connection <topology name> button to open
the connectivity system table <topology name>_CONN.

NOTE For topologies that are used in a utility model, restrictions apply. See also
Utility Topology Properties (page 319).

See also:

■ Logical Topology Introduction (page 326)

■ Checking a Logical Topology
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Flow Direction Management
When you define a logical topology, you specify a default flow direction that
is valid for all features in the topology. For example, you set the default flow
direction to Backward, and in Topobase Client you use the Manage
Connections dialog box to set specific flow directions.

Depending on your data, the flow information might already be stored with
the feature data. Then, you can specify the feature class attribute that stores
the flow direction along with the values that indicate the flow options. For
example a road feature class uses the attribute DIRECTION to store the flow.
Then you can specify that the attribute DIRECTION is used to define the flow
direction.

To use flow information from a feature attribute

1 In the Logical Topology dialog box, click the Feature Classes In The
Topology tab.

2 Select the feature class.

3 Under Flow Per Feature Class, select the feature class attribute that stores
the flow direction.

4 In the data grid, for each flow option, enter a value that indicate the flow
direction.

5 Click OK.

Connection Tolerance Radius
The connection tolerance radius determines when a feature is spatially
connected to another feature. For example, when you digitize features using
Topobase Client, the connection is created automatically if they lie within
the tolerance.

Also, during topology initialization, the connections of spatially connected
features are automatically added to the connectivity table. See also Logical
Topology Initialization (page 335).

You can modify the connection tolerance radius. The unit corresponds to the
default length unit of the document. Example: If your spatial reference system
(SRID) uses meters, the unit is meters.

If you modify the connection tolerance radius, you must initialize the topology
again.
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To modify the connection tolerance radius

1 Start the data model administrator.

2 In the data model explorer, select the topology.

3 Right-click and click Properties.

4 Modify the tolerance value.

5 Click OK and click Yes to initialize the topology.

The Connection Tolerance Radius determines whether a feature is connected
to another feature. It is applied during topology initialization and online
processing. For example, if there are two features in the tolerance radius, both
features will be connected to the line. However, for a topology that is related
to a utility model, this would cause a topology error of the type Line Has Two
Start Points.

Utility Topology Properties
The Topobase utility model (page 586) requires a logical topology that is based
on an arc-node model.

NOTE During the creation of a utility model, you can create an appropriate logical
topology with properties as shown in the following table.

To view the properties, in the data model administrator, select the topology,
right-click, and select Properties.

DescriptionLogical Topology Prop-
erties (utility model)
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Specifies the name of the topology. The name corres-
ponds to the name of the utility model.

Topology Name

Specifies the distance within which two features are
considered as spatially connected.

Connection Tolerance
Radius

Cannot be edited.Default Flow

Define Logical Topology
area

Displays the utility feature classes. For a utility model,
the topology consists of one line string feature class,

Feature Classes In The
Topology

and one point feature class. These feature classes store
the edges and the nodes. Cannot be edited.

Cannot be edited.Flow Per Feature Class

Displays the attribute feature classes that are related to
the point geometry, and the line geometry feature
classes.

Connectivity Between
Feature Classes

When you create the utility model, the points are con-
nected to the lines, and the lines are connected to the
points. After the utility has been created, when you edit
the logical topology properties, you can define the
connections using the attribute feature classes. However
you cannot connect points to points, or lines to lines.

If you want to perform network tracing, the features must be connected, that
means that they must have an entry in the connectivity table <topology
name>_CONN.

See also:

■ Overview of the Utility Model (page 244)

Area Topology Introduction
Autodesk Topobase defines area topologies with a line feature class and a
centroid feature class. The line features are also referred to as edges. They are
the master objects that store the primary data that determines the topological
relationship. Topology routines create secondary redundant objects that can
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be recreated from master objects when needed. However, despite their
redundancy, these secondary objects play important role in the representation
and analysis of the topological configuration.

Topobase area topology supports two operation modes: online and offline.

The online, or interactive, mode is a response of the area topology subsystem
to certain user actions. For example, an area is built when the edges make a
topologically valid configuration after the user creates new edges or edits
existing ones.

In the offline, or initialization mode, areas are built from all available edges
as a batch. Offline mode is used mostly at topology creation time, when huge
number of line strings and centroids are related topologically, but
corresponding secondary objects, such as areas, are still missing.

An area topology consists of several lines or polylines that build an enclosed
polygon. The polygon contains a centroid, which is the representative of the
polygon. One specific quality of area polygons is the fact that they do not
overlap and cover the whole area with an exhaustive and complete net, such
as the way that land parcels cover the surface of the earth.

Area topologies consist of centroids and polylines. The polygon geometry (area) of
the edges is generated with the topology.

To build an area topology you need two feature class types.

■ Centroid (page 581) feature class where attributes of the polygon are stored.
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■ Line String feature class, which normally only comprises the geometry and
has one attribute that can be used for stylization using the Display Manager.
If you name the line string like the associated centroid and with the suffix
_L, you can easily identify it. You can also define the line string feature
class as a sub feature class.

You create both the centroid feature class, and the line feature class. Both
feature classes will not be modified by the system.

When you create a topology, the system creates several support feature classes,
such as a polygon (area) of the line strings <topology name>_TSUR. Do not
store any polygon related information in the support feature class. These
feature classes are maintained by the topology.

NOTE There is no entry in TB_RELATIONS. Centroids and line strings have no
explicit relation.

See also:

■ Creating Topologies (page 312)

■ Topology Online Processing (page 339)

■ Area Topology Initialization (page 324)

Area Topology Tables
In addition to the line and centroid feature classes, each topology requires
some volatile tables that hold secondary objects, such as areas generated, error
reporting, and analysis facilities.

When a topology is defined in the data model administrator, a set of secondary
feature classes is created. They all bear the name given to the topology, such
as Parcel, and are differentiated by the suffix, such as Parcel_TCEN.
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Topobase Data Model: Master and secondary objects of an area topology

DescriptionArea Topology Tables

Suffix, used to name a secondary feature class that
contains generated areas (polygons). The table is up-
dated by feature rules on the base feature class.

Suffix _TSUR

See also Topology: _TSUR State Codes (Area) (page 324).

Suffix used to name a secondary feature class that saves
polygons with an invalid geometry, such as a Line

Suffix _TSER

Crosses Or Touches Self error. As long as invalid objects
cause problems with spatial selects, such objects are
moved from _TSUR to _TSER. There is no spatial index
on the table, and invalid geometries do not cause any
problems.

NOTE Only polygons are processed here. if lines are
not in a closed loop, no polygon can be created and
there will be no entry in either the _TSUR or _TSER table.

Suffix used to name attribute type feature classes where
information about topological edges and centroids is
stored.

Suffix _TEDG and
_TCEN

Suffix used to name a point feature class that contains
redundant data: polygons built in improper direction

Suffix _TISL
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(clockwise instead of CCW). The geometry field matches
the arbitrary vertex in the invalid polygon. These poly-
gons are hole templates for building a polygon that
contains an island.

Topology: _TSUR State Codes (Area)
State codes are saved in *_TSUR.STATE.

DescriptionState Code

OKNULL or 0

General error (occurs when built polygon is heavily incon-
sistent)

17

Any other value corresponds to an Oracle Spatial error code,
for example:

Polygon boundary crosses itself13349

More topology errors and their descriptions are displayed in the topology
checker in Topobase Client or Web.

See also:

■ Checking an Area Topology

Area Topology Initialization
Topobase area topologies can be processed in offline mode, during
initialization. Before you can process an area topology in online mode, it has
to be initialized. The initialization can be started manually in the data model
administrator after you create a topology.

To initialize a topology

1 Start the data model administrator.

2 In the data model explorer, select the topology.

3 Right-click and click Initialize Topology.
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4 In the Area Topology Initialization dialog box, optionally check one or
all of the following options:

■ Create Missing Centroids—Creates a centroid feature that lies inside
of the polygon.

■ Create Logfile Of Topology Errors—Logs the topology errors.

5 Click OK to start the initialization.

NOTE If the topology is job enabled, missing centroids cannot be created.

Topology initialization is mostly used at topology creation time, when a huge
number of line strings and centroids are related topologically, but
corresponding secondary objects, such as areas, are still missing. The procedure
of topology initialization (= building the topology) includes the following
steps:

■ Filling a table *_TEDG with information about the edges

■ Building the polygons *_TSUR from the edges

■ Handle the islands of the polygons

■ Mapping centroids to polygons (*_TCEN)

The polygon geometry is created for each area in counter clock-wise direction,
except for the perimeter polygons which are clock-wise. Every island is
surrounded by such a perimeter. Upon successful completion of the
initialization, a spatial index on the _TSUR table is created. The *_TSER table
stores topological constructs that failed to make a valid topological
configuration.

Logging topology errors

During the initialization you can optionally log topology errors. The default
location of the log file is <topobase_client>\Log\<topology name>.log. The log
file contains the same errors that would be detected when you run the topology
checker, however with better performance, and including intersecting lines.
For example, select this option when you initialize the topology after you
have imported a large amount of data. Then you can assess the quality of the
data, without having to start Topobase Client.

For job-enabled topologies, errors are only logged for live data, but not for
open and pending jobs.
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Missing centroids

A Topobase area topology requires centroids, and the topology checker will
identify missing centroids as errors. For example, centroids can be missing if
you have imported data from another system that does not support centroids.
Or if you have imported only the line features. To resolve this topology error,
do one of the following.

■ Digitize the missing centroids manually.

■ In Topobase Administrator, initialize the topology.

■ In Topobase Client, run the Area Topology Checker, and use the Create
Missing Centroids command. See also Checking an Area Topology.

A missing centroid is only created, if the polygon geometry is valid. For invalid
polygons, correct the polygon geometry, and then create the centroid
manually.

Logical Topology Introduction
Autodesk Topobase logical topologies support both spatial and attributive
connectivity. For example, using logical topologies you can administer
networks that have no geometry stored.

The Topobase applications such as Water, Wastewater, Gas, and Electricity
are based on logical topologies that represent the utility networks.

Before you start working with a logical topology, you must configure the
logical topology using the data model administrator.

To configure a logical topology (data model administrator)

■ Create a logical topology. See Creating Topologies (page 312)

■ Initialize the logical topology using the data model administrator. In the
data model explorer, right-click the topology and click Initialize Topology.
See also Logical Topology Initialization (page 335).

To work with logical topologies (Topobase Client)

■ Start Topobase Client and open the workspace.

■ Generate graphic.
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■ In the drawing, select a feature. On the main toolbar, click the Manage
Connections icon.

See also the Topobase Client User Guide, section Managing Logical
Connections.

See also:

■ Topology Offline Initialization Processing (page 338)

■ Overview of the Utility Model (page 244)

Network Tracer

Tracing Topologies

You can define tracing templates for the topology feature classes. The following
functionality is available:

■ Shortest Path

■ Minimum Spanning Tree

■ Reachability

■ Cycle Detection

For topology analysis, you can use stop conditions and cost functions. Autodesk
provides some predefined tracing models.

Logical topology analysis (tracing) can be performed either within predefined
workflows or manually using the network tracer. The network tracer is available
in both Topobase Client and Topobase Web.

To analyze a topology (in Topobase Client)

1 Start Topobase Client and open the workspace.

2 Generate graphic.

3 In the document explorer, expand the Topologies item.

4 Right-click the topology you want to trace and click Network Tracer.

5 In the Network Tracer dialog box, in the Tracing Template list, select a
template.
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6 Follow the on-screen instructions in the Features section. Depending on
the tracing template, there are various workflows.

7 When you finish, click Trace.

8 The resulting features are highlighted in the map and listed in the Tracing
Result dialog box.

The Tracing Result dialog box displays the features in an explorer tree, from
which you can process the features. Expand the items, select a feature and use
the buttons on the toolbar.

NOTE Tracing templates can be defined in the data model administrator.

DescriptionTracing Result Dialog Box

Opens the feature class form and shows feature inform-
ation.

Highlights the selected feature in the drawing.

Unhighlights the feature.

Zooms to the selected feature.

Removes the selected feature from the explorer tree.

Specifies a predefined tracing model (propagation).
Tracing templates can be defined in the data model
administrator.

Tracing Template

See also Logical Topology: Tracing Templates (page
329).

Specifies a start node where the tracing shall begin.Start Features

328 | Chapter 4   Topology Reference



Specifies an end node for the shortest path analysis.Visit/End Features

If you are tracing an attributive topology, you can specify the start and end
features in the attribute feature class form.

Logical Topology: Tracing Templates
You can define tracing templates and tracing conditions in the data model
administrator. In Topobase Client, you can then use them as templates to
execute network tracing, for example, in utility applications such as water
and wastewater.

Start Topobase data model administrator, expand the topology, and right-click
Tracing Templates.

DescriptionTracing Template dialog
box

General settingsTracing Template area

Specifies the template name. Use this name to select
the tracing in the network tracer.

Name

See Tracing Types (page 330).Tracing Type

Specifies the tracing direction:Tracing Direction

■ Both Directions.

■ Forward

■ Backward

The tracing direction configures which connection can
be followed while tracing. For example, in the Manage
Connections dialog box, set one or more connections
to Forward or Backward. If you set a connection from
feature A to feature B to Forward, the tracing can only
follow one direction. If you set the connection to Both,
the tracing can follow both directions.

Specifies a description of the tracing.Comment
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After the tracing, highlights the results in the drawing.Highlight Features On
Screen After Tracing

After the tracing, displays the results in the feature ex-
plorer.

Show Feature Explorer
After Tracing

Specifies that the template is available in the network
tracer.

Template Is Enabled

Lists current tracing conditions. Select one or more
conditions which will be applied to the tracing.

Tracing Conditions
area

Opens the Tracing Condition dialog box, where you
can define a new tracing condition.

New

See also Defining Tracing Conditions (page 331).

See also:

■ Defining a Tracing Template for a Logical Topology (page 339)

Tracing Types
You can define tracing templates using the following tracing types.

■ Shortest Path—Use this type to find the shortest path between two nodes
in an edge network. In this context “shortest” means “with the least effort”
as you can use any attribute (cost attribute) to be minimized. If you
minimize the length attribute, the result is the shortest path. If you set the
cost attribute to a constant, the result is the path with the fewest
connections.

■ Minimum Spanning Tree—Use this type to find the minimum-cost tree
that connects all nodes of a network or part of a network. This tracing type
is available only for arc-node models. The minimum-cost tree minimizes
the number of connections needed to connect all nodes with each other.
If you assign a cost attribute, the tracing considers those values in finding
the lines with minimum cost. For example, use this type when designing
electrical networks.

■ Reachability—Use this type to find all edges and nodes that can be reached
from a start node, either directly (direct connecting edge) or indirectly
(using several edges).
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■ Cycle Detection—Use this type to identify loops in a topology. For example,
use this tracing type in Topobase Electric.

For each tracing type, you can define stop conditions or cost functions.

If no cost functions are defined, and if the feature has a LENGTH attribute
(2D document) or a LENGTH3D attribute (3D document), the length is used
for the cost. Otherwise, the feature has no costs (zero).

The tracing templates are stored in the system table TB_NET_TRACE_TPL.

See also:

■ Logical Topology: Tracing Templates (page 329)

■ Defining Tracing Conditions (page 331)

■ System Table TB_NET_TRACE_TPL (page 167)

Defining Tracing Conditions
You can define any number of tracing conditions. They are applied in the
tracing template definition.

DescriptionTracing Condition Dialog
Box

General SettingsTracing Condition area

Specifies the name. Use this name to select the condi-
tion in the Tracing Template dialog box.

Name

Defines the type of the condition:Condition Type

■ Select Cost Function for the Shortest Path or Min-
imum Spanning Tree analysis. For example, if you
use the length of a line as a cost attribute, you can
find the shortest path.

■ Select Stop Condition to determine a feature to
constrain the tracing. For example, a valve that is
closed.

Specifies a description.Comment
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Includes the condition in the trace. If you clear the
check box, the trace ignores the condition.

Condition Is Enabled

Select the feature classes you want to use in your con-
dition. If the topology is used in utility model, the list
displays the attribute feature classes.

SQL Statement

For standard topologies, the list displays the feature
classes of the topology.

Generates and edits the SQL statement. For editing
click Generate to generate a skeleton SQL query. It is

SQL Statement For Condi-
tion

generated depending on the condition type and the
selected feature class.
See Also Tracing Condition SQL Statements (page 332).

Opens the SQL Assistant: Optionally, you use the SQL
Assistant to create SQL expressions. See also Creating
SQL Expressions (page 137).

Assistant

Validates the SQL select statement.Validate

Saves the condition.OK

The tracing conditions are stored in the system table TB_NET_SCOND_DEF.

See also:

■ Logical Topology: Tracing Templates (page 329)

■ Defining a Tracing Template for a Logical Topology (page 339)

■ System Table TB_NET_SCOND_DEF (page 169)

Tracing Condition SQL Statements
Use the Tracing Condition dialog box to define SQL statements that control
the network tracing. SQL and data model knowledge is required.

Enter the statement directly or click Generate to generate a skeleton SQL query.
Then, click Assistant to open the SQL Assistant.

■ Cost function—SQL statement that returns a number; it may return NULL
if the cost does not apply. This is rated as zero costs.
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■ Stop condition—SQL statement that returns NULL if the condition does
not apply. Then, the feature is not a stop feature. If the condition returns
any other number, the feature is a stop feature.

DescriptionSQL Skeleton query

case /* Point */ when &f_class_id=33 then

( select case /* Armature */ when

Example: Utility tracing
with stop condition

f_class_id_attr=3 then ( select 1 from

GA_ARMATURE where fid=ga_point.fid_attr

and <CONDITION>) else null end from

GA_POINT ga_point where fid=&fid) else

null end

case /* <feature class> */ when

&f_class_id=<id> then ( select 1 from

Example: Non-utility tra-
cing with stop condition:

<feature class> where fid=&fid and <CON-

DITION>) else null end

Place holder used in a stop condition. Replace this value
with the attribute that contains the information when

<CONDITION>

you want to stop the tracing. Example: The attribute
OPEN = YES indicates open armatures.
case /* Point */ when &f_class_id=33 then

( select case /* Armature */ when

f_class_id_attr=3 then ( select 1 from

GA_ARMATURE where fid=ga_point.fid_attr

and not OPEN = 'yes') else null end from

GA_POINT ga_point where fid=&fid) else

null end

case /* Point */ when &f_class_id=33 then

( select case /* Armature */ when

Example: Utility tracing
with cost function

f_class_id_attr=3 then ( select <VALUE>

from GA_ARMATURE where

fid=ga_point.fid_attr) else null end from

GA_POINT ga_point where fid=&fid) else

null end

case /* <feature class> */ when

&f_class_id=137 then nvl(( select <VALUE>

Example: Non-utility tra-
cing with stop condition
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from <feature class> where fid=&fid ),0)

else 0 end

Placeholder used in a cost function. Replace this value
with the cost attribute to be minimized in the tracing.
Example:

<VALUE>

PIPE_LENTH

Helper select for a stop condition to get a return value
that is not NULL if the conditions applies.

select 1

Stop Condition Editor
When executing an analysis workflow, you can use the Stop Condition Editor
to define stop conditions. For example Gas Network Analysis: Find Connected,
Wastewater Network Analysis: Find Connected, or Water Network Analysis:
Find Connected.

NOTE The Stop Condition Editor list box displays only the stop conditions that
are not assigned to any tracing template.

■ You can only edit the stop conditions that you have created while executing
a workflow.

■ You cannot edit stop conditions that other users have created while
executing a workflow.

■ You cannot edit stop conditions that have been created using Topobase
Administrator, or that have been created by the system.

To create a stop condition

1 In the Topobase Task Pane, click the Workflow explorer icon.   

2 Right-click the workflow, for example, Find Connected With Stop
Conditions.

3 Click Execute.

4 In the Stop Conditions section of the Workflows pane, click Add.

5 In the Stop Condition Editor dialog box, click New and enter a name for
the used stop condition.
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NOTE If you do not enter a name, the stop condition is used for the current
process but is not stored for later use.

6 Select a feature class.

7 Select an attribute in that feature class.

8 Enter a condition value for the attribute, such as =100.

NOTE There is no blank space between the value and the operator.

If the network trace finds a feature of the selected feature class with the
specified attribute, the network trace stops at that feature.

9 Click OK to save the stop condition.

Logical Topology Initialization
Topobase logical topologies must be initialized before you can use them, for
example, in a utility model (page 586). Start the initialization manually in the
data model administrator.

IMPORTANT Initialization only considers spatial connectivity. It is recommended
that after the initialization you check the logical topology in Topobase Client using
the Manage Connection dialog box.

To initialize a logical topology

1 Start the data model administrator.

2 In the data model explorer, select the topology.

3 Right-click and click Initialize Topology

For each possible connection, the system tries to spatially connect the features
when they are digitized and lie within the Connection Tolerance Radius.

Spatial initialization—When you initialize the topology, the system fills the
<logical topology name>_CONN system table with the connectivity
information.

Spatial online mode—In Topobase Client, when you digitize new features in
Topobase Client, the connectivity table is maintained automatically, where
spatial connection is possible.
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To check the connectivity table after initialization

1 Start Topobase Client and open the workspace.

2 Generate graphic.

3 Click Manage Connections, and explore the connectivity of the features.

Optionally, in the feature class form, click the Connection <topology name>
button to open the connectivity table <topology name>_CONN, and check
for logical, non-spatial connectivity.

Network Topology Update
The topology concept has been updated with the previous version Topobase
2009. When you open a workspace that has an old topology structure for the
first time, the data structure will be updated. Network topologies and attributive
network topologies are automatically upgraded into logical topologies. With
Autodesk Topobase 2009, network topologies have been replaced by logical
topologies.

The self-acting upgrade of a network topology <topology name> into a logical
topology performs several steps.

■ Creating the connectivity table <topology name>_CONN.

■ Transferring connectivity information that is stored in the system tables
<topology name>_NLNK and <topology name>_NNOD, and in the
FID_<name>_FROM and FID_<name>_TO attributes to the connectivity
table <topology name>_CONN.

■ Dropping the system tables and attributes.

■ Defining the following logical topology properties.

■ All point attribute feature classes can only be connected to the line
attribute feature classes.

■ All line attribute feature classes can only be connected to the point
attribute feature classes.

■ Default flow: Forward.

■ Adjusting the forms of the participating feature classes.
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IMPORTANT After the upgrade, we recommend that you check the following.

■ Tracing Conditions—Check the feature class names and attributes names
that are used in the tracing condition SQL statement. See Updating Tracing
Conditions (page 337).

■ Reports

■ Display Models.

Updating Tracing Conditions
Network tracing conditions cannot be updated automatically. If you are
working with a document that has been updated from a previous version, you
must manually convert existing tracing conditions. For example, you must
convert the tracing conditions, if you import an existing Topobase 2008
document.

To convert a network tracing template (cost function)

1 Open the data model administrator.

2 In the data model explorer, select the tracing condition, and click
Properties.

3 Review the SQL Statement For Condition, and find the feature class name
and the SQL expression. For example, a previous tracing condition is:
select PIPE_LENGTH from WA_PIPE where FID = L.FID_ATTR, where
PIPE_LENGTH is the expression, and WA_PIPE is the feature class.

4 Copy the expression to the clipboard.

5 Under SQL Statement, select the feature class, such as Pipe. Click Generate.

6 Replace the placeholder <VALUE> by the expression that you copied.

case /* Line */ when &f_class_id=22 then

( select case /* Pipe */ when f_class_id_attr=30 then

( select PIPE_LENGTH from WA_PIPE where fid=wa_line.fid_attr

) else null end from WA_LINE wa_line where fid=&fid

) else null end

7 Click Validate.
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To convert a network tracing template (stop condition)

1 Open the data model administrator.

2 In the data model explorer, select the tracing condition, and click
Properties.

3 Review the SQL Statement For Condition, and find the feature class name
and the SQL expression. For example, a previous tracing condition is:
select 1 from WA_VALVE where FID = N.FID_ATTR AND ID_VALVE_STATUS

= 3, where ID_VALVE_STATUS = 3 is the expression, and WA_VALVE is
the feature class.

4 Copy the expression to the clipboard.

5 Under SQL Statement, select the feature class, such as Valve. Click
Generate.

6 Replace the placeholder <CONDITION> by the expression that you copied.

case /* Point */ when &f_class_id=31 then

( select case /* Valve */ when f_class_id_attr=45 then

( select 1 from WA_VALVE where fid=wa_point.fid_attr

AND ID_VALVE_STATUS = 3

) else null end from WA_LINE wa_line where fid=&fid

) else null end

7 Click Validate.

See also:

■ Logical Topology: Tracing Templates (page 329)

Topology Offline Initialization Processing
Topobase topologies support two operation modes: Online and Offline.

In offline or initialization mode, you build topologies from all available
elements as a batch. Offline mode is used mostly at topology creation time,
when a huge number of features are related topologically, but corresponding
secondary objects, such as areas, are still missing.

See also:

■ Area Topology Initialization (page 324)
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■ Logical Topology Initialization (page 335)

Topology Online Processing
Topobase topologies support two operation modes: Online and Offline.

In online or interactive processing mode, the topology subsystem responds
to certain user actions, causing a specific result. For example, an area is built
when the edges make a topologically valid configuration, after the user creates
new edges or edits existing ones.

Client-side feature rules control the online processing of area topologies that
occur during user interaction with topology-enabled master feature classes
(centroids and/or edges).

Topology Tutorial
In this tutorial, you will define a template and a condition for tracing a
network.

Defining a Tracing Template for a Logical Topology
You can define templates for network tracing.

Required: logical topology (page 583). It is also useful to define the tracing
conditions before you start to define the tracing templates.

See also:

■ Defining Tracing Conditions (page 331)

To define a tracing template

1 Start Topobase data model administrator.

2 In the data model explorer, select the logical topology, expand it,
right-click Tracing Templates and click Create Tracing Template.

3 Enter a name and comment.

4 Select the tracing type and tracing direction.

5 Select the option Template Is Enabled.
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6 Select the tracing conditions. If no conditions are available, click New to
define a condition.

7 Click OK to finish the definition. The tracing template is added to the
data model explorer.

The tracing can be executed in Topobase Client and Web from the network
tracer.

See also:

■ Network Tracer (page 327)

Defining a Tracing Condition

To define a tracing condition

1 Start Topobase data model administrator.

2 In the data model explorer, select the topology, expand it, right-click
Conditions and click Create Condition. (Alternatively, click the New
button in the Tracing Template dialog box).

3 Enter a name and comment.

4 Select the Condition Type.

5 Select the feature classes that will be used in the condition.

6 Click Generate to generate a skeleton SQL query.

7 Click Assistant, and edit the query.

8 If you are finished selecting and creating conditions, click OK.

See also:

■ Tracing Condition SQL Statements (page 332)
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Jobs Reference

Overview of Jobs
Based on the Oracle® database, Autodesk delivers a long transaction and
versioning framework that meets the specifics of the cadastral applications,
Topobase Jobs.

Topobase Jobs are based on Oracle's VPD (Virtual Private Database) technology.
This makes it possible to have multiple states for an object in the database, such
as live, pending, and open.

Data may change only within a job; whereas data outside a job is read-only.
Within the Topobase Jobs data can be Live, Pending, Open (project data). Live
data is read-only and common for entire enterprise (visible identically in all
jobs, and outside jobs, also).

In addition, any user defined job state can be defined.

■ Open—Once a data modification process is initiated, any data change is
isolated within that job and is not visible in other jobs and outside jobs. The
job is set to open. Feature locking is either Pessimistic Feature Locking, or
Optimistic Feature Locking.

■ Pending—When changes are ready for review and approval, the job
(including all altered data) is set to Pending.

■ Live—When the work is approved and the job is ready for production, the
job is set to Live.

■ Other states—You can define additional job states.

5
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Topobase provides different UIs to configure and process jobs.

■ Topobase Administrator provides Job Administrator.

■ Topobase Client and Web provide Job Manager and Job Explorer.

See also:

■ Getting Jobs Started (page 345)

About Jobs And Job Templates
To work with job-enabled feature classes you must create a job that contains
these feature classes. You can use job templates to create the jobs.

A job template contains pre-defined feature classes that can be processed in
the jobs that are created from this template. Other job enabled feature classes,
which are not in this job, may not be modified or deleted in that job.

Job enabled feature classes can only be edited if they belong to the current job. A job
can only be processed if its state is open.
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You can define an arbitrary number of job templates with any combination
of job enabled feature classes.

Job templates and user groups

You can assign job templates to one or more user groups. For example, to
improve security, a user group is only allowed to use a limited set of job
templates. In Topobase Client, members of this user group can only work with
the assigned jobs templates, and with the jobs that have been created using
these templates.

NOTE Members of the Administrator group can access all job templates, and
process all jobs. When you create a user group, by default all job templates are
available to the members of the new group.

In the Job Administrator, use the Assign Templates To User Groups command
to assign unassigned job templates to user groups.

NOTE Existing jobs from previous versions will not be assigned to a user group,
so they can be used by everyone.

See also:

■ Job Administrator (page 353)

■ Creating a Job Template (Job Administrator) (page 350)

About Job States
Job states and their transitions can freely be defined. They are stored in the
system tables TB_JOB_STATE and TB_JOB_STATE_TRANSITION.

When you job enable the document, you lock the features so that they can
only be modified within a job (long-term transaction). Any feature
modification is isolated in the job, and after approval you can change the job
state of all modified features to Live.

Default job states

■ Live

■ Pending

■ Open
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■ Deleted: Pseudo state. Deleted jobs are not stored in the database.

A job may contain one or more topics and each topic has its own job state.
The topic's job states are stored in TB_JOB_TOPIC_STATE.

You can use the document options to specify whether to perform a job topology
(page 586) check when the job state is changed.

Change the job state in Topobase Client. See the Topobase Client User Guide,
section Changing the Job State.

See also:

■ Job Administrator (page 353)

■ System Table TB_JOB_STATE (page 162)

■ System Table TB_JOB_STATE_TRANSITION (page 163)

Jobs Feature Locking
Topobase supports two types of feature locking, where the main difference is
the handling of job conflicts. A job conflict occurs if the same feature is
modified in different jobs.

Pessimistic Feature Locking

Feature Locking type where a feature can only be modified in one job. Use
Pessimistic Feature Locking to detect and solve any job conflicts as early as
possible. For example, in Job A you add a transformer on a pole, and in Job B
another user B selects the same pole to delete it from the database. Then, with
pessimistic feature locking, user B immediately receives the warning that the
feature is locked, rather than at job commit time. User B cannot modify the
feature.

To solve the job conflict, user B would contact you, and you can jointly decide
how to proceed. For example, you can use the Partial Posting command to
extract the respective features from your Job A, so that it can be modified in
Job B.

You use Partial Posting to extract a subset of features from the current job to
change its state to Live immediately. Then the modified features can be
modified again in other jobs.
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For more information about Partial Posting, see Topobase Client User Guide,
section Changing the Job State.

Optimistic Feature Locking

Feature locking type, where a feature can be modified in different jobs. Use
Optimistic Feature Locking, if you want to allow modifications, even if conflicts
occur. With Optimistic Feature Locking, job conflicts will not be detected
immediately, but only when you change the job state. After the first job has
been merged forward, and when the second job is being merged forward, the
Job Conflict Manager appears.

To change the feature locking type

Requirement: No job must be Open or Pending.

1 In the administrator explorer, select the document.

2 Click Document menu ➤ Settings. On the navigation pane, click Jobs.

3 On the right pane, clear Enable Jobs (Versioning) For This Document. If
the document contains Open or Pending jobs, this option is deactivated.

4 Click Save to job disable the document.

5 Select Enable Jobs (Versioning) For This Document.

6 Select the new Feature Locking Type.

7 Click Save.

Getting Jobs Started
Before you start working with jobs in a document, you must configure jobs
using Topobase Administrator, and create jobs, using Topobase Client or Web.

Start Topobase Administrator.-----To configure Jobs
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Optionally assign a perimeter feature class.-----
Job enable the document (page
348) See also Jobs Feature Locking (page 344).

See also About Jobs And Job Templates (page 342).-----Create Job templates. (page 351)

Use Display Models to style the features that are
part of a job.

-----
Style job enabled features. (page
470)

Start Topobase Client.-----Work with Jobs
Start the Job Manager.

Use a job template. After a job is created, it has
the job state Open and you can start working.

-----Create a Job

See also:

■ Job Administrator (page 353)

See also Topobase Client User Guide, section Managing Jobs.
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Job Enabling (Document Settings)
To work with jobs, you must job enable the document. When you job enable
the document, you lock the features so that they can only be modified within
a job.

Job enabling comprises the following steps.

■ Setting the document to job enabled. You either create a job enabled
document, or you job enable an existing document later. Also, you can
modify this setting.

■ Specifying the feature locking type.

■ Optionally, assigning perimeter feature classes.

NOTE You job enable a document when you create the document. However the
perimeter settings must be set after job enabling, because only job enabled feature
classes can be assigned as a perimeter feature class.

Job enabling starts certain routines. For example, it adds a JOB_VERSION
attribute to each feature class and writes Topobase Jobs metadata (TB_JOB*
system tables).

WARNING Do not edit the Topobase Job system tables manually.

You use the job enabled feature classes to define any number of job templates.
Job templates are defined in the Topobase Job Administrator.

See also:

■ System Tables TB_JOB_* (page 159)

■ Creating a Job Template (Job Administrator) (page 350)

To create a job enabled document

Use the Job Document Settings to job enable a document.

1 Create the database. See Create New Document Dialog Box (page 71).

2 Click Document menu ➤ Settings. On the navigation pane, click Jobs.

3 On the right pane, select Enable Jobs (Versioning) For This Document.

4 Under Feature Locking Type, select the locking type. See also Jobs Feature
Locking (page 344).
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5 Click OK to create the document.

Optionally, after the document has been created, you can assign the perimeter
feature classes. See Assigning a Job Perimeter (page 349)

To job enable a document

You can job enable a document at any time. Use the Job Document Settings
to job enable a document.

1 In the administrator explorer, select the document.

2 Click Document menu ➤ Settings. On the navigation pane, click Jobs.

3 On the right pane, select Enable Jobs (Versioning) For This Document.

4 Under Feature Locking Type, select the locking type. See also Jobs Feature
Locking (page 344).

5 Click Save.

Optionally, assign the perimeter feature classes. See Assigning a Job Perimeter
(page 349)

To job disable a document

If all jobs are Live, you can job disable a document. That means that no job
must be Open or Pending. For example, if you want to modify the feature
locking type, you must job disable the document.

Use the Job Document Settings to job disable a document.

1 In the administrator explorer, select the document.

2 Click Document menu ➤ Settings. On the navigation pane, click Jobs.

3 On the right pane, clear Enable Jobs (Versioning) For This Document.

4 Click Save.

NOTE If the check box Enable Jobs (Versioning) For This Document is disabled,
the document contains open or pending jobs.

See also:

■ Jobs Feature Locking (page 344)
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Assigning a Job Perimeter
A job perimeter is a polygon feature class that limits the area where a certain
job shall be processed (job perimeter (page 583)). Perimeters are mainly used
in Survey applications; however, they may be introduced in arbitrary
applications as well. The perimeter feature class stores the job perimeter of
the respective jobs. You either assign one perimeter for all feature classes, or
you assign a different perimeter feature classes for single topics.

NOTE The use of job perimeters is optional. However, if you assign a perimeter
feature class and then create a job, you also must select a job perimeter.

With job perimeters, you can control the spatial area within a certain job,
where modifications are allowed. Also, you can define feature rules to be
applied on the objects with a perimeter, such as a perimeter check.

We recommend that you assign a polygon feature class that is used only for
perimeters. If necessary, create a polygon feature class for that purpose.

Topobase Client User Guide, Defining the Job Perimeter

To assign perimeter feature classes

1 In the administrator explorer, select the document.

2 Under Document, on the navigation pane, click Jobs.

3 Under Perimeter Settings, enter the options as shown in the following
table.

DescriptionPerimeter Settings

Optional: Assigns a perimeter feature class. Lists
all available polygon feature classes of the current

Perimeter Feature Class

document. Feature Classes that belong to a topo-
logy or an intersection are not listed.

Assigns a buffer. Notice, that the unit is the length
unit as set in the document settings. You can en-
hance the perimeter polygon with the buffer.

Additional Buffer Around
Perimeter

Assigns a perimeter feature class to a topic. Click

 if you do not want to use the same

Advanced Settings
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perimeter for all topics, but if you want to use
different perimeter feature classes for some or all
topics. The advanced settings override the general
setting.

To view the perimeter check feature rule

1 In the data model explorer, select the feature class.

2 Right-click and click Edit Feature Rules.

3 Click the Server Side (PL/SQL) tab. The Check Perimeter rule is applied.

If you have assigned a perimeter feature class, the Perimeter Check feature
rule has been activated automatically. This is one of the predefined Topobase
server-side feature rules. It checks whether a feature is inside the selected
perimeter.

See also:

■ About Feature Rules (page 571)

Creating a Job Template (Job Administrator)
Before you start working with a job, you must specify which of the job enabled
feature classes you want to work with. Normally, you work with the same
grouping of feature classes, so it is helpful to pre-select those feature classes.
Do this by creating job templates.

NOTE Use the job templates in the Topobase Job Manager to create the jobs.

You can define job templates with the Topobase Job Administrator. It is
required that before you define job templates, you must job enable the
document.

Creating a job template means combining job enabled feature classes to process
together in one job. You can combine feature classes from different topics
into one job template. When you work with a job that has been created from
this template, you can change the state of each topic separately.

See also:

■ Job Enabling (Document Settings) (page 347)
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■ About Jobs And Job Templates (page 342)

To create a job template

1 Start Topobase Administrator and open the workspace.

2 Select the document and click Document menu ➤  Job Administrator.

3 In the Job Administrator explorer, expand Jobs and select Job Template.

4 Right-click and click Create.

5 In the Job Template dialog box, click the Feature Classes tab.

6 Select the topics and feature classes you want to add to the template.

7 Click the User Groups tab.

8 Assign the job template to the user groups that are allowed to use the
template.

9 Click OK. The new template is added in the explorer tree.

To change the user group of a job template

1 Start Topobase Administrator, and open the workspace.

2 Select the document, and click Document menu ➤ Job Administrator.

3 In the explorer tree, select the job template, and click Edit.

4 In the Job Template dialog box, click the User Groups tab, and assign the
user group.

Job Leasing
By default, data that is processed within a job can only be accessed by the
Topobase application. Using Job Leasing, you can make data available to other
applications also, for example to SQL plus or import routines. Without job
leasing, data is not available until the job state has been set to Live.

To lease a job

Use the Topobase Client Job Manager to lease a job.

1 Start either Topobase Client or Web and open the workspace.
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2 Start the Job Manager.

3 In the Job Manager explorer, select the job, right-click, and click Lease
Job.

4 In the Lease Job dialog box, specify the end date of the lease.

To release a job

Use the Topobase Client Job Manager to release a job.

1 Start either Topobase Client or Web and open the workspace.

2 Start the Job Manager.

3 In the Job Manager explorer, select the job, right-click, and click Release
Job.

Jobs Update
The previous version Topobase 2009 provided a new job concept. When you
open a Topobase workspace containing the old job concept, you can update
the jobs to the new concept.

Topobase Job Concept

■ Job Enabling—You can only job enable the whole document. Job enabling
of single feature classes or topics is no longer possible.

■ Job Perimeter—You can use one perimeter feature class for the whole
document. Or you can assign a perimeter feature class for each topic. If
necessary, use the Edit Feature Class command to assign a perimeter to a
single feature class.

■ Feature Locking—You can set the feature locking type either to Pessimistic
Locking, or Optimistic Locking. The previous version supported Optimistic
locking.

When you open an existing workspace for the first time, the document
structure is updated automatically. For job enabled documents, if the job
configuration does not match the new job concept, a message informs you
that you must repair the job configuration.

You use the Document Settings to repair an invalid job configuration.
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To repair the Job Document Settings

1 Start Topobase Administrator, and open the workspace.

2 In the administrator explorer, select the document.

3 Click Document menu ➤ Settings. On the navigation pane, click Jobs.

Topobase checks the job configuration. For existing documents, that have
been processed using Topobase 2008, the Feature Locking Type is set to
Optimistic Feature Locking.

4 If different perimeter feature classes are detected in one topic, the
Perimeter Feature Class is set to Advanced Settings (See Below). Click

 to open the Advanced Settings. Select one perimeter feature class
per topic.

If necessary, you are prompted to repair the job configuration. Click Repair
to job enable the whole document.

To change the feature locking type, see Jobs Feature Locking (page 344).

See also:

■ Assigning a Job Perimeter (page 349)

■ Jobs Feature Locking (page 344)

Job Administrator
Use the Topobase Job Administrator to define and edit job templates, assign
job templates to user groups, specify topology checks for job states, and
administer job transition passwords.

See also:

■ About Job States (page 343)

■ Setting Document Option (page 130)

To start the Job administrator

1 Start Topobase Administrator.
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2 Open the workspace.

3 Click Document menu ➤ Job Administrator.

To set up job templates

1 Start Topobase Administrator.

2 Open the workspace.

3 Click Document menu ➤ Job Administrator.

4 On the right pane, in the explorer tree, expand Jobs and Job Templates
to see all available templates.

In the explorer tree, use the buttons or shortcut menus to process the job
templates.

DescriptionJob Template com-
mands

To create a job template. See also Creating a Job Template
(Job Administrator) (page 350)

Create

To edit a job template, to assign the template to a user group,
and select feature classes.

Edit

To delete the job template.Delete

Opens the Set User Groups For Job Templates dialog box.
Select a user group, and assign the templates. See also About
Jobs And Job Templates (page 342).

Assign Templates To
User Groups

To set job transition options

You can specify at which transitions an area topology check shall be executed.
We reccommend that you check the topologies when the job transition state
changes from Pending to Live.

1 Start Topobase Administrator.

2 Open the workspace.

3 Click Document menu ➤ Job Administrator.
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4 Under Job Transitions, for each topology, and for each transition state,
select the state changes, at which to check the topologies.

NOTE You must set the document to job-enabled before creating job templates,
or specifying topology checks on job transitions. See Job Enabling (Document
Settings) (page 347).

DescriptionJob Transitions com-
mands

Temporarily disables all checks, but keeps the settings. Clear
this option, to enable your settings again.

Disable All Checks

Allows to change the job state, even with topology errors
detected.

Allow Transition With
Topology Errors

Saves the settings.Save

Clears all settings.Reset

To change the passwords that allow a user to change the job
states. For each transition you can define different passwords.
See also About Job States (page 343)

Password
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Form Designer Reference

Form Designer Introduction
Autodesk Topobase Client is a basic module, used to process both geometry and
attribute data that is stored in the database. With Topobase Form Designer you
can customize the feature class forms.

Use the Form Designer to define multiple forms for a single feature class, and
to assign different forms to different user groups.

NOTE Also, you can customize the forms of any tables, views, synonyms, or domain
tables with the form designer.

To learn more about customizing Topobase feature class forms, you should start
with the following topics:

See also:

■ Starting Form Designer (page 357)

■ Form Designer: Controls (page 367)

■ Form Designer: Toolbar (page 369)

See also the Topobase Client User Guide, section Using Feature Class Forms.

Starting Form Designer
Topobase Form Designer is a tool that you use to design forms for processing
feature data (feature class forms). For example, you can hide or show text boxes,

6
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create controls, check boxes, radio buttons, and combo boxes in the forms.
Arrange elements to create a form that suits your needs.

You must have Topobase Administrator login rights (member of the ADMIN
user group (page 586)) to use the form designer.

To start the form designer

1 Start Topobase Administrator and open a workspace (page 586).

2 In the Administrator explorer, select the document (page 581).

3 In the Administrator window, click Document menu ➤ Form Designer.
Alternatively, you can click the Form Designer item in the administrator
explorer.

4 The form designer is displayed in the right pane. The topics and feature
classes are displayed in the form explorer.

5 In the form explorer, select a feature class. In the right pane, the forms
of the selected feature class is displayed.

6 Under Form Types, select a form, such as Default.

7 Click Edit. The Designer dialog box opens.

If you have selected a master detail form (page 584), you are prompted to select
the form to edit.

See also:

■ Form Designer: Creating Generic Forms (page 359)

■ TB_RELATIONS: Master-Detail Relations (page 175)

Form Designer: Managing Multiple Forms
Use the Form Designer to define multiple forms for a single feature class, and
to assign different forms to different user groups.

When you start the form designer, in the designer pane, you administer
multiple feature class forms. For example, you define a form that only displays
the attributes that are allowed to be edited by the VIEWER user group. Then
you assign this form type to the user group VIEWER.
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NOTE A user can be in multiple user groups. If each user group has a different
form assigned, a priority applies. See User Group Priority (page 100).

DescriptionDesigner pane

Displays the form definition that are available for
the selected feature class. The default form provides

Form Types

a basic form definition containing controls for all
feature class attributes.

Adds a form definition. Opens the Designer dialog
box for the selected feature class. See Form Design-
er: Creating Generic Forms (page 359).

Add

Opens the Designer dialog box to edit the selected
form. See Form Designer: Creating Generic Forms
(page 359).

Edit

Duplicates the selected form.Duplicate

Displays the selected feature class form.Preview

Deletes the selected feature class form. You cannot
delete the default form.

Delete

Assigns a form type to a user group.Assign a form type area

Displays the user groups.User Groups

Assigns the form to the user group.Assigned Form Type

Form Designer: Creating Generic Forms
Use the Topobase form designer to customize feature class forms.

NOTE Make sure you know all about the components of Topobase feature class
forms.

In the Form Designer, when you edit a feature class form, two windows are
opened: the feature class form and the Designer dialog box. In the Designer
dialog box, in the right pane, you can see all the form’s controls (input fields,
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controls, buttons, and so on). In the left pane, you can process the particular
elements.

Use the Controls tab to define the database attributes and controls that are
shown in the form.

Use the Properties tab to define the properties of each control.

Topobase Form Designer: In the left pane, on the Properties tab, a list of the properties
of the control that is selected in the right pane is displayed.
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Topobase Form Designer: On the Controls tab, a list of visible and hidden controls is
displayed.

■ Visible controls—This list is an overview of all controls that are visible in
the current form. To hide a control, drag it from the Form to the Hidden
list box.

■ Hidden controls—This list contains all controls that are currently hidden.
To display a control in the form, double-click or drag the entry.

Hidden controls—This list contains all controls which currently are hidden.
To show a control in the form, double-click (or drag-and-drop) the entry.

Also, you can use the Edit menu commands to hide or show controls.

NOTE To hide a control in the form, drag it to the Hidden list.

See also:

■ Starting Form Designer (page 357)

■ Form Designer: Menu Bar (page 361)

Form Designer: Menu Bar
Contains the following commands to control the
appearance of the feature class forms:

Designer menu
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Controls the general appearance and assigns Help
files or Help documents.

Options

Controls the appearance of master-detail forms.Master-Detail

Changes the order of the attributes or hides/shows
certain controls in table view mode (in the grid).

GridOrder

Select Automatic to order the controls by their
position (Top, Left) as defined in the form designer.
For forms containing several tabs, the order is Tab
ID, Top, Left.
Clear Automatic to define your own grid order. Se-
lect or clear the controls and use the arrows to move
them.

Cancels all changes that you have made.Exit Without Saving

Exits the form designer and saves all layout changes
and configurations.

Exit

Contains the following commands to process the
controls of the current form. Note that in some
cases, you can use hotkeys or drag a control.

Edit menu

You can copy and paste controls with all settings,
such as for the position and caption. Controls that

Copy
Paste

are related to an attribute are only pasted, if the
attribute exists in the target form. If you paste a
control that is related to an attribute, you are noti-
fied that some controls already exist and that you
can replace them. If you do not want to replace
them, only the new controls are pasted.

Hides hide or shows controls. By default, all controls
are displayed. All hidden controls are listed in the

Hide All
Show All

left pane on the Controls tab (Hidden). All others
are listed in Visible.

NOTE Use the Hide command to remove a control
that refers to a database attribute.
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Hides hide all controls that have no data (NULL) in
the attribute of the table. You can remove the con-
trols of unused attributes.

Hide Controls Without Data

Use Close Gaps to close the gaps in the layout.

Hides all reference controls.Hide All Reference Controls

Removes or creates gaps between controls. If you
hide some of the default controls, there can be gaps
between the remaining controls.

Create Gap
Close Gaps

The tab order defines the order, in which the cursor
will move when you press <TAB> or <ENTER>. De-

Auto Tab Order

fault setting is Auto Tab Order is ON = From left to
right and from top to bottom.

NOTE The tab order affects only the Form view
mode. You can set the Grid Order in Table View
mode.

Changes the position of a control by moving it up-
wards or downwards. The command refers to a
single highlighted control.

Move Control

Deletes the selected control. If the control refers to
a database attribute, for example FID, delete does

Delete Control

not affect the database. The next time you start the
form designer, the control is listed as Hidden.
Controls with no relation to database attributes are
completely deleted.

NOTE Use this command to delete controls, such
as for picture box or static label.

Contains commands to select and process the con-
trols of the current form.

Selection menu

Selects and highlights the controls of the current
form.

Select All

Note: You can also select several controls at once
(multi-selection), using the following:
By rectangle—Drag a rectangle containing the
controls you want to select.
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By click—Press Ctrl or Shift+click.

Hides or deletes the selected controls. Notice the
difference between hide and delete.

Hide Selected
Delete Selected

Moves a control from one tab to another.Move Selected To Tab Page

Contains commands to process tab pages.Tab Pages menu

See also:

■ Designer Menu: Options (page 364)

■ Designer Menu: Master-Detail (page 366)

■ Designer Menu: Tab Pages (page 366)

■ Form Designer Example: Auto Tab Order (page 406)

Designer Menu: Options
In the Designer dialog box, click Designer menu ➤ Options.

DescriptionOption Dialog
Box

These settings cannot be edited.System Category

TB_GN_DIALOG.ID, can help to find the record in trouble-
shooting.

ID

Oracle table name of the current feature class.Tablename

Alias = caption for the oracle table (as defined in Topobase Ad-
ministrator).

Name

Defines the title to be shown in the forms title bar.Title

NOTE By default the title of a form corresponds to the title that
has been set in Topobase Administrator.

Assigns a special toolbar to the form. Usually you will define
tool bars for the different types of tables, such as feature class,

Toolbar
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domain and so on. For example, a domain table toolbar does
not need any tools concerning graphic connection. Therefore
you need to define only a single toolbar for a group of forms.
Select a toolbar from the Toolbar box.

Defines the order in which features are listed, such as according
to point number or according to FID.

Startup
SortOrder

Assigns a Help topic to the form.Help

NOTE You can also assign Help topics to each control of the
form. See also Form Designer: General Control Properties (page
373)

For desktop Help: Enter any help file (*.chm, *.hlp or any Win-
dows document), as for example Topobase.chm. The files must

Filename

be located in the directory <topobase>\Help or in a subdirectory
of this. Always set the filename without the directory name.
If you specify a (*.chm) help file, you can specify a topic ID in
the Context property.

For desktop and Web help: Context ID or URL of the Help topic,
as for example topobase_introduction.htm.

Context

Example: topic.htm#bookmarkname or topic.htm.

NOTE If you leave the URL empty, this context is also used for
the Web Help. In this case the Web Help location will be <topo-
base_web>/help/context.

For the Web Help: URL of the Help topic, as for example index-
web.html. Default folder is <topobase_web>\help.

Url

Example: To use a file in a subfolder of the default directory,
you have to specify the file starting with the subfolder name,
as for example customized/help.html.

NOTE Without the “http://” the files are searched on the Topo-
base Web server.

See also:

■ Defining Form Toolbars (page 424)

■ Assigning Help Files to Feature Class Forms (page 426)
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Designer Menu: Master-Detail
In the Designer dialog box, click Designer menu ➤ Master-Detail.

DescriptionMaster-Detail Dialog
Box

Lists the relations that are defined as master-detail.Current Details

Lists all related tables: <table_name of related table>,
<column of related table>, <column of table>.

Available

Click to select an item and then click an arrow button
to move from one list to the other or to change the or-
der.

Height of detail form: One default value for the height is stored in the system
table TB_GN_DIALOG.DefaultDetailHeight. Do not edit this table manually.
If someone who is not an ADMIN user (page 586) opens a master-detail form
for the first time, this size is applied.

See also:

■ TB_RELATIONS: Master-Detail Relations (page 175)

Designer Menu: Tab Pages
For feature class forms in form view mode, you can apply several tabs (Tab
Pages) to display information.

In the Designer dialog box, click Tab Pages menu and click commands to
create and edit tabs.

Click Tab Pages menu ➤ Group Suspend to specify that the tab page is invisible
for one or more user groups. Tab pages can be suspended for certain user
groups.

See also:

■ Defining Tab Pages for Forms (page 423)

For more information about feature class form view modes, see the Topobase
Client User Guide, section View mode shortcut menu.
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Form Designer: Controls
Topobase Form Designer provides different types of controls to customize the
feature class forms.

The first type of controls show the content of a particular database attribute,
for example FID, POINT_NUMBER, and so on. Each attribute of a table may
have exactly one control of one of the following types:

■ Property text box (TEXTBOX)

■ Basic combo box (COMBOBOX)

■ Check box (CHECKBOX)

■ Color combo box (COLORBOX)

■ Picture linker (PICTUREBOX)

■ Picture combo box (PICTURECOMBOBOX).

These controls have a property category Database that shows the attribute
name and dimension.

The second type of controls allow access to records related to the current
record. These are created for each relation, but you can define additional
controls. For example, by default, a reference control is defined for label feature
classes.
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Form Designer: Reference type controls look like a button and allow accessing related
data. Click the control in the right pane and set its properties.

The third type of controls add layout elements, such as text, pictures, buttons,
and lines. They have no counterpart in the database. For example, they are
used to write commentary, illustrate the form, or add a company logo.

Form Designer: Default Forms
When you start the Topobase form designer for the first time, a default form
is created. It normally contains controls of the following type:

■ Property text boxes—For database attributes without any relation

■ Basic combo boxes—For database attributes with relation to another table

■ Check boxes—For database attributes declared as number (1)

■ Basic form launcher—For relations pointing to the current table, for
example for a relation to a label feature class (page 583)

The maximum InputLength of an attribute corresponds to the data structure
and input is limited to this size.

The sort order of the attributes is defined by the COLUMN_ID of
USER_TAB_COLUMNS. This order should correspond to the order of creation
in Oracle.
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Form Designer: Toolbar
The toolbar of the Designer dialog box provides distinct commands for creating
and editing forms. The toolbar icons are grouped according to their function.

Click an icon to add a control to the form, as shown in the following table:

DescriptionIcon

NOTE The controls TEXTBOX, CHECKBOX, COMBOBOX, COLORBOX,
PICTUREBOX and PICTURECOMBOBOX refer to a database attribute.
For each attribute, you can apply one appropriate control.

If all database attributes have one of these controls, no further control
of this type can be created. The message "All Attributes Have A Control!
Would You Like To Replace An Existing Control ?" indicates that there
are no attributes without a control in the current form. Click Yes to
replace the control. In the Select Control To Be Replaced list you can
select the attribute.

Controls, used to show a text box, referencing a value

Property TextBox
Class name: TEXTBOX
Adds a text box to show the content of the database attribute. Use a
text box to show the content of a database attribute. The Message:
All Attributes Have A Control ! means: In the current form, there are
no attributes remaining without control.

Read-Only SQL TextBox
Class name: SQLLABEL
Adds an SQL Label. Use this to show the result of an SQL query. You
can define a select statement to query any information. The result is
shown in the form, but cannot be edited. Example: Use SQL label to
calculate the total area of all related parcels.

Editable SQL TextBox
Class name: SQLTEXTBOX
Adds an SQLTextBox: Use this to show the result of an SQL query, for
example, to show the area which is stored in a different table. The
result can be edited and the value is saved (update). Use this type of
control only if you query a single attribute.
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Class name: FORMULA
Adds a formula to show the result of a calculation using the database
attributes. Use this to calculate values. You can use all database attrib-
utes and all mathematical expressions (VB .NET code).

Controls that open an editable form, showing all properties of a
referenced feature or set of features.

Basic Form Launcher
Class name: REFERENCE
Adds a Reference. Use this to show data related to the current record.
Reference controls are created for all relations that point to the current
table, for example, the relation to the label feature class.

NOTE This control is set by default, according to TB_RELATIONS

FID Form Launcher
Class name: FIDREFERENCE
Adds a FID-Reference to open a form that belongs to a certain FID
(dynamic relation, multi-relation). An FID Reference is not linked to a
database attribute of the current table. Use FID References to show
data with a special FID.

SQL Form Launcher
Class name: COMLEXREFERENCE
Adds a ComplexReference to create references using complex SQL
statements, for example to open a form of another table. A Complex
Reference is not linked to a database attribute of the current table. Use
this to open the form of another table with a filter. You can define this
filter with complex SQL statements.

Advanced Form Launcher
Class name: MULTIREFERENCE
Similar to the Reference control, you can use multi-relations.

Combo boxes

Basic Combo Box.
Class name: COMBOBOX
Adds a combo box that enables acquisition through a dropdown list.
A combo box is always linked to a database attribute. Use this control
to select your entry through a combo box from a domain table (*_TBD)
or any other related table.
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Color Combo Box.
Class name: COLORBOX
Adds a color combo box that can be used to select a color from a list.

Advanced Combo Box.
Class name: MASTERBOX
Adds an advanced combo box (master box). The master box control
is similar to an add-on to the combo box control. Use this control to
define one or more filters (pre-selections) for a combo box. For ex-
ample, to enter a street name, you define a filter for the city. In the
form, the master box looks like a combo box.

Picture ComboBox
Class name: PICTURECOMBOBOX
Provides picture file names in a list box.

Model Selector
Class name: MODELBOX
Adds a control for acquisition of model driven attributes. See also Data
Model: Model Tables (page 220).

Linkers

Document Linker
Class name: DOCUMENTMANAGER
Opens the document manager and shows whether any documents
are available.

Picture Linker
Class name: PICTUREBOX
Displays record-related pictures.

FID Linker
Class name: FIDBUTTON
Adds an FID button that can be used to select a feature in the map
and fill an attribute with this value (data acquisition).

Programmable controls

Script-Programmable Control
Class name: SCRIPTBUTTON
Inserts a control that is programmed using VB script.
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API-Programmable Control
Class name: APICONTROL
Inserts a control that is programmed as a DLL.

Static content

Static Text
Class name: LABEL
Adds a label. Use this to write any text, notes, or remarks in the form.

Static Picture Box
Class name: STATICPICTURE
Adds a StaticPicture: Use this to position a picture in the form, for ex-
ample, a company logo.

Horizontal Line
Class name: LINE
Draws a line. Use this to paint horizontal or vertical lines into the form.

Other controls

Coordinates Editor
Class name: GEOMETRY
Adds a Geometry control to show coordinates and to enable edition
of coordinates. Use this to show coordinates (Y, X, Z) in the form.

Checkbox
Class name: CHECKBOX
Adds a Yes/No CheckBox. A check box is always linked to a database
attribute. Use this control to show the content of a database attribute
which can only be 1 or 0, respectively Yes/No, or Open/Closed.
A check box control is assigned to database attributes which are de-
clared as num (1).

Feature Highlighter
Class name: HIGHLIGHTBUTTON
Highlights a feature in the map.

See also:

■ Creating Controls (page 420)

■ Form Designer Example: Advanced Combobox (page 415)
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Form Designer: General Control Properties
The following general control properties belong to all types of controls:

DescriptionProperty

Specifies the name of the form. For each feature class,
Topobase provides a default form. You can define mul-

Form Type

tiple forms per feature class. See also Form Designer:
Managing Multiple Forms (page 358).

System category properties cannot be changed.System Category

All controls related to a database attribute are named
like the attribute. For example, the text box FID.

Name

All other names start with the suffix "$", such as
$FIDREFERENCE or $FORMULA1 or $FORMULA2.

For example: TextBoxClassName

Base Category

This caption is displayed in front of the input box.Caption

Specifies that the controls are visible but locked for one
or more user groups. Select the group whose members
are not allowed to use this control.

GroupLocked

Specifies that the controls are invisible for one or more
user groups. Controls can be suspended for certain user

GroupSuspend

groups. Select the group whose members are not al-
lowed to use this control.

Hides a control in Table View mode. True = hidden, false
= shown.

HideAtGrid

Defines the tab order. Each time a user presses <TAB>
or <ENTER>, the cursor moves to the control (input field)

NextControl

that you can define here. This way, you can control the
order of inputs.

Help text that is displayed when the cursor hovers over
the input field.

ToolTipText
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Database Category

Description of the attributeColumnDesc

Attribute nameColumnName

Assigns a help topic to a control. The topic is displayed
if you press F1 while the cursor is on the control. The

Help Category

properties are the same as for the form Help. See also
Designer Menu: Options (page 364)

Assigns a help topic, such as topobase_introduction.htm.Help Context

For the desktop version: Specifies the help file. For ex-
ample, Topobase.chm.

HelpFilename

NOTE If you define no HelpFilename for a control, To-
pobase Client will use the HelpFilename of the form.

For the Web version: URL of the Help topic. For example,
index-web.html.

HelpURL

Specific Category

True = if the user enters a value, the system checks
whether the value is unique for the feature class. Note,

ClientSideUniqueCheck

that this property does not apply to the Oracle database
property. Example: Set this value to True to import data
from excel, that may contain identical values. In this case,
you would have set the Oracle property to Non Unique
to allow the import from excel. However, you want to
prevent the user from entering new values that already
exist.
The default is False.

More properties are shown in the following sections.

See also:

■ Form Designer Example: Auto Tab Order (page 406)

■ Designer Menu: Options (page 364)
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Form Designer: Advanced Combobox - Properties
An Advanced Combobox (master box) control is an add-on to a combo box.
You can relate an advanced combo box both to a basic combo box or to
another advanced combo box in the current form. Therefore, you can catenate
several dropdown lists and trace multiple relations, as shown in the following
table:

DescriptionProperty

System Category

MasterBoxClassName

Name, for example $MASTERBOX7Name

Base

Default = falseIsLocked

Specific Category

Name of the ComboBox control, for example FID_STREETDetailControl

Detail attribute with relation to master table
(child_column_name),

DetailAttributeName

for example FID_CITY

DetailFilter

With the FidButton, you can select a feature in the map.
Then, the record of the master table is selected with the FID

FidButton

of the selected feature and the dependent value of the record
is selected in the list.

True = show a highlight buttonHighlightButton

Master attribute of the master table (parent_column_name),
for example FID

MasterAttribute-
Name

Filter: you can define a filter for the master box dropdown
list.

MasterFilter
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Display attributes: Shown in dropdown list of the master
box, such as NAME

MasterList

Orderby. You can sort the items in the dropdown list.MasterOrderBy

Table from which you choose the pre-selection for the detail
control (parent_table_name), for example LM_CITY.

MasterTable

See also:

■ Form Designer: General Control Properties (page 373)

■ Form Designer Example: Advanced Combobox (page 415)

Form Designer: Advanced Form Launcher - Properties
You use Advanced Form Launcher (Multi Reference) controls in the same way
as Basic Form Launcher (Reference) controls. The difference is that can use
multi–relations. That is, with one button, you can open more than one form
at the same time.

The Advanced Form Launcher generates two buttons: the Reference button
and the Projection button. If the user presses the Reference Button, the form
of all the related tables is opened, with a filter set to the current record.

NOTE There is a difference between Reference and Projection: The Reference
Button shows related features of the current record. The Projection Button shows
the related features of all records that are in the current filter.

DescriptionProperty

System Category

MultiReferenceClassName

Name, default = $MULTIREFERENCE9Name

Specific Category

Select the relations/formsDetailRelations

Default = trueProjectionButton
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Default = trueReferenceButton

Example with Feature classes Parcel, SmallHouse and LargeHouse with relations
in TB_DICTIONARY

■ Parcel.FID -> SmallHouse.FID_Parcel

■ Parcel.FID -> LargeHouse.FID_Parcel

If you click the FID button, all related forms that have at least one record that
matches the relation, are opened.

See also:

■ Form Designer: General Control Properties (page 373)

■ Form Designer: Basic Form Launcher - Properties (page 381)

Form Designer: Basic ComboBox - Properties
This control is frequently used for domains (*_TBD). When a form is created,
every attribute with a relation to a domain receives a basic combo box. All
entries in TB_RELATIONS are analyzed.

Basic combo box properties: A combo box always has a drop-down arrow that
you use to select an entry. If the related feature has geometry, you can
optionally set an FID Selection button to identify and assign the related object
in the map and a Highlight button to highlight the related object in the map.

DescriptionProperty

System Category

ComboBoxClassName

Name = attribute name, for example ID_STATUSName

Base

If True, the value can be entered by using a reference
record.

AllowReference

True = cannot be editedIsLocked
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True = must always be acquired. In edit mode these at-
tributes are highlighted by a red background color.

IsMandatory

Defines a validation code for each input field. During
validation, values from other attributes can also be
queried.

ValidationCode

Defines a message to display if validation fails.ValidationMessage

Specific Category

True = default = If you double-click, the form of the re-
lated table will appear.

AllowDoubleClick

False = If you double-click, no table will appear.

All Detail entries belong together. They can be entered
together in a separate dialog box that appears when
you click any of the respective drop-down arrows.

Detail

The detail table may also reside in a document that is
not the current document.

DetailDocument

Detail attribute that is stored, for example, ID; usually
the attribute is set according to TB_RELATIONS.

DetailFieldName

Default filter = empty. Detail Listfilter: You can define
which records of the detail table are available, for ex-

DetailFilter

ample, ACTIVE=1. Also, you can define an additional
filter.

Detail Listfiled: attribute to show in the form, for ex-
ample, VALUE.

DetailList

For example, use ID || ' - ' || VALUE to show both ID and
VALUE.
For domains usually the ID is listed. It is reasonable to
change this into VALUE, as this is more clarifying.

Defines the sort order of entries in the detail table, for
example, VALUE.

DetailOrderBy

The related table. For example *_TBD, which is usually
the detail table that is set according to TB_RELATIONS.

DetailTable*
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True = an FID selection button is shown next to the input
box. Use this only if the relation points to a geometry
feature that can be identified in the map.

FidButton**

True = shows a highlight buttonHighlightButton

True = default; by default, all values of the specified de-
tail table are loaded once in a session. If set to False,

UseBuffer***

loads the detail table every time you open the combo
box (by pressing the drop-down arrow button) or you
change (update, or navigate to) the record.
Note: A False setting negatively impacts performance.
Always set this option to True if you work in Table View
mode, because in this case records are changed fre-
quently in order to show all records.

Specifies a default value to insert when you add a new
record. You can also use this for the AutoIncrement value
or date/time and to create GUIDs.

ValueDefault

* DetailTable: The preview pane shows the detail list. Click refresh to check
whether your definition has the desired results.

** FID button: The Fid Selection button is used to assign the related object by
clicking in the drawing. It is visible even if the attribute is locked. That means
that the drop down list will not open, and the user will always need to use
the button to select the feature in the map. He cannot select one from the
list. In this special case, locked means that the user cannot enter any values
using the keyboard.
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Combo box detail table settings: Normally you would change the Detail Listattribute
or Detail Sort Order only, because the Detail Table and Detail Attribute values are read
from TB_RELATIONS.

*** UseBuffer: Normally, you set the UseBuffer property to True for best
performance. In the case of real domain tables (*_TBD), the entries do not
change much, so they are not loaded every time you change the record. It
may be necessary to set the UseBuffer property to False, for example, if the
related table is not a real domain, but an ordinary feature table, whose contents
frequently change.

Multi-relations, which are relations to several tables, can be set in the data
model administrator. If a multi-relation is defined, you can select those tables
from the Detail Table dropdown list as well. In this case, you will see an entry
in the dropdown list in {} as the first item.

If you have a complex expression instead of a simple attribute, you can use
multi-relations, which means that you can have a list of FIDs from several
defined feature classes. For example: 'FID: ' || FID || ', NR: ' || NR

To get this working, the expression in the property box has to look like this:
'FID: ' || FID || ', NR: ' || NR, NR. Note, that you should list all attribute names
used in the expression after the expression and separated by commas. The
attribute name FID is an exception and should not to be listed.

See also:

■ Form Designer: General Control Properties (page 373)
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■ Form Designer Example: Validation Code (page 407)

■ Form Designer: FID Form Launcher - Properties (page 391)

For more information about Refresh Records see the Topobase Client User
Guide, section Using Feature Class Forms.

Form Designer: Basic Form Launcher - Properties
The Basic Form Launcher (Reference) control generates two buttons: the
Reference button and the Projection button. If the user presses the Reference
button, the form of the related table is opened, with a filter set to the current
record.

NOTE There is a difference between Reference and Projection: The Reference
Button shows related features of the current record. The Projection Button shows
the related features of all records that are in the current filter.

The first time you open a form, Topobase Client creates a Basic Form Launcher
according to the entries in TB_RELATIONS. Most of the Basic Form Launchers
are of this type. However, in very special cases you can define your own
references.

DescriptionProperty

System Cat-
egory

ReferenceClassName

Name, default = $REFERENCE1Name

Specific Cat-
egory

The Detail properties can be edited in the Reference Options dialog

box. Click the property row and then click  .

Detail

Shows details or forms that belong to another document (page
581).

DetailDocu-
ment
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Child_column_name. For example, FID_PARENT.DetailAttribute-
Name

Default filter = empty = all related records. You can define an addi-
tional filter to this filter.

DetailFilter

Child_table_name. For example, POINT_TEXT.DetailTable

Parent_column_name. For example, FID.MasterAttrib-
uteName Note: The current form is the parent_table.

True = a projection button is generated. This is the default.ProjectionBut-
ton

True = a reference button is generated. This is the default.ReferenceBut-
ton

For DetailFilter, you can define which of the related records are to be shown.
For example, in the feature class form Water Pipe, you can create a Reference
button that shows all related points of a certain type (TYPE):

■ Define DetailFilter as: TYPE = 'Fireplug'

You can use any SQL expression (that is the part following the WHERE), for
example:

TYPE = 'Fireplug' or TYPE = 'any' OR

TYPE = 'Fireplug' and TYPE in (select ty from tytable where v1='any'

For DetailDocument, you can open a form that belongs to a table of another
document (page 581). This document has to be open so that you can select it
from the dropdown list. For example, a workspace (page 586) with two
documents is open, and you want to show Real Estate data in a Water form.
In the Water form, you need to select Real Estate for DetailDocument.

NOTE The detail document might not exist, or not be opened in the user's current
workspace. This can happen if the form designer selects his document name
(template), but the user has checked in the document with another name (for
example, the template with the name real_estate was checked in as document
my_real_estate). In this case, Topobase Client will search all open documents for
this form.
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The form designer uses the DetailDocument property to select the form of the
document in a list box. This property is also helpful if the same table name
occurs in several document (page 581)s (for example, TB_* tables), which is an
extremely rare case. Normally, all Topobase applications use a prefix to
distinguish table names (W = water, RE = real estate, and so on) so the problem
of opening the wrong table when the detail document name is not correct,
will not occur.

If the DetailDocument property is not specified, the system searches in the
current database, and if the DetailDocument is specified (even with a nonsense
name), searches in all open databases.

See also:

■ Form Designer: General Control Properties (page 373)

■ Form Designer: Advanced Form Launcher - Properties (page 376)

Form Designer: CheckBox - Properties

DescriptionProperty

System Category

CheckBoxClassName

Specifies the name of appropriate database attribute.Name

Base

If True, the value can be entered by using a reference
record.

AllowReference

If True, the value cannot be edited.IsLocked

If True, attributes must always be acquired. In edit
mode, these attributes are highlighted by a red back-
ground color.

IsMandatory

Defines a validation code for each input field. During
validation, values from other attributes can also be
queried.

ValidationCode
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Defines a message to display if the validation fails.ValidationMessage

Specific Category

Defines a value to be displayed in the form if the
database value is 0 or NULL. For example, No, Close,
or False.

FalseValue

Defines a value to be shown in the form if the database
value is 1. For example Open, True, or Yes.

TrueValue

Specifies a default value that is inserted when you add
a new record. You can also use this for the AutoIncre-
ment value or date/time, and to create GUIDs.

ValueDefault

See also:

■ Form Designer: General Control Properties (page 373)

■ Form Designer Example: Validation Code (page 407)

Form Designer: Color ComboBox - Properties
With the Color ComboBox (ColorBox) control, you can select a color from a
list. The control displays each color in a small box in front of each color name.
This box is not available in the Web version. The Web version displays only
the name.

By default, all database attributes have a control. To set a color combo box,
you are prompted to replace an existing control. Select the existing control
in the Select Control To Be Replaced dialog box.

DescriptionProperty

System Category

ColorBoxClassName

Specifies the attribute name.Name

Base
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If True, the value can be entered by using a reference re-
cord.

AllowReference

If True, the value cannot be edited.IsLocked

If True, attributes always be acquired. In edit mode, these
attributes are highlighted by a red background color.

IsMandatory

Defines a validation code for each input field. During val-
idation, values from other attributes can also be queried.

ValidationCode

Defines a message to display if the validation fails.ValidationMessage

Specific Category

Specifies the table in which the colors are defined. Default
is TB_COLOR_ACAD.

ColorSchema

You can create your own color schema table in order to
provide different color definitions (in the TBSYS user, arbit-
rary name). The table must have the following attributes:
- ID (varchar2): value of the color;
- VALUE (varchar2): name displayed for the color
- RGB_VALUE (varchar2(6)): RGB color, to display the color
in the control and the list.
For Web applications, you can use TB_COLOR_WEB, which
stores W3C color definitions.

If set to True, generates an additional button that displays
a free RGB color selection dialog box, to select a RGB color.

RGBButton

Specifies a default value to insert when you add a new
record. You can also use this for the AutoIncrement value
or date/time and to create GUIDs.

ValueDefault

See also:

■ Form Designer: General Control Properties (page 373)

■ Form Designer Example: Validation Code (page 407)
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Form Designer: Coordinates Editor - Properties
Use the Coordinates Editor (Geometry) control to display geometry and
coordinates of points, lines and polygons, as shown in the following table:

DescriptionProperty

System Category

GeometryClassName

Specifies the name. For example, $GEOMETRY4.Name

Base

If True, the value cannot be edited.IsLocked

Specific Category

Instead of the coordinates, you can show a text. If no
geometry exists, the UnAvailableValue text is displayed.

AvailableValue

UnAvailableValue If geometry exists and the AvailableValue is not empty
this text is displayed.
If the AvailableValue is empty (default), the coordinates
are shown.

Defines the precision of the values shown in the form.PrecisionXY

PrecisionZ

ShowEndPointOnly

Shows the start or end or mid point of an arc.ShowInterpretation

If False, in the case of lines/polygons, all coordinates of
all vertices are shown.

ShowStartPointOnly

If True, only the coordinates of the first or last vertex
are shown.

X = easting, Y = northing, Z = elevation.ShowX
If True, the respective value X, Y, or Z is shown in the
text box/list box. The order of display is X (easting), Y
(northing), Z (elevation).

ShowY
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ShowZ If False, the respective value (x,y,z) will not be shown
in the text box/list box.

Default: empty. You can define an SQL statement to
show the geometry of related child features, which is

SQL

stored in a different table. For example, this happens,
if the table is of the attribute type, as is the case in the

Topobase utility model (page 586).
Note the parallel to label definitions. With a geometry
control in addition to SQL, you can display the coordin-
ates of the related geometry. With a Parent Geometry
select statement, you can query the geometry of a re-
lated feature if the parent label is of the attribute type.

See also:

■ Form Designer: General Control Properties (page 373)

■ Form Designer Example: Coordinates Editor with SQL (page 418)

■ Showing the Coordinates of Utility Features (page 421)

■ Using the SQL Assistant (page 139)

■ Label Geometry Select Statements (page 238)

Form Designer: Document Linker - Properties
The Document Linker (DocumentManager) control is not linked to a database
attribute of the current table. This control inserts a button with the number
of assigned documents on it (documents that have been assigned using the
document manager).

When the user clicks the button, the document manager is opened, with the
assigned documents filtered.

NOTE Using this control will make the performance of the form slower.

DescriptionProperty

System Category

DocumentManagerClassName
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Specifies the name. For example, $DOCUMENTMAN-
AGER1.

Name

Specific Category

The color, if documents are available.AvailableColor

Message that is displayed on the button. For example,
{0} Document(s) Available.

AvailableValue

The color, if no documents were found.UnAvailableColor

The returned message, when no documents are found.
For example No documents available.

UnAvailableValue

See also:

■ Form Designer: General Control Properties (page 373)

Form Designer: Editable SQL TextBox - Properties
Use the Editable SQL TextBox (SqlTextBox) control to display the result of an
SQL query, for example, showing the area which is stored in a different table.
It is recommended that you use this type of control only when you query a
single attribute.

If you do not want to edit the value and just show it, it is recommended that
you use the Read-Only SQL TextBox control, which has a better performance.

DescriptionProperty

System Category

SqlTextBoxClassName

Specifies the name. For example, $SQLTEXTBOX1.Name

Base

If True, the value cannot be edited.IsLocked

Specific Category
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If True, aligns the value. Specifies whether the value is aligned
to the right edge of the input box.

AlignRight

If False, checks whether the update tries to update more than
one row in the linked table. If so, the whole update is ignored,

AllowMultiRowUp-
date

and a message will appear. Otherwise with a wrong SQL
statement, you could destroy your data when your SQL would
create unwanted updates.

Specifies the attribute (to be selected from the detail table)
that you want to display.

DetailAttributeName

The filter expression for the select statement (without a

WHERE expression). Click  to open the SQL Assistant.

DetailFilter

Use the SQL Assistant to build the filter statement. However,
you must cut off the first part, including the WHERE.

Specifies the table from which you want to select data.DetailTable

Note the difference between Read-Only SQL TextBox and Editable SQL TextBox.
Both controls allow you to query data, but the Read-Only SQL TextBox results
in a read-only label, that cannot be edited. The Editable SQL TextBox results
in a text box, where the value can be edited and saved (updated) in the
database.

For this reason, the SQL statements differ in the way they are defined. While
the Read-Only SQL label statement can be defined as one expression in the
SQL property, the Editable SQL text box statement consists of three
components (DetailAttributeName, DetailFilter and DetailTable properties).
However, both statements have the same result.

Because of the splitting, the system is able to update the record. When the
user saves the record, the system updates the related detail table, using the
following command:

Update <detailtable name> set <detailfield name> ='<your input>'

where <detail filter>.

See also:

■ Form Designer: General Control Properties (page 373)

■ Using the SQL Assistant (page 139)

Form Designer: Editable SQL TextBox - Properties | 389



■ Form Designer Example: Editable SQL TextBox (page 413)

■ Form Designer: Static Text - Properties (page 405)

Form Designer: Feature Highlighter - Properties
Use a Feature Highlighter (HighlightButton) control to highlight a feature in
the map that is not in the current table, but is linked to the database attribute
with a relation. This control works in a similar way to the FID Button control,
but it will highlight a feature. It is a special variation of the combo box
highlight button.

Example from a Wastewater application: Use the Feature Highlighter in the
section feature class, which has a relation to the manhole at the section start
point, to highlight the manhole.

You can also use a filter to highlight a feature that is different from the one
where you get the FID.

DescriptionProperty

System Category

HighlightButtonClassName

Specifies the name. For example, $HIGHLIGHTBUTTON1.Name

Specific Category

Specifies the name of the database attribute that con-
tains the FID. For example, FID_DETAIL.

DetailAttributeName

SQL filter that highlights another feature. You can use
the SQL Assistant to define the SQL statement.

DetailFilter

See also:

■ Form Designer: General Control Properties (page 373)

■ Form Designer: FID Linker - Properties (page 392)

■ Form Designer: Basic ComboBox - Properties (page 377)

■ Using the SQL Assistant (page 139)
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Form Designer: FID Form Launcher - Properties
You use the FID Form Launcher (FidReference) control to generate an FID
button. When a user clicks this button, the form the FID belongs to is opened,
with the filter set to the FID.

NOTE The FID is unique in the whole database. Therefore, with the FID Form
Launcher you can create dynamic relations. Use table TB_UFID to see which FID
belongs to which feature class.

DescriptionProperty

System Category

FidReferenceClassName

Specifies the name. For example, $FIDREFERENCE.Name

Specific Category

Selects the attribute name (of the current table) where the
FID is saved.

MasterAttribute

If the current record contains attributes that have FIDs saved, for example,
those that have a relation to another table, you may wish to show this related
record. If this relation is a multi-relation, you can use the FID Reference to
create a reference button that will open the form the FID belongs to. The filter
is set to the FID. Because the FID is unique in the whole database, you can
handle dynamic relations.

Example: In relation to a point, where the relation is dynamic (to several point
feature classes), you can either use the basic combo box or FID form launcher
to show the related record. Also, you can define the field as a simple text box
and add an FID form launcher. In addition, you can hide the text box and
use only the FID form launcher.

See also:

■ Form Designer: General Control Properties (page 373)

■ Form Designer: Basic ComboBox - Properties (page 377)
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Form Designer: FID Linker - Properties
An FID Linker (FidButton) control is not linked to a database attribute
belonging to the current table. With this control, you can select a feature in
the map and fill an attribute with this value (This is the same as acquiring
related features simply by selecting them in the map). However, normally,
you would select a related feature from a basic combo box, for example, you
could select a detail that belongs to a manhole.

DescriptionProperty

System Category

FidButtonClassName

Specifies the name. For example, $FIDBUTTON1.Name

Specific Category

Specifies the name of the database attribute that should be
filled with the FID. For example, FID_DETAIL.

DetailAttribute

Filter statement (optional): The SQL statement that gets an-
other FID as a result. Example: You want to select a feature
in the map but fill the FID of its parent into the attribute.

DetailFilter

Use the SQL Assistant to define the filter statement.
Select FID from parent where FID_CHILD={Fid}
Note: {FID} is case sensitive.
The {FID} is replaced by the selected FID at runtime.

Specifies the feature classes that should be selectable in the
map. Use this, when you need more than one feature class,
such as {FeatureC1,FeatureC2,FeatureC3}

DetailTable

See also:

■ Using the SQL Assistant (page 139)

■ Form Designer: General Control Properties (page 373)

■ Form Designer: Basic ComboBox - Properties (page 377)
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Form Designer: Formula TextBox - Properties

DescriptionProperty

System Category

FormulaClassName

Specifies the name: For example, $FORMULA3.Name

Specific Cat-
egory

Clicking  defines a formula and opens the formula editor.
You can calculate formula, using the database attributes and all
valid VB .NET codes.

Formula

NOTE The formula expressions obey the same rules as validation statements.

Functions (excerpt)

In the formula, you can use the expression “result=me.”
to see a list box with all the available functions that you
can use in the formula. In the formula pane where a list
box appears you can select the desired function by
double-clicking.

Returns the Current Connection (Type Topobase.Data.TB-
Connection).

Me.Connection

Returns the Current ConectionTools (Type Topo-
base.Data.Tools.ConnectionTools).

Me.ConnectionTools

Returns whether Geometry is available or not.Me.GeometryAvailable

Returns the number of Microsoft Documents (Doument-
Manager) that are related to this feature.

Me.DocumentCount

Sets the color (HTML color).Me.BackColor= ""
Me.ForeColor=""
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NOTE In the formula editor, you can select the available functions in a list box
that appears after you enter "me.". The result of the formula is always assigned to
the variable “result".

See also:

■ Form Designer: General Control Properties (page 373)

■ Form Designer Example: Formula TextBox (page 408)

■ Formula TextBox: Sample Formulas (page 409)

Form Designer: Horizontal Line - Properties
Use the Horizontal Line (Line) control to draw horizontal and vertical lines
with various properties, as shown in the following table:

DescriptionProperty

System Category

LineClassName

Specifies the name. For example, $LINE6.Name

Specific Cat-
egory

Specifies the color of the line.ForeColor

Specifies the size of the line.LineSize

If True, the line is three dimensional.ThreeD

If False, the line is horizontal.Vertical

See also:

■ Form Designer: General Control Properties (page 373)
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Form Designer: Picture Combobox - Properties
This control is linked to a database attribute. You use the Picture ComboBox
control to display picture files, which are stored in one directory, in a combo
box.

DescriptionProperty

System Category

PictureComboBoxClassName

Specifies the attribute name.Name

Base

If True, the value can be entered by using a reference
record.

AllowReference

If True, the value cannot be edited.IsLocked

If True, the value must always be acquired. In edit
mode, these attributes are highlighted by a red back-
ground color.

IsMandatory

Defines a validation code for each input field. During
validation, values from other attributes can also be
queried.

ValidationCode

Defines a message to display if validation fails.ValidationMessage

Specific Category

Specifies the size (height) of picture in the list.ItemHeight

Specifies the size (width) of picture in the list.ItemWidth

Specifies the directory containing the picture files you
want to provide in the list box.

PictureDirectory

Specifies a default value to insert when you add a new
record. You can also use this for the AutoIncrement
value or date/time, and to create GUIDs.

ValueDefault
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NOTE Although the picture files can be stored in any folder, it is recommended
that you store them in the <topobase>\Pics folder or a subfolder. Then, they are
available with the dynamic path <topobase>\Pics and you need to enter the
subfolder/filename only. If you use picture files with a static path, they are not
available on a different computer unless the path is exactly the same. Alternatively,
you can use //Servername to store the picture files on a server.

NOTE To show the pictures in the Web version, if you do not use the
<topobase>\Pics folder, you must map the folder names in the system table
TB_GN_DIRECTORY_ALIAS.

See also:

■ System Table TB_GN_DIRECTORY_ALIAS (page 153)

■ Form Designer: General Control Properties (page 373)

■ Form Designer Example: Validation Code (page 407)

Form Designer: Picture Linker - Properties
The Picture Linker (Picture Box) control is linked to a database attribute. It
shows record-related pictures (*.gif, *.bmp, and so on). In the form, the user
can use a list box to select a picture. When the picture is selected, the directory
or path names of the pictures are saved in the database.

NOTE Although the picture files can be stored in any folder, it is recommended
that you store them in the <topobase>\Pics folder or a subfolder. Then, they are
available with the dynamic path <topobase>\Pics and you need to enter the
subfolder/filename only. If you use picture files with a static path, they are not
available on a different computer unless the path is exactly the same. Alternatively,
you can use //Servername to store the picture files on a server. The dimension of
the respective database attribute must be large enough to store the directory
names.

TIP Make sure that the size of the control is large enough to display the picture.

NOTE To show the pictures in the Web version, if you do not use the
<topobase>\Pics folder, you must map the folder names in the system table
TB_GN_DIRECTORY_ALIAS.

DescriptionProperty
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System Category

PictureBoxClassName

Specifies the name. For example, PICTURE.Name

Base

If True, the value can be entered by using a reference re-
cord.

AllowReference

If True, the value cannot be edited.IsLocked

If True, the value must always be acquired. In edit mode,
these attributes are highlighted by a red background color.

IsMandatory

Defines a validation code for each input field. During val-
idation, values from other attributes can also be queried.

ValidationCode

See also Form Designer Example: Validation Code (page
407).

Defines a message to display if validation fails.ValidationMessage

Specific Category

Specifies whether the list box text is hidden. Set to True
to hide the list box with the file name and show the pic-

HideText

ture only. This property only works in View mode. Default
= False.

Specifies how the image is displayed. If True, the picture
is stretched to the size of the control.

StretchImage

If False, the picture is shown in its original size.

See also:

■ System Table TB_GN_DIRECTORY_ALIAS (page 153)

■ Form Designer: General Control Properties (page 373)
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Form Designer: Property TextBox - Properties

DescriptionProperty

System Category

TextBoxClassName

Specifies the database attribute name. For example, FID,
COMMENTARY.

Name

Base

If True, the value can be entered via reference record.AllowReference

If True, the value cannot be edited. In the form, locked
input fields are highlighted with light gray color.

IsLocked

If True, the value must always be acquired. In edit mode,
these attributes are highlighted by a red background color.

IsMandatory

Defines a validation code for each input field. During val-
idation, values from other fields can also be queried.

ValidationCode

Defines a message to display if validation fails.ValidationMessage

Specific Category

If True, aligns the value. Specifies whether the value is
aligned to the right edge of the input box.

AlignRight

Specifies the date format to be shown in the form. Only
available for Oracle attributes of Date type.

DateFormat

For text boxes where DateFormat is set, a Calendar But-
ton is displayed. However, if DateFormat is set to "yyyy"
the calendar button is invisible.

Specifies whether all characters that are entered in the
text box are converted to upper-case characters.

EnforceUpper

Specifies that a reference is made to an external file. De-
fault = False. Set this property to True to refer to an extern-

FileSelection

398 | Chapter 6   Form Designer Reference



al file, for example a picture. Two additional buttons are
displayed. One selects the file, the other shows the file
with its related application (for example a *.docx with Mi-
crosoft® Word).
See also Web File Upload (page 119).

Specifies that a filter list box is displayed. Default = False.
Set this property to True to define that in filter mode a list

FilterComboBox

box will be displayed, where the user can select the items.
This means that in filter mode, the user can find a record
by its name or another value, in a list.

Specifies whether to enable multi line text. If True, creates
text of more than one line. Press <RETURN> to insert a

MultiLine

line break. If this property is set to False, your cursor will
move to the next input field, when you press <RETURN>.

Specifies the precision of the value, which is shown in the
form. As a rule, this will differ from the precision saved in
the database.

Precision

By default, set to the precision of the DB definition.

Specifies a default value that is inserted when you add a
new record. You can also use this for the AutoIncrement
value or the date/time and to create GUIDs.

ValueDefault

Specifies that automatic word wrap is enabled.WordWrap

NOTE If you want to use this option in the Web version,
you must also enable the MultiLine property.

Example for the FilterComboBox property: Filter mode of a form Streets with
a text box Name. If the user clicks the button, he will see a list of all street
names in the whole table. He can select one in the list, and then click Filter
to select the record. The FilterComboBox property executes a Select distinct
to avoid the possibility that items are shown twice.

Example for the ValueDefault property: ValueDefault can either be used for
AutoIncrement, AutoGUID or date/time values.
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Topobase Form Designer: Assigning a default value.

NOTE FileSelection in the Topobase Web version: Use the table
TB_GN_DIRECTORY_ALIAS to handle the link to a file name. In view mode, the
first part of the file name is replaced (mapped) using this table. In this way it is
possible to show the linked files in the Web browser.

See also:

■ Form Designer: General Control Properties (page 373)

■ Form Designer Example: Validation Code (page 407)

■ System Table TB_GN_DIRECTORY_ALIAS (page 153)

Form Designer: Read-Only SQL TextBox - Properties
Use the Read-Only SQL TextBox (SqlLabel) control to display text in the feature
class form that is queried with an SQL statement. For example, you can display
the area of the related polygon in a centroid feature class. You can also query
and display data from different attributes and tables.

Test the SQL statement in the SQL Assistant.

DescriptionProperty
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System Category

SqlLabelClassName

Specifies the name. For example, $SQLLABEL1.Name

Specific Category

If True, aligns the value. Specifies whether the value is aligned
to the right edge of the input box.

AlignRight

Selects a windows font including style and size.FontName

Specifies the color of the text.ForeColor

Specifies the precision of numeric values.Precision

Defines SQL statements to query any information.Sql

If the SQL returns no result, this value is displayed.UnAvailableValue

Specifies whether the buffer for the data can be switched off.
If True, you can switch the buffer off the data. In some cases,
it is necessary to see real data. Default = True.

UseBuffer

Notice the difference between Read-Only SQL TextBox and Editable SQL
TextBox. Both controls allow you to query data, but in one case the result is
displayed as a label, which means that it cannot be edited. In the other case,
the result is displayed in a text box, and the value can be edited and saved
(updated) in the database.

See also:

■ Form Designer: General Control Properties (page 373)

■ Form Designer: Editable SQL TextBox - Properties (page 388)

■ Using the SQL Assistant (page 139)

■ Form Designer Example: Read-Only SQL TextBox (page 411)

■ Form Designer Example: Editable SQL TextBox (page 413)
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Form Designer: Script Programmable - Properties
Use the Script Programmable (ScriptButton) control to execute small scripts.
Its function is similar to the Formula TextBox control. You can use VB .NET
and the Topobase API in the scripts.

DescriptionProperty

System Category

ScriptButtonClassName

Specifies the name. For example, $SCRIPTBUTTON1.Name

Specific Category

Specifies the text that is displayed on the button.ButtonCaption

Click the property row to open the editor. Opens a script
code editor, where you can edit the code.

ScriptCode

Sample Script:

dim c as Topobase.Forms.DialogControls.ComboBox

c = Me.Dialog.Controls.Item("Fid_Street")

Msgbox( "The Street has the Fid:" & c )

See also:

■ Form Designer: General Control Properties (page 373)

■ Form Designer: Formula TextBox - Properties (page 393)

Form Designer: SQL Form Launcher - Properties
An SQL Form Launcher (ComplexReference) control is not linked to a database
attribute of the current table. With Complex Reference, you can open the
form of another table, using a filter. You can define this filter using complex
SQL statements.
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Test the SQL statement in the SQL Assistant.

DescriptionProperty

System Category

ComplexReferenceClassName

Specifies the name. For example, $COMPLEXREFER-
ENCE1.

Name

Specific Category

Specifies the table you want to open. Select the
table.

DetailTable

Defines the filter that will be executed. Set the val-

ues that should be replaced in {}. Click  to
open the SQL Assistant.

Filter

Examples:
FID = {FID_CHILD}.
name = (select typename from specialtable where
height = {objectheight} and width={objectwidth})

You can use the ComplexReference control with input parameters, such as a
radius, which the user is prompted to enter. An input box will appear. If the
parameter is a numeric value, you must use the # character. If it is a text value,
use the $ character.

Example: {#Radius} {$Name}

SDO_WITHIN_DISTANCE(a.Geom,

(select geom from LM_POINT where fid={fid}) ,

'distance = {#Radius}') = 'TRUE'

See also:

■ Form Designer: General Control Properties (page 373)

■ Using the SQL Assistant (page 139)
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Form Designer: Static Picturebox - Properties
Use the Static Picturebox (StaticPicture) control to show pictures in the feature
class form, for example, your company logo.

DescriptionProperty

System Category

StaticPictureClassName

Specifies the name. For example, $STATICPICTURE4.Name

Specific Category

Specifies the directory and file name of the picture to be
shown in the form (*.gif, *.bmp, and so on).

FileName

Specifies how the image is displayed. If True, the picture is
stretched to the size of the control.

StretchImage

If False, the picture is shown in its original size.

NOTE Although the picture files can be stored in any folder, it is recommended
that you store them in the <topobase>\Pics folder or a subfolder. Then, they are
available with the dynamic path <topobase>\Pics and you need to enter the
subfolder/filename only. If you use picture files with a static path, they are not
available on a different computer unless the path is exactly the same. Alternatively,
you can use //Servername to store the picture files on a server.

To show the pictures both in Topobase Client and Topobase Web, make sure
that the pictures are stored both in the <topobase_client>\Pics folder and the
<topobase_web>Pics folder or subfolder.

NOTE To show the pictures in the Web version, if you do not use the
<topobase>\Pics folder, you must map the folder names in the system table
TB_GN_DIRECTORY_ALIAS.

See also:

■ System Table TB_GN_DIRECTORY_ALIAS (page 153)

■ Form Designer: General Control Properties (page 373)
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Form Designer: Static Text - Properties
Use the Static Text control to display static text in the feature class form, for
example, explanations.

DescriptionProperty

System Category

LabelClassName

Specifies the name. For example, $LABEL5.Name

Specific Category

If True, aligns the value. Specifies whether the value is
aligned to the right edge of the input box.

AlignRight

Selects a windows font including style and size.FontName

Color of the textForeColor

Specifies the text you want to write onto the form. Enter
the text.

Text

See also:

■ Form Designer: General Control Properties (page 373)

Form Designer: Model Selector - Properties
Use the Model Selector control to add the Model selector to a feature class
form.

DescriptionProperty

System Category

ClassName

Specifies the name. For example, $MODELSELECTOR.Name
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Specific Category

Form Designer: Examples
The following examples provide information you need to know to work with
the form designer, including:

■ Setting the tab order

■ Defining validation code

■ Defining a formula or functions (some sample formulas are provided)

■ Using a read-only SQL text box

■ Using an editable SQL text box

■ Showing geometry with SQL

See also:

■ Using the SQL Assistant (page 139)

Form Designer Example: Auto Tab Order

Using the Auto Tab Order option

When entering data, you press the <TAB> or <ENTER> key to move to the
next input field. You use the Auto Tab order option to define the order in
which the cursor will move (in Form view mode).

To define the tab order

1 Start Topobase form designer.

2 In the form explorer, select the feature class, select the Form Type, and
click Edit.

3 In the Designer dialog box, click Edit menu ➤ Auto Tab Order. If you
select Auto Tab Order, the cursor will move according to default settings:
from left to right and from top to bottom.

4 Clear Auto Tab Order to define your customized order.
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5 In the right pane, click the first control.

6 In the left pane, click the Properties tab.

7 Select NextControl and click  . Select the next control in the list.

Form Designer Example: Validation Code
You can define validation code (check rules) according to the same rules as
those for defining formulas (using VB .NET). The code defines the value
“result”, which can either be True or False. If True, the value is accepted. If
False, the modification is blocked and the user has to correct the input until
it fits the rules. The application stays in Edit mode until the input is correct.

The following example from the water utility application assumes that a
hydrant has two elevation attributes: ELEVATION is the height of the point
where the hydrant is connected to the water network, GROUND_ELEVATION
is the height of the hydrant above sea level.

To define a check rule to ensure that the GROUND_ELEVATION is always
higher than the ELEVATION

1 Start Topobase form designer.

2 In the form explorer, select the feature class Hydrant, select the Form
Type, and click Edit.

3 In the Designer dialog box, in the right pane, click the General tab and
select the GROUND_ELEVATION text control.

4 In the left pane, click the Properties tab.

5 Select the ValidationCode property and click  .

6 In the Validation Code dialog box, enter the validation code. You can
double-click the attribute names in the list to insert them into your code.

if {ELEVATION} < {GROUND_ELEVATION} then

Result=True

Else

Result=False

End if

Form Designer Example: Validation Code | 407



7 In the Validation Code dialog box, enter the following text that is
displayed if the validation code returns False:

Elevation must not be higher than ground elevation!

8 Click OK to close the Validation Code window.

To see the validation, open the Hydrant feature class form and enter values
for ELEVATION and GROUND_ELEVATION. The error message is displayed
if you enter an ELEVATION value that is higher than the
GROUND_ELEVATION value.

Control input with a validation code. If the user enters a value that does not match,
the specified error message is displayed.

See also:

■ Form Designer Example: Formula TextBox (page 408)

Form Designer Example: Formula TextBox
You can define formulas or functions according to the VB .NET rules. For more
information, see http://msdn.microsoft.com/vbasic.

Use the Formula control to add, subtract, multiply or divide values.

To define a formula control

1 Start Topobase form designer.

2 In the form explorer, select the feature class, such as DOC_GREENSPACE.
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3 Select the Form Type, such as Default, and click Edit.

4 In the Designer dialog box, on the designer toolbar, click the Formula
Textbox icon.

5 Click OK for the name.

6 In the left pane, click the Properties tab.

7 Select the Formula property.

8 Click  to open the formula editor. In the formula editor, all current
database attributes are listed in the attributes pane.

9 Double-click an attribute name to use it in the formula. In the formula,
you may use all valid VB .NET expressions, for example, you can use result
= {AREA} * {MAINTENANCE_COSTS}.

10 In the formula editor, click Check Code to check the formula for syntax
errors, using the current record.

11 Click Test to check the result with the current record set.

12 Click OK.

13 Exit the form designer.

Formula TextBox: Sample Formulas

Showing the FID

result="The FID is " & {FID}& "."

Showing the result of any selection

result = Me.ConnectionTools.LngValue("select count(*) from <table>

where column=" & LngValue("parent_fid"))
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Showing whether geometry is available and to set the color of the box

if Me.GeometryAvailable then

result="Geometry available"

Me.ForeColor=""

Me.BackColor=""

else

result="No Geometry available"

Me.ForeColor="white" 'These are HTML colors !

Me.BackColor="red"

end if

Showing how many Microsoft documents (DocumentManager) are available
and to set the color of the box

Notice, that the temp variable c is used in order to avoid calling the function
twice:

dim c as integer

c = me.DocumentCount

if c=0 then

result="No Documents available"

Me.BackColor=""

else

result=c & " Document(s) available"

Me.BackColor="red"

end if

NOTE This example shows the concepts. However, it is much easier to use the
Document Manager control for this task.

See also Form Designer: Document Linker - Properties (page 387).
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Calculating with the attribute values

Result = {HEIGHT} + 20

Result = {HEIGHT} * 20

Result = {HEIGHT} / 20

Result = {HEIGHT} – 20

Combinations with other attribute names are also possible, for example:

Result = {HEIGHT_1} + {HEIGHT_2} *10

Result = {attribute name1} * {attribute name3} *10

Assembling the contents of two text attributes. Delete or add the characters
of text fields (data type varchar2)

result = {TEXT1} & {TEXT2}

Appending a prefix and a suffix

result = "Approx. " & {AREA} & "m2"

Generating a manhole name from an FID

result = "MH " & {FID}

Calculating the remaining days until next maintenance (using a feature class
attribute MAINTENANCE_NEXT_DATE)

Dim d As Date

Dim t As System.TimeSpan

d = Me.Value("maintenance_next_date")

t = d.Subtract(now)

result=t.Days

Form Designer Example: Read-Only SQL TextBox
You can display text in the feature class form that is queried with an SQL
statement. The following example shows how to display the label text that is
stored in the label feature class (page 583) *_TBL directly in the parent feature
class form.
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To display the label text in the parent feature class

1 Start Topobase form designer.

2 In the form explorer, select the feature class, select the Form Type, and
click Edit.

3 In the Designer dialog box, on the designer toolbar, click  .

4 Click OK for the name.

5 In the left pane, click the Properties tab.

6 Select the UnAvailablValue property and enter the following text: No
label text available.

7 Select the SQL property and click  to open the SQL Assistant.

8 In the SQL Assistant dialog box, under Relations, expand the feature class,
and click the label feature class *_TBL. The SQL expression is inserted
into the expression input box.

9 Replace the asterisk (*) in the SQL expression with LABEL_TEXT. Result
is:

select LABEL_TEXT from <featureclass>_TBL

where FID_PARENT in (select FID from <featureclass> where

fid={fid})

10 Click  Execute to run the SQL statement, and to check the syntax.

11 Click OK to exit the SQL Assistant.

12 Exit the form designer.

13 In the feature class form, browse for the records. If a record has no label,
the UnAvailableValue is displayed instead of the label text.

NOTE A feature can have more than one label, which is not considered in the
above example.
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Example: SQL label statement to display the area of an area topology in the
centroid feature class:

select ROUND(bts.EXACT_AREA,6)

from BF_TSUR bts, BF_TCEN btc

where btc.FID_TSUR = bts.FID

and btc.FID_CENTROID = {FID}

select exact_area from LM_T_LANDUSE_TSUR

where FID in (select FID_TSUR from LM_T_LANDUSE_TCEN

where FID_CENTROID in (select FID from LM_LANDUSE

where fid={fid}))

See also:

■ Form Designer: Read-Only SQL TextBox - Properties (page 400)

■ Using the SQL Assistant (page 139)

■ Data Model: Labels (page 223)

Form Designer Example: Editable SQL TextBox
You can display text in the feature class form that is queried with an SQL
statement. The following example shows how to use an editable text box to
display data.

This example shows how to display the maintenance date of the green space
the tree belongs to.

1 Start Topobase form designer.

2 In the form explorer, select the feature class, select the Form Type, and
click Edit.

3 In the Designer dialog box, on the designer toolbar, click the Editable
SQL Text Box icon.

4 Click OK for the name.

5 In the left pane, click the Properties tab.
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6 Select the DetailTable property, click  and select the feature class.

7 Select the DetailAttribute property, click  and select the attribute.

8 Select the DetailFilter property and click  to open the SQL Assistant.

9 In the SQL Assistant dialog box, under Relations, expand the feature class
nodes and click the detail feature class that contains the information you
want to display. The SQL expression is inserted into the expression input
box.

select * from DOC_GREENSPACE where FID in (select FID_GREENSPACE

from DOC_TREE where fid={fid})

10 In the expression input box, delete the first part of the select statement
including the WHERE. The result is:

FID in (select FID_GREENSPACE from DOC_TREE where fid={fid})

11 Click  Execute to run the SQL statement, and to check the syntax.

12 Click OK to exit the SQL Assistant.

13 Select the DetailFilter property again, and click  . Note that the
expression input box shows how the select statement has been put
together from the three parts.

The select statement result is shown in a text box. If a user modifies this value,
the related table is updated.

See also:

■ Form Designer: Editable SQL TextBox - Properties (page 388)

■ Using the SQL Assistant (page 139)
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Form Designer Example: Advanced Combobox
The form designer uses Advanced Combobox (MasterBox) controls to control
the filter of a combo box. For example, instead of selecting a street in a large
dropdown list showing all streets of all cities, select the city first and then the
street from a smaller list of pre-selected items.

In a feature class form, the advanced combo box is controlled by the combo
box. For example, the advanced combo box has no relation to any attribute
of the form. It is related only to the combo box. If you browse, you will always
see the corresponding values, such as city, district, or street. If you change any
of these values, the corresponding location is emptied.

The specific properties can be set in a special Master Box properties window.

Click  in any of the master box property rows to open this window.

Advanced Combobox properties example

■ Detail Control: FID_STREET

■ Master Table: LM_CITY

■ Detail Table:

■ Master Attribute: FID

■ Detail Attribute: FID_CITY

■ Display Attributes: NAME

■ OrderBy: NAME

Example: Multi-relation Advanced Combobox: City ->District -> Street
->Location

Target: To assign a location (house number) to a building with the help of a
combo box (BUILDING.FID_LOCATION <- LM_LOCATION.FID).

The user does not want to select the location from the table LM_LOCATION.
He wants to select the city first, then the district and street, and finally the
location. Each drop down list will only contain the pre-selected items.
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Form Designer: Using an advanced combo box control, you can set one or more filters
to assign the location. In this example, the user can restrict the selection of the location
by city, district, and street.

The following relations exist: There are several cities; every city has several
districts and every district has streets and every street has locations (house
numbers).

LM_LOCATION { FID, ..., Number, FID_STREET }

LM_STREET { FID, ..., Name, FID_DISTRICT }

LM_DISTRICT { FID, ..., Name, FID_CITY }

LM_CITY { FID, ..., Name }

PARENT_TABLE_NAME.PARENT_COLUMN_NAME

-> CHILD_TABLE_NAME.CHILD_COLUMN_NAME

LM_CITY.FID -> LM_DISTRICT.FID_CITY

LM_DISTRICT.FID -> LM_STREET.FID_DISTRICT

LM_STREET.FID -> LM_LOCATION.FID_STREET

LM_LOCATION.FID -> BUILDING.FID_LOCATION
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The above relations must be defined in TB_RELATIONS. Now you can configure
the master boxes for the feature class form Building. Master boxes are created
for the FID_LOCADTION combo box.

To define an advanced combo box control

1 Start Topobase form designer.

2 In the Designer dialog box, in the right pane, select the control
FID_LOCATION. Change the DetailList attribute property to
HOUSE_NUMBER and the DetailSortOrder property to HOUSE_NUMBER.
With this you make certain that the house number is displayed instead
of the FID. Note that the Detail ListFilter will not work in this special
case, so do not use it.

3 On the Designer toolbar, click the  AdvancedComborBox icon. A
control named MASTERBOX1 is created. Change its properties in the left
pane as follows:

■ Caption = Street:;
Detail Control = FID_LOCATION = name of the combo box

Master Table = LM_STREET

Master Attribute = FID

Detail Attribute = FID_STREET

Display attributes = NAME (attribute with street name)

Orderby = NAME (sorts by street name)

4 Click  to add another advanced combo box. A control named
MASTERBOX2 is created. Change its properties in the left pane as follows:

■ Caption = District:
Detail Control = MASTERBOX1 (the above Street box)

Master Table = LM_DISTRICT

Master Attribute = FID

Detail Attribute = FID_DISTRICT

Display attributes = NAME (attribute with name of district)

Orderby = Name (sorts by district names).
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5 Click  to add another advanced combo box. A control named
MASTERBOX3 is created. Change its properties in the left pane as follows:

■ Caption = City:
Detail Control = MASTERBOX2 (the above District box)

Master Table = LM_CITY

Master Attribute = FID

Detail Attribute = FID_CITY

Display attributes = NAME (attribute with the city name)

Orderby = Name (sorts by city names)

6 Now, relocate the controls as you want, and exit the form designer.

In case any SQL errors occur, check the settings of the above steps. Also, check
to be certain that the indices of the attributes you have used are set up
correctly.

NOTE Any use of combo boxes, master boxes and so on will debase performance
of the feature class form, because additional SQLs must be executed each time
you change the record. This is especially true for Table View mode, which requires
many record moves to show the visible records of the grid. Therefore, in table
view mode you will notice quite a slowdown if you use basic combo boxes or
advanced combo boxes.

TIP  To optimize the speed, check whether you have set indexes on the related
attributes.

See also:

■ Form Designer: Advanced Combobox - Properties (page 375)

Form Designer Example: Coordinates Editor with SQL
You can use the SQL property to show geometry that is not stored in the
current table, but in a related table. The current table may also be an attribute
table without inherent geometry, but with a related feature.

By default, the SQL property of a geometry control is empty. In this case, the
geometry of the current form is shown. You can use an SQL statement to show

418 | Chapter 6   Form Designer Reference



the geometry of a feature, which is saved in a related table (a "related child"
feature).

Some rules:

■ See Using the SQL Assistant (page 139)

■ An SQL statement always returns an FID.

■ Attribute names must be written in braces, for example {FID}, {Y1}.

■ You can use SQL statements that follow the relation of up to ten tables. If
the SQL returns more than one FID, only the first FID is taken. Geometry
controls using the SQL property always are read-only (locked).

■ All attributes in {} are replaced by the actual value. The {} attributes are
existing in the current form (in the following example: the Line table).

Geometry Controls with SQL - Examples

Showing the geometry of a related point

The feature class form (table) WA_LINE has an attribute FID_STARTPOINT
that is related to a table WA_POINT from which the geometry shall be shown.

select FID from WA_POINT where fid={FID_STARTPOINT}

or:

{FID_StartPoint}

The FID is unique in the whole database, therefore the system can find the
feature class (table) with this FID without knowing the table name.

Showing the coordinates of the manholes at the beginning and the end of
a section in the WW_SECTION form

The manhole FIDs are saved in the WW_SECTION form in the attributes
{FID_first_manhole} and {FID_last_manhole}.

In the WW_SECTION form: Create a geometry control and define the SQL:

{fid_first_manhole}

The detailed SQL is:

select FID from WW_MANHOLE where fid={FID_first_manhole}

The SQL statement has to yield an FID. The geometry of this FID is shown.
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Showing the pipe geometry in a sewage works form

SEWAGE_WORKS.FID_STRUCTURE; STRUCTURE.FID_PIPE; PIPE.GEOM

select FID_PIPE from STRUCTURE where FID = {FID_structure}

Selecting

select FID_<t1> from t2 where FID in (select FID from <t3> where

FID_<t4>={t4} and structuretype ='iron')

See also:

■ Form Designer: Coordinates Editor - Properties (page 386)

■ Showing the Coordinates of Utility Features (page 421)

Form Designer Tutorial

Creating Controls

To create a control

1 Start Topobase Administrator and open the workspace.

2 Start Topobase form designer.

3 In the form explorer, select a feature class, and do one of the following.

■ Select the Form Type, such as Default, and click Edit.

■ Select the Form Type, and click Duplicate.

■ Click Add.

4 In the Designer dialog box, on the left pane, notice the Form Type name.

5 If the Designer dialog box shows different tabs, click the tab you want to
add the control to. Usually there is one All tab. All controls on this tab
are available in all other tabs.

6 On the Designer toolbar, click a control icon, such as Static Text  .

7 Enter the name of the control and click OK. The control is added to the
Form pane.
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8 Select the control in the right pane.

9 In the left pane, click the Properties tab and define the control’s properties.

Defining Properties

Each control has its own set of properties which can be edited directly. Select
(click) the control you want in the form pane. On the Properties tab, on the

left, you can either enter the values directly or click  to continue.

Example 1: Modifying a caption:

■ In the Form pane, click a caption. You can enter the new value directly in
the Form pane.

Example 2: Defining a validation code:

■ Select a control.

■ In the Base category, click the ValidationCode row in the left pane. A
button appears. Click it to open the Validation Code dialog box and define
the validation code.

■ See also Form Designer Example: Validation Code (page 407)

Example 3: Removing controls from the form.

■ Select the control in the Form pane.

■ Drag it from the right to the left pane.

The control is added to the Hidden list on the Controls tab on the left. From
there you can drag it back to the Form pane.

NOTE New database attributes that have recently been added are not visible in
the form. You can drag them from the Hidden list into the form pane.

Showing the Coordinates of Utility Features
Use the Coordinates Editor control to show the coordinates of a feature, even
if they are not stored in the feature table itself. The Topobase utility model
(page 586) stores the utility objects separately from the geometry. There are
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several attribute feature classes that share one geometry feature class. The
following example is from the water utility model:

Example: All point objects, as for example the point object WA_ARMATURE,
use the feature class WA_POINT and all line objects use the feature class
WA_LINE to store the geometry. Therefore no coordinates are stored in the
WA_ARMATURE feature class.

The following steps show the concept and explain how to display the
coordinates in an Armature feature class form. To reproduce the steps, use the
Water demo data set.

To show the geometry of a utility object

1 Start Topobase form designer.

2 In the form explorer, select the feature class Armature, select the Form
Type, such as Default, and click Edit.

3 In the Designer dialog box, click the General tab.

4 On the Designer toolbar, click  Coordinates Editor.

5 Click OK for the name.

6 Select the control and in the left pane edit the properties:

UnAvailableValue = No coordinates available.

7 Exit the form designer.

8 Select an armature in the feature class form. The new geometry field
shows the text you entered earlier, because the coordinates are not stored
in WA_ARMATURE.

With a geometry select statement you can retrieve the coordinates from
the related geometry table WA_POINT.

9 In the form explorer, select the feature class Armature, select the Form
Type, such as Default, and click Edit.

10 In the Designer dialog box, click the General tab.

11 In the right pane, select the coordinates control.

12 In the left pane click, the Properties tab.
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13 Under Specific, click the SQL property and click  to open the SQL
Assistant.

14 In the SQL Assistant dialog box, under Relations, expand the feature class
WA_ARMATURE, and click the related feature class WA_POINT. The SQL
expression is inserted into the expression input box.

select * from WA_POINTwhere FID_ATTR in (select FID from

WA_ARMATUREwhere fid={fid})

15 In the SQL Assistant, click  Ex ecute to check the syntax.

16 Click OK to set the property.

17 Exit the form designer.

If you select the same armature as before, you can see the coordinates in the
feature class form.

Variant

To display the X (easting) and Y (northing) coordinate in two separate fields,
add another geometry control and use the following attributes:

■ Set one Control to True the other to False. Either:

■ ShowX=True and ShowY=False
or:

■ ShowX=False and ShowY=True

Defining Tab Pages for Forms
You can assign several tab pages to a form, and customize the tabs. You use
controls on the tab pages to set up the information that is displayed in a form.

Using the Tab Pages commands on the Designer menu, you can create or edit
the tabs. (Example can be reproduced in workspace TB2007_LM).

To define additional tab pages

1 Start the Form Designer
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2 In the form explorer, select the feature class Point, select the Form Type,
such as Default, and click Edit.

3 In the Designer dialog box, click Tab Pages menu ➤ Add Tab.

4 Enter a name, such as “Special Form” and click OK.

5 The new tab page is added to the right pane. Note that the All tab shows
all controls and is only visible in the form designer. Controls that are
visible in all tab pages are indicated by a blue caption.

6 In the left pane, click the Controls tab.

7 In the right pane, click the All tab and remove all controls that you want
to display on other tab pages. For example, do not remove the FID control
if you want to display this on all tab pages. Shift+click to select multiple
controls. In the left pane, in the Hidden list you can see the controls that
you removed.

8 To add controls to a tab, in the right pane, click the tab and drag the
controls that you want to add from the left pane to the tab on the right.

9 Next, define the Special Form tab.

10 Exit the Designer.

Defining Form Toolbars
You can assign a special toolbar to each form and each user group. Usually
you will define toolbars for the different types of tables, such as feature class
(page 582), label feature class (page 583), domain (page 582), and so on. For
example, a domain table toolbar does not need any tools related to graphic
connection.

By default, there are some toolbar definitions: Feature, Domain, Label, and
Others. When you create a new form, one of these toolbars is assigned:

■ Feature class form: Feature toolbar type

■ Label feature class form: Label toolbar type

■ Domain: Domain toolbar type

■ system tables and other tables: Others toolbar type

By configuring toolbars, you can hide or show certain icons.
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To assign a toolbar to a form

1 Start Topobase Administrator and open a workspace.

2 In the Administrator explorer, select the document.

3 In the Administrator, click Document menu ➤ Form Designer.

4 In the form explorer, select the feature class, select the Form Type, and
click Edit.

5 In the Designer dialog box, click Designer menu ➤  Options.

6 In the Options dialog box, assign a toolbar to the form.

See also:

■ Designer Menu: Options (page 364)

To configure a form toolbar

1 Start Topobase Administrator and open the workspace.

2 In the Administrator, click Document menu ➤ User Interface.

3 In the right pane, click the Forms tab.

4 Select the user group whose form toolbars you want to configure.

5 Click Add to create a new type of form toolbar.

6 Expand the items by clicking the + in front of the selected entry. All
available tools are listed. Select or clear the buttons that you want to hide
or show in the form.

NOTE Hiding a button in a toolbar definition affects all forms that use this toolbar.

NOTE The toolbar definition list also includes the setting that specifies the
commands that are in the related shortcut menus.

See also:

■ Defining Shortcut Menus for Feature Class Forms (page 426)

■ Customizing Form Toolbars and Menus (page 81)
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Defining Shortcut Menus for Feature Class Forms
You can customize the shortcut menus of the feature class forms. You perform
the same steps as for configuring form toolbars.

See also:

■ Defining Form Toolbars (page 424)

To define a shortcut menu for a form

1 Start Topobase Administrator and open the workspace.

2 In the Administrator, click Document menu ➤ User Interface.

3 In the right pane, click the Forms tab.

4 Select the user group whose form shortcut menus you want to configure.

5 Select the form type you want to configure, such as Feature.

6 Expand the list. All available commands are listed. Select or clear the
commands that you want to show or hide in the form.

Assigning a Feature Class Form to a User Group
For each user group you can assign specific feature class forms. See also Form
Designer: Managing Multiple Forms (page 358).

To assign a form to a user group

1 Start Topobase Administrator and open a workspace.

2 In the Administrator explorer, select the document.

3 In the Administrator, click Document menu ➤ Form Designer.

4 In the form explorer, select the feature class.

5 Under User Groups, for each user group, select the appropriate form type.

Assigning Help Files to Feature Class Forms
You can configure a Help system for either desktop or Web version. Also, you
can assign Help files to each form and each control.
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To assign Help topics to a form

1 Start Topobase Administrator and open the workspace.

2 In the Administrator explorer, select the document.

3 In the Administrator, click Document menu ➤ Form Designer.

4 In the Administrator, click Document menu ➤ Form Designer.

5 In the form explorer, select the feature class. Select the Form Type, and
click Edit.

6 In the Designer dialog box, click Designer menu ➤  Options.

7 In the Options dialog box, in the Help section, enter the properties, as
for example:

File Name: topobase.chm

Context: form_designer_introduction.htm

The Help file and topic are displayed when the user presses F1 and the cursor
is not on a control.

You can also assign a Help topic to each control. This topic is displayed when
the user presses F1 while the cursor is on that control. In this case, you must
select the control and edit the Control properties. After editing the properties,
you can enter the Help file name and Help context again. See also Form
Designer: Property TextBox - Properties (page 398)
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Working with Display
Models

Overview of Display Models
In Topobase, you use display models to administer thematic views. You apply
different display models to render the data of a workspace. A display model
specifies which set of layer files (feature layers) is loaded into the Display
Manager.

For detailed information about Generate Graphic and defining viewports, see
the Client User Guide, section Displaying Features In Your Map.

A display model consists of several files. See also Display Model Repository (page
431). You can export and import the display models to share with other users
and across workspaces.

Multi Windows

You can define display models that display the features in multiple drawings.
That means that your display model can consist of several display model maps.
For each drawing window you can define different stylizations. For example,
define one window to display all feature layers, using basic stylization, and
another window to display a selection of feature layers, using a thematic style.
In Topobase Electric, you might use a second window to display the network
in a schematic view. Both windows are connected to the database. Operations
such as highlighting a feature apply to both windows.

7
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Display options

You can control the behavior of display models and Generate Graphic by
several application options. See To set Generate Graphic options (page 126).

■ Number of open drawings

■ Highlight features

Default Display Model
Topobase provides a temporary default display model that allows easy and
quick rendering of the workspace data. Temporary means that the display
model is loaded in memory, but not yet stored in the file system. However,
you can modify the temporary display model and save it as display model for
further use. When you generate graphic using the default display model, a
default style applies to each feature class. You cannot influence the styling of
a default display model. You can create new display models and save them
for all your stylization requirements.

The default display model contains all layers of the workspace, that means all
feature layers of all documents. When you open a workspace, and select Open
Default Display Model, it is created automatically. You use the default model,
if you have not yet defined any stylization, which also means that you have
not yet specified any Autoload layers.

NOTE In the default display model, label feature classes with the extension _TBL
are loaded as feature layers. See also Styling Label Features (page 452).

NOTE If you open the default display model in a job-enabled document, you can
optionally track feature deletion. See also Styling Job-Enabled Features (page 470).

To generate graphic using the default display model

1 Select the workspace.

2 Click Home tab ➤ Display panel. In the Display Model list, click Open
Default Display Model.

3 Click OK.

This loads all feature layers of the document into the memory, and
generates graphic. All feature layers are displayed in the Display Manager.
For documents with many feature classes, this can take some time.
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NOTE The drawing viewport extends over the complete spatial extent of your
document. If the spatial extent is larger than the extent of your project data, zoom
in to the area of interest.

See also To create a display model based on the default display model (page
42).

Autoload Layer
In a display model, you optionally specify autoload layers that are displayed
automatically when you open a workspace. You do not need to generate
graphic explicitly. Use autoload layers as context for the spatial selection of
your viewport. For better performance, autoload layers should not contain
too many details. For example, set the administrative boundaries as Autoload
layer. In the Display Model definition, you can set one or more layers as
autoload layers.

To specify autoload layers

1 Open your display model.

2 Click Home tab ➤ Display panel ➤ Edit Display Model.

3 In the Display Model Edit dialog box, on the right pane, under Layer
Properties, select the layers, select Autoload, and clear Confine to
Viewport.

Display Model Repository
Topobase display models are stored in the file system in (*.xml) files. A display
model consists of several files as shown in the following table.

DescriptionDisplay model file

XML file that stores the name and related display model
maps. A display model consists of one or more display model
map files.

<display model
name>.tbdm

Display model map file: XML file that stores the size, position,
and references to the feature layers of each window. If you

Map_<nr>.tbdmmap

define multiple windows, for each window one display
model map file is used.
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Layer file (XML file). For each layer that is referenced in the
display model map file.

<feature class
name>.LAYER

DWG file containing the block definitions that are referenced
in the display model. See also Block References (Symbols)
(page 432).

Blockdefini-
tions_<nr>.DWG

DWG file containing blocks.<prototype>.DWG

We recommend that you store the display models in a file system that
represents the structure. For example, save each display model (set of files) in
a separate folder. Or create separate folders for layer files that you want to use
in multiple display models.

To specify the default location of the display model repository (Application
Options)

In the application options, you specify the Repository Base Path to the central
location of the display model files.

1 Start Topobase Client, and open the workspace.

2 Click Settings tab ➤ Setup panel ➤ Application Options.

3 In the tree view, click Generate Graphic.

4 Under Display Model, Repository Base Path, browse for the folder.

See also To specify the default location of the display model repository (page
126).

To specify the default location of the display model repository (display model
manager)

1 Open the display model manager.

2 Click Settings menu ➤ Change Default Location.

3 Select the folder.

Block References (Symbols)
When you style point features, you can use symbols. In the layer files, the
location of the symbols is stored differently, depending on whether you use
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Standard Stylization, or Enhanced Stylization. See Styling Point Features (page
450), and Enhanced Point Stylization (page 457).

Standard Stylization

You can reference blocks that are either available in the current drawing, or
that are stored in a separate (*.DWG) file, such as the prototype drawing, or
a block symbol file.

■ Current drawing—If you use a block from the current drawing, the layer
file stores the Block Name. When you save your display model, each block
definition will be stored in a separate local block definition file
Blockdefinitions_<nr>.DWG, and the display model map file (*.tbdmmap)
stores the relative path of the block definition files. When you start
Generate Graphic, the separate block definitions are loaded into the current
drawing.
Note that these block definition files are a part of the display model, and
need to be copied with the display model files.

■ Block symbol file—If you use a symbol from an external (*.DWG) file, the
(*.layer) file stores the absolute path to the file. For example, if you want
to share a central prototype drawing. If you modify a block definition in
the referenced file, these modifications apply when you Generate Graphic.

Enhanced Stylization

You can use default symbols, or you can include symbols from the repository.
For example, you import symbols into the repository that are stored in a
separate (*.DWG) file, such as the prototype drawing.

■ Default symbol—If you use a default symbol, the (*.layer) file stores the
symbol name. For example, <Name>Triangle</Name>.

■ Repository symbol - Copy—If you include a symbol from the repository
as a copy, the (*.layer) file stores the symbol definition.

■ Repository symbol - Reference—If you include the a symbol from the
repository as a reference, the (*.layer) file stores the symbol resource library
ID.

NOTE Using Enhanced Stylization, if you modify a block definition in the (*.DWG)
file you imported into the repository, these modifications will not apply when you
Generate Graphic, because the (*.layer) files do not reference the (*.DWG) directly.
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Display Model Manager
Use the display model manager to create and edit display models, display
model maps, and layers.

You can provide display models per document, and per extension, and then
combine them as needed, for example Land + Water + COGO + Plot. See also
Setting up Display Models (page 441).

The Display Model dialog box provides different areas, depending on the
context.

DescriptionDisplay Model Man-
ager

Tree view of the display models repository. See also Display
Model Repository View Area (page 435).

Display Model Re-
pository  area

Displays the display model components. See also Display
Model View Area (page 436).

Display Model area

This option is only available, if the document is job enabled.
And this option only applies, if the display model has been
created using the Display Deleted Features option.

Display Deleted Fea-
tures

For display models that have been created using the Display
Deleted Features option, you clear this option, to display only
the features of the job state Live. Then, you do not display
features that have been deleted in the current job. With this
option enabled, the Display Manager uses the Topobase text
function TB_SQL for TB_JOB_OPERATION_ID.
See also Styling Job-Enabled Features (page 470).

Displays the properties of the selected layers. See Layer
Properties (page 439).

Layer Properties area

Available in edit mode: Closes the dialog box, generates
graphic, and temporarily applies the changes to the map.

Apply

You can review the changes. To save the changes, or to
continue to edit the display model, select Edit Display Model
again.

Saves the changes.Save

Settings menu
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Specifies that layers are referenced by default, when you add
a layer from an existing display model. See also To reference
a layer (page 444).

Always Reference
Layers

Specifies the default location for the display model repository.
See also Display Model Repository (page 431).

Change Defauit Loca-
tion

To open the display model manager

1 Start Topobase Client, and open the workspace.

2 Click Home tab ➤ Display panel, and click one of the following.

■ Create Display Model

■ Edit Display Model

■ Save Display Model

■ Save Display Model As

Each of these commands opens the display model manager with the
appropriate commands enabled.

Display Model Repository View Area
The Display Model Repository tree view displays the logical structure of the
display models that are stored in your repository. Expand the items to display
the levels.

■  Display model. Right-click, and click Open Display Model to select
the display model. You can then review and edit the display model files
in the right pane, in the view area.

■  Display model map. Right-click, and click Add To Current Display
Model, to add the map to the current display model.

■  Layer. Right-click, and click Add To Current Display Model, to add
the layer to the current display model.
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Click Recently Used to see the last 5 display models opened. For example,
expand a display model, right-click, and click Open Display Model to select
the display model.

Click Open Display Model to open a display model from another location.
The browse window shows either the display model repository, or the last
opened directory.

Display Model View Area
The right pane of the display model manager displays the display model maps
and layers. You can drag layers, or display model maps from the display model
repository to the display model view.
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Click the View Alphabetically tab to see the display model maps, and the
feature layers in alphabetical order. Edit the items as shown in the following
table.

DescriptionView Alphabetically
tab

A display model can have one or more drawing windows =
display model maps.

Display Model Map
node

Displays the coordinate system.Coordinate System

Displays the display model map properties such as size, loca-
tion and state. See also Multi Windows (page 429).

State
X, Y, Height, Width

Creates a new display model map.

Cuts the selected items to the clipboard.

Cuts the selected items to the clipboard.
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Pastes the items from the clipboard.

Removes the selected items.

Renames the item.

Click the View By Draw Order tab to see the feature layers in their draw order.
The first layer in the list is drawn on top of the layers lower down. Edit the
items as shown in the following table.

DescriptionView By Draw Or-
der  tab

Displays the coordinate system.Coordinate System

Displays the display model map properties such as size, loca-
tion and state. See also Multi Windows (page 429).

State
X, Y, Height, Width

Moves selected layer up.

Moves the selected layer down.

Removes the selected items.

Renames the item.
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Layer Properties
In the Layer List, use drag-and-drop to change the order of the columns.
Right-click the title row to select the columns you want to show or hide. Show
and hide the columns by right clicking and checking and unchecking.

DescriptionLayer Properties

Specifies the name of the display model map.Map Name

Displays the layer caption, as displayed in the Display Man-
ager. Related to <Name> in the (*.tbdmmap) file.

Name

Displays the feature class name.Feature Class

Displays the Display Manager group.Group

Specifies whether the layer is an Autoload layer. Select this
option if you want to draw the feature layer automatically

Autoload

upon selection of the display model. See also Autoload Layer
(page 431).

Saves a filter that has been applied to the selected feature
layer.

Filter

■ Example—In Display Manager, select a feature layer,
right-click Query To Filter Data, and define a filter.

■ Example—Zoom into the drawing, and click Generate
Graphic. Then, the filter is set to the extents of the current
Window viewport.

When you save the display model, the check box will be se-
lected, and the filter will be saved in the LAYER file.
Clear this option, if you do not want to save the filter.

Specifies whether the layer will have its viewport updated on
Generate Graphics or not. Use this option to control which

Confine To Viewport

feature classes are represented in the current viewport and
which are not.
Select Confine To Viewport to draw feature data based on
the current viewport. When you zoom out, features outside
the viewport are not visible.
Clear Confine To Viewport to draw all feature data without
clipping. When you zoom out, features outside the viewport
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are visible, and can be used as context for another Generate
Graphic. For example, for feature layers that represent the
base map content, or a map grid.
See also Map Options (page 122), Always Display Highlighted
Features.

Specifies whether the layer is enabled in the Display Manager,
and the features are shown in the drawing.

Visible

For example, to change multiple layers without having to
click on each layer in the Display Manager.

Specifies whether the layer is marked as Make Layer Selectable
in the Display Manager.

Selectable

For example, to change multiple layers without having to
right-click on each layer and without editing the (*.tbdmmap)
file.

Displays the document name for display models that contain
layers from different documents with the same name.

Source

For example, in a workspace with two water documents, you
can add two feature layers WA_POINT to the display model,
one of each document. Then, the Source of each document
is displayed.

NOTE This setting can only be changed if you are saving a
display model.

Ref.

Specifies whether the layer is a referenced layer.
Clear this option to create a copy of the layer (LM_Build-
ing_2.layer), leaving the original referenced layer file un-
touched.
For example, to open a shared Display Model on a read-only
network share, and to save it as a working copy in your own
repository. See also To reference a layer (page 444).

Displays the path where the LAYER file is stored. The path is
relative to the Repository Base Path that is specified in the
application options; see Generate graphic (page 126).

Path

NOTE The path also indicates whether the display model
shares layers with other display models.

440 | Chapter 7   Working with Display Models



Setting up Display Models
Use the AutoCAD Map 3D Display Manager to create and edit the styles for
the feature layers, see also Overview of the Display Manager (page 446).

You create a display model either by modifying the default display model, or
by using the Display Manager to style the feature layers from scratch.

You can extend an existing display model by adding new layer files. The
display model files use references to store the layers. For example, open an
existing display model, then add new layer files to the Display Manager, and
save the files as a new display model.

You can predefine separate display models for different use cases, modules,
and extensions, such as land management, urban planning, green cadastre,
utilities, COGO, plot, profiles. Then you can use the display model manager
to create display model by merging any of the predefined components. See
also Display Model Manager (page 434).
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To create a display model from scratch

This procedure creates an initial set of feature layers from scratch.

1 Use the Display Manager to connect and style the feature layers. See
Bringing In Features From Topobase (page 447).

2 Click Home tab ➤ Display panel ➤ Save Display Model As.

3 In the Display Model dialog box, specify the properties, and click Save.

To create a display model by modifying the default display model

To get an initial set of feature layers, you can also modify the default display
model. See To use the default display model (page 42).
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To create a display model from a set of existing layers

You create a display model by reusing layers of predefined display models.

1 Click Home tab ➤ Display panel ➤ Create Display Model.

2 Under Create Display Model, enter a name.

3 Click  Create New Map.

4 Select the new map, click  Rename Selected Item, and enter a
name.

5 Under Display Model Repository, expand the display model / display
model map that contains the layers you want to add.

6 Do one of the following.

■ Select the layer, and click Add  .

■ Drag the layer from the repository to the map.

7 Under Layer Properties, notice whether Ref is selected. If you reference
the layer file, the file will not be copied to the new display model folder,
but the path to the original layer will be stored.

Notice that referenced layers are highlighted with a special icon.

8 Click Save, and specify a name and folder to save the display model.

To create a plot display model (from sample)

1 Copy the sample display model from <default display model
repositoryt>\Extensions\Plot to your display model repository <display
model repository>\DM Plot.

2 Click Home tab ➤ Display panel ➤ Open Display Model. Select the DM
Plot.

3 Click Generate Graphic.

4 Modify or edit the stylization as needed.

5 Click Home tab ➤ Display panel ➤ Save As.
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6 Create a new folder, and save the display model.

To reference a layer

To share layer stylization, you can reference layers from existing display
models.

1 Start Topobase Client, and open the workspace.

2 On the Home tab ➤ Display panel, open, or select the display model you
want to edit.

3 Click Home tab ➤ Display panel ➤ Edit Display Model.

4 Under Display Model Repository, expand the display model map that
contains the layers you want to reference.

5 Select the layer, and click Add  .

6 In the right pane, under Layer Properties, select the layer, and check the
Ref. option. Notice that the referenced file is listed under Path.

7 Click Save.

The layer will be referenced in the display model file, and the path to the
original layer will be stored.

By default, layers are added as reference. You can change this behavior in the
reference options.

IMPORTANT If you use references layers, be aware that if you modify the
stylization, the modifications will apply to all display models that use this layer.

To set the reference option

You can specify whether existing layers will be added as referenced layers.

1 Open the display model manager.

2 Click Settings menu ➤ Always Reference Layers.
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To add the COGO layers to your display model

You can administer separate display models for each extension that can be
referenced by your module specific display models. For example, you reference
feature layers for the COGO extensions.

1 On the Home tab ➤ Display panel, open, or select the display model you
want to enhance.

2 Click Home tab ➤ Display panel ➤ Edit Display Model.

3 Under Display Model Repository, expand the COGO display model map.

4 Select the COGO layers, and click Add  .

5 Under Create Display Model, click the View By Draw Order tab, and select
the COGO layers.

6 Click  , and move the layers to the top of the list.

7 Under Layer Properties, for the COGO layers, select Ref.

8 Click Save, and specify a name and folder to save the display model.

To apply temporary changes to display model properties

1 Click Home tab ➤ Display panel ➤ Edit Display Model.

2 In the Display Model Edit dialog box, under Display Model Repository,
select the display model.

3 Right-click, and click Open Display Model.

4 On the right pane, edit the display model. For example, change the draw
order.

5 To review the changes, click Apply.

The command closes the display manager, and performs a Generate
Graphics.

6 To save the changes, click Home tab ➤ Display panel ➤ Save Display
Model.

See also Modifying Display Models.
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To save a Topobase 2008 drawing template as display model

You can save existing drawing templates (*.dwt) that have been used with
Topobase 2008 as display models.

1 Start Topobase Client, and open the workspace.

2 Open the drawing template (*.DWT).

3 Click Home tab ➤ Display panel ➤ Save Display Model As.

4 In the New Display Model dialog box, enter a name. Click OK, and save
the display model in a separate folder, such as Land102.

5 Generate Graphic.

NOTE The label feature classes <name>_TBL are loaded as feature layers, so you
can reuse existing stylization. Optionally you can add the label feature classes as
annotation layers. See Styling Label Features (page 452).

Overview of the Display Manager
Autodesk Topobase uses the AutoCAD Map 3D Display Manager to create,
edit, and display styles for feature source data in your map. You can use the
standard stylization functionality available in AutoCAD Map 3D, or you can
use Enhanced Stylization available only in Topobase. Both stylization
procedures are available through the Display Manager Style command.

NOTE You must enable Enhanced Stylization through a special data connection.
For more information, see Using Enhanced Stylization (page 456).

In addition to styling feature source data, you can change the display order
and specify different styles for different views based on scale. You can also
create themes for feature layers, to identify different types of data.

For example, you can highlight all the roads in a parcel that need to be paved
or identify all the lots within 100 meters of a proposed highway.

You can also use themes to change colors, line types, symbols, text, or other
properties that can help you present map information and tell a story. Themes
can help make information more visible, illustrate how data is distributed,
make data easier to analyze and interpret, and reveal patterns.
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NOTE The styles you create with the Display Manager can be reused in Topobase
Web by publishing the map containing those styles to Autodesk MapGuide first.
See the MapGuide Studio Help for more information.

For detailed information about using the Display Manager to create and apply
the styles, see the following sections in the AutoCAD Map 3D help:

■ Styling Features

■ Creating Themes

For additional Topobase specific information, read the following sections:

■ Using Enhanced Stylization (page 456)

■ Styling Label Features (page 452)

■ Topobase Line Styles (page 451)

■ Creating Topobase Calculations (page 466)

Using the Display Manager with Autodesk
Topobase

Before using the Display Manager to style data in Autodesk Topobase, and to
create feature layers, you need to connect to the Topobase provider.

Bringing In Features From Topobase
You can create a feature layer in Display Manager for each feature class that
is stored in Topobase. Then, you style the feature layers.

To bring in features from Topobase

1 Start Topobase Client.

2 In Display Manager, click Data ➤ Connect To Data.

3 In the Data Connect window, select Add Topobase Connection in the
Data Connections By Provider list.

4 Under Connection Name, type a name for this connection. You can give
the connection any name you like.
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5 Under Service Name, enter the service name for the Oracle data store.
For example, ORCL.

6 Under Topobase Main Or System User Name, enter the name for the
Topobase Main or System User. Also, enter the password. The default for
the Topobase System User is TBSYS.

7 Under Document, select the document name in the list.

8 Click Connect.

9 In the Add Data To Map section, select the feature classes you want to
add.

10 Do either of the following:

■ Click Add To Map to use standard AutoCAD Map 3D stylization.

■ Click Add To Map Using Enhanced Styles to use enhanced stylization.
For more information on using enhanced stylization, see Using
Enhanced Stylization (page 456).

11 Close the Data Connect window.

Then, style and edit the feature layers, and save the display model.

Optionally, save the settings as LAYER files, and create the display model from
LAYER files. LAYER files can easily be modified using a text editor.

NOTE If you use the Oracle provider (Add Oracle Connection), you cannot use
TBSYS to log in, you must log in with DBA rights.

See also:

■ Styling Features (page 450)

Creating LAYER Files
After you have set up the styles and feature source information, you can
optionally save this information as LAYER files.

Saving Styled Feature Layers

After you have styled feature layers, you can save the connection and styling
information to LAYER files that you can share with other users, or add to any
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display model. A LAYER file contains connection and style information only.
It contains no feature data.

To save LAYER files

1 In the Display Manager task pane, right-click the layer containing the
information and styles you want to save and select Save Layer.

In the Save Layer dialog box, under Files Of Type, your new file is given
a (*.layer) extension and a default file name from the name of the layer
you selected.

2 You can rename the file or not. Then, save it to a convenient location
on your system.

NOTE Autodesk Topobase provides sample layer files for the demo data sets. See
also Topobase Installation and Configuration Guide.

When you select a display model, Topobase Client adds the source files to the
AutoCAD Map Explorer, creates the connection, adds the feature layer to the
Display Manager (page 581). Click Generate Graphic to style the layers correctly.

To add a LAYER file to a display model

1 Navigate to where you saved your LAYER files.

2 Select the files you want to include in the template, and drag them to
the Display Manager task pane.

3 In Display Manager, click Data ➤ Connect To Data.

4 In the Data Connect window, under Data Connections By Provider, select
the Topobase connection the feature layers belong to.

5 Check the connection parameters. After you have entered the Topobase
Main User Password, under Document, select the document (datastore)
containing the feature classes, whose LAYER files you just created. For
example, select the Water demo data set TB2010_WA_102.

6 Click Connect and close the Data Connect window.

7 In the Display panel, click Display Model icon ➤ Save As.
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Styling Features
You can specify properties that control how features appear on a map. For
example, you can specify the scale ranges at which a feature is visible, set line
color, and add labels.

Styling Point Features

Read the following AutoCAD Map 3D help topic:

■ Styling Point Features

NOTE Autodesk Topobase provides sample prototype drawings with predefined
symbols for the demo data sets. See also Topobase Prototype Drawings (page 47).

To use symbols of a prototype drawing

1 In the Display Manager, in the Style Point dialog box, click  .

2 In the Select A Symbol dialog box, click  .

3 In the Open Block Symbol File dialog box, select the prototype drawing
(*.dwg). For example,
<topobase_client>\Template\Modules\Water\DisplayStyle\Prototype_WA.dwg.

4 Click Open. Select a symbol.

See also Block References (Symbols) (page 432).

Styling Line Features

Specify the thickness, color, and pattern of polyline features. Style a single
line or build a composite line with several components and then style each
component. For example, to illustrate a highway, create a thick black line and
add a thinner, dashed, yellow line.

Read the following AutoCAD Map 3D help topic:

■ Styling Line Features

NOTE Autodesk Topobase provides additional line styles. See Topobase Line Styles
(page 451).
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Styling Area Features

Specify the fill style and color, background color, edge style and color, and
line thickness used to draw area (polygon) features.

Read the following AutoCAD Map 3D help topic:

■ Styling Area Features

Adding Labels to Features

Add labels to features on feature layers. The label is placed near the line, point
symbol, or polygon.

Read the following AutoCAD Map 3D help topics:

■ Adding Labels to Features

■ Allowing Labels to Obscure Points

■ Displaying Fixed Labels at Point Locations

IMPORTANT In addition to the method of Adding Labels to Features, which is
provided by the Display Manager, Autodesk Topobase provides another approach
of labeling. Using Topobase you can create label features that are stored in the
database. You use label features to create complex labels with a precise positioning.

See also:

■ Styling Label Features (page 452)

Topobase Line Styles
For line stylization you can use the AutoCAD Map default line styles.
Additionally, Autodesk Topobase provides Topobase line styles that are stored
in the <topobase_client>\linx folder in style definitions files (*.linx).

You can edit the style definition files with any XML editor. For example, you
can use a files as template for your own enhancements. Also, you can create
additional style definition files.

A (*.linx) file contains two parts. The first part stores decorations and the
second part stores the current line style definitions referencing those
decorations. To draw filled symbols, you can use pre-defined symbols for filled
circles and squares that are defined in the style definition file.
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You can use decorations, and definitions that use those decorations. AutoCAD
Map 3D provides four default decorations. You can add new decorations
following a simple MoveTo/LineTo pattern.

For a complete format description, see the schema definition file
<topobase_client>\linx\linestyles.xsd.

NOTE Rendering time significantly increases with more pixel runs used in a line
style definition.

Styling Label Features
You use Topobase label features to create inscription with a precise and fix
positioning relative to the features. Also, label feature text can be queried
using complex SQL select statements and therefore display information of
multiple feature attributes.

Label features are stored in the database in a special feature class type. The
label text is stored in the attribute LABEL_TEXT. In Display Manager, label
features are represented using separate feature layers.

You can either load a label feature class as feature layer or as annotation layer.

■ Annotation layer—Under Data  ➤ Connect To Data, select a feature class
that has the name extension _TBL. In the Display manager, annotation

layers are marked by a special icon  .

■ Feature layer—On the Home tab ➤ Display panel, open the default display
model. All label feature classes are loaded as feature layers.

NOTE We recommend that you load the label feature classes as Annotation layer.

See also:

■ Data Model: Labels (page 223)

To style an annotation layer

1 In Display Manager, select the annotation layer. Click the Style And
Theme Layers icon.

452 | Chapter 7   Working with Display Models



2 In the Style Editor, under Symbolization Style For Scale Range, click the
box under Style.

3 In the Style Text Layer dialog box, style the annotation.

4 For Text, click the box next to Exp, and edit the expression. The label
text is stored in the attribute LABEL_TEXT.

Notice that the expression includes a prefix, and a suffix.

Concat(Concat(PRE,LABEL_TEXT),SUF)

You can add a static prefix/suffix to your label definition, such as a unit
or a caption. The prefix and suffix values are stored in the label feature
class in the attributes PRE and SUF. See also Label Properties: Label
Information (page 226).

5 For Horizontal Alignment, and for Vertical Alignment, click the box next
to Exp, and edit the expression to specify the position of the text origin
relative to the feature.

You can select the alignment values that have been specified in the label
definition: HORIZONTAL, and VERTICAL.

6 For Rotation, click the box next to Exp, and edit the expression. Either
use the value that is stored in the database, or edit the expression,
depending on the document unit settings. See also Displaying Label
Features with Orientation (page 455).

To style a feature layer (label)

NOTE By default, a label feature is displayed using a symbol. Style the label feature
as follows:

1 In Display Manager, select a feature layer containing the label feature
class, such as LM_STREET_TBL. By default, a label feature class is named
<name>_TBL.

2 Click the Style And Theme Layers icon.
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IMPORTANT When styling label features in the Style Editor, you must enable
the following options:

■ Allow Other Labels To Obscure Feature Symbols On This Layer—Select
this option to specify that labels on other layers be allowed to obscure
points on the selected layer.

■ Labels Are Fixed (Not Dynamic)—Select this option to specify that
the labels are always displayed according to the draw order.

These options make sure that the labels are displayed exactly at the
position that is stored in the database.

3 In the Style Editor, under Scale Ranges, select a scale range.

4 Under Point Style For Scale Range, click the box under Style.

5 In the Style Point dialog box, select Style A Point Symbol and specify a
symbol. Click OK.

6 Under Point Style For Scale Range, click the box under Feature Label.

7 In the Style Label dialog box, select the Create A Label check box.

8 For Property To Display, select LABEL_TEXT.

9 Use the Horizontal Alignment and Vertical Alignment lists to specify the
position of the text origin relative to the feature.

You can select the alignment values that have been specified in the label
definition. In the list, select Expression. In the Text Expression dialog
box, under Property, select HORIZONTAL_ALIGNEMENT or
VERTICAL_ALGINEMENT.

10 For Rotation you use the value that is stored in the database. Select
Expression, depending on the document unit settings. See also Displaying
Label Features with Orientation (page 455).

IMPORTANT You must style a point symbol for the label feature, if you want to
edit the label in the drawing, such as changing the orientation or the position.

If you do not style a point symbol for the label feature, you cannot select the
label in the drawing.

Read the following AutoCAD Map 3 D help topics:

■ Adding Labels to Features
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■ Allowing Labels to Obscure Points

■ Displaying Fixed Labels at Point Locations

Displaying Label Features with Orientation
You can use the orientation that is stored in the database to specify the rotation
of Topobase label features. The orientation is stored in the label feature class
attribute ORIENTATION. Note, that the Display Manager interprets the
ORIENTATION as degrees counterclockwise, regardless of the document units
and Autodesk Map drawing settings. Also, the document base angle is North,
and the Display Manager base angle is East. To display properly, you must
convert the orientation from document units to degrees counterclockwise

To convert the label orientation

1 In Display Manager, select a feature layer containing the label feature
class. Click the Style And Theme Layers icon.

2 In the Style Editor, specify an expression for the rotation. In the Style
Label dialog box, select Rotation = Expression. Use the expressions exactly
as shown in the following table:

ExpressionRotation UnitDocument Unit

ORIENTATION + 90counterclockwiseDegree

((ORIENTATION * 9/10) + 90)counterclockwiseGon

((ORIENTATION * 1800000/31415)
+ 90)

counterclockwiseRadian

(90 - ORIENTATION)clockwiseDegree

(90 - (ORIENTATION * 9/10))clockwiseGon

(90 - (ORIENTATION *
1800000/31415) )

clockwiseRadian

Displaying Label Features with Orientation | 455



Map Drawing Units
When generating a graphic, Topobase sets the following drawing units
according to the document unit settings:

■ Angle Type—For example degrees or gons.

■ Rotation—For example clockwise or counterclockwise.

■ Base Angle—In Topobase documents the direction is North.

The drawing units apply to all construction commands.

If a workspace contains more than one document with different unit settings,
you are notified that the label orientation unit can not be determined clearly
when you digitize an orientation.

To view the map unit settings

1 On the Map command line, enter Units.

2 Click Direction for the Base Angle direction.

To view the document unit settings

1 Start Topobase Administrator.

2 In the Administrator explorer, select the document.

3 Click Data Model. In the data model explorer, select the label feature
class.

The ORIENTATION unit is displayed in the properties pane on the right.

NOTE All Topobase documents use the Base Angle direction North. You cannot
modify this value.

Using Enhanced Stylization
When you use Data Connect within Topobase Client to add data to your map,
you can enable enhanced stylization functionality that is not available in
AutoCAD Map 3D. This stylization enables you to build a collection of styles
laid one on top of the other for points, lines, polygons, and text and symbol
labels.
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Use Enhanced Stylization to leverage existing line types that are defined in
(*.lin) files. For Enhanced Point Stylization, see also Block References (Symbols)
(page 432).

Enabling Enhanced Stylization
To enable enhanced stylization you must select it when you connect to data.

To enable enhanced stylization

1 In Display Manager, click Data ➤ Connect To Data.

2 Configure the data connection.

For more information, see Bringing In Features From Topobase (page 447).

3 When you are ready to add the data to the map, click Add To Map Using
Enhanced Styles instead of Add To Map.

Enhanced Point Stylization
Add a point or multigeometry layer to your map using Add To Map Using
Enhanced Styles in the Data Connect dialog box. For more information, see
Enabling Enhanced Stylization (page 457).

To style points using enhanced stylization

1 In Display Manager, right-click a feature layer that contains points.

2 Click Edit Style.

3 In the Style Editor, under Scale Ranges, select the scale range to style.
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4 In the Symbolization Style area for the selected scale range, click the box
under Style.

5 In the Style And Label Editor dialog box, click the Style tab.

If you are working with a multigeometry layer, for Geometry Type, click
Point, Line, or Polygon to specify the type of geometry you want to style
on this layer.

6 For Size Context, specify the type of units:

■ Select Device Space to specify symbol widths and heights in screen
units. Available units are Points, Inches, Millimeters, or Centimeters.

■ Select Map Space to specify symbol widths and heights in Mapping
Coordinate System (MCS) units. Available units are Inches, Feet, Yards,
Miles, Millimeters, Centimeters, Meters, and Kilometers.

7 For Units, select the type of units to use.

8 Under Symbol And Style, click Add to add a new style component. 

9 Select each style component in the Symbol And Style list and style as
desired.

Styles are drawn from the bottom of the list to the top so use Move Down

and Move Up to control the draw order. 

Click Load to open a symbol from a .dwg file. See also Block References
(Symbols) (page 432).

Use Width and Height to adjust the size of the symbol. Click Maintain
Aspect Ratio to keep the symbol intact as you modify either of these
settings.

Use X Offset and Y Offset to specify the offset of the symbol from the
location of the point feature.

For any style setting, click Edit Expression to build styles using expressions
based on feature properties. For more information about expressions, see
Building If, Lookup, and Range Expressions (page 464).

10 When you are finished styling points, click OK.

To add text labels to this layer, see Feature Text Labels (page 462). To add symbol
labels to this layer, see Feature Symbol Labels (page 463).
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Enhanced Line Stylization
Add a line or multigeometry layer to your map using Add To Map Using
Enhanced Styles in the Data Connect dialog box. For more information, see
Enabling Enhanced Stylization (page 457).

To style lines using enhanced stylization

1 In Display Manager, right-click a feature layer that contains lines.

2 Click Edit Style.

3 In the Style Editor, under Scale Ranges, select the scale range to style.

4 In the Symbolization Style area for the selected scale range, click the box
under Style.

5 In the Style And Label Editor dialog box, click the Style tab.

If you are working with a multigeometry layer, for Geometry Type, click
Point, Line, or Polygon to specify the type of geometry you want to style
on this layer.

6 For Size Context, specify the type of units:

■ Select Device Space to specify symbol widths and heights in screen
units. Available units are Points, Inches, Millimeters, or Centimeters.

■ Select Map Space to specify symbol widths and heights in Mapping
Coordinate System (MCS) units. Available units are Inches, Feet, Yards,
Miles, Millimeters, Centimeters, Meters, and Kilometers.

7 For Units, select the type of units to use.

8 Under Symbol And Style, click Add to add a new style component. 

9 Select each style component in the Symbol And Style list and style as
desired.

Styles are drawn from the bottom of the list to the top so use Move Down

and Move Up to control the draw order. 

Click Load to open a line style from a .lin file.

Use Width and Height to adjust the size of line pattern elements. Click
Maintain Aspect Ratio to keep the pattern intact as you modify either of
these settings.
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For any style setting, click Edit Expression to build styles using expressions
based on feature properties. For more information about expressions, see
Building If, Lookup, and Range Expressions (page 464).

10 When you are finished styling lines, click OK.

To add text labels to this layer, see Feature Text Labels (page 462). To add symbol
labels to this layer, see Feature Symbol Labels (page 463).

Enhanced Polygon Stylization
Add a polygon or multigeometry layer to your map using Add To Map Using
Enhanced Styles in the Data Connect dialog box. For more information, see
Enabling Enhanced Stylization (page 457).

To style polygons using enhanced stylization

1 In Display Manager, right-click a feature layer that contains polygons.

2 Click Edit Style.

3 In the Style Editor, under Scale Ranges, select the scale range to style.

4 In the Symbolization Style area for the selected scale range, click the box
under Style.

5 In the Style And Label Editor dialog box, click the Style tab.

If you are working with a multigeometry layer, for Geometry Type, click
Point, Line, or Polygon to specify the type of geometry you want to style
on this layer.

6 For Size Context, specify the type of units:

■ Select Device Space to specify symbol widths and heights in screen
units. Available units are Points, Inches, Millimeters, or Centimeters.

■ Select Map Space to specify symbol widths and heights in Mapping
Coordinate System (MCS) units. Available units are Inches, Feet, Yards,
Miles, Millimeters, Centimeters, Meters, and Kilometers.

7 For Units, select the type of units to use.
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8 Under Symbol And Style, click Add. Then click Border Symbol or Fill

Symbol to add a new style component. 

9 Select each style component in the Symbol And Style list and style as
desired.

Styles are drawn from the bottom of the list to the top so use Move Down

and Move Up to control the draw order. 

For polygon border styling, click Load to open a border line style from a
lin file.

For polygon fill styling, click Load to open a fill pattern from a pat file.

Use Width and Height to adjust the size of line or fill pattern elements.
Click Maintain Aspect Ratio to keep the pattern intact as you modify
either of these settings.

For any style setting, click Edit Expression to build styles using expressions
based on feature properties. For more information about expressions, see
Building If, Lookup, and Range Expressions (page 464).

10 When you are finished styling polygons, click OK.

To add text labels to this layer, see Feature Text Labels (page 462). To add symbol
labels to this layer, see Feature Symbol Labels (page 463).

To configure the polygon hatch pattern orientation

1 In Display Manager, right-click a feature layer that contains polygons.

2 Click Edit Style.

3 In the Style Editor, under Scale Ranges, select the scale range to style.

4 In the Symbolization Style area for the selected scale range, click the box
under Style.

5 In the Style And Label Editor dialog box, click the Style tab.

6 Under Symbol And Style, select the fill pattern preview.

7 Select each pattern component and style as desired.

8 Specify the hatch angle by doing one of the following:
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Select a predefined value from the list.

Click Edit Expression to specify the orientation using expressions based
on feature properties, such as ORIENTATION. For more information about
expressions, see Building If, Lookup, and Range Expressions (page 464).

9 When you are finished styling polygons, click OK.

10 Click Apply, to see the changes in the drawing.

BEST PRACTICE If the polygon feature class has no attribute that stores the
orientation, use Topobase Administrator to add an attribute, such as ORIENTATION.

To set the hatch pattern orientation relative to the longest side of a building.

Use enhanced stylization to specify the hatch angle.

1 In Topobase Administrator, add an orientation attribute to the building
polygon feature class. See Adding Attributes (page 213).

2 Define a feature rule that automatically updates the orientation attribute
to be relative to the longest side of the polygon.

3 For Hatch Angle, use an expression with the orientation attribute.

Feature Text Labels
Add a point, line, polygon, or multigeometry layer to your map using Add To
Map Using Enhanced Styles in the Data Connect dialog box. For more
information, see Enabling Enhanced Stylization (page 457).

To style feature text labels using enhanced stylization

1 In Display Manager, right-click a feature layer that contains the features
you want to label.

2 Click Edit Style.

3 In the Style Editor, under Scale Ranges, select the scale range to style.

4 In the Symbolization Style area for the selected scale range, click the box
under Feature Label.

5 In the Style And Label Editor dialog box, click the Feature Text Label tab.
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If you are working with a multigeometry layer, for Geometry Type, click
Point, Line, or Polygon to specify the type of geometry you want to label
on this layer.

6 For Size Context, specify the type of units:

■ Select Device Space to specify symbol widths and heights in screen
units. Available units are Points, Inches, Millimeters, or Centimeters.

■ Select Map Space to specify symbol widths and heights in Mapping
Coordinate System (MCS) units. Available units are Inches, Feet, Yards,
Miles, Millimeters, Centimeters, Meters, and Kilometers.

7 Under Symbol And Style, click Add to add a new style component. 

8 Select each style component in the Symbol And Style list and style as
desired.

Styles are drawn from the bottom of the list to the top so use Move Down

and Move Up to control the draw order. 

For line features, Vertical Alignment controls the placement of the text
relative to the line feature being labeled.

For any style setting, click Edit Expression to build styles using expressions
based on feature properties. For more information about expressions, see
Building If, Lookup, and Range Expressions (page 464).

9 When you are finished styling text labels, click OK.

Feature Symbol Labels
Add a point, line, polygon, or multigeometry layer to your map using Add To
Map Using Enhanced Styles in the Data Connect dialog box. For more
information, see Enabling Enhanced Stylization (page 457).

To style feature symbol labels using enhanced stylization

1 In Display Manager, right-click a feature layer that contains points.

2 Click Edit Style.

3 In the Style Editor, under Scale Ranges, select the scale range to style.

4 In the Symbolization Style area for the selected scale range, click the box
under Feature Label.
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5 In the Style And Label Editor dialog box, click the Feature Symbol Label
tab.

If you are working with a multigeometry layer, for Geometry Type, click
Point, Line, or Polygon to specify the type of geometry you want to label
on this layer.

6 For Size Context, specify the type of units:

■ Select Device Space to specify symbol widths and heights in screen
units. Available units are Points, Inches, Millimeters, or Centimeters.

■ Select Map Space to specify symbol widths and heights in Mapping
Coordinate System (MCS) units. Available units are Inches, Feet, Yards,
Miles, Millimeters, Centimeters, Meters, and Kilometers.

7 Under Symbol And Style, click Add to add a new style component. 

8 Select each style component in the Symbol And Style list and style as
desired.

Styles are drawn from the bottom of the list to the top so use Move Down

and Move Up to control the draw order. 

Click Load to open a symbol from a dwg file.

Use Width and Height to adjust the size of the symbol. Click Maintain
Aspect Ratio to keep the symbol intact as you modify either of these
settings.

For any style setting, click Edit Expression to build styles using expressions
based on feature properties. For more information about expressions, see
Building If, Lookup, and Range Expressions (page 464).

9 When you are finished styling symbol labels, click OK.

Building If, Lookup, and Range Expressions
Topobase supports expressions as values for almost all style settings. Use the
Expression Builder to style features using expressions based on feature
attributes. In addition to standard expressions, Topobase provides three
theming functions: If, Lookup, and Range. These functions define a theme
for one display attribute, for example, line color or thickness. They work with
multiple data types: string, real, integer, boolean, color, date-time.
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NOTE Each parameter can be a constant or expression that evaluates to a string
or numerical value.

If Expression
If('Condition', TrueValue, FalseValue)

The ‘Condition’ parameter is a string containing any expression that evaluates
to a Boolean value (essentially, a filter). Typically, this might be a single
comparison such as 'population > 1000', where ‘population’ is a feature
property of the layer. ‘TrueValue’ and ‘FalseValue’ are expressions that are
evaluated and returned when the condition is true or false, respectively. Both
expressions must evaluate to the same data type (string or number).

This example could be used to rotate an upward-facing arrow symbol to
indicate rising or falling populations:

If('pop2005 > pop2000', 0.0, 180.0)

Lookup Expression
Lookup(Expression, DefaultValue, Key1, Value1, … KeyN, ValueN)

This function implements a lookup table where each key is associated with a
single value. ‘Expression’ is an expression that evaluates to a key (string or
number). This key is compared to the remaining constant ‘Key#’ parameters
to select the constant ‘Value#’ parameter that is to be returned. If the requested
key is not found, ‘DefaultValue’ is returned. The ‘Expression’ and all ‘Key’
parameters must have the same data type, as must the ‘DefaultValue’ and all
‘Value#’ parameters. The number of key-value pairs is not fixed.

This example could be used to assign colors to parcels based on their zoning
type:

Lookup(zoning, 0xff888888, 'Industrial', 0xffff0000, 'Commercial',

0xff00ff00, 'Residential', 0xff0000ff)

Range Expression
The range function compares the ‘Expression’ key to a set of ranges, where a
key matches a range if MIN <= KEY < MAX:
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Range(Expression, DefaultValue, Min1, Max1, Value1, … MinN, MaxN,

ValueN)

Ranges are specified by the ‘Min#’ and ‘Max#’ parameters, and each has an
associated ‘Value#’ parameter. If the requested key does not match any of the
provided ranges, ‘DefaultValue’ is returned. If ranges overlap, the first range
that matches the key will be selected. The ‘Expression’ and all ‘Min’ and ̀ Max’
parameters must have the same data type, as must the ‘DefaultValue’ and all
‘Value#’ parameters. The number of range-value sets is not fixed.

This example could be used to specify symbol size depending on city
populations:

Range(population, 4.0, 100000, 1000000, 6.0, 1000000, 10000000, 8.0)

Creating Topobase Calculations
You use the FDO expression builder to define stylization that is based both
on feature class attributes and on attributes of related features, or on any values
that you calculate using attribute values.

Use the Expression Builder to create calculated properties that can be used for
dynamic stylization. Topobase provides two text functions.

■ TB_SQL—Use this text function to query attributes from a related feature
class. The attributes can be used for thematic rules.

■ TB_VARIABLE—Use this text function, if you want to define thematic rules
that use user defined variables.

To create a calculated text property

1 In the Display Manager, select the feature class.

2 Right-click, and click Create Calculations.

3 See Topobase Text Function TB_SQL (page 467) and Topobase Text
Function TB_VARIABLE (page 468).

To modify a calculated text property

1 In the Display Manager, select the feature class.

2 Right-click, and click Manage Calculations.
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3 In the Manage Layer Data dialog box, select the calculated property, and
click Edit.

4 Modify the calculation, and click OK.

Topobase Text Function TB_SQL
Use the text function TB_SQL to create a calculated text property that queries
attributes of a related feature class. Then, you use the calculated property for
stylization.

Defining the SQL command

The SQL command must correspond to the following rules.

■ The statement must return one column.

■ The statement must return a string. For numbers, use the function
TO_CHAR.

■ For the feature class, use the alias g.

IMPORTANT To test the SQL command, execute SELECT g.FID, (SQL command)

FROM <feature class name> g. For example, use SQL Sheet to execute the
command.

To create a calculated text property (TB_SQL)

The following example can be reproduced with the demo data set. You use
the TB_SQL text function to define a thematic rule for the stylization of the
Landuse feature class. Using the calculated property, you can define the area
stylization without using an Oracle view.

1 Start Topobase Client, and open the workspace.

2 Select the display model, and click Generate Graphic.

3 In the Display Manager, select the feature class, such as LANDUSE_TSUR.

4 Right-click, and click Create A Calculation.

5 In the Create A Calculation dialog box, enter a name, such as LU_Type.

6 Click Text Function, and click TB_SQL.
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7 Insert the SQL command in parentheses after the function. Make sure
you use apostrophes to get a text string.

’SELECT TO_CHAR(MAX(C.ID_TYPE)) FROM LANDUSE_TCEN m,LM_LANDUSE

c

WHERE C.FID=M.FID_CENTROID AND M.FID_TSUR=g.FID’

The calculated property provides the landuse type that is stored in the
centroid feature class LM_LANDUSE.

8 Click OK to create the calculated property.

9 In the Display Manager, select the feature class. Right-click, and click
Zoom To Extends.

10 Right-click, and click Edit Style.

11 In the Style Editor, add a Thematic Rule.

12 In the Create/Modify Expression dialog box, click Properties, and under
Text Properties select the calculated property, such as LU_Type.

13 Define the rule, such as LU_TYPE = ’27’. This rule styles the landuse
polygons that have the land use type LM_LANDUSE.ID_TYPE = 27 =
Building Area.

14 Style the layer.

Topobase Text Function TB_VARIABLE
Use the text function TB_VARIABLE to create a calculated text property that
provides a user defined variable for thematic stylization. The variables are
stored in the system table TB_VARIABLE. For each personal login, you can
define such variables.

For example, in TB_VARIABLE, you define a variable BUILDING whose value
represents the FID. In Display Manager you use the variable to style the
building. To highlight a single building in the map, you enter the FID of the
building in TB_VARIABLE. If you want to highlight another building, you
need not to modify the display model, but you can enter the new FID in
TB_VARIABLE.
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To create a calculated text property (TB_VARIABLE)

In the following example, you use the TB_VARIABLE text function to define
a thematic rule for the stylization of a building.

1 Start Topobase Client, and open the workspace.

2 Select the display model, and click Generate Graphic.

3 In the Display Manager, select the feature class, such as LM_BUILDING.

4 Right-click, and click Create A Calculation.

5 In the Create A Calculation dialog box, enter a name, such as
VARIABLE_BUILDING.

6 Click Text Function, and click TB_VARIABLE.

7 Insert the Key in parentheses after the function. Make sure you use
apostrophes to get a text string.

(’BUILDING’)

8 Click OK to create the calculated property.

9 In the Display Manager, select the feature class. Right-click, and click
Zoom To Extents.

The key values that are used in the calculated properties, and the user ID must
be specified in TB_VARIABLE.

To use variables with more than 1 value

To work with a TB_VARIABLE that contains 1 or more values, enter an
expression, such as the following:

Instr (

Concat(

Concat( ',' ,

TB_VARIABLE ('Highlight_List_Building' ) ),

',' ),

Concat( Concat( ',', ToString( FID) ), ',' )

)

To add the key values in TB_VARIABLE

1 In the Document explorer, under System Tables, right-click TB_VARIABLE,
and click Show Form.

2 On the form toolbar, click New Record.
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3 Enter the key values as shown in the following table.

DescriptionTB_VARIABLE attrib-
ute

Specifies the user. Enter the TB_USER.ID. In Topobase Client,
the variable will only apply, if this user is connected to the

USER_ID

database. For other users, the variable will not take any effect.

Specifies the key that is used in the calculated property, such
as BUILDING.

KEY

Specifies a value for the key. For example enter the FID of
the specific building you want to represent using a special
style.

VALUE

To style the feature layer

1 In the Display Manager, select the feature class. Right-click, and click Edit
Style.

2 In the Style Editor, add a Thematic Rule.

3 In the Create/Modify Expression dialog box, click Properties, and under
Text Properties select the calculated property, such as
VARIABLE_BUILDING.

4 Insert an expression, such as VARIABLE_BUILDING = TOSTRING(FID).

5 Click OK.

When you use a data connection without Topobase, no Topobase user is set.
However you can use the variables, if TB_VARIABLE.USER_ID = Null.

Styling Job-Enabled Features
When you work with Topobase jobs that are in open or pending job state,
you can highlight modified or newly created features, so they can be
distinguished from live features. Also, you can define a special style for the
deleted features.
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For job enabled documents, Topobase provides an option that enhances the
display model, so you can easily style the features that have been created,
modified, or deleted in a job.

To create a display model that tracks feature modification and deletion

The document must be job enabled.

1 Start Topobase Client, and open the workspace.

2 Click Home tab ➤ Display panel.

3 From the Display Model list, select Open Default Display Model.

4 In the Generate Graphic - Default Display Model dialog box, select Enable
Deleted Features To Be Displayed.

5 In the Display Manager, style the layers, and save the display model.

6 Click Home tab ➤ Display panel ➤ Generate Graphic.

The display model provides a Topobase text function TB_SQL for
TB_JOB_OPERATION _ID. You use this text function to define Thematic Rules
for the features that have been created, modified, or deleted in the current
job.

To style features that are modified or created in a job

1 In Display Manager, select the feature layer, such as Building
(LM_BUILDING).

2 Click Style.

3 In the Style Editor, under Polygon Style For Scale Range, click Add A Rule.

4 Click the box under Thematic Rules.

5 In the Create/Modify Expressions dialog box, click Property.

6 In the Property list, select JOB_OPERATION_ID and enter the following
condition:

■ For new features: JOB_OPERATION_ID = ’1’.

■ For modified features: JOB_OPERATION_ID = ’2’.

■ For deleted features: JOB_OPERATION_ID = ’3’.

7 Click OK.
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8 Click the box under Style. In the Style Point dialog box, specify the style.

For more information about the Topobase text function TB_SQL see the
Topobase Administrator Guide, section Creating Topobase Calculations (page
466).

Variant: Style features using Oracle views

Requirements: For each job-enabled feature class that you want to style, you
must create an Oracle view that includes the JOB_OPERATION_ID attribute.
Job-enabled feature classes have a JOB_VERSION attribute, which is related to
the TB_JOB_VERSION table.

■ Create an Oracle view, such as the building view LM_V_BUILDING in the
land management demo data set (CREATE VIEW LM_V_BUILDING AS select

a.FID, a.AREA, a.GEOM, a.IDENTIFICATOR, a.ID_QUALITY, a.ID_TYPE,

a.JOB_VERSION, b.JOB_OPERATION_ID FROM LM_BUILDING a,

TB_JOB_VERSION b WHERE a.JOB_VERSION = b.JOB_VERSION).

■ Register the view as feature class. See Creating a Feature Class From a View
(page 212).

To style features that are modified or created in a job

1 In Display Manager, select the feature layer of the view, such as
LM_V_BUILDING.

2 Click Style.

3 In the Style Editor, under Polygon Style For Scale Range, click Add A Rule.

4 Click the box under Thematic Rules.

5 In the Filter dialog box, under Property Or Expression, select Property.

6 In the Property list, select JOB_OPERATION_ID and enter the following
condition:

For new features: JOB_OPERATION_ID = 1.

For modified features: JOB_OPERATION_ID = 2.

For deleted features: JOB_OPERATION_ID = 3.

7 Click OK.

8 Click the box under Style. In the Style Polygon dialog box, specify the
style.
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NOTE You use the layer of the view for stylization, such as LM_V_BUILDING. Do
not use the feature class layer, such as LM_BUILDING.

Settings for Topobase Web

In Topobase Web, you cannot use the Display Deleted Features option.

To style job enabled features in Topobase Web

■ Edit the system table TB_SETTINGS. Add a row with the following values.
ITEMKEY = SHOW_DELETED_FEATURES_ENABLED

ITEMVALUE = 1

■ Create views over the feature classes that include the JOB_OPERATION_ID
from TB_JOB_VERSION joined by JOB_VERSION, and style the views using
the value JOB_OPERATION_ID. See Variant: Style features using Oracle
views (page 472)

See also:

■ System Tables TB_JOB_* (page 159)

■ Overview of Jobs (page 341)
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Plot Reference

Getting Plot Started
Before you start working with plots in a document, you must configure plots
using Topobase Administrator, and create plot templates, using Topobase Client.

■ Plot enable the document. See Configuring Plots (page 475).

■ Use Topobase Client to create plot templates. See Topobase Client User
Guide, Creating Plot Templates.

■ Use Display Models to style the plot features such as north arrow, legend,
scale bar. See also Plot Display Models (page 477).

■ In Topobase Client, create the plots, and print the plots. See Creating a Plot.

Configuring Plots
This section describes how to plot enable a document. To plot enable a
document, you add the Plot Extension.

To plot enable a document

1 Start Topobase Administrator.

2 Open the workspace, and select the document.

3 In the administrator explorer, select the document.

4 In the right pane, click Extensions.

5 Select Plot Extension.

8
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6 Click Save.

7 In the Update Modules And Data Models dialog box, click Update.

The system adds the plot feature classes and system tables to the document.
See also Plot Extension (page 479).

Plot Settings
When a document is plot enabled, you can specify plot settings in the
administrator explorer.

To specify Plot Settings

1 Open the workspace and select the document.

2 Click Document menu ➤ Plot.

3 On the right pane, specify the settings as shown in the following table.

4 Click Save.

In Topobase Client, the settings can be modified in the Create New Plot dialog
box, under Advanced.

DescriptionDefault Plot area

Specifies the default scale.Default Scale

Specifies the real world coordinates within the Topobase
document where the initial plot features will be created.

Insertion Point

When you create a plot, or a plot template, these coordinates
are used to display the page canvas. If these coordinates do
not lie within the document’s spatial extents, you cannot
create any plots. However, in Topobase Client, in the Create
New Plot dialog box, you can modify the insertion point.

IMPORTANT Enter coordinates that are valid for the spatial
settings of the document, such as the spatial reference system,
and the extents.

See also Create New Document Dialog Box (page 71)

NOTE The current insertion point of the map place holders
will be specified during capturing.
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For example, for the demo data set, enter (600000, 200000).

See also Topobase Client User Guide, Plotting an Island Map.Island Map Setting
area

Displays all polygon feature classes of the selected document.
Select one or more feature classes that can be used to specify
the island map perimeter.

Define The Feature
Class And The Buffers
Used For Island Maps

Specifies the default distance for an additional buffer. In To-
pobase Client, you use the buffers to expand the island out
from the selected feature.

First Buffer

In the display model, use the drawing order to specify which
features shall be displayed in the buffer.

Specifies the default distance for a second additional buffer
to the island.

Second Buffer

Plot Display Models
This section describes which feature layers have to be loaded and stylized to
display the plot components.

Sample Display Model

Autodesk provides a plot display model in the folder <default display model
repositoryt>\Extensions\Plot. We recommend that you enhance the sample
display model for your own purposes. See also To create a plot display model.
(page 443)

Style the following plot features. The features are shown in the order in which
they appear in the Display Manager draw order view. For example, the Plot
Label is drawn in front of the layers lower down.

DescriptionFeature class

PLT_PLOT_TBL. Label feature class that stores labels.Plot Label
Define thematic rules that use the LABEL_DEF_ID to style
different labels for different types of labels, such as plot name,
or plot scale.
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PLT_PLOT_DECORATION_TEXT. Point feature class that stores
the static text. Loads as annotation layer.

Decoration Text

PLT_PLOT_NA. Point feature class that stores the north arrow.
Style the point using a north arrow symbol.

North Arrow

PLT_PLOT_SCALEBAR. Point feature class.Scalebar

PLT_PLOT_LEGEND. Point feature class. Style the point using
a block that represents the legend.

Legend

PLT_PLOT_IMAGE. Point feature class.Image

PLT_PLOT_DECORATION_TBL. Label feature class.Plot Decoration Label

PLT_PLOT_DECORATION. Collection feature class.Decoration

PLT_PLOT_GRID_FRAME. Line feature class.Grid / Cross Hair Ex-
tension Lines Frame

PLT_PLOT_GRID_EXTLINE. Line feature class.Grid / Cross Hair Ex-
tension Line

PLT_PLOT_MAP. Polygon feature class that represents the
map placeholder.

Map Placeholder

PLT_PLOT_COVER. Collection feature class that represents
the canvas.

Plot Cover

PLT_PLOT_CROSSHAIR. Collection feature class.Crosshair

PLT_PLOT_GRID. Line feature class.Grid Line

Use the application options to specify a Repository Base Path. See also To set
Generate Graphic application optionsviewport:default sizeYou use the Generate
Graphic applica... (page 126).

See also:

■ Plot Extension (page 479)
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Plot Extension
This section describes the plot feature classes and system tables. These tables
are added to the document, when you add the Plot Extension. See also To add
the Plot Extension (page 70).

To view the plot feature classes

1 Start Topobase Administrator.

2 Open the workspace, and select the document.

3 Click Document menu ➤ Data Model.

4 In the data model explorer, expand the topic Plot.

The Plot Extension consists of two topics, as shown in the following table.
Plot table names have the prefix PLT_<table name>.

DescriptionFeature classes and
topics

Topic that groups all plot feature classes.Plot

PLT_PLOT. Point feature class that stores the plot origin, and
plot attributes, such as the name.

Plot

PLT_PLOT_COVER. Collection feature class.Plot Cover

PLT_PLOT_MAP. Polygon feature class. See also Plot Map
Placeholder (page 480).

Map Placeholder

PLT_PLOT_CROSSHAIR. Collection feature class.Crosshair

PLT_PLOT_GRID. Line feature class.Grid Line

PLT_PLOT_GRID_EXTLINE. Line feature class.Grid / Cross Hair Ex-
tension Line

PLT_PLOT_GRID_FRAME. Line feature class.Grid / Cross Hair Ex-
tension Lines Frame

PLT_PLOT_ISLAND_COVER. Polygon feature class.Island Plan Cover
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PLT_PLOT_SCALE. Attribute feature class. Stores the scales
that can be selected when creating a plot.

Predefined Plot Scale

PLT_PLOT_TBL. Label feature class. For dynamic text inform-
ation.

Plot Label

Sub topic that groups geometry feature classes and label
feature classes that store the plot components.

Plot Decoration

PLT_PLOT_DECORATION. Collection feature class.Decoration

PLT_PLOT_DECORATION_TEXT. Point feature class that stores
static text information. See also Plot Decoration Text (page
481).

Decoration Text

PLT_PLOT_IMAGE. Point feature class.Image

PLT_PLOT_LEGEND. Point feature class.Legend

PLT_PLOT_NA. Point feature class.North Arrow

PLT_PLOT_SCALEBAR. Point feature class.Scalebar

Plot Map Placeholder
The plot feature class PLT_PLOT_MAP stores the map placeholder properties
as shown in the following table. Some attributes are set automatically, when
you create the plot template, and add the map placeholder. To edit the
attributes manually, open the Map Placeholder feature class form.

DescriptionCaptionPLT_PLOT_MAP at-
tribute name

Specifies the type of grid that is added to the
map. Can be Crosshair, Grid, or No Grid Or

DisplayID_GRIDCROSS_TYPE

Crosshair. Relation to domain table
PLT_PLOT_GRIDCROSS_TBD.

Specifies the distance between the grid crosses.IntervalsGRIDCROSS_EAST-
ING_INTERVALL
GRIDCROSS_EAST-
ING_INTERVALL
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DescriptionCaptionPLT_PLOT_MAP at-
tribute name

Creates extension lines for the grid, or the cross
hairs.

Grid Exten-
sion Lines

GRID-
CROSS_SHOWEXTLINES

Specifies the label type. Can be No Labels; Align
Along The Grid Extension Line; Align Along The
Map Frame. References the label definition.

Extension
Lines La-
bels

ID_GRIDCROSS_LA-
BELTYPE

Specifies a tolerance that suppresses the creation
of grid extension lines. For example, if you create

Suppress
Labels Tol-
erance

GRIDCROSS_SUP-
PRESS_LABELS

a rotated plot, the labels for easting and northing
might overlap. The tolerance specifies a radius
around an existing label where no other label can
be created. Enter a distance.

■ NULL, 0, or a value < 0. Each grid extension
line label will be created. This may cause
overlapping labels.

■ Value > 0. This value specifies the paper space
value. If a grid extension line label is located
within this distance, another label would not
be created, to prevent overlapping text.

Specifies whether the frame for the grid extension
line is created inside or outside the map place-

Frame In-
side

GRID-
CROSS_FRAME_IN-
SIDE holder. Default is No, so the frame does not

overlap any GIS data.

Plot Decoration Text
The point feature class PLT_PLOT_DECORATION_TEXT stores static text
information that is used in plots and plot templates. While plot label text is
dynamic and is retrieved for each plot from the database (PLT_PLOT), plot
decoration text is static and the same for all plots.
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For stylization, PLT_PLOT_DECORATION_TEXT is loaded as an annotation
layer. For stylization and configuration use the decoration text properties as
shown in the following table.

DescriptionCaptionPLT_PLOT_DECOR-
ATION_TEXT attrib-
ute name

Specifies the content of the text.Decorative
Label Text

LABEL_TEXT

Specifies the text size, such as large, medium,
small. Use this attribute to style the annotation.

Text SizeID_TEXT_SIZE

Relation to domain table
PLT_PLOT_TEXT_SIZE_TBD.

Specifies the text style, such as normal, bold, ital-
ic. Use this attribute to style the annotation. Rela-

Text StyleID_TEXT_STYLE

tion to domain table
PLT_PLOT_TEXT_STYLE_TBD.

Specifies that the text cannot be edited when
you edit or create a plot.

Text
Locked By
Template

TEXT_LOCKED_BY_TEM-
PLATE

In Topobase Client, when you enter a decoration text, reference records can
be defined to enter consistent attributes for stylization. For example, use a
reference record Heading 1 to set ID_TEXT_SIZE = Large, and ID_TEXT_STYLE
= Bold. And use a reference record Heading 2 to set ID_TEXT_SIZE = Medium,
and ID_TEXT_STYLE = Normal. For information about reference records, see
the Topobase Client User Guide, section Using Reference Records.

Decoration text that has been defined in a plot template, and that is not
locked, can be edited directly in the Plot New dialog box. For each decoration
text, a field appears in the Additional Plot Information section. You can specify
the caption of the field as shown in the following table.

DescriptionCaptionPLT_PLOT_DECOR-
ATION_TEXT attrib-
ute name

Specifies the caption of the field to enter decora-
tion text.

Additional
Plot Inform-

FIELD_NAME

ation Field
Name
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Report Designer Reference

Report Designer Introduction
Using Topobase report designer, you can design your own reports and assign
them to any Topobase feature class form. The report definitions are stored in
the document (page 581) (TB_RPT_*tables).

The handling of the designer is similar to the Topobase form designer. See Form
Designer Introduction (page 357).

See also:

■ Report Designer Control Properties (page 498)

■ Creating a Report (page 492)

To start the report designer

You start the report designer in the Topobase Administrator.

1 Start Topobase Administrator and open a workspace.

2 Select the document (page 581).

3 On the Administrator toolbar, click the  Report Designer icon.

Layout Components
A Topobase report layout consists of different parts:

9
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Group—A group consists of three sections: head, body and foot.

Report Designer: Report layout showing a group with head, body, and foot sections
and a group with a child group

Child Group—You can insert a child group with detail head, body and foot
sections. Child groups are added between the body and foot section.

Zones—Optionally, each section can be divided into different zones. A default
section has only one zone. Note that there is a difference between zone and
section. You can define zones that can for example be suppressed under certain
conditions.

Pages—You can define different pages for a report, for example, to provide a
title page (report head) that should look different.

Controls—You can use a number of control elements to design the content
for each layout section.

You use the sections to design report layout as shown in the following table:

DescriptionSection

Page Group
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The content of this section is repeated on top of every page.Page Head

The content of this section is repeated at the bottom of every
page.

Page Foot

Detail Group

The content of this section is printed only once, above the data
in the preceding body section.

Detail Head

The content of this section is repeated for every record of the
SQL statement that is set in the Group properties.

Detail Body

The content of this section is printed after the records of the
body section.

Detail Foot

Report Designer Menu Bar
Some commands of the menu are only available after a report has been opened.

DescriptionReport menu

These commands are used to create a report defini-
tion.

New >

Creates a report, using page-by-page procedures.Wizard
See also Report Designer Wizard (page 492).

Starts the definition from the draft, using a a blank
template.

Blank Report

Opens an existing report (from the current docu-
ment (page 581)).

Open

Saves the definitions.Save

Deletes a report definition.Remove

To rename the report.Rename
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These commands are used to exchange report
definitions with XML files.

Import/Export >

For importing/exporting.Export XML Report Defini-
tion
Import XML Report Defini-
tion

Checks for invalid scripting code.Check All

NOTE This check can also be started in the 1-Click
Maintenance batch. See Database Maintenance (page
136).

You use these options to define paper size and orient-
ation for Web and Desktop reports. See also Report
Designer Options (page 491)

Options

Edit menu

Moves the layout components relative to each other.Move >

Moves the selected child group.Move Group

Moves the selected zone.Move Zone

Moves the selected page.Move Page

These commands are used to delete groups, zones,
and pages. Select the respective item and start the
command.

Remove >

Deletes the selected controls.Delete Controls F11

Copies the selected controls.Copy Controls

Pastes the controls (to the selected section).Paste Controls

These commands are used to add controls. See also
Report Designer: Adding Controls (page 487).

Add menu

These commands are used to generate reports in
different formats, such as Print or HTML. These com-

Print menu
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mands are also available on the Preview tab. See also
Report Designer Options (page 491)

Displays a preview. If errors in SQL statements, formu-
las, and functions occur, these are displayed in an
error list.

Preview F5

Prints the report on a printer.Print

Creates a report in PDF.PDF

Creates a report in HTML.HTML

Exports data into an ASCII text file. See also Report
Designer ASCII Export (page 518).

ASCII

Report Designer: Adding Controls
You can customize the report layout, using a number of controls to add
elements, such as static text, line, and pictures.

To add a control to a report definition

1 Start Report Designer and open a workspace.

2 Click Add menu and select a control, as shown in the following table:

DescriptionAdd menu >

Adds a database attribute. See also Report Designer:
DB Column Control (page 505).

DB Column

Adds a text control. Use this control to add static text,
such as headings, annotations, and comments. See also
Report Designer: Text Control (page 502)

Text

Adds a picture to the report.Picture

TIP To embed a WMS URL, add a picture control and
enter the URL as file name.
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Adds a line. You can modify the line parameters either
in the right pane by dragging the line or in the left pane
by editing the properties.

Line

See also Report Designer: Line Control (page 506).

Adds a chart.Chart
See also Report Designer: Chart Control (page 507).

These commands are used to process functions. You
use functions to display the results of calculations in the
report.

Function >

See also Report Designer: Functions (page 512).

Opens the function manager to define and edit func-
tions.

Manage

Adds an existing function <name> to the current sec-
tion. You should only add functions to body sections
that contain records (SQL statements).

<name>

These commands are used to process SQL values.SQL >
See also Report Designer: SQL Values (page 514).

Opens the SQL manager to define and edit SQL state-
ments.

Manage

Adds an existing SQL value <name> to the current sec-
tion.

<name>

These commands are used to insert special controls to
be used in the layout sections.

Special >

Displays the total number of pages to print {Report.Page-
Count}.

Page Count

Displays the page number (starts with one) {Re-
port.PageIndex}.

Page Index

Displays the current page number and the total number
of pages.

Page X Of Y

Displays the page number of the following page {Re-
port.ContinuePage}.

Continue Page
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Example: Continues on page {Report.ContinuePage}.
The complete text is suppressed on the last page.

Displays the total number of records in the current body
group {Report.RecordCount}.

Record Count

Displays the index of the current record {Report.Re-
cordIndex}.

Record Index

NOTE Do not use this as a stand-alone. It is listed here
to show you that this function is available. Use it in
functions to identify the first record and, for example,
to apply a differing style or to suppress data. The value
returns -1 (true) or 0 (false)

Not First Record

This function {Report.RecordNotFirst} is normally used
together with the Suppress property.
For example, in the Suppress property of a text control,
enter {Report.RecordNotFirst}. Then, the control is only
shown for the first Record and suppressed for all follow-
ing records.

Displays the date {Report.PrintDate}.Print Date

Displays the time {Report.PrintTime}.Print Time

Displays the sum of values listed in the previous body
section, for example, displays the length of all listed

Sum

pipes. You can use this control only in foot sections,
either in detail or page foots.
The Sum function is inserted as a text control with the
content {Report.Sum(ColumnName)}. Replace Colum-
nName with the name of the attribute for which you
want to calculate the sum, for example, LENGTH.

Displays the average of the listed values. The Average
function is inserted as a text control along with the

Average

content {Report.Avg(ColumnName)}. Replace Column-
Name with the name of the attribute you want to cal-
culate the average of.
See also Report Designer: Page Controls (page 500).

These commands are used to add unit placeholders.Unit >
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See also Report Designer: Unit Placeholder (page 515)

These commands are used to add functionality using
the Topobase API.

Plugin Function>

Opens the Plug-Ins manager to add and remove Plug-
Ins.

Manage

Adds an existing Plug-In <name>.<name>

These commands are used to process parameters.
See also Report Designer: Parameter (page 516).

Parameter >

Opens the parameter manager.Manage

Adds an existing parameter <name>.<name>

Adds a form control in a body section that contains an
SQL query. All the DB controls of the queried table are

Form Control

displayed. You can select one or more controls. Note
the difference between DB Column and Form Control:
A DB attribute displays the value that is stored in the
database. A form control displays the database value
as it has been defined in the form designer.
See also Report Designer: DB Column Control (page
505)
Example: A database attribute is displayed with a check
box control. It can have only the values 0 and 1. In the
form, the display of 1 is mapped to the string “closed”
and 0 to “Open”. If you use the DB column control,
the report shows only the values 1 or 0. If you use the
form control, the strings are shown.

Inserts a group with head, body and foot section. You
can add a child group to the master group or to any

Child Group

child group (between body and foot section). You can
define nested groups (child group with child groups)
to print master-detail information.
See also To create a master-detail reportreport defini-
tion:creating a master-detail reportIn this tutorial yo...
(page 497).
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Inserts a zone into a section. Select the section to which
you want to add a zone. For example, use zones to

Zone

define conditions to suppress. See also Report Designer:
Suppress a Zone (page 522).

Inserts a page. In the right pane, each page is shown
on a separate tab. You can add multiple pages with

Page

different layout and content to your report. For ex-
ample, you can create a report head or title page.

Report Designer Options
You can define paper size and orientation for Web and desktop reports.

To set report options

1 Start Report Designer and open a workspace.

2 Click Report menu > Options. Set options, as shown in the following
table:

DescriptionReport Designer Options

Selects a printer format. The values for Paper Width and
Height are set automatically but can be modified. It is

Format

recommended that you use the A4 Portrait format in
the Internet Explorer IE (Web version). Adjust the paper
height to 2800 and in Internet Explorer click File

menu ➤ Page Setup. In the Page Setup dialog box,
delete all entries in the header and footer section. If
necessary, set the paper height smaller.

Sets a module name to be used by the application API.
Default: Empty.

Module Name

Specifies a title for the Web preview window.HTML Window Title

Draws a frame. For each page, you can specify the size
of a frame to be drawn. For example, with this option
you can design a report head (title page).

Page X
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Report Designer Wizard
You can use the Report Designer wizard to create a report with a basic layout.

In the Report Designer window, click Report menu ➤ New ➤ Wizard. Enter
a name. In the New Report dialog box, you can specify the layout of the report,
as shown in the following table:

DescriptionNew Report Dialog Box

Selects the feature class or view that contains the data
to be printed.

Table/Form

Specifies the name of the report.Title

Specifies the Page Break property, This property can
also be modified on the designer tab. Select Forms to

Style

print every record on a new page (Page Break Before =
true). Select Table/List to print the records continuously
(Page Break Before = False).
See also Report Designer: Page Controls (page 500).

Selects the paper format.Format
See also Report Designer Menu Bar (page 485), Options
menu.

Selects the feature class attributes that you want to add
to the report.

Attributes

Click OK to create the report definition. The definition contains the page head
with title and print date, the page body with captions for the selected attributes,
and a child group with detail body.

You can use the menu commands to modify these report definitions.

See also:

■ Report Designer Menu Bar (page 485)

Creating a Report
You use Topobase report designer to create reports for Topobase Web and
Client.
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To create a report

1 Start Topobase Administrator and open a workspace.

2 In the Administrator explorer, select the document.

3 Click Document menu ➤ Report Designer.

4 Click Report menu ➤ New ➤ Blank Report.

5 Enter a report name, such as Label Definition Overview. In the right pane
the Page Head section is highlighted.

6 Click Add menu ➤ Text and enter Label Definition Overview. The text
control is added in the right pane.

Topobase Report Designer: Creating a new report.
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7 Click the new text. The properties are displayed in the left pane on the
Design tab.

8 On the Design tab, in the Control category, change Font Size to 20.

9 In the right pane, use the mouse to move and resize the text box and
change the height of the page head section.

10 Click the Detail Body 1 section.

11 In the left pane, in the Group: Detail category, select the SQL property

and click  .

12 In the SQL Assistant, enter the following SQL statement:

select * from TB_LABEL_DEF where {Parameter.Filter}

Use the tables list, and the Advanced Controls to enter the SQL statement.
For example, instead of typing the table name, select the table, and double
click. Instead of typing the parameter expression, select the parameter in
the list, and double click.

13 In the SQL Assistant, click  Execute to validate the SQL statement.

14 Click OK to exit the SQL Assistant.

15 Click Add menu ➤ DB Column.

16 In the Add DB Column dialog box, Ctrl-click NAME and
SELECT_STATEMENT. Click OK. Two controls are added to the Detail
Body 1 section.

17 You can now position the controls with the mouse.

The application replaces the value {Parameter.Filter} at runtime with the
current filter of the relevant form. Only the data of the current filtered
records is printed.

18 Click the Page Body section.

19 Click Add menu ➤ Text.

20 Add two text controls: “Name” and “Label Select Statement”.

21 Click the Page Foot section.

22 Click Add menu ➤ Special ➤ Page X Of Y to add a page counter.
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23 Click Add menu ➤ Line to add a line to separate the foot from the body.

24 Click Report menu ➤ Save.

Next, you will assign the new report to the feature class form
TB_LABEL_DEF.

25 In the left pane, click the Preview tab to display the report. You can print
or export the report to HTML or ASCII.

26 Click Report menu ➤ Quit to save the report.

27 In Topobase Client, in the document explorer, expand the System Tables
node and open the form TB_LABEL_DEF.

28 On the form toolbar, click the Print icon.

29 Right-click the Report dialog box. Click Add ➤ Topobase Report.

The Title is displayed when a user selects a report. The Report Name is
the name of your newly created report.

30 Click OK to save the report.

To view the report, select it in the list and click OK.

To create a report head

You design reports with different layouts for each page, such as a report with
a heading.

1 Define a report as described in Creating a Report (page 493).

2 Click Report > Open to open the report designer.

3 Click Add > Page.

In the right pane, for each page, a separate layout tab is displayed.

4 Click the new empty page. Click Edit menu ➤ Move ➤ Move Page Up.
Now, the new page is the first page.

5 Design the title page. For example, add a title (text control) and a logo
(picture control) to the page head section.

6 Click Report menu ➤ Options, to draw a frame round the title page.

7 In the Options dialog box, click the Page 1 tab. Select Draw Frame and
click OK.

8 Save the report and click the Preview tab, to view the new report.
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To create a report that contains a chart

In this tutorial you will insert a chart to a report, displaying the land use
distribution.

1 Start the report designer.

2 Click Report menu ➤ New ➤ Wizard.

3 Enter the report name, such as Land Use Distribution, and click OK.

4 In the New Report dialog box, under Table/Form, select the land use
feature class LM_LANDUSE.

5 Under Title, enter Land Use. Click OK.

6 In the report designer, enlarge the Page Body section by dragging the
section.

7 On the toolbar, click  .

8 In the Chart Wizard dialog box, under Chart Type, select Bar.

9 On the navigation pane, click the Title tab, and under Text, enter Land
Use. Select a font, and a color.

10 On the navigation pane, click the Chart tab, and select Show Legend.

11 Click the Axes tab, and for the Axis Y, select Automatic.

12 Click OK to finish the Chart Wizard.

13 In the Page Body section, select the chart control, and modify size and
position.

14 In the left pane, in the Control property grid, select the SQL property.

Click  to open the SQL Assistant.

15 In the expression input box, enter the following select statement.

select b.value, count (a.id_type)

from LM_LANDUSE a,

LM_LANDUSE_TYPE_TBD b

where a.id_type=b.id

group by a.id_type, b.value

16 Click Execute menu ➤ Execute to check the select statement.
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17 Click OK.

18 In the report designer, on the left, click the Preview tab.

19 Click the Design tab, and in the Control property grid, select Config, and

click  .

20 In the Chart Wizard dialog box, click the Axis tab.

21 Under Axis Y, clear Automatic, and adjust the scaling of the Y axis. For
example, enter the following values. Minimum: 10, Maximum: 1300,
Minor Step: 50, Major Step: 100.

22 Click OK.

23 Click the Preview tab.

24 Click Report menu ➤ Save.

The select statement returns a value for each land use type
(LM_LANDUSE_TYPE_TBD.VALUE), and counts the number of features
(LM_LANDUSE) for each type.

See also:

■ Report Designer: Chart Control (page 507)

To create a master-detail report

In this tutorial you will define reports that print master-detail information.
These reports print information in a report, using related information that is
stored in another feature class.

1 Open the report, using the report designer.

2 In the right pane, click the Detail Body 1 section.

3 Click Add menu ➤ Child Group. The child group with Head 1.1, Body
1.1, and Foot 1.1 is inserted between the Detail Body 1 and Detail Foot
1 sections.

4 In the right pane, select the Detail Body 1.1 section.
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5 In the left pane, in the Group:Detail property grid, select the SQL property

to define the SQL statement. Click  and enter the following
statement:

select * from ...

where ... = {Id}

At runtime, the application replaces the value {Id} with the value of the
column ID from the record in the parent group.

6 Click Add menu ➤ DB column. Select the columns you want to print.
You can select several items (multi selection) by pressing and holding
<SHIFT> or <CTRL>.

7 Click the Detail Head 1.1 section.

8 Click Add menu ➤ Text. Add the text controls for the caption.

9 Click Report menu ➤ Save.

10 Click the Preview tab. Each master display model followed by the detail
definitions and colors is displayed in the report.

For more information about master-detail forms refer to TB_RELATIONS:
Master-Detail Relations (page 175).

Report Designer Control Properties
You can define the report layout and content with a number of control
elements that can be applied to the different sections.

To work on the different sections, select a section in the right pane of the
Report Designer window. The selected section is highlighted. In the left pane
the control properties are displayed in the property grid (Design tab).
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Report Designer: Specifying text control properties in the property grid

The property grid on the left is categorized: The upper category shows the
properties of the group that the selected control belongs to. Following are the
section and zone properties, followed by the control properties.

DescriptionProperty Category

Properties for the whole page.Group

Properties for the particular head, body, or foot section or
a zone.

Zone

Properties of the current control, for example, text or pic-
ture control properties.

Control

Report Designer Toolbar

DescriptionIcon

Creates a new report.

Opens an existing report definition. You are prompted whether to save
the current report definition.
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Saves the current report definition.

Displays a preview.

Prints the report.

Adds a text control. Use this to add static text comments to any section.
See also Report Designer: Text Control (page 502).

Adds a database attribute in a body section that contains an SQL query.
See also Report Designer: DB Column Control (page 505)

Adds a line.
See also Report Designer: Line Control (page 506).

Adds a picture to the report.
See also Report Designer: Picture Control (page 505).

Adds a chart to the report.
See also Report Designer: Chart Control (page 507).

More commands are available on the menu bar.

See also Report Designer Menu Bar (page 485).

Report Designer: Page Controls
Note that the positioning properties, such as height, left, or top, can be
modified by dragging the element in the right pane.

DescriptionPage Control Prop-
erty

Properties for the whole group (page, detail section).Group:

Defines Plug-Ins or functions that are executed before or
after the query. For example, you can write data to a tem-

After Query
Before Query

porary file and then print this file. Alternatively, you can
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change to another job state to print a parcel list with the
state before and after the modifications.

Prints the content together on the same page, as far as this
is possible. If no space is left on the current page, the
“glued” group is printed on the next page.

Glue

Select True to print all group sections (head, body, foot, and
their children) on the same page. The default is False.

Prints one group on the left and another group on the right
side of the report. This works like a layer where the second

Parallel

group is printed over the first one. Set to True to print a
group parallel to another group.

Prints the head section of a group on every new page.Repeat Head On New
Page

Sets the page count to 1.Reset Page Count

Shows or hides the foot or head section. Hide unused sec-
tions to make the designer view more clear.

Show Foot
Show Head

Defines an SQL statement to retrieve the data to be printed
in the particular section. Click the property row, and then

click  to open the SQL Assistant.

SQL

See also Using the SQL Assistant (page 139) and Report De-
signer: SQL Statements (page 510).

Selects the source of the data to be printed.SQL Source
Database—Default is Database.
Memory, Plug-In—Select either of these, if the application
developer fills data into the memory in a DataTable object
and you want to use this as data instead of reading the data
from a database table or database view. This is useful if you
need to do some preprocessing and you cannot directly use
a database table for the output. Memory can only be used
together with the API.

Suppresses the head and foot section if the body section is
empty because there are no records available.

Suppress If No Re-
cords
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Specifies properties for the head, body and foot sectionSection

Prints the section together on the same page as far as this
is possible. If no space is left on the current page, the
“glued” section is printed on the next page.

Glue

Select True to print the section (head, body, foot or their
children) on the same page. The default is False.

Specifies the height of the section.Height

Specifies the properties of the section zone.Zone:

Controls the height of the zone. Select True to calculate the
height of the zone based on the controls that are inside.

Autosize

Note that this takes effect only at runtime, but not during
the design.

Specifies the eight of the zone. Optionally, use the AutoSize
property.

Height

Starts the section on a new page. The default is False.Page Break Before

Suppresses the zone under certain conditions. The condition
can be a function or a select that produces either true or
false (0 or 1).

Suppress

If the condition is True, the zone is suppressed.

Specifies the properties of the particular controls. See alsoControl
Report Designer: Text Control (page 502)
Report Designer: Picture Control (page 505).
Report Designer: Line Control (page 506).

Report Designer: Text Control
You can use text controls to add static text, such as headings, annotations,
comments, and to define the text, and the styles of the text, as shown in the
following table:

NOTE Basically all control types, except picture and line control are text controls,
some of which contain functions instead of plain text. For example, a DB Column
control used to display the NAME attribute is a text control with the text “{NAME}”.
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Note that the positioning properties, such as height, left, or top, can be
modified by dragging the element in the right pane.

DescriptionText Control Prop-
erty

Defines static text to be displayed. The text can also be
modified in an input field in the upper section of the window

or by clicking  in the content row in the right pane.

Content

Prints text with variable height. If the text you want to display
is a multi-line text with an unknown number of rows, you

Dynamic Multiline

need this option to dynamically enhance the section. Without
the Dynamic Multiline option, the text would probably be
printed into the following section.

Defines a fill color for the text box.Fill Color

Specifies the font attributes.Font

Defines the text color. You can either select a color clicking

 or enter either an SQL statement or a function to
specify the color.
See also Report Designer: Change Colors at Runtime (page
524).

Fore Color

Specifies a format, for example 0.000, for numbers. You can
use any VB .NET format. See also Text Control: Format (page
504).

Format

Locks the control on the grid. A locked control cannot be
moved with the mouse. With this option, you can prevent

Locked

moving a control unintentionally. Note that you can move
a locked control with the Left and Top property by specifying
the offset values.

Aligns the text in the text box. Select either left, center, right
(horizontal) and top, center, bottom (vertical).

Horizontal Align,
Vertical Align

Positions the text box relative to the section borders.Left, Top
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Controls the drawing priority of text and pictures. For ex-
ample, this would prevent a picture covering a text control.

Priority

Controls with a low priority value are drawn first. Example:
A picture with priority 10 covers a text with priority 1.

TIP Save and reopen the report to see the result in the pre-
view.

Suppresses the control under certain conditions, such as a
function or a select statement that produces either True or
False (0 or 1).

Suppress

If the condition is True, the text is suppressed.
Example: To print the word “Warning” if the status of a tree
is “damaged”.
Write a function, for example, Fun.Tree that queries the at-
tribute and returns True if the tree is healthy.
Enter the Suppress property in braces. For example, {fun.tree}.

Suppresses the value if it has the same content as the previ-
ous one. This property works only in body sections.

Suppress Duplicates

Defines the width of the text box. You can align the text
content horizontally and vertically, in relation to this box.

Width

Specifies formatted attributes for an ASCII export. You can
define the width of the text box as number of characters.
Additionally, you can align the text to the left or right.

Width ASCII

See also Report Designer ASCII Export (page 518).

Text Control: Format
You can use any VB .NET format, either in a predefined format or with your
own definitions. This means that there is a flexible format specification for
different types of data (strings, numbers, date).

TIP Syntax validation is not available, but you can switch to the Preview tab to
check that the data is displayed correctly in the report.

Example: Formats for a DB Column control (number (2) attribute)

Result displayedFormatValue
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($2)($#,##0)2

($2.00)($#,##0.00)2

2.000.002

200.00%0.00%2

Report Designer: DB Column Control
Use this control to add a database attribute. You can select any of the attributes
that are retrieved by the body section SQL statement.

NOTE This control is identical to the text control. The difference is that you can
select the DB attribute from a list. However, if you know the attribute name, you
can enter it as text control content as well. Make sure the attribute name is in {}
braces. You can also mix parameters, such as {Column} with static text, functions,
and parameters.

You can also use a form control, which is similar to the DB Column control.
Click Add menu ➤  Form Control. See also Report Designer: Adding Controls
(page 487).

For control properties, see Report Designer: Text Control (page 502)

See also:

■ Report Designer: SQL Statements (page 510)

Report Designer: Picture Control
Note that the positioning properties, such as height, left, or top, can be
modified by dragging the element in the right pane.

DescriptionPicture Control
Property

Specifies the height of the picture.Height

Scales the picture uniformly (in X and Y). This effect is visible
only in the preview.

Keep Size
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Positions the picture relative to the section borders.Left, Top

Locks the control on the grid. A locked control cannot be
moved with the mouse. With this option, you can prevent

Locked

moving a control unintentionally. Note that you can move
a locked control with the Left and Top property by specifying
the offset values.

Selects the picture to be displayed. The default path is <topo-
base>\pics.

Picture File

NOTE Although the picture files can be stored in any folder,
it is recommended that you store them in <topobase>\Pics
or a subfolder. Then, they are available with the dynamic
path <topobase>\Pics. If you use picture files with a static
path, they are not available on a different computer unless
the path is exactly the same.

For variants and Web version, see Form Designer: Picture
Linker - Properties (page 396)

Controls the drawing priority of text and pictures. For ex-
ample, this would prevent a picture covering a text control.

Priority

Controls with a low priority value are drawn first. Example:
A picture with priority 10 covers a text with priority 1.

TIP Save and reopen the report to see the result in the pre-
view.

Suppresses the control under certain conditions, such as a
function or a select statement that produces either True or
False (0 or 1).

Suppress

See also Report Designer: Text Control (page 502).

Specifies the width of the picture. Can also be specified with
the mouse.

Width

Report Designer: Line Control
Note that the positioning properties, such as height, left, or top, can be
modified by dragging the element in the right pane.

DescriptionLine Control Property
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Specifies the length of a vertical line.Height

Positions the line relative to the section borders.Left, Top

Specifies the line weight.Line Size

Locks the control on the grid. A locked control cannot
be moved with the mouse. With this option, you can

Locked

prevent moving a control unintentionally. Note that you
can move a locked control with the Left and Top property
by specifying the offset values.

Controls the drawing priority of text and pictures. For
example, this would prevent a picture covering a text

Priority

control. Controls with a low priority value are drawn first.
Example: A picture with priority 10 covers a text with
priority 1.

Suppresses the control under certain conditions, such as
a function or a select statement that produces either True
or False (0 or 1).

Suppress

See also Report Designer: Text Control (page 502).

Draws a vertical line. Select True to draw the line.Vertical

Draws a line to the bottom of the page. Select 1 to draw
the line. The default is 0 (Off).

VerticalAuto Height

Enter a value to be added to the line height. For example,
enter "-100" to draw the line almost to the bottom of
the page (where Pageheight -100).

Specifies the length of a horizontal line.Width

Report Designer: Chart Control
Note that the positioning properties, such as height, left, or top, can be
modified by dragging the element in the right pane.

DescriptionChart Control Property

Report Designer: Chart Control | 507



Opens the chart wizard to define the chart layout. Click

the property, and click  . See also Using the Chart
Wizard (page 508).

Config

Specifies the height and the width of the chart.Height, Width

Positions the chart relative to the section borders.Left, Top

Locks the control on the grid. A locked control cannot
be moved with the mouse.

Locked

Controls the drawing priority.Priority

Adds a script. For example, to modify the chart at

runtime. Click the property, and click  .

Script

Edits the SQL expression that queries the data to be
visualized in the chart.

SQL

Click the property, and click  to open the SQL
Assistant. See also Using the Chart Wizard (page 508) and
Creating SQL Expressions (page 137).

Suppresses the control under certain conditions, such as
a function or a select statement that produces either True
or False (0 or 1).

Suppress

See also Report Designer: Text Control (page 502).

Using the Chart Wizard
You use the chart wizard to design the chart. A chart can be of type Bar, Line,
Point, or Pie. Use the tabs on the left side to specify the layout. On the right
side, a preview of the chart is displayed.

To open the chart wizard

1 Start the Report designer, and open the report definition.
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2 Do one of the following:

■ Click  Add Chart To The Report to insert a new chart.

■ On the Design tab, select an existing chart control. On the left pane,

in the property grid, select Config, and click  .

3 In the Chart Wizard dialog box, specify the chart layout.

4 Click OK.

5 In the Report Designer, on the Design tab, define the SQL select statement
to query the data to be visualized.

6 Select the chart control. In the Control property grid, select Sql, and click

 .

7 In the SQL Assistant dialog box, define the SQL select statement that
returns the data to be visualized in the chart.

8 Click the Preview tab, to generate a preview of the report.

Select Statements for Charts

When you add a chart control, a sample SQL select statement is provided.
Depending on the chart type, the query for the chart representation, must
return an appropriate number of values.

Return values for the different chart types

■ Line chart—Series (legend text), X, Y

■ Point chart—Series (legend text), X, Y

■ Bar chart—Legend, value

■ Pie chart—Legend, value
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The sample SQL select statement shown below visualizes how many feature
classes of each type are stored in the system table TB_DICTIONARY. Use a
chart of type Bar.

select F_CLASS_TYPE,

count(F_CLASS_TYPE) from TB_DICTIONARY group by F_CLASS_TYPE

For example, in a Line chart, each line corresponds to a series, and the select
statement could return the following <series>,<X>,<Y>.

1,15,20

1,16,30

1,17,31

...

2,15,20

2,16,30

2,18,19

...

3,15,20

3,16,30

3,17,31

...

In the chart, 3 lines would be drawn.

See also:

■ To create a report that contains a chartreport definition:adding a
chartchartIn this tutorial you wi... (page 496)

Report Designer: SQL Statements
To retrieve the data to be printed in the report, you can define SQL statements
in the body sections. You can use record values in body sections and SQL
statements.

NOTE Record values are written in braces { }.

DescriptionRecord Value

Displays an attribute name. The value is replaced
at runtime by the record value of the respective

{ColumnName}

SQL statement that is defined for the group. You
can also use record values with text.
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Example: The display model {Name} has the FID
{Fid}.

Filters records. The filter is replaced at runtime
with the current filter of the respective form, so

{Parameter.Filter}

that only the data of the current filtered records
is printed.

Finds the record value of a parent group.{Parent.ColumnName}

Finds the record value of the parent of a parent.{Parent.Parent.ColumnName}

Calculates the sum of the attribute values. You
can use this function only in the body and foot
section. Note the differences between the sections:

{Report.Sum(ColumnName)}

In the Body section, calculates the current sum.
In the Foot section, calculates the total sum.

TIP To calculate the sum in a head section you
can use SQL values. Example: select
sum(money) from table where par-

ent={key}.

Calculates the average. You can use this function
only in the body and foot section.

{Report.Avg(ColumnName)}

Executes functions.{fun.xxx}
See also Report Designer: Functions (page 512).

Runs a complex SQL statement.{sql.xxx}
See also Report Designer: SQL Values (page 514).

See also Report Designer: Parameter (page 516).{Parameter.xxx}

NOTE If a record value that is used in an SQL statement returns a NULL value,
this is translated to 0 or ‘’.

See also:

■ Report Designer: DB Column Control (page 505)
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Report Designer: Functions
You can use functions in body sections to calculate any values to be printed
in your report. Functions must be written in VB .Net. These functions provide
all possibilities that are available in VB .NET, for example, IF – THEN
statements. In addition, the functions provide all Topobase API functions.

To define a function, click Add menu ➤ Function ➤  Manage. In the Function
manager dialog box, you can define and edit the functions.

DescriptionFunction Manager

Adds a function.Add
Click the button and enter a function name, for example,
MyTest.

Deletes a function.Remove

Checks the syntax of the function.Syntax Check

Enters the function code. If you add a function, a sample
code is displayed:

Function

<name> = Me.Record.LngValue("Fid") * 10.

This code reads the value of the attribute FID and multi-
plies it with 10.
Me.record is of type Topobase.Data.Tools.RecordReader
and can be used in the same way.

Reads a numeric value from VB data type LongRecord.LngValue("Fid")
Reads a numeric value from VB data type DoubleRecord.DblValue("Scale")
Reads a text value from VB data type StringRecord.StrValue("Name")

To add a function to the report, click Add menu ➤ Function ➤ <name>.

NOTE You can also add a text control and enter the text {fun.name}, for example,
{fun.MyTest}.

See also:

■ Report Designer: Text Control (page 502)

■ Form Designer: Formula TextBox - Properties (page 393)

■ Report Designer: Suppress a Zone (page 522)
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Report Designer: Functions - Example
In the example you create a function to print rounded values. The functions
uses parameters. With the parameters you can apply the function for different
database columns. The function prints

■ “--” if the attribute value is empty.

■ “Infinite” if the value is 999999.

■ the rounded value, for all other values.

To create a function

1 Start the Report designer, and open a report.

2 Click Add menu ➤ Function ➤ Manage.

3 In the Functions dialog box, click Add.

4 In the New Function dialog box, enter a name, such as MyRound. Click
OK.

5 Under Function, enter the code.

dim columnName AS String

dim scale as integer

columnName = Me.FunctionParameters.Item(0) ' First parameter

scale = Me.FunctionParameters.Item(1)' Second parameter

if Me.Record.IsDBNull(columnName) then

MyRound = "--" 'Attribute value is empty

else

dim value as double

value = Me.Record.DblValue(columnName)

if value = 999999 then

MyRound = "Infinite"

else

MyRound = System.Math.Round(value, scale)

end if

end if

6 Click Syntax Check.

7 Click Close.
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8 In the report, add the function Control and enter the parameters, for
example:

■ {Fun.MyRound("column_name1",2)

9 {Fun.MyRound("column_name2",7)}

Report Designer: SQL Values
You can run complex SQL statements that are related to the current records,
and retrieve a single value. This is similar to the SQL label controls in the Form
Designer.

For example, you can define an SQL value to display the value of a domain
table (_TBD) instead of the value that is stored in the related table.

To define an SQL value, click Add menu ➤ SQL ➤ Manage. In the SQL Manager
dialog box, you can define and edit the functions.

DescriptionSQL Manager

Adds an SQL statement.Add
Click the button and enter a name, for example: MySQL.

Deletes a statement.Remove

Starts the SQL Assistant to build the statement.Assistant

Shows the SQL statement. You can edit the statement dir-
ectly in this dialog box or click Assistant.

SQL

Example:
select value from SYMBOL_TBD where

id={id_symbol}

The value {id_symbol} is replaced at runtime by the value
of the current record.

To add an SQL value to the report, click Add menu  ➤ SQL ➤ <name>.

NOTE You can also add a text control and enter the text {SQL.name}, for example,
{SQL.MySQL}.

In the report, the value in braces {} is replaced at runtime by the result of the
SQL statement.
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TIP If you have a Check Box value (Yes/No value), you can define an SQL as follows:
select decode({Active},0,'No',1,'Yes') from dual.

See also:

■ Creating SQL Expressions (page 137)

■ Using the SQL Assistant in the Form Designer (page 148)

Report Designer: Unit Placeholder
You can use unit placeholders to display unit names, such as foot, inch,
centimeters, for length values.

All available units and their translations are stored in the Topobase system.
If you use a placeholder instead of a static text to display the unit name, the
name will always appear in the appropriate language. This is useful if a report
is used in different countries, using different languages.

There are different placeholders:

■ Default unit—Displays the document default unit as specified in the unit
settings during the creation of the document.

■ Unit item—Displays an individually selected unit.

■ Unit from attribute—Displays the unit as specified in the attribute’s unit
type during the creation of the feature class attribute in the data model
administrator.

■ Unit from SQL field—Displays the unit that is stored with a feature in a
special feature attribute.

DescriptionUnit placeholder

Adds a default unit to your report. Click Add

menu ➤ Unit ➤ <name>.

For default units:
{Unit.Area}
{Unit.Length} This adds a text control containing the appropriate

placeholder.{Unit.<name>}

Adds a unit item to your report,. Click Add menu ➤ 

Unit ➤  Units. Select a unit from the list.

For unit items:
{Unit.Item("Centimeter")}
{Unit.Item("Foot")} This adds a text control containing the placeholder.
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{Unit.Item("<name>")}

Adds an attribute unit to your report. Click Add

menu ➤ Text and enter the placeholder manually in

For attribute units:
{Unit.Attribute("Feature-
ClassName","Attribute-
Name")}

the content property. Note that the expression must
be enclosed in braces.

{Unit.Attribute("Feature-
ClassName","Attribute-
Name", "DefaultUnitType")}

Adds an SQL field unit to your report. Click Add

menu ➤ Text and enter the placeholder manually in

For SQL field units:
{Unit.Field("ColumnName")}

the content property. Note that the expression must
be enclosed in braces. ColumnName is the attribute
of the current feature class that stores the unit ID. It
has to be part of the query result of the particular
section.

See also:

■ Report Designer Menu Bar (page 485)

■ Report Designer: Text Control (page 502)

■ Create New Document Dialog Box (page 71)

Report Designer: Parameter
Use parameters to set values using the API at runtime. The expression
{Parameter.Filter} is used as default. It is replaced by the current filter of the
form. The value is used if the report is shown in the report designer.

To edit the default {Parameter.Filter}

1 Start the report designer and open a report.

2 Click Add menu ➤ Parameter ➤ Manage.

3 In the Parameter dialog box, select FILTER and edit the value. The default
is “(1=1)”.

516 | Chapter 9   Report Designer Reference



The following are examples of parameters:

ReplacementExpressionFilter

"and h. fid=10""and h. {Parameter.Fil-
ter}"

fid=10

"and h. fid=10 or fid=13”"and h. {Parameter.Fil-
ter}"

fid=10 or fid=13

“and h.fid in (select fid from
WA_HYDRANT where fid=10 or
fid=13”

“and h.fid in (select fid
from WA_HYDRANT
where {Parameter.Fil-
ter})”

fid=10 or fid=13

To create a new parameter

1 Start the report designer and open a report.

2 Click Add menu ➤ Parameter ➤ Manage.

3 In the Parameters dialog box, click Add.

4 In the New Parameter dialog box, enter a name and click OK.

5 In the Parameters dialog box, enter a value.

You can also specify a default filter value for a stand-alone start of a Topobase
report. An application developer can set the filter by using the API if the report
is called without a Topobase feature class form.

Report Designer Import Report Definition
You can import Topobase XML report definitions. XML report definitions can
be created with the report designer using the export command.

Use XML report definitions to share report definitions with other users.

To import a report definition

1 Start Topobase Administrator and open the workspace.

2 In the Administrator explorer, select the document to which you want
to import the report definition.

3 Click Document menu ➤ Report Designer.
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4 Click Report menu ➤ Import/Export ➤ Import XML Report Definition.

5 Select the XML file and click OK.

6 Click Report menu ➤ Open and select the report. You can customize the
report definition if necessary.

Report Designer ASCII Export
You can use Topobase reports to create ASCII text files. With this you can use
it as an export interface that can be customized.

To export data in an ASCII file

1 Create a report that contains the database attributes you want to export.

2 Make sure that the Width ASCII property matches the desired character
count of your output file. You can also set Width ASCII to 0 (not NULL).
In this case the width is set to <number of characters + 1 space>.

3 In the Preview tab, click the ASCII button to start the export.

Report Designer: Advanced Topics

Report Designer: Polygon and Line Definition Report
Using Topobase Client and Web, you can print detailed polygon or line
definition reports, such as a parcel report that lists the area, the distance
between the parcel border points, the parcel borders, the points, and parcel
number. These detailed reports require a special configuration. If you have
installed the Land demo data set, you can reproduce the following steps.

To configure a polygon/line definition report

1 Start Topobase Client and open the workspace.

2 In the document explorer, right-click the system table
TB_SURFACE_CONFIG and click Show Form.

3 Add a new record with the following attributes:

ID: feature class ID of the line string or polygon feature class, as for
example 29 (LM_PARCEL_L).
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NAME: The name of the configuration will be displayed in the Report
For Lines/Polygons dialog box.

4 In the document explorer, right-click the system table
TB_SURFACE_POINT and click Show Form.

5 For each point feature class you want to include in the report, add a new
record with the following attributes:

SURFACE_CONFIG_ID: TB_SURFACE_CONFIG.ID of the record you
created before.

POINT_F_CLASS_ID: feature class ID of the point feature class, as for
example 37 (LM_POINT).

PRIORITY: You can include several point feature classes. Only the points
of the feature class with the highest priority will be used. If a vertex has
no such point, the point feature class with the next priority will be used.

Make sure to use point feature classes that store points that are located
on the specified polygon or line features.

NOTE When you select a feature class in the Topobase Client document explorer,
you can see the ID of that feature class in the status bar of the Topobase task pane.
See also To set document explorer optionsforms:double click opens the -You use
the Topobase document explorer... (page 125).

To create the report definition

1 Start Topobase Administrator and open the workspace.

2 Start the report designer and create a new report definition for the table
TB_SURFACE_DEF.

3 In the report definition, set the module name. Click Report
menu ➤ Options. In the Other Options section, enter the Module Name:
SURFACE_DEFINITION.

To print a polygon/line report

1 Start Topobase Client and open the workspace.

2 See Topobase Client User Guide, section Generating Reports.
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Report Designer: Spatial Selection Report
In Topobase applications you can perform spatial selections for reports to
print. For example, you can select all features that lie within a job perimeter
or within a specified area. For this type of reports a special definition is
required.

To create the report definition

1 Start Topobase Administrator and open the workspace.

2 In the Administrator explorer, select the document for which you want
to define the report, such as TB2010_GA_102.

3 Click Document menu ➤ Report Designer.

4 Click Report menu ➤ New.

5 Create the report definition.

6 To set the module name, click Report menu ➤ Options.

7 In the Other Options section, enter the Module Name:
Topobase.SpatialExportTool.

In the report definition you must use the parameter PERIMETERID.

To add the parameter PERIMETERID to the report definition

1 In the Report Designer, click Add menu ➤ Parameter ➤ Manage.

2 In the Parameters dialog box, click Add.

3 In the New Parameter dialog box, enter the parameter name
PERIMETERID.

4 Under Value, enter 1.

5 Click OK. Click Close.

PERIMETERID contains the ID of the perimeter definition in TB_PERIMETER.
It is always set. TB_PERIMETER stores the perimeter that you digitize when
you use the Spatial Export tool in Topobase Client. For example, in the Spatial
Export dialog box, when you select No Spatial Selection, TB_PERIMETER.ID
= 0.
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Your report definition must contain a query for the PERIMETERID, as shown
in the following sample.

WHERE

{parameter.PERIMETERID}=0

OR SDO_RELATE(T.geom, (SELECT geom FROM TB_PERIMETER

WHERE id={parameter.PERIMETERID}),

'mask=anyinteract query=window')='TRUE'

To define the report definition

1 Click the Detail Body 1 section.

2 On the Design tab, in the Group Detail category, click the SQL property.

3 Define a query that selects the features which are located in the perimeter.

4 Click Add ➤ DB Column, and select the attributes you want to display.

5 If needed, add more controls, and save the report.

Example: Query to select features within a perimeter.

select P.FID from GA_PIPE P, GA_LINE T

WHERE P.FID = T.FID_ATTR AND

({parameter.PERIMETERID}=0

or SDO_RELATE(T.geom, (SELECT geom FROM TB_PERIMETER

WHERE id={parameter.PERIMETERID}),

'mask=anyinteract query=window')='TRUE')

GROUP BY P.FID ORDER BY P.FID

The parameter SPATIALMASK is only set if it is in the report definition. Sample
SQL statement:

WHERE

{parameter.PERIMETERID}=0

OR SDO_RELATE(T.geom, (SELECT geom FROM TB_PERIMETER

WHERE id={parameter.PERIMETERID}),

'mask={parameter.SPATIALMASK} query=window')='TRUE'

For more information about using the spatial selection reports, see the
Topobase Client User Guide, section Using Spatial Export.
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Report Designer: Coordinate Report
Topobase provides templates to print coordinate report. You use the Coordinate
Export tool to print coordinate reports. See Topobase Client User Guide -
Printing Reports.

When you create your own coordinate reports, you must use the parameter
filter FilterCoordinateFID.

See also:

■ Report Designer: Parameter (page 516)

Report Designer: Suppress a Zone
You can suppress a zone of a report, if that zone does not display any content.
For example, if the attribute value to be printed is empty.

To suppress a zone with no content to print

1 Create a zone containing the attribute, for example COMMENT.

■ Select the section, and click Add menu ➤ Zone.

■ Add the attribute to be printed, such as COMMENT.

2 Define the condition for the zone to be suppressed. For example, suppress
the zone if the attribute COMMENT is empty.

■ Click Add menu ➤ Function ➤ Manage.

■ Add a new function IsEmpty.

■ dim columnName as string

columnName = Me.FunctionParameters.Item(0)

return Me.Record.IsDBNull(columnName)

3 Select the zone. Under Suppress, enter the condition
{Fun.IsEmpty("COMMENT ")}.

See also:

■ Report Designer: Functions (page 512)

522 | Chapter 9   Report Designer Reference



Report Designer: Create a Crystal Report
In Topobase Client, you can use reports that have been generated using Crystal
Reports™.

When you generate a report, follow the using

Guidelines for creating a report

■ At least, select the table TB_CRYSTAL_REPORTS, and the feature class.

■ Both TB_CRYSTAL_REPORTS, and the feature class must have a column
FID.

■ In the Crystal Reports designer, link the FID columns.

To add the report to a feature class form

1 Copy the Crystal Reports (*.rpt) file to your reports rook directory.

You specify the report root directory in the Application Options. See To
set common application optionsYou use the common application options
to specify layout, directori... (page 121).

2 Start Topobase Client, and log in as Admin user.

3 Open the feature class form.

4 On the form toolbar click the Print icon.

5 In the Report dialog box right-click anywhere and click Add ➤ Crystal
Reports.

6 Enter a title, and select the Crystal Reports (*.rpt) file. Click OK.

Report Designer: Call a Report via API
Create a reference to the assembly “Topobase.Forms.Report.dll”:

Dim report As Topobase.Forms.Report.Report

report = Me.Document.ReportEngine.Reports.Item(ReportName)

report.SetParameter("Filter", "Fid=17)")

report.SetParameter("Title", "Annual Report 2005")

report.PreView() ‘ Show the Report

You can also save the report as HTML via the API.

report.SaveHtml("c:\test.html")
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NOTE Take care to always define the parameters in the report before setting a
value to a parameter.

Report Designer: Change Colors at Runtime
The following example shows how to change colors at runtime.

To change colors at runtime

1 Enter a function name in the ForeColor property of the text control
instead of the color name (or HTML color) itself. For example,
{Fun.TreeColor}

2 Create a function that calculates the color you want to set for each single
record.

3 In the report designer window, click Add menu ➤ Function ➤  Manage.

4 Click Add to add a new function. Enter the name, for example, TreeColor.

5 In the Function pane, define:

if Me.Record.LngValue("status") = 1 then

TreeColor = "red"

else

TreeColor = "black"

end if

6 In the designer window, select the text box and set the ForeColor property
as follows: {fun.TreeColor}.

See also:

■ Report Designer: Functions (page 512)

Report Designer: Reading Data from the Memory
Example:

Dim table As New DataTable

‘Define a Table in Memory
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table.Columns.Add("FID", System.Type.GetType("System.Int64"))

table.Columns.Add("NAME", System.Type.GetType("System.String"))

Dim i As Integer

‘Fill the Table with Data

For i = 1 To 20

Dim newRow As DataRow

newRow = table.NewRow

newRow.Item("FID") = i

newRow.Item("NAME") = "a" & i & "bbb" table.Rows.Add(newRow)

Next

Report.SetDataSource("MyMemoryTest", table)

In the report definition, you then can treat this table like a database table and
apply a SQL statement:

select * from MyMemoryTest where Fid={Fid}

Set the SQLSource property to Memory.
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Feature Search Reference

Feature Search Introduction
Using the Topobase Feature Search, you can quickly find the location of a certain
object, such as a building, parcel, or any other type of feature that has geometry.
The detected geometry becomes the center of a graphic generation or a zoom
GoTo.

Topobase Feature Search finder is based on search definitions that can arbitrarily
be defined. The definitions are stored in the document (page 581) in the system
table TB_POSITION_FINDER. That means that you can define special search
definitions for each document.

Both Topobase Client and Web use Feature Search to generate graphic using
geographical selection.

Topobase Client - Advanced Generate Graphic dialog box: In the Feature Search group
box, you can specify a map center by selecting a certain object. The searches can be
defined with the Feature Search Administrator. This search is of the search type
sequential with input type combo box.

10
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There are three types of Feature Search definitions:

■ Sequential Search—By performing a sequential search, you improve the
search from one level to another. Finally, you get the feature you want.
The sub-searches can be defined with selection lists or text boxes. For
example, you first select a city, then the street, and finally a building.

■ Flat Search—The flat search is well known from other address or phone
number searches. You can fill in what you know about the location to
find. Feature Search searches the data source for all matching results. You
must select the result for the center of the graphic generation process.

■ PlugIn search—This can be used if the geometries do not exist in the
database. The coordinates for the bounding box come from the memory.
It is possible to code PlugIns, which return coordinates from given
parameters.

In the Web version, you can highlight the result with a symbol. See also To
set up the Web layout (page 117).

See also:

■ Feature Search Administrator (page 528)

■ Defining a Sequential Search (page 533)

■ Defining a Flat Search (page 536)

■ Feature Search: PlugIn Search (page 538)

■ System Table TB_POSITION_FINDER (page 170)

Feature Search Administrator
Use the Feature Search Administrator to define and edit search definitions.

To start the Feature Search Administrator

1 Start Topobase Administrator.

2 In the Administrator explorer, select the document (page 581).

3 Click Document menu ➤ Feature Search.
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To view or edit a Feature Search definition

1 In the Definition list, select the definition you want to edit.

2 Click Rename to rename the search name.

3 Click Delete to delete the search definition.

4 Click Create to define a search definition.

See also:

■ Feature Search: Sequential Search (page 529)

■ Feature Search: Flat Search (page 536)

■ Feature Search: PlugIn Search (page 538)

Feature Search: Sequential Search
When you use sequential search, you use several steps to find the center
feature. Each step improves the results with different SQL statements.

■ Each step has a select statement and a title for the query. The geometry
query is optional.

■ The select statement returns some result rows.

■ The first attribute contains the key (mandatory); the second attribute
contains a text (optional).

■ The values of these rows will usually be elements in the next searches.
They can be used in the following select statements with the help of
placeholders.

■ Every select statement (apart from the first) can access the values of the
rows returned by the previous search, which is also true for the geometry
queries. When a result row of a select statement has a geometry attribute,
it is possible to create a geometry query for this search. This geometry
query will always look as follows:

Select geom from <table> where fid = {x}

In this query, you only select the geometry attribute. The WHERE clause is
composed of the primary key attribute and the current ID of the previous
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returned row. The placeholder {X} is replaced by the ID of the selected result
row (X=0 for the first select statement).

See also:

■ Defining a Search to Find a Building (page 539)

■ Defining a Search to Find an Object (page 541)

Sequential Search: Input Types
In sequential searches, the input type specifies how the user communicates
the next sub searches. The main difference is in the execution of the search,
as in the following input types:

■ Selection List (default)—You can select further search items from a combo
box. In this case, the select statement has already been executed.

■ Text Box—You have to enter the search text. Then, the query is executed.
The search text is part of the WHERE clause in the SQL statement.

■ Text Box With Auto Complete— You do not have to enter the complete
search text. The search starts as soon as you start to enter the text. The
search text is part of the WHERE clause in the SQL statement.

IMPORTANT For Text Box and Text Box With Auto Complete, the SQL statement
must contain a LIKE statement. Also, you must use the placeholder {0}.

Text Box example—To find table names, define the following SQL statement:

select f_class_name from tb_dictionary where upper(f_class_name)

like upper('{0}')

Using this definition in Topobase Client, for example, you enter "lm_b*". At
runtime, the placeholder {0} is replaced by the character the user has entered.
The * is replaced with a "%" and all tables starting with LM_B* are displayed.

Text Box With Auto Complete example— To find table names, use the same
SQL statement:

select f_class_name from tb_dictionary where upper(f_class_name)

like upper('{0}')

For example, using this definition in Topobase Client, you start to enter any
character. At runtime, the placeholder {0} is replaced by the character the user
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has entered plus a prefix %. The result is all tables that start with A, as shown
in the following SQL statement:

select f_class_name from TB_dictionary where UPPER (f_class_name)

like UPPER ('A%')

Selection List example— To find street names, use the following SQL statement:

select distinct LABEL_TEXT from LM_STREET_TBL where GEOM is not

NULL order by LABEL_TEXT

Text Box example— To find street names with a text box, use the following
SQL statement that includes a LIKE statement and uses the placeholder {0}.

select distinct LABEL_TEXT from LM_STREET_TBL where LABEL_TEXT

like ('{0}') and GEOM is not NULL order by LABEL_TEXT

The following diagram shows the workflow with different input types.

Feature Search: Sequential search workflow with different input types.
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Sequential Search: Placeholders
When you define a sequential search, you can use placeholders to access the
values that were returned in the previously executed SQL statements. This is
very helpful if you need the ID of the selected row in the next select statement.

For example, to select the buildings in a certain street, you need the ID of this
street in the buildings query.

Placeholders are written in {} braces: {X}, where X is the number of the select
statement that the result was returned from (index).

NOTE The index always begins with 0 (zero). This means that the results of the
first query must be accessed with {0}.

Example:

Statement 1:

Select id, name from City order by name;

Result rows for 1:

ID NAME

1 Athens

2 Berne

3 Berlin

Statement 2:

Select id, name from Street where id_city = {0} order by name

In this example, the query for statement 2 depends on the previously selected
result, because it contains a placeholder ‘{0}’. When you select the city Berlin,
the following query is executed:

Select id, name from Street where id_city = 3 order by name

NOTE The index has to be smaller than the number of search queries.
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Defining a Sequential Search
Use the Topobase Feature Search Administrator to administer sequential search
definitions.

To define sequential search

1 Start the Feature Search Administrator

2 Click Create to define a new search.

3 Enter a name, such as Streets.

4 For Type, select Sequential Search.

5 Click OK.

6 In the Feature Search Administrator, click the Statement 1 tab and specify
the first query, for example, select (demo data set):

Title: Street Name.

Input Type: Selection List.

Select Statement: select distinct LABEL_TEXT from LM_STREET_TBL

where GEOM is not NULL order by LABEL_TEXT

Geometry Select Statement: select GEOM from LM_STREET_TBL where

LABEL_TEXT like '{0}'

7 If necessary, click each of the Statement 2 to Statement 4 tabs and specify
further queries.

For each statement, enter a title, input type, and select statement. Optionally,
enter a geometry statement, using options, as shown in the following table:

DescriptionInput

Specifies the name of the definition, which appears in the To-
pobase Client selection list.

Definition

Specifies the input type that configures how the user will inter-
act for the next searches. See also Sequential Search: Input
Types (page 530)

Type

Validates or executes the select statement. See also Sequential
Search: Executing and Validating (page 534)

Validate
Execute
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Opens the SQL Assistant. See also Creating SQL Expressions
(page 137)

Assistant

The second attribute of the select statement is shown in the Feature Search
selection list. If there is no second attribute, you are prompted for the first.
The first attribute usually is used for the primary key.

It is recommended that you do not select more than two attributes.

NOTE You can define a Not Found message in the TB_POSITION_FINDER system
table.

See also:

■ System Table TB_POSITION_FINDER (page 170)

Sequential Search: Executing and Validating
When defining the search statements in the Feature Search Administrator,
you can test them either by executing the search or by validating the
statements.

To execute a sequential search

1 Click the Statement_x tab.

2 Click Execute.

To validate a sequential search definition

1 Click the Statement_x tab.

2 Click Validate.

See also:

■ Select Statement Validation (page 107)

Sequential Search: Example
The following Feature Search definition example is also provided with the
demo data set. It demonstrates a sequential search that is used to find a feature
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by selecting a feature class, then selecting an attribute, and then selecting a
value for the attribute.

ValueInput

Statement 1 tab

Feature over Attribute. This definition is a sequential search.Name

Feature ClassTitle

select f_class_name, caption from TB_Dictionary

where f_class_type <> 'T' order by f_class_name

Select Statement

Selection listInput Type

Statement 2 tab

select COLUMN_NAME from cols where TABLE_NAME

= '{0}' and COLUMN_NAME not in (select

Select statement

COLUMN_NAME from user_sdo_geom_metadata where

TABLE_NAME = '{0}' or TABLE_NAME = '{0}_HOST')

AttributeTitle

Selection listInput Type

Statement 3 tab

ValueTitle

select distinct {1} from {0}Select Statement 3

Selection listInput Type

Statement 4 tab

FeatureTitle

select fid from {0} where {1}='{2}' order by

fid

Select Statement 4
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SELECT GEOM FROM {0} WHERE FID={3}Geometry Select
Statement

Selection listInput Type

Feature Search: Flat Search
Using a flat search, you can find a location, using only one step. You need to
fill text boxes 1 - 5 with all the information you know about the target location.
Feature Search will then dynamically compose a select statement and execute
it against a flat data table containing the locations.

The generated search statement is as follows.

select <pk_column>, <input_colums>

from <table_name>

where upper(<input_column>) like upper(<param>)

order by <order_column>

This statement is composed by Feature Search when you start the flat search.
If the query returns more than one row, the results are presented in a separate
dialog box, and you can select an item to be the center of the next graphic
generation.

If the query returns only one row, the Selection dialog box is not shown.

After you have selected a result (or when only one row has been returned),
Feature Search finds the geometry of the selected result. The geometry select
statement is as follows:

select <geom_column> from <table_name> where <pk_column> = key

This statement is composed and executed by the Feature Search. The geometry
(coordinates) are saved in the View port.

See also:

■ System Table TB_POSITION_FINDER (page 170)

Defining a Flat Search
Use the Topobase Feature Search Administrator to administer flat search
definitions.
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To define a flat search

1 Start the Feature Search Administrator

2 Click Create to define a new search.

3 Enter a name, such as Streets - flat.

4 For Type, select Flat Search.

5 In the Settings tab, you can specify the search query, using options as
shown in the following table:

DescriptionInput

Defines a data source. You must define a view or select a table
containing all data. This data source must contain a Key Attrib-

Basic

ute (primary key), a Geometry Attribute, and at least one input
attribute Attribute 1.
Optionally, you can specify a sort attribute to order the result
rows. The data in this table or view is normally in the first normal
form (1NF).

Specifies the search attribute. The description appears on the
Topobase Client GUI when you execute the search.

Search Attributes

Adds a WHERE clause to the automatically composed select
statement.

Additional Where
Clause

Validates the select statement. See also Select Statement Valid-
ation (page 107)

Validate

NOTE Because the data source that has not been normalized is very slow, you
need to optimize the data with indices and compute the statistics.

Flat Search: Example
The following input is used in a flat search to find a parcel marking by either
point number, marker, surveyor, reliability or dossier.

ValueInput

Parcel MarkingsName
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LM_BORDERPOINT (This table stores all filter attributes. If they
are stored in different tables, you can create a view containing
the attributes.)

Table Name

Point NumberAttribute 1 Descrip-
tion

BORDER_POINT_NUMBERAttribute 1

MarkerAttribute 2 Descrip-
tion

ID_BORDER_POINT_TYPEAttribute 2

DossierAttribute 3Descrip-
tion

DOSSIERAttribute 3

FIDKey Attribute

GEOMGeometry Attribute

BORDER_POINT_NUMBERSort Attribute

Feature Search: PlugIn Search
Use the Topobase Feature Search Administrator to administer PlugIn search
definitions.

To define a PlugIn search

1 Start the Feature Search Administrator.

2 Click Create to define a new search.

3 Enter a name, such as Tiles.

4 For Type, select PlugIn Search.
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5 On the Settings tab, specify the assembly name, class name, namespace,
and parameters, as shown in the following table:

DescriptionPlug-In Search
Settings

Name of the DLL. The DLL must be available in the <topo-
base>\bin folder.

Assembly Name

Example: Topobase.Customers.Autodesk.OSTile.dll

Example: Topobase.Customers.Autodesk.OSTileNamespace

Example: OSTileClassname

To define the prompts in the Advanced Generate Graphic dialog
box.

Parameter Descrip-
tion

Example: Tile Name.

For more information refer to the Topobase Developer’s Guide.

Feature Search Tutorial

Defining a Search to Find a Building
Using Feature Search you can define search statements that find the center
coordinates of an arbitrary object. In the following example, you can find a
building that has a certain address.

To find a building, if you know the address

1 Start Topobase Client and open the workspace with the document you
want to search.

2 Click Setup menu > Administrator.

3 In the administrator explorer, select the document and click Feature
Search Administrator.

4 Click Create.

5 Enter a name, such as Sample Sequential Search.
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6 For Type, select Sequential Search.

7 Click OK.

8 Define the search with the following settings:

On the Statement 1 tabAttribute

CityTitle

Selection listInput Type

Select id, name from City order by nameSelect Statement

Leave this empty.Geometry Select Statement

Result rows of the first select statement are ID and Name. For example:

■ 1, Newcastle

■ 2, Bern

■ 3, Sidney

If you select ID 1, Newcastle in the combo box, then:

On the Statement 2 tabAttribute

StreetTitle

Selection listInput Type

Select id, name from Street where

id_city = {0} order by name

Select Statement

Select geom from Street where id = {1}Geometry Select Statement

The geometry query will find the position of the street, even if you do not
select a building.

If you have selected Newcastle, that means {0} = 1.

Result rows of the second select statement are ID and Name. For example:

■ 1, Nile Street
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■ 2, Bathwick Street

■ 3, Bennet Street

If you select ID 3, Bennet Street in the combo box, then:

On the Statement 3 tabAttribute

BuildingTitle

Selection listInput Type

Select id, number from Buildings where

id_street = {1} order by number

Select Statement

Select geom from Buildings where id =

{2}

Geometry Select Statement

The geometry query uses the result {2} of the select statement.

Result rows are ID and Number. For example:

■ 1, 15

■ 2, 17

■ 3, 17A

Defining a Search to Find an Object
Using Feature Search you can define search statements that find the center
coordinates of an arbitrary object.

To find an object when you know the feature class and the FID

1 Start the Feature Search Administrator.

2 Click Create and select Sequential.

3 Enter a name, such as Sample Search 2.

4 On the Statement X tabs, enter the following values.

On the Statement 1 tabAttribute
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Feature ClassTitle

Selection listInput Type

select f_class_name, caption from

TB_Dictionary where f_class_type <>

Select Statement

'T' order by f_class_name; (feature

class type ‘T’ = attribute)

Leave empty.Geometry Select Statement

Result rows are F_Class_Name and Caption. For example:

■ SW_BUILDING Building

■ SW_MANHOLE Manhole

■ SW_SEWER Sewer

On the Statement 2 tabAttribute

FeatureTitle

Text boxInput Type

select fid from {0} where fid = {1}

order by fid

Select Statement

Select geom from {0} where fid = {1}Geometry Select Statement

Note that this select statement works with input type Text Box. The select
statement uses the value (FID) that you have entered: {1}.

Result rows: FID … 100 … 101 … 102

Defining a Flat Search (Example)

To find a parcel in the Swiss survey data model

1 Create a view to compose the data (locations) in a flat table, as follows:

SELECT
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d.fid, trim(a.value) district, b.nom commune, c.numero, d.geom

FROM

district_tbd a, commune b, immeuble c, bf_tsur d, bf_tcen e,

bien_fonds f

WHERE

a.id = b.no_district AND

substr(c.identdn,4,3) =

decode(length(b.numcom),1,'00'||b.numcom,2,'0'||b.numcom,b.num

com) AND

f.fid_bien_fonds_de = c.fid AND

e.fid_centroid = f.fid AND

e.fid_tsur = d.fid

ORDER BY

a.value, b.nom, length(c.numero), c.numero

This view can be very complex. Be careful about performance. The order
of the input attributes does not matter, but you should have at least one
input attribute.

2 In the Administrator explorer, select the document and click Feature
Search Administrator.

3 Click Create.

4 Enter a name.

5 For Type, select Flat Search.

6 In the Settings tab, enter the following values: (You need to define the
different attributes, so Feature Search knows which attributes contain
which data.)

ValueInput

V_ImmeubleTable Name

DistrictAttribute Description 1

DISTRCITAttribute 1

CommuneAttribute Description 2
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COMMUNEAttribute 2

NumberAttribute Description 3

NUMEROAttribute 3

FIDKey Attribute

GEOMGeometry Attribute

7 Using the previous definitions, when you start the search, the program
will execute the following select statement: (The example is filled with
some sample input data).

SELECT FID,DISTRICT,COMMUNE,NUMERO

FROM V_IMMEUBLE

WHERE UPPER(DISTRICT) LIKE UPPER('Lau%') AND

UPPER(NUMERO) LIKE UPPER('1002')

8 Executed geometry statement for the result row:

SELECT GEOM FROM V_IMMEUBLE WHERE FID=20407749

544 | Chapter 10   Feature Search Reference



Profiles

Overview of Profiles
You use Autodesk Topobase profiles to generate three dimensional views of
utility features, for example, in the Wastewater, Water or Gas application.

A profile data model consists of five primary system tables and the corresponding
profile feature classes. Profiles are stored in the document (page 581).

Profile feature classes store the profile drawing.

Profiles provide a detailed view of the network. You can query network
information by selecting a feature in the profile or in the drawing.
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Work with profiles

■ Profile data structure—In Topobase Administrator, you use the data model
administrator to add the Profile Extension to your document. The Profile
data structure is a system of tables that define the underlying structure of
the profile. See To add the Profile extension profiles:add to data modelYou
use the data model administrator to add t... (page 548)

■ Profile designer—Use the Profile designer to set up your profile definitions.
Based on the profile data structure you can create any profile definitions
for different profiles. See Profile Designer (page 546).

■ Profile templates—Use the Profile designer to save a profile definition as
template, and to reuse the template for modifications. See also Working
With Profile Templates (page 556).

■ Creating and drawing profiles—In Topobase Client you can use the Profile
Manager to create and draw profiles using the profile definitions.

NOTE The Wastewater, and Gas demo data sets provide a sample profile definition.

Profiles can be created for linear objects, such as pipes, by projecting features
onto an axis. The axis can be selected in the drawing or it can be defined
through network tracing.

Profiles are stored in a local spatial reference system, with 0,0 as the base
coordinates. These coordinates can be placed anywhere in the global coordinate
system.

In order to create a profile, profile features will be calculated and stored in the
document. All features and feature classes can be edited and styled using the
Display Manager.

See also:

■ Profile Data Model (page 557)

Profile Designer
Use the Profile designer to set up your profile definitions for use in the
Topobase Client Profile Manager. Based on the profile data model you create
your profile definitions for different profiles. The Profile designer guides you
through the process, and it provides schematic overviews as reference guide
for profile elements.
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IMPORTANT Do not edit the profile feature classes, or the profile system tables
manually. You use the Profile designer.

When you create a profile definition from scratch, the profile explorer helps
you to review the profile feature classes and their relations. See also Profile
System Tables (page 558) and Profile Feature Classes (page 568).

To start the Profile designer

The Profile designer is available in all documents that contain the Profile
Extension.

1 Start Topobase Administrator, and open the workspace.

2 Select the document, and click Document menu ➤ Profile Designer.

3 On the Profile designer pane, the profile explorer displays the profile
definitions of the selected document.

Use the Profile designer to view and edit the profile system tables, and the
profile feature classes.

Profile Explorer

■ In the profile explorer, expand the document node, and the Profile node
to display the profile definitions.

■ Expand a profile definition node to display the associated feature classes.

■ Select the profile definition node to display the profile system table
TB_PROFILE_DEFINITION in the right pane. See also Profile Data Model
(page 557).

■ Select an associated table to display table preview in the right pane.

NOTE The Wastewater demo data set provides a sample profile definition. Use
the sample to get familiar with profile definitions.

Create a Profile Definition
You can create your own profile definitions in any document to draw
longitudinal profiles of any feature classes. Profile definitions are based on
the Profile data model. The following steps are required:
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Creating a profile definition from scratch

■ Add the Profile Extension (profile data model) to the document. See To
add the Profile extension profiles:add to data modelYou use the data model
administrator to add t... (page 548).

■ Design a profile, identifying which features will be included, such as
layouts, scale ranges, and labels.

■ Use the data model administrator to create the profile feature classes.
Usually you have one corresponding profile feature class for each real world
feature class. See Profile Feature Classes (page 568)
Example: You want to draw a wastewater profile with manholes and
sections (feature classes WW_MANHOLE and WW_SECTION). Then, you
need the profile feature classes WW_MANHOLE_PRO and
WW_SECTION_PRO.

■ Use the Profile Designer to create the profile definitions.

The profile definitions are available in Topobase Client in the Profile Manager.
In the Profile Manager, you can select the definition, modify the default
settings, select the features and the profile axis, and create and store the
profiles.

Topobase Client User Guide, section Working with Profiles.

To add the Profile extension

You use the data model administrator to add the Profile Extension to a
document.

1 Start Topobase Administrator and open a workspace.

2 In the Administrator explorer, select the document.

3 Click Document menu ➤ Settings.

4 Under Document Settings, on the navigation pane, click the Extensions
link.

5 Select Profile Extension.

6 Click Save. The document is loaded again.

7 If prompted, click Update to create the profile tables.
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See also:

■ Profile Data Model (page 557)

To create a Profile definition

1 Start the Profile designer.

2 In the profile explorer, select the Profile node, and click Create.

3 In the Profile Designer dialog box, specify the profile settings. Follow the
order that is indicated in the navigation pane on the left.

NOTE When your cursor hovers over an input field for more than 2 seconds, an
extended tooltip displays additional information.

Specify the following profile components.

■ General Settings (page 549)

■ Features Settings (page 550)

■ Decoration Settings (page 554)

■ Labels Settings (page 555)

General Settings
In the Profile designer, click the General tab. Under General, you specify profile
properties, such as profile origin, scale factor, title, or template.

In Topobase Client, Profile Manager, when you create a profile from the profile
definition, you can modify the height scale factor, length scale factor, distance
offset, and elevation offset.

DescriptionProfile Designer dialog box - General
settings

Specifies the name of the profile definition.Title

Selects a profile template. The selected
template overrides all fields in all pages of

Template

the profile definition with the settings
stored in the template. To reset all fields
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DescriptionProfile Designer dialog box - General
settings

to NULL, select None. See also Working
With Profile Templates (page 556).

Specifies the scale factor in height.Height
Ratio between the elevation of real world
features in the planimetric view and height
of profile features in the profile view. For
example, set the height as 2 to specify that
meter in the real world view is equal to two
meters in the profile view.

Specifies the scale factor in length.Length
Ratio between distance in the real world
and distance in the profile.

Specifies the distance offset.Distance Offset
Distance from the first digitized axis vertex
in the planimetric view that the profile
origin x axis is referenced from.

Reference altitude. Height that the profile
origin is referenced from, this height is
adjusted according to the scale factor.

Elevation Offset

When you use the profile definition in To-
pobase Client, you can adjust this value.

Features Settings
In the Profile designer, click the Features tab, and the sub tabs Lines, Polygons,
and Attributes.

Under Features, you map the real world feature classes to the profile details.

The settings are stored in the profile feature class TB_PROFILE_DETAIL.

DescriptionProfile Designer dialog box - Feature
settings

Defines the mapping of the profile features
and the real world features. You can add
as many mapping definitions as needed.

Profile Features
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DescriptionProfile Designer dialog box - Feature
settings

Specifies the name of the detail, such as
Fitting, or Manhole.

Detail Title

Selects the real world feature class, such as
WW_POINT. The list displays all non profile
feature classes of the document.

Main Feature Class

Selects the profile feature class, such as
WW_POINT_PRO. The list displays all pro-

Profile Feature Class

file feature classes of the document. See
also Profile Feature Class Attributes (page
569).

Selects a distance attribute of the selected
main feature class on which the profile
distances are based.

Distance Attribute

Defines a WHERE Clause on the selected
main feature class that is used as a filter

Where Clause

when the corresponding profile feature is
generated. For example, to only add net-
work points of type fitting to the profile.
Click Assistant to open the SQL Sheet, and
click Validate to validate the WHERE clause.

Defines an SQL select statement on the
geometry of the selected main feature class

Select Statement

to filter profile features according to geo-
metric relationship. For example, to only
add points to the profile that are topologic-
ally associated with a section.
Click Assistant to open the SQL Sheet, and
click Validate to validate the WHERE clause.

Under Features - Lines, you define the connector lines, and the vertical lines
that can be applied to the profile features.

DescriptionFeature - Lines settings

Displays the mapping definitions that have
been created under Feature Settings. Select

Profile Features
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DescriptionFeature - Lines settings

a mapping definition, and specify the
connector line, or the vertical line.

Specifies a line that connects the profile
point features.

Connector Lines

Selects the profile feature class to store the
line. The list displays all profile feature

Feature Class

classes of the document. See also Profile
Feature Class Attributes (page 569).

Selects an attribute of the connector line
feature class that can be used for styliza-
tion.

Attribute

Specifies a value for the selected attribute.Value

Specifies a vertical line for the profile fea-
tures.

Vertical Lines

Selects the profile feature class to store the
vertical line. The list displays all profile fea-

Feature Class

ture classes of the document. See also
Profile Feature Class Attributes (page 569).

Specifies the distance (in document units)
between the X axis (easting) and the start
of the vertical base line.

Offset

Selects an attribute of the vertical line fea-
ture class that can be used for stylization.

Attribute

Specifies a value for the selected attribute.Value

Under Features - Polygons, you define the depth polygons. You use depth
polygons to add depth related information to your profile.

DescriptionFeature - Polygon settings

Displays the mapping definitions that have
been created under Feature Settings. Select

Profile Features
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DescriptionFeature - Polygon settings

a mapping definition, and specify the
polygon.

Specifies a polygon.Depth Polygon

Defines a WHERE Clause on the main fea-
ture class.

Where Clause

Click Assistant to open the SQL Sheet, and
click Validate to validate the WHERE clause.

Selects the profile feature class to store the
polygon. The list displays all profile feature

Feature Class

classes of the document. See also Profile
Feature Class Attributes (page 569).

Specifies the height (in document units)
of the polygon.

Depth

Under Features - Attributes, you define up to 5 attribute values for each profile
detail.

DescriptionFeature - Attributes settings

Displays the mapping definitions that have
been created under Feature Settings. Select
a definition, and specify the attributes.

Profile Features

Feature Class Attributes

Selects an attribute of the selected main
feature class.

Attribute

Specifies a value for the attribute.Value
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Decoration Settings
In the Profile designer, click the Decoration tab. Under Decoration, you specify
layout elements such as legends, profile borders, graticules, guide lines, or axis
markers.

DescriptionProfile Designer dialog box - Decora-
tion settings

Specifies the profile decoration feature
classes. You can add as many feature
classes as needed.

Decoration Features

Specifies a name for the decoration, for
example “Static Text”.

Detail Title

Selects the profile feature class to store the
decoration features, such as WW_PRO-

Profile Feature Class

FILE_STATIC_TEXT. The list displays all
profile feature classes of the document.
See also Profile Feature Class Attributes
(page 569).

Distance Attribute

Decoration Feature Setting

Specifies the type, such as Single Point,
Single Line, or Repeated Horizontal Line.

Decoration Type

The list depends on the selected profile
feature class type. For example, use single
elements to represent decorative elements
such as legend frames or axis borders.
Use repeated elements to represent ele-
ments within the profile such as label
frames or tables which are comprised of
features repeated many times at a prespe-
cified distance.

For repeated features. Specifies the vertical
or horizontal distance (in document units).
Enter 0, or a positive or a negative value.

Interval
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DescriptionProfile Designer dialog box - Decora-
tion settings

Specifies the relative position of the decor-
ation elements in the local profile coordin-
ate system.

Reference Origin

Specifies the position of a decoration fea-
ture in the profile.

Start Easting
End Easting

If the decoration type is a single element,
the start and end coordinates define the

Start Northing
End Northing

absolute position of the feature in the local
profile coordinate system.
If the decoration type is a repeated ele-
ment, the start and end coordinates define
the absolute position of the first feature in
the repeated set, and also the reference
origin from which the repeated features
are placed.

Select this option to add the profile width
to the start / end easting value.

Add Profile Width

For example, to place the axis border
around the profile.

Select this option to add the profile height
to the start / end northing value.

Add Profile Height

For example, to place the axis border
around the profile.

Labels Settings
In the Profile designer, click the Labels tab.

DescriptionProfile Designer dialog box - Labels
settings

Label Features

Specifies the name of the sub detail, such
as Section Label.

Sub Detail Title
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DescriptionProfile Designer dialog box - Labels
settings

Selects the profile label feature class, such
as WW_POINT_PRO_TBL. The list displays

Profile Feature Class

all profile feature classes of the document.
See also Profile Feature Class Attributes
(page 569).

Selects the reference feature (label parent),
such as Manhole. The list displays the titles

Reference Feature

of all profile feature classes of the docu-
ment.

Selects the label definition. The list displays
all label definitions of the document.

Label Definition

Specifies the relative position of the label
features in the local profile coordinate sys-
tem.

Reference Origin

Specifies the position of a label feature in
the profile.

Start Easting
End Easting

If you do not specify any coordinates here,
the labels are placed according to the
geometry of the reference feature.

Start Northing
End Northing

Select this option to add the profile width
to the start / end easting value.

Add Profile Width

For example, to place the profile title.

Select this option to add the profile height
to the start / end northing value.

Add Profile Height

Working With Profile Templates
You can save your current profile definition as template that can be reused.

To save a profile definition template

1 Start the Profile designer.

2 In the profile explorer, select the profile definition, and click Edit.
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3 In the Profile Designer dialog box, under Template, click Save As.

4 Enter a Template Name, and click OK.

To delete a profile definition template

1 Start the Profile designer.

2 In the profile explorer, select the Profile node, and click Create.

3 In the Profile Designer dialog box, select the template, and click Delete.

The system stores the profile definition templates in the system tables
TB_*_TPL.

Profile system tables that store the templates

■ TB_PRO_DEFINITION_TPL

■ TB_PRO_DETAIL_TPL

■ TB_PRO_SUB_DETAIL_TPL

Profile Data Model
Topobase Administrator creates the underlying structure for the profiles that
users will create, using their feature classes and attribute data.

The profile data model consists of two sets of tables that are stored in the
document.

Profile system tables

Adding the Profile Extension adds the profile system tables to your document.
See also To add the Profile extension profiles:add to data modelYou use the
data model administrator to add t... (page 548).

■ TB_PROFILE

■ TB_PROFILE_AXIS

■ TB_PROFILE_DEFINITION

■ TB_PROFILE_DETAIL

■ TB_PROFILE_SUB_DETAIL
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Profile feature classes

Use the Topobase Data Model Administrator to create your profile feature
classes.

■ xx_featureclassname_PRO

■ The names of the profile feature classes are arbitrary. We recommend that
you use the data model code as a prefix and add the suffix “_PRO”.

■ Mandatory attributes, see Profile Feature Class Attributes (page 569).

Profile System Tables
Profile system tables store the configuration of the profiles in the document,
as shown in the following table. You use the Profile Designer to edit the
configuration. See Create a Profile Definition (page 547).

DescriptionTable

Point feature class that stores the origin of
a profile.

TB_PROFILE

Line string feature class that stores the axis
of the profile.

TB_PROFILE_AXIS

Stores the profile definition.TB_PROFILE_DEFINITION

Stores profile details.TB_PROFILE_DETAIL

Stores profile sub details.TB_PROFILE_SUB_DETAIL
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System Table TB_PROFILE
The point feature class TB_PROFILE stores the created profiles. All profile
features are related to this table.

When you create a profile in Topobase Client, you are prompted to position
the profile in the drawing, which means that you can digitize the origin in
the global coordinate system. This origin is stored in TB_PROFILE.
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All profile features are defined in a local coordinate system, with the origin
of the profile as point 0/0. The width and height of the profile depend on the
profile length and height difference in combination with Z_ORIGIN,
SCALE_FACTOR_HEIGHT, SCALE_FACTOR_LENGTH.

DescriptionTB_PROFILE attribute

Primary key.FID

Origin of the profile in the global coordin-
ate system. This is the local 0,0 coordinate.

GEOM

Orientation of the profile.ORIENTATION

Quality of the point.QUALITY

Height of the point. A standard point attrib-
ute.

Z

User who creates the profile. Corresponds
to TBSYS.TB_USER.ID

USER_ID

Title of the profile.PROFILE_TITLE

Profile definition used to create this profile.
Related to TB_PROFILE_DEFITION.ID

PROFILE_DEFINITION_ID

NOTE The values for the following attrib-
utes are set when you create a profile.

If you change a PROFILE_DEFINITION_ID,
the default values of the definition are set.

Scale factor for the height, used to define
the relationship between the global co-

SCALE_FACTOR_HEIGHT

ordinate system and the profile coordinate
system for the height information.
NORTHING_PROFILE = (Z - Z_ORIGIN) /
SCALE_FACTOR_HEIGHT +
GEOM.NORTHING

Scale factor for the length, used to define
the relationship between the global co-

SCALE_FACTOR_LENGTH
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DescriptionTB_PROFILE attribute

ordinate system and the profile coordinate
system for the length information
EASTING_PROFILE =(LENGTH_GLOBAL -
DISTANCE_ORIGIN) /
SCALE_FACTOR_LENGTH +GEOM.EAST-
ING

Specifies the origin of the profile. Reference
altitude of the profile. You can enter this
value in the Profile Manager dialog box.

Z_ORIGIN

Specifies the reference distance of the
profile. The origin of the profile is at this
distance.

DISTANCE_ORIGIN

System Table TB_PROFILE_AXIS
The line string feature class TB_PROFILE_AXIS stores the axis or alignment of
the profiles.

Data represented in the profile is determined by an axis that can be selected
by using the logical topology between a start and end point or by digitizing
a polyline.

DescriptionTB_PROFILE_AXIS attribute

Primary keyFID

Geometry of the axisGEOM

Length of the line stringLENGTH

Foreign key of the profile that has been
generated with this axis; related to
TB_PROFILE.FID

FID_PROFILE
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System Table TB_PROFILE_DEFINITION
The feature class TB_PROFILE_DEFINITION stores the main profile definition.

DescriptionTB_PROFILE_DEFINITION
attribute

Primary key.ID

User who creates the profile definition. This corresponds
to TBSYS.TB_USER.ID.

USER_ID

Title of the profile that you define when you create or edit
a profile in the Profile Manager.

DEFINITION_TITLE

Specifies that the profile definition is available in the Profile
Manager:

ACTIVE

■ 1 = Yes (default)

■ 0 = No

The following attributes store default values to define the relationship between the
global coordinate system and the profile coordinate system for height and length inform-
ation.

Default scale factor for the height:SCALE_FACTOR_HEIGHT
NORTHING_PROFILE = (Z_GLOBAL - Z_ORIGIN) /
SCALE_FACTOR_HEIGHT + GEOM.NORTHING

Default scale factor for the length:SCALE_FACTOR_LENGTH
EASTING_PROFILE =(LENGTH_GLOBAL - DISTANCE_ORI-
GIN) / SCALE_FACTOR_LENGTH +GEOM.EASTING

Default reference altitude of the profile definition. The
origin of the profile is at this altitude.

Z_ORIGIN

Default reference distance of the profile definition. The
origin of the profile is at this distance.

DISTANCE_ORIGIN
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System Table TB_PROFILE_DETAIL
The feature class TB_PROFILE_DETAIL stores the definition details of profile
lines, profile points, or frame lines.

Each record in TB_PROFILE_DETAIL that corresponds to a feature class will
create one profile feature per feature.

Each record in TB_PROFILE_DETAIL that does not correspond to a feature
class will create one profile feature only.

For example, the profile detail containing the profile WW_MANHOLE_PRO
corresponds to the WW_MANHOLE feature class. For each manhole, one
profile feature will be stored. The detail WW_VERTICALLINE_PRO has no
relation to the manhole feature class, so this profile detail only defines the
one line.

DescriptionTB_PROFILE_DETAIL at-
tribute

Primary key.ID

User who creates the profile definition. This corresponds
to TBSYS.TB_USER.ID.

USER_ID

Title of the profile detail.DETAIL_TITLE

Profile definition related to this detail, related with
TB_PROFILE_DEFINITION.ID

PROFILE_DEFINITION_ID

Name of the feature class containing the features shown
in the profile.

F_CLASS_NAME_PROFILE

Name of the feature class corresponding to the profile
feature class: If F_CLASS_NAME_MAIN is null, only one

F_CLASS_NAME_MAIN

feature is created as detail. If F_CLASS_NAME_MAIN is
not null, one feature per main feature is created as de-
tail.

WHERE clause assigned to F_CLASS_NAME_MAIN in
order to make a sub-selection of the features.

WHERE_CLAUSE_MAIN

select * from F_CLASS_NAME_MAIN f where

WHERE_CLAUSE_MAIN

The alias f can be used in the WHERE clause.
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Selection of the geometry of the main feature. The
query must use the column alias FID, EASTING,
NORTHING, HEIGHT.

SELECT_STATEMENT
_GEOM_MAIN

For point feature classes, 0 or 1 row can be returned
by this statement. For line feature classes, 0, 1 or more
rows can be returned.

Name of the line feature class containing the features
used to connect the point features in the profile.

FEAT_CONN_LINE_
F_CLASS_NAME

Attribute name of the line connection feature classFEAT_CONN_LINE_ATTR1

Value set for the attribute FEAT_CONN_LINE_ATTR1FEAT_CONN_LINE
_VALUE_1

Name of the line feature class containing the features
used to make a vertical line from the feature to the ref-
erence height.

VERT_CONN_LINE_
F_CLASS_NAME

If F_CLASS_NAME_PROFILE is a point feature class, one
vertical line is created.
If F_CLASS_NAME_PROFILE is a line feature class, one
line is created at the start and one at the end. If two
lines are geometrically connected, only one vertical line
is created at the connection point.

Attribute name of the line connection feature class.VERT_CONN_LINE_ATTR1

Value set for the attribute VERT_CONN_LINE_ATTR1.VERT_CONN_LINE
_VALUE_1

Offset between the reference height and the vertical
line. Has the global coordinate system unit.

VERT_CONN_LINE _ORI-
GIN_OFFSET

Name of the polygon feature class that can only be
used for F_CLASS_NAME_PROFILE point feature classes.

POLYGON_NEXT_PT_
F_CLASS_NAME

A polygon is created from the current point feature to
the next point feature.

Height of the polygon.POLYGON_NEXT_PT
_HEIGHT
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WHERE clause used to make a sub selection of the point
features. Creates a polygon only if the following state-
ment gives a row back:

POLYGON_NEXT_PT
_WHERE_CLAUSE

select 1 from F_CLASS_NAME f
where POLYGON_NEXT_PT_WHERE_CLAUSE, the alias
f can be used in the where clause.

Attribute name of F_CLASS_NAME_PROFILE in which
the distance along the axis is stored.

DISTANCE_ATTRIBUTE

Only if F_CLASS_NAME_PROFILE is a point feature class.

First easting coordinate in the local coordinate system.LOCAL_EASTING_1

First northing coordinate in the local coordinate system.LOCAL_NORTHING_1

Second easting coordinate in the local coordinate sys-
tem.

LOCAL_EASTING_2

Second northing coordinate in the local coordinate
system.

LOCAL_NORTHING_2

Flag that defines whether the profile width has to be
added to LOCAL_EASTING_1.

LOCAL_EASTING_1
_ADD_WIDTH

Flag that defines whether the profile height has to be
added to LOCAL_NORTHING_1.

LOCAL_NORTHING_1
_ADD_HEIGHT

Flag that defines whether the profile width has to be
added to LOCAL_EASTING_2.

LOCAL_EASTING_2_
ADD_WIDTH

Flag that defines whether the profile height has to be
added to LOCAL_NORTHING_2.

LOCAL_NORTHING_2
_ADD_HEIGHT

Object is placed every REPEATED_DISTANCE distance;
only for point feature class and if F_CLASS_NAME_MAIN
is null.

REPEATED_DISTANCE

Attribute name of the table F_CLASS_NAME_PROFILESET_ATTRIBUTE_1 - 5

Value set to the corresponding feature attributeSET_VALUE_1 - 5

A LOCAL* value replaces the information of the feature and is considered an
absolute value in the profile coordinate system.
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If F_CLASS_NAME_MAIN is null and F_CLASS_NAME_PROFILE is a point
feature class, then LOCAL_EASTING_1 and LOCAL_NORTHING_1 must be
not null and are used as absolute values.

If F_CLASS_NAME_MAIN is null and F_CLASS_NAME_PROFILE is a line feature
class, then LOCAL_EASTING_1, LOCAL_NORTHING_1, LOCAL_EASTING_2
and LOCAL_NORTHING_2 must be not null and are used as absolute value.

For line feature class, if a point is not exactly on the line, it is projected to the
nearest position of the line.

The relation between the feature of F_CLASS_NAME_PROFILE and
FEAT_CONN_LINE_F_CLASS_NAME must be stored in TB_RELATIONS. This
relation is automatically filled during the profile generation process.

The relation between the features of F_CLASS_NAME_PROFILE and
VERT_CONN_LINE_F_CLASS_NAME must be stored in TB_RELATIONS. This
relation is automatically filled during the profile generation process.

The relation between the features of F_CLASS_NAME_PROFILE and
POLYGON_NEXT_PT_F_CLASS_NAME must be stored in TB_RELATIONS. This
relation is automatically filled during the profile generation process.

System Table TB_PROFILE_SUB_DETAIL
The feature class TB_PROFILE_SUB_DETAIL stores sub-detail definitions. Only
labels can be sub-details, all other feature classes are details. Label sub-details
correspond to the detail feature classes.

TB_PROFILE_SUB_DETAIL DescriptionTB_PROFILE_SUB_DETAIL
attribute

Primary keyID

User who creates the sub-detail. This corresponds to TB-
SYS.TB_USER.ID.

USER_ID

Title of the sub-detail.SUB_DETAIL_TITLE

Detail definition related to this sub-detail; related to
TB_PROFILE_DETAIL.ID.

PROFILE_DETAIL_ID

Name of the feature class containing the label features
shown in the profile.

F_CLASS_NAME_PROFILE
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Label definition used to create the label; related to LA-
BEL_DEF.ID.

LABEL_DEF_ID

First easting coordinate in the local coordinate system.LOCAL_EASTING_1

First northing coordinate in the local coordinate system.LOCAL_NORTHING_1

Second easting coordinate in the local coordinate system.LOCAL_EASTING_2

Second northing coordinate in the local coordinate sys-
tem.

LOCAL_NORTHING_2

Flag that defines whether the Profile width has to be ad-
ded to LOCAL_EASTING_1.

LOCAL_EAST-
ING_1_ADD_WIDTH

Flag that defines whether the Profile height has to be
added to LOCAL_NORTHING_1.

LOCAL_NORTH-
ING_1_ADD_HEIGHT

Flag that defines whether the Profile width has to be ad-
ded to LOCAL_EASTING_2.

LOCAL_EAST-
ING_2_ADD_WIDTH

Flag that defines whether the Profile height has to be
added to LOCAL_NORTHING_2.

LOCAL_NORTH-
ING_2_ADD_HEIGHT

Attribute name of the class F_CLASS_NAME_PROFILE.SET_ATTRIBUTE_1

Value set to the corresponding feature attribute.SET_VALUE_1

A LOCAL* value replaces the information of the feature and is considered as
an absolute value in the profile coordinate system.

One sub-detail feature is created per detail feature. The only exception is for
a line profile feature class.

For a line feature class, if a point is not exactly on the line, it is projected to
the nearest position of the line.
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Profile Feature Classes
Profile feature classes store the points, lines, and labels for each profile. Profile
feature classes represent two types of features:

■ A real world feature (parent), such as a manhole cover. Each real world
feature corresponds to a profile feature. Real world features are profile
objects that are normally displayed in the global reference system. The
profile feature class stores the relation to the real world feature in the
attribute FID_PARENT.

■ Decoration elements of the profile drawing, such as frame lines, legend,
and fix labels. Decoration elements do not correspond to any real world
features.

For example, a profile feature of WW_LINE_PRO stores the profile line that
corresponds to a real world feature of WW_LINE.

The following table is an example of how a wastewater profile could be stored.

level of detailProfile feature class (example)Profile compon-
ent

detailWW_LINE_PRONetwork line
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level of detailProfile feature class (example)Profile compon-
ent

detailWW_POINT_PRONetwork point

sub detailWW_LINE_PRO_TBLFeature label
WW_POINT_PRO_TBL

detailWW_PROFILE_LINE_PROVertical line

detailWW_PROFILE_LINE_PROConnector line

detailWW_PROFILE_POINT_PROSymbol such as ori-
gin, reference
height:

detailWW_PROFILE_POLYGON_PROPolygon

detail and sub detailWW_PROFILE_STATIC_TEXTStatic text such as
height, legend la-
bels.

Profile Feature Class Attributes
Use profile feature classes to store the profile elements of the related parent
feature classes.

DescriptionWW__featureclass_PRO
Attribute

Primary key.FID

Parent feature class, related with <feature class>.FID; can
be null.

FID_PARENT

Profile, for which the feature has been created, related
with TB_PROFILE.FID; not null. This attribute is mandat-

FID_PROFILE

ory. In the Profile Designer, all feature classes that have
an attribute FID_PROFILE, are recognized as profile fea-
ture class.

Geometry of the feature in the profile.GEOM
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Specific profile feature class attribute. The name of this
attribute can be freely defined. ATTRIBUTE_1 is only an
example.

ATTRIBUTE_1

For profile points, the height values are taken from the Z attribute. If Z is null,
the attribute Z_ORIGIN is used.

For profile lines, the height is obtained from the point on the line or it can
be queried with an SQL statement.

Detail profile feature class properties

■ Point or line feature class in the topic Profile, containing an attribute
FID_PROFILE.

■ Point or line feature class in any topic, containing an attribute FID_PROFILE
that has a child relation to TB_PROFILE.FID.

Sub Detail feature class properties

■ Point or line feature class in the topic Profile, containing an attribute
FID_PROFILE.

■ Point or line feature class in any topic, containing an attribute FID_PROFILE
that has a child relation to TB_PROFILE.FID.

■ Label feature class in the topic Profile.

See also:

■ System Table TB_PROFILE (page 559)

Profile Manager
In Topobase Client, you can use the Working with Profiles to create and draw
profiles based on the profile definitions.

NOTE The Wastewater, Water, and Gas demo data sets provide a sample profile
definition.
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Feature Rules

About Feature Rules
Using Topobase feature rules (rule base), you can execute procedures, such as
automatic data correction or adding functionality, whenever changes are made
to the database.

Feature rules are methods and triggers that process data accordingly to predefined
algorithms. For example, rules perform complex consistency and dependency
checks at certain events, such as before inserting or after modifying a feature.

Feature rules are provided by Autodesk Topobase. However, users with some
experience with PL/SQL triggers can define their own server-side feature rules
or to create their own client-side feature rule in .NET.

The feature rules configuration is stored in the document (page 581) in the system
tables TB_RULE_*.

Topobase provides client-side and server-side feature rules.

See also:

■ Autodesk Topobase Feature Rules

■ Server Side Feature Rules

■ Client Side Feature Rules

■ System Tables TB_RULE* (page 176)
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Feature Rule Properties
In Topobase data model administrator, you select the feature class in the data
model explorer. Right-click the feature class and click Edit Feature Rules.

In the Feature Rules Properties dialog box you can assign the feature rules, as
shown in the following table:

DescriptionFeature Rule Properties

Name of the feature classFeature Class

Feature rules can be server-side or client-side.Server Side (PL/SQL)
Click the respective tab.Client Side (.NET)
Note, that you can only define new server-side feature
rules.

Lists feature rules that are currently assigned to the
feature class. The assigned feature rules are recorded
in the system table TB_RULE_BASE.

Applied Rule Bases

The TB_RULE_FCLASSTYPE table defines which feature
rule is available for which feature class type. Example:
Calculating the length is valid for LineString feature
classes but not for point feature classes.

Edits the feature rules. Select a row and click the but-
ton. See also Edit Feature Rule Properties (page 573)

Edit

Defines the execution order of the feature rules. A fea-
ture rule with a lower priority value is executed before
a rule with a higher value.

Priority

Example: It makes sense to validate the geometry of a
feature, before calculating the area.
Use the Up and Down button to change the order and
modify the priority.

Lists all feature rules (TB_RULE_DEF) and rule groups
(TB_RULE_GROUP) that are available for the current
feature class.

Rule Base Definitions

If you select a group, all included rules are added to
the Applied Rule Bases list.

NOTE Only feature rules that are not part of a group
are available individually.
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Adds a feature rule definition. Select a row and click
Add.

Add

Removes an applied feature rule.Remove

Edits your own feature rule definitions. Displays the
server-side feature rule definitions.

Edit

Creates a new server-side feature rule definition.New

Creates a feature rule group. See also Feature Rule
Group (page 576)

New Group

Event on which a feature rule reacts.Event

Before insertBI

Before updateBU

Before deleteBD

After insertAI

After updateAU

After deleteAD

After you have assigned the feature rule, you can modify some properties.

Edit Feature Rule Properties
You can view and edit the properties of an assigned feature rule. Select it in
the Applied Rule Bases list and click the Edit button to open the Edit Rule Base
dialog box.

Edit the following properties, as shown in the following table:

DescriptionProperty

Activates or deactivates the rule. You can temporarily
disable a rule without losing the configuration.

Active
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This is the primary key in TB_RULE_BASE. Cannot be
edited.

ID

Modifies the priority. In most cases, you can keep the
default priority of the feature rule definition. See also
Feature Rule Priorities

Priority

Displays the feature class caption.Feature Class

Defines server-side feature rules only. Click 
to view the feature rule definition (trigger text). See
also Feature Rule Definition (page 574)

Definition

Selects the event at which the rule shall be executed.
Modify the regular settings here, if needed. For ex-

Before Trigger
After Trigger

ample, deactivate the perimeter check before an up-
date.

Assigns a value to the parameters that are used in the
trigger text. For example, most server-side feature rules

Parameters

have a default parameter for the feature class name.
See also Feature Rule Parameters (page 577)

Feature Rule Definition
You can define your own server-side feature rules if you know Oracle triggers
and the Topobase API. Please refer to the respective manuals.

Feature rules are stored in the system table TB_RULE_DEF in the document
(page 581). The following topics cover the configuration process in feature rule
definition.

Configuration process

1 In Topobase data model administrator, select a feature class in the data
model explorer.

2 Right-click and click Edit Feature Rules

3 Click the Server Side tab.
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4 Click the New button next to the Rule Base Definitions area.

In the Feature Rule Definition dialog box, you can define the rules, as shown
in the following table:

DescriptionFeature Rule
Definition

Specifies either selected (1) for row trigger or deselected (0)
for statement trigger.

Row Trigger

Primary key in TB_RULE_DEF. See also the Topobase Feature
Reference, section Feature Rule ID.

ID

Specifies the name of the feature rule. It is recommended
that you assign a unique name to each feature rule. Also,

Name

add a suffix to indicate the event, for example, add AU for
after update.
A name for a rule that is part of a group should contain the
group name <GROUPNAME>_<ACTION>. For example
MoveConnectedLines_BU and MoveConnectedLines_AU.

Specifies a description for the new feature rule. enter a de-
scription.

Description

Specifies when the trigger executes. The trigger executes
only when an attribute matching the specified name is
modified. If the text box is empty, it will always execute.

Execute Col:

Sets the default priority. If assigned to a feature class, this
default value can be modified for each feature class. See the

Default Priority

Topobase Feature Rule Reference, section Feature Rule Prior-
ities.

These primary settings can be modified later for each feature
class to which the rule has been assigned.

Template Values

Specifies parameters that can be used in the trigger text.
You can use up to 10 parameters. While you are entering

Parameters

the trigger text all used parameters (%P1 - %P10) will be
shown and you can enter a name (1st parameter) and a
default value (2nd parameter).
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Specifies the trigger text. Enter the trigger text.Trigger Text

NOTE To create client-side feature rules, you need a .NET developer kit and .NET
knowledge.

Feature Rule Group
A group can contain several feature rules that define other rules, such as one
Before and one After rule.

Server-side rules must adhere to the Oracle trigger limitations. In particular,
row triggers cannot query or modify tables in jobs, except for the changed
row. Because of this, most server-side rules are implemented as a group of
rules. A group of feature rules consists of a before-action rule on the row that
inserts the ROWID of modified features into a temporary table, and an
after-action statement rule doing the actual work.

You can edit a feature rule group. In the Feature Rules Properties dialog box,
select the group in the Feature Rule Definitions list and click the Edit button.

DescriptionEdit Definition Group
Dialog Box

Group ID (TB_RULE_GROUP).ID

Group name.Name

Selects the feature rules that belong to the group.Available Definitions

NOTE You can only add feature rules that do not yet be-
long to another rule group. Also, you cannot add the system
feature rules to a new customer rule group.

Displays a rule definition to edit. Note that you can edit
only server-side definitions.

Edit Rule Definition

You can create new feature rule groups. First, create the new feature rules.
Then, in the Feature Rules Properties dialog box, click New Group.

See also:

■ Label rule group
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Feature Rule Parameters
You can specify up to 10 parameters that can be used in the trigger texts. The
parameters are stored in the TB_RULE_PARAM system table.

In the Edit Rule Definition dialog box, you can edit the parameters. To
introduce a parameter, enter the parameters %P1, %P2 through %P10 in the
trigger text. For each parameter, a text box is displayed, where you can define
a name and a default value.

See also:

■ System Table TB_RULE_PARAM (page 178)

Assigning Feature Rules
You can assign feature rules in Topobase data model administrator.

To assign a feature rule

1 Select the feature class you want to assign a rule to. Right-click and click
Edit Feature Rules.

2 Click either the Server Side (PL/SQL) or Client Side (.net) tab. The upper
part of the tab displays the rules that are currently applied. In the lower
part. all available rules are displayed.

3 In the lower part, select a rule.

4 Click Add to assign the rule.

5 Click the Edit button next to Applied Rule Bases list to edit the applied
feature rule. This is only available for the Server Side rules.

NOTE With the Edit command you can edit the applied feature rule to specify
feature class dependent settings.

Exploring Feature Rules
You can view and modify feature rule definitions in Topobase data model
administrator.
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To explore the feature rules

1 Select a feature class. Right-click and click Edit Feature Rules.

2 Click either the Server Side (PL/SQL) or the Client (.net) tab.

3 In the Applied Rule Bases list, select a rule.

4 Click Edit. In the Edit Rule Base dialog box, click  next to the
Definition field (only available for server-side feature rules).

5 Click Cancel to close the Edit Rule Definition dialog box.

6 Click Cancel to close the Edit Rule Base dialog box.

7 In the Rule Base Definitions list, select a feature rule.

8 Click Edit to open the Edit Rule Definition dialog box.

9 Click Cancel to close the Edit Rule Definition dialog box.

10 Click Cancel to close the Feature Rules Properties dialog box.

NOTE The Rule Base Definition list only shows the feature rules that are applicable
for the selected feature class.

See also:

■ Edit Feature Rule Properties (page 573)

■ Feature Rule Definition (page 574)

Exploring Feature Rule Groups
You can view feature rule groups and their definitions in Topobase data model
administrator.

To explore a feature rule group

1 Select a feature class. Right-click and click Edit Feature Rules.

2 Click the Server Side (PL/SQL) tab.

3 In the Rule Base Definitions list, select a group. Feature rule group names
are highlighted.
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4 Click Edit. In the Edit Definition Group dialog box select one of the
selected feature rules and click Edit Rule Definition.

See also:

■ Feature Rule Group (page 576)

■ Feature Rule Definition (page 574)
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Glossary

area topology Description of spatial relationship between geographic area
features. Area topologies contain line strings and centroids. In Topobase™,
the polygons are generated automatically from the surrounding line strings.
Examples of area topologies are parcels, land use, land cover and political
boundaries. See also Topology.

centroid A point that indicates a polygon (approximately in the center). In
Topobase, centroids are part of area topologies and belong to the surrounding
edges (line string feature class). The centroid normally holds the polygon's
attribute data. See also Area Topology.

COGO Abbreviation for Coordinate Geometry. COGO functionality provides
calculation routines, such as for intersection, projection, orthogonal survey,
offset lines, and right angle course.

Display Manager For stylization in Autodesk Map 3D, applies custom styles
to selected features and objects. To view the Display Manager task, select
Display Manager in the list at the top of the Task Pane. Also used for stylization
of Topobase features.

display model In Topobase, you use display models to administer thematic
views. A display model definition specifies which set of layer files (feature
layers) is loaded into the Display Manager. Also, the display model defines
multi map windows and autoload layers.

display model repository Central location on your file system or on a shared
network to store the display model files (*.tbdm, *.tbdmmap, *.LAYER, *.DWG).

Autodesk provides a default display model repository <default display model
repository> containing the display models for the demo data sets, and the
extensions.

document In Topobase, a document is an Oracle® database schema with
additional settings in the Topobase System user (database server schema TBSYS).
A document is an Oracle database user plus settings for menu bars, toolbars
and forms. A document must be assigned to a workspace to be accessible by
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Topobase Client or Topobase Web. You can create, edit, and configure the
documents using the Topobase Administrator.

document explorer Control element in the Topobase Client task pane and
in the Topobase Web layout. Use the tree view to show the objects that are
stored in the database. For different requirements and more clarity these
objects can be grouped into explorer groups. Provides a document-specific
view to process the following objects: Topics (and feature classes), domains,
topologies, intersections, system tables, and workflows. You can define a
different document explorers for each document. Also called Topobase explorer.

domain Sets of values. For example, a domain defines the values that are
allowed for a feature attribute. Topobase data models store domains in domain
tables (*_TBD). Domain tables are created using the Topobase data model
administrator.

explorer group In Topobase Administrator, a configuration that specifies
which objects are to be shown in the document explorer. These settings are
saved as Explorer Groups.

feature In Topobase, an entity of a feature class. Each feature in a feature class
represents a row or record in the feature class table.

feature class In Topobase, the basic class for objects. For example, a parcel is
a feature class. In a database, each feature class corresponds to one Oracle
table. A feature class can have any number of attributes (Oracle columns), one
of which can be of type "geometry". There are general types of feature classes,
such as the following:

■ Attribute (feature class without geometry)

■ Line String

■ Polygon

■ Point

■ Centroid

■ Label

■ Compound Polygon

■ Compound Linestring

You can group several feature classes for each topic. Each feature class contains
many entities/instances or records, which are called features.
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feature class form Database form to view and edit attribute data stored in
Topobase. Forms can be customized with the Topobase form designer.

feature explorer Control element used to display a set of features in a tree
view, resulting from a selection, a validation, or a tracing.

Feature Search Finds the location of a certain object, such as a building, a
parcel, or any other type of feature that has geometry. The geometry found
will be the center of a graphic generation or a zoom GoTo. There are several
types of search such as Sequential search and Flat search.

graphic connection A connection between Topobase and Autodesk Map or
Autodesk MapGuide to display the features. Topobase Client has a graphic
connection to Autodesk Map. Topobase Web has a graphic connection to
Autodesk MapGuide.

job perimeter Spatial area where a job can be processed. You can use job
perimeters to control where the modifications of the current job is allowed.
Features outside the job perimeter cannot be processed. Also, you can define
feature rules to be applied on the objects within the perimeter.

label In Topobase, any attribute data of a feature can be displayed as text,
using label features. Label features are generated by arbitrary select statements
that can be defined by the customer and therefore are a flexible way to add
inscriptions to the objects. Label definitions (select statements and other
settings) are stored in the system table TB_LABEL_DEF. Label definitions can
be created or edited using the Topobase data model administrator. Label
features can be stylized with the Display Manager by displaying the
LABEL_TEXT property.

label definition Select statements that create labels. The label definition 1)
queries data from the database and 2) specifies positioning and text orientation.
This information is used in the Display Manager for stylization.

label feature class Feature class type used to store label features in the database
<feature class name>_TBL. Each feature class (parent feature class) can have
exactly one label feature class. The label feature class contains default attributes
only, and contains no other specific attributes. It stores a relation to the parent
feature class.

label placer Places a label to generate a label feature, to write information
into the drawing or the map.

logical topology Description of the relationship of features of any feature
classes, both attribute or geometry feature classes. The features need not to be
spatially connected. For example, a logical topology connects points with
points, lines with lines,lines to points, or attribute features to attriute features.
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Utility networks are based on logical topologies that connect points (nodes)
and lines (edges).

For example, a logical topology can represent a waste water network or
electrical transmission lines.

master-detail form Type of feature class form where related records are shown
in an embedded sub-form on one or more tabs.

network topology See logical topology.

Polygon Object built of line segments that form an enclosed area. In Topobase,
polygons are stored in a polygon feature class.

profile In Topobase, a longitudinal section of line features. A profile is created
by projecting features on an axis.

profile data model Data model consisting of a set of profile system tables
and an arbitrary set of profile feature classes. Profile system tables store the
basic configuration and settings. Profile feature classes store the components
of each profile drawing.

prototype drawing Drawing that stores all used blocks, symbols, regular and
other lines, text styles and dimensioning styles.

schema plan A schematic diagram that represents real world features by
transforming the original feature geometry to an alternative location, for
example by applying a coordinate offset. The schema plan represents the real
world features in a clear structure, and preserves topology. A schema plan can
either be displayed as overlay to the original features, or in a secondary
window. You use Topobase Administrator to define schema plans.

schematic feature In Topobase, schematic features are derived from real world
features. They are stored in the database and are used to draw the schema
plan. Each schematic feature is associated to its real world feature.

TBMAIN Topobase Main User, which is a Topobase System User with restricted
rights. The default name for the Topobase Main User is TBMAIN. To start the
application, non-administrator users can optionally connect to the Topobase
Main User.

TBSYS Topobase System User. Topobase system database schema. Topobase
server component that stores application settings and server-side stored
procedures. The default name for the Topobase System user is TBSYS.
Application users must be connected to the Topobase System user or to the
Topobase Main User TBMAIN to start the application.
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template In Topobase, a template is an arrangement of recurrent features.
The arrangement includes feature attributes, geometry and connectivity. In
Topobase Client, you use templates to place a feature arrangement in one
single step.

topic In Topobase, a group of several feature classes. A topic is a collection of
feature class tables. Topics can be thought of as containers used to organize
feature classes. Considering a data transfer, topics are fully independent of
one another. Each topic may have sub-topics.

To build a clear and transparent data structure, you can group feature classes
into topics, group several topics into main topics, and define feature classes
with sub-feature classes. These relations between topics and feature classes
serve only as an illustration of the data structure. There is not necessarily an
actual relation between the tables.

Topobase Administrator A Topobase basic module, used for Topobase
administration. Topobase Administrator contains several components, such
as:

■ Topobase data model administrator

■ Topobase form designer

■ Topobase report designer

■ Topobase job administrator

Topobase Client A component of Topobase Administrator, used for registering
and processing data stored in Topobase through forms and using Autodesk
Map for graphic processing.

Topobase data model administrator A Topobase module used to process
and establish data structures (topics, tables, attributes, topologies, and
intersections) in Topobase. Also, you can define label definitions and
dimensioning.

Topobase job All changes in the Topobase data pool can be controlled and
performed by exact reports on appropriate processing steps, if they are
performed inside a job. Using jobs allows you to control the version. A job
includes various processing states (live, pending, project). For each processing
state, an application exactly defines which actions are allowed.

Topobase System User Database schema that stores application settings and
server-side stored procedures. Default name is TBSYS. Application users must
be connected to the Topobase System User to start the application. They can
either connect directly to the Topobase System User or use a Topobase Main
User which has restricted rights. See also TBSYS and TBMAIN.
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Topobase Web The web version of Topobase applications.

topology A geometric shape property in which metrical relations play no role.
Topology describes how lines, nodes, and polygons connect and relate to each
other, and it forms the basis for spatial analysis as network tracing. In
Topobase, topologies can be administered within individual groups of feature
classes. They can be defined with the Topobase data model administrator.

topology checker Tool to check topologies. The results are displayed in a tree
view, displaying all feature errors.

user A person who works with any Topobase application. Each application
user belongs to a group called a user group, with certain tasks and rights.
Examples of users: Mr. MILLER, Mr. SMITH, Ms. BAKER; BILLY, TONY, LARRY.

user group A group of users having certain task and rights. Examples of user
groups: ADMIN, VIEWER, EDITOR, and so on. A member of a user group can
access workspaces only if he has a permission. He may use certain tools and
functions and he has certain rights to edit or view the data.

utility model Topobase data model component for utility applications, which
provides feature classes and rules for utility networks.

viewport Area of interest for the generate graphic process. A Topobase viewport
is a spatial filter on the map.

workflow In Topobase applications, a guide for the user through tasks like
acquisition, analysis, and reports.

workspace The central workflow unit in Topobase. For different user groups,
such as EDITOR, VIEWER or ADMIN, you can define the appropriate
workspaces, with respective roles and rights. A workspace comprises one or
more documents.

From the user’s point of view, a workspace is the starting point of his work.
He must open a workspace to work with any Topobase application. By selecting
a workspace, he will load all necessary objects, including the appropriate
menus and toolbars, with a single mouse-click. Therefore, he can even access
data from different applications, such as land management and wastewater,
in arbitrary combinations.

586 | Glossary



Index

1-Click Maintenance 136
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access rights
read only feature class 196

accuracy (point feature class) 209
Add Attributes dialog box 214
Advanced Combobox control 375
Advanced Form Launcher control 376
ALGNMENT

label text 233
alias

in label definition select
statements 237

path (web configuration) 153
path to file name (web

configuration) 400
aligned dimensioning 252
analysis

network - 327
annotation

see also labels 223
annotation layer 206, 452
application options 121
Application Options dialog box 121
arc linearization (area topology) 315
area topology

centroid 320
edge 320
initialization 324
introduction 320

Area Topology dialog box 314
areas

calculating (topology) 324
label definition to inscribe - 238
printing reports 518
see area topology 320
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in forms - example 408

Assistant
SQL - example 148

attribute
data types 216
relation settings 216

auto labels 226
creating - later 194

AutoGUID 399
AutoIncrement 399
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Basic ComboBox 377
Basic Form Launcher control 381
buffer

intersection 278
Build Compounds 263
business rules

see feature rules 571
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calculation
arithmetic - in forms - example 408
define -s in forms 393
in forms (example) 408

centroid feature class 200
centroids

area topology 314, 320
creating missing 324

chart 496, 507
Chart Wizard 507
Check Box control 383
COGO

add topic to document 69
COGO features

delete temporary - 129
Color ComboBox 384
ColorsShema (forms) 385
command line

start Topobase 37
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ComplexReference 402
compound

feature class attributes 201–202
compound polygon feature class 201
compounds

building 263
convert to - 262
data model 260
eliminate - 262

configuration
document explorer 103
feature search 527
job state transition 163
job states 162
jobs 345
link to file name (web) 400
link to picture folder (web) 153
polygon and line reports 518
search definitions 527
Topobase Web 117
topologies 312

connection radius
logical topology 316

connection tolerance radius (logical
topology) 318

connextion tolerance
logical topology 316

construction features
delete temporary - 129

context help
assigning context - to forms 426

controls
creating form - (form designer) 420

Convert to Compound 262
coordinate system 75

updating SRID 76
coordinates

displaying - of utility features 421
displaying feature - 418
show - in a form 386

Coordinates Editor control 386
cost functions (tracing) 332
Create Feature Class dialog box 196
Create Generalization dialog box 272
Create Intersection dialog box 275
Create New Document dialog box 71

Create Schematics dialog box 265
credentials

Topobase login 34
customizing

date format in forms 398
customizing Administrator toolbar 100
customizing Client menus 101
customizing Client toolbar 100
customizing Electric explorer 78
customizing form menu bar 81
customizing form toolbar 81
customizing form toolbars 424
customizing forms 359

displaying a select list 399
specifying a default value 399

customizing reports 483
customizing shortcut menus (document

explorer) 79–80
customizing TB commands 81
customizing the document explorer 94
customizing user interface

(document) 78
cycle detection (tracing) 331

D

data base schema
view name 128

Data Checker 131
data model 181

add to document 69
administrator 181
compounds 260
creating 71
delete feature class attribute 219
dimensioning 252
exploring 186
labels 223
modify attribute property 219
see also documents 58
template 58, 73
utility 246

data model administrator
introduction 181

data model code 152, 184
data model template 73
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view code 128
data model explorer 185
data structure

update 28
data transfer 289
database

maintenance 136
optimization (DBMS_STATS) 191

database check 136
date

customizing the format 398
form designer - default value 399

decimals
number of - in a report 504

decoration text
reference record 482

default
attributes (feature class) 213
forms (form designer) 368
job states 343
label orientation 231
setting - values (form designer) 399
unit settings 73

delete
display -d features (jobs) 470

DELETE_CHILD
TB_RELATIONS 172

DetailDocument
form designer 381

Digitizing Options 210
dimensioning

creating 258
data model 252
defining 258
feature classes 203
line types 205
point types 204
types 252
types (codes) 203

Dimensioning
add topic to document 69

Display Manager 446
overview 446

display model
creating 434
merging 434

display models
repository 431

Display Settings
feature explorer 92

document
administration and clean up 189
creating 71
database maintenance 136
structure update log file 29
transfer data between two -s 289
update 29

document explorer
configuration 94, 103
customizing shortcut menus 79–80

Document Linker control 387
document manager

file upload 119
Document Manager control 387
document options 127

export 53
import 53

documents
creating 58
creating - from template 58
import - into workspace 60
view data model codes 128
view name of data base schema 128
view version 128

domain
creating - tables 219
displaying - values in a combo

box 377
editing - values 219

dropdown list
add related - (form designer) 375

dump
import - 60

dynamic relation 391
Dynamic Stylization 466

E

edge
area topology 320
logical topology 326

Edit Attributes dialog box 219
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Edit Rule Base dialog box 573
Editable SQL TextBox control 388
editing

domain values 219
Electric CE

schema plan settings 268
Electric explorer

customizing commands 78
Eliminate Compound 262
Enable Jobs dialog box 347
enabling jobs 347
Enhanced Styles 446
export

ASCII text files 518
document 53
document into Oracle dump file 63
document options 53
line definitions 518

extension
add to document 69
template 259

F

feature class
adding attributes 213
creating 196
creating a label feature class 240
geometry attribute 198
label - 223
make - read only 196, 211
model table 220
naming limitations 196
relations 172
types 198

Feature Class Create dialog box 196
feature explorer

customizing 92
zoom factor for highlight 122

Feature Highlighter control 390
feature locking 344

settings 75
feature redirection 154

examples 155
Feature Rule Definition dialog box 575

feature rule group
view definitions 578

feature rules
assigning - 577
data model administrator 194
defining 574
exploring - 577
group 576
introduction 571
parameters 577
see business rules 106
system table 176
utility model 247
viewing 572
viewing and editing 106

Feature Rules Properties dialog box 572
feature search 527
Feature Search 527
feature styles

saving 448
features

bounded highlight settings 153
FID Button control 392
FID Form Launcher control 391
FID Linker control 392
FID Reference control 391
file selection

Web 119
FilterComboBox

example 399
flow direction management 318
flyIns

document options 83
view available 83

form
assigning toolbars 364

form designer
assigning toolbar 364
AutoGUID 399
AutoIncrement 399
calculate values in a form 393
controls 367
customizing forms 359
defining form toolbars 424
defining multiple tab pages 423
displaying a combo box 377
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displaying a RGB color button 385
drawing lines (layout) 394
dynamic relation 391
editing tab pages 366
enabling highlight for features 377
general control properties 373
hiding controls 361
hiding controls for user groups 373
inscribe dynamic editable text 388
inscribe dynamic text (SQL) 400
inscribe static text 405
introduction 357
link to picture folder (web) 153
locking controls for user groups 373
open a second form 402
related dropdown lists 375
selecting a color from a list 384
show coordinates 386
starting 357
toolbar 369
yes/no check box 383

forms
customizing 359
double click opens the - 125
import/export 52
locking input fields 398
master-detail 173, 175
specify mandatory fields 398
specify validation for input

fields 398
formula

-control example 408
Formula control 393

G

generalization 264
GEOM 198
Geometry control 386
grid cross settings 480
GUID

form designer - Auto- 399

H

hard split 244

help
assigning context - to forms 426

Highlight Button control 390
history

erasing job - 192
see jobs 341

history (job version) 159

I

import
document into a new workspace 60
document options 53
dump (document) into

workspace 60
report definition 517

initialization
area topology 324
logical topology 335

input type
feature search 530

insertion point (label) 233
intersection

adjusting areas 278
creating 275
feature class 275
introduction 274
meta data 157
results 275
types 274

invalid job configuration 352

J

job administrator 353
job conflict 344
Job Enabled 347
job state

defaults 162
introduction 343
selecting the default - 130
transition options 354
transition state configuration 163

job state configuration 162
job transition 343
job version 159
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jobs
assigning perimeter feature class 347
creating templates 350
enabling 347
erasing job history 192
feature locking 344
getting started 345
introduction 341
invalid configuration 352
leasing 351
perimeter 122, 349
perimeter settings 75
repair and update configuration 352
selecting feature classes 342
settings 75
states 341
style modified and new features 470
template 342, 353

L

Label control (form designer) 405
label definition

content to display 226
creating 240
example 237
inscribe area 238
inscribing utility attributes 251
parent geometry select

statement 238
rules 237
scale factor select statement 234
select statements 236
SQL format commands 238

label feature class
creating 240

label features
display orientation 455
display prefix and suffix 453
style - 452

label ID
data model administrator 235

Label Properties dialog box 225
Label Regeneration Definition dialog

box 227

labels
creating 240
data model 223
defining the textbox insertion

point 233
feature class attributes 206
horizontal alignment 233
insertion point 231
orientation 231
origin 233
origin conversion 235
properties 225
redirecting to parent feature 122
regeneration rules 227
update label text 191, 240
vertical alignment 233

LDAP 39
LDF files

loading 449
saving 448

Lease Job dialog box 351
leasing jobs 351
license

assigning 50
Line control 394
line definition

configuring a report 518
line style

using Topobase -s 451
lines

drawing - in a form (layout) 394
splitting 244

loading
feature styles 449

location 264
locking input fields 398
logical topology

connection radius 316
initialization 335
introduction 326

Logical Topology dialog box 316
login

changing password 38
credentials 34
default user 38
document password 77
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Topobase Administrator 34
Topobase Client 55
Topobase credentials 34

login.aspx
request parameter 37

long transaction
see jobs 341

M

maintenance
database 136

Manage Document Password dialog
box 77

mandatory
specify - fields 398

maps
styling 446

Master Box control 375
master-detail 173, 175

properties (form designer) 366
Master-Detail dialog box 366
menu

customizing form shortcut -s 426
menus

customizing form - 81
merge

display models 434
migration method

TB2TB 297
minimum spanning tree (network

tracing) 330
missing centroids 324
model driven attribute 220
Model selector (form designer) 405
model table 220
module

add to document 69
creating a - from template 73

Multi Reference control 376
multi-relation 215

reference 376
use with combo box controls 380

multi-selection
form designer 363

multi-user
read only feature class 196

multiple
coordinate systems 264
location 264

multirelation
data model administrator 216

N

network analysis 327
network topology

see logical topology 244
Network Tracer dialog box 327
node

area topology 312
logical topology 326

O

optimistic feature locking 344, 352
options

application - 121
form designer 364
job topology - 354
setting document - 127

Oracle
convert Oracle schema 285
view name of data base schema 128

Oracle dump
exporting a document 53

orientation
default setting 73
define default - for labels 231
enter when digitizing 198, 210

orthogonal dimensioning 252

P

parent geometry (select statement)
example (utility model) 251

password 34, 55, 77
job transition 353
user login 38
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pending
jobs state 341

perimeter
check job - 350
display options 122
feature class 349
job - 349

perimeter check
enabling 350

perimeter feature class 210
pessimistic feature locking 344
pessimistic locking 75
Picture Box control 153
Picture ComboBox control 395
Picture Linker control 396
pictures

display static - in a form 404
use in form designer and report

designer 153
picures

display record-related - 396
plot

decoration text 482
Plot

add to document 69
point number 209

automatic generation 84
points

feature class attributes 208
feature class optional attributes 208

polygon feature class 209
polygons

compound - 201
printing reports 518
see also area topology 320

position finder
symbol 117

primary feature class (intersection) 275
printing

page setup 491
reports in Web version 491

profile definition
creating 547

profiles
add to data model 548
data model 557

introduction 545
projection

displaying a - button 376, 381
propagation

see tracing 327
Property TextBox control 398
prototype drawing 450

path 432
Publish to MapGuide 108

Q

quality
point measurement 209

R

reachability (topology tracing) 330
read only

feature class 211
Read-Only SQL TextBox control 400
Read-Only SQL TextBox example 411
reference button

displaying a - 376, 381
Reference control 381
Reference Options dialog box 381
relation type 216
relation wizard 139
reliability (point

feature class) 209
Repair job configuration 352
report definition

adding a chart 496
creating 492
creating a head 495
creating a master-detail report 497
import 517
number of decimals 504

report designer
adding layout controls 487
charts 507
creating a report (wizard) 492
example- call via API 523
example- change colors 524
getting started 483
handling see also form designer 483
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introduction 483
link to picture folder (web) 153
options 491
printer format 491

report head 495
reports

creating (report desiger wizard) 492
defining 483
designing layout 483
number of decimals 504
with spatial selection 520

repository
display model - 431

representation 264
request parameter

urlaction.aspx 114
Restricted Topobase Main User 32
right angle course

setting the mode 124
rule base

see feature rules 194, 571

S

saving feature styles 448
scale factor select statement

label with - 234
schema

convert Oracle schema 285
schema converter 285
schema plan 264
Script Button control 402
Script Programmable control 402
scripts

assigning to a form 402
search

defining a flat search (example) 542
defining a flat search (feature

search) 536
defining a sequential search

(example) 539, 541
defining a sequential search (feature

search) 533
position finder 527
types (feature search) 527

secondary feature class (intersection) 275

Server Administrator 27–28
server data model

update 27
Set User Group For Job Template dialog

box 353
shortest path (topology tracing) 330
single sign on 39
snap radius

logical topology 316
soft split 244
spatial intialization

logical topology 335
spatial operator SDO_RELATE 282
spatial reference ID 74
spatial relationship settings 282
spatial selection

enable - for reports 520
spatial tolerance 74
split lines

feature rules 247
soft and hard split 244

SQL assistant 137
SQL Error Spy 145
SQL Form Launcher 402
SQL Info dialog box 107
SQL Label control 400
SQL label example 411
SQL protocol 192
SQL Sheet 142
SQL Spy 145
SQL Text Box control 388
SRID 74–75

updating 76
start

Topobase Web 37
Topobase WEB 114

Static PictureBox control 404
Static Text control 405
statistics

optimizing Topobase schema 191
stop condition

define 334
tracing 332

string editor 92
Structure Editor 303
Structure Editor dialog box 305
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structure update
details 29

styled maps 446
styling

label features (Topobase) 452
lines 451
maps 446

symbol
assigning a - for position finder 117

symbol library
prototype drawing 450

T

tab order
defining the - (form designer) 406

Task Pane
Display Manager overview 446

TB_COLOR_ACAD 385
TB_COLOR_WEB 385
TB_DATAMODELCODE 152
TB_GN_DIALOG_HIGHLIGHT 153
TB_GN_INFO_REDIRECT 154
TB_INFO 156
TB_LABEL 166
TB_LABEL_DEF 166
TB_POINTNUMBER 84
TB_POSITION_FINDER 170, 527
TB_RELATIONS 172
TB_RELATIONS.DELETE_CHILD 216
TB_SQL 466
TB_VAR 466
TB_VARIABLE 466
TB2TB 289

migration method 297
TBMAIN 32
TBSYS

creating 30
updating 31
view version 128

template
creating a job - 350
feature arrangement 259
job - 342

Templates
add to document 69

terrain elevation 208
text

assembling contents of
-attibutes 411

TextBox control 398
tolerance

arc linearization (topology) 315
area topology 314
connection tolerance radius

(topology) 318
intersection 278
setting the split - 124
spatial - 74
topology 315, 318

toolbar
assigning form - 364
customizing Administrator - 100
customizing Client - 100
customizing form -s 424
document main - 78

topic 181
creating 192
template 259

Topobase Main User (TBMAIN) 32
creating 30

Topobase Server Administrator 28
Topobase Web

Pop-up blocking 45
topology

creating 312
flow direction 318
getting started 312
initialization 263
introduction 311
node 312
overlapping lines 315
system tables 180

topology checker 312, 324
tracing 327

conditions 332
cost functions 332
defining - conditions 331
defining conditions 329, 340
defining templates 339
stop condition 332
templates 329
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types 330
visualize results 123

tracing result
configuring the feature explorer 92

Tracing Result dialog box 328
Tracing Template dialog box 329
trigger

compounds 261
feature rule 571

U

unit support
reports 515
set attribute units 215
settings 73

Update Coordinate System dialog box 76
URL

request parameter for Topobase
Web 37, 114

URLaction.aspx
request parameter 114

user admininstration 98
user groups

adding 98
concept 97
creating 97
removing 98

user interface
customize Administrator

toolbar 100
customize Client toolbar 100
customizing Client menus 101
customizing form shortcut

menus 426
defining form toolbars 424
hiding form controls for user

groups 373
locking form controls for user

groups 373
toolbar for feature class form 364

users
adding 98
creating 97
removing 98

utility model
creating 248
data model 246
feature rules 247
introduction 244

V

validation
defining - code for data

acquisition 407
version

document structure 128
TBSYS (topobase.jar) 128

versioning
feature locking 344
see jobs 341

vicinity 122
view

check definition 136
registration 212
using an Oracle - in a document 212

viewport
default size 126

W

web
position finder symbol 117

web layout
assigning a workspace 117

workflows
definition 103
introduction 103
show - in document explorer 106
system tables 180

workspace manager 62
workspaces

adding - to a document 62
assigning a web layout 117
creating 58
setting up - (concept) 55
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X

XYZ
show - values in a form 386

Z

Z value
enter when digitizing 210

zoom
factor for feature highlight 122
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